Introduction

Thank you for purchasing SoftBank 830N.

@ For proper handset use, read this guide.

@ Keep this guide in a convenient place for reference.

@ Accessible SoftBank services may vary by service area, subscription, etc.

SoftBank 830N is compatible with 3G network technology.

Notes
- Copying this guide in whole or part without authorization is prohibited.
- Content of this guide is subject to change without prior notice.

- Efforts have been made to ensure the accuracy and clarity of this guide. Please contact SoftBank Customer Center, General
Information (P. 15-52) about unclear or missing information.

Download the latest edition of this guide from SOFTBANK MOBILE Corp. Website.
http://mb.softbank.jp/mb/r/support/830n/




Before Using This Guide

@ SoftBank 830N is referred to as "handset” in this guide. Getting Started

@ Most operation descriptions are based on default settings and begin in Standby. ’T‘ N .

@ Sample screenshots* are provided for reference only. Actual handset windows, menus, etc. may differ |2 Basic Operations
in appearance. i

@ Key illustrations are simplified and differ in appearance from actual handset keys. ’E‘ Calling

@ "(Japanese)” appears next to functions or services which require Japanese ability to use. ’E‘ Security

* Standby Display used in this guide is based on SoftBank 830N Glitter Orange model. Design theme of i
Main Menu and windows is based on default setting Gallery. ’i‘ Mail
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’;‘ Music Player & S! Appli

’_X‘ Entertainment

’@_‘ Tools
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Basic Operations

Search Guide

Text Entry Messaging Services Mobile Internet

Learn basic menu navigation
and key operations.

P. 2-2

Use S! Mail or SMS to send text
messages. Attach and send files
via S! Mail.

Use Yahoo! Keitai to access
Mobile Internet sites tailored for

SoftBank customers.
P. 6-2

Enter text for composing
messages, creating Phone Book

entries, etc.

P. 2-12 P. 5-2

Customize E-mail Address

My Phone Number

Check your phone number on
handset.

P. 1-22

My Account Details

Save your contact information
to Account Details to send it to
your friends.

Exchange Information Wirelessly

Send your e-mail address to
compatible devices via infrared.

Change the account name (part
before @) of your e-mail address.

P. 1-22 P. 14-22 P. 13-2

Download Music
Download songs from
Chaku-Uta® sites and set as

ringtones or play back on Music
Player. P.9-4

Add Shortcuts

Add frequently used functions
to Desktop Icons.

Set Ringtones

Set your favorite songs as
ringtones.

Wallpaper
Set your favorite image to appear
in Standby with clock or calendar.
P. 14-10

P. 14-4 P. 2-5

Music Player

Camera & Video Camera Osaifu-Keitai®

Download songs and play them
on handset.

P. 9-2

Shoot still images and videos. Handset supports One Seg

Digital TV.

Use your handset for payment of
purchases with electronic money
or as a commuter ticket or point

P.7-2 P. 8-2 card. P. 11-2

Yahoo! Keitai Sites

A special portal site for SoftBank
handsets enhances your Internet

browsing experience.
P. 6-3

Graphic Mail
Create HTML messages by
changing font and background

colors, inserting images, etc.
P.5-4

S! Quick News
Subscribe to News and receive
automatic updates regularly.

Gaming Device

Play S! Appli games downloaded
from Yahoo! Keitai sites.

P.9-8 P. 10-5




@ Duplicating, modifying or publicly transmitting copyright-
protected contents (e.g. text, images, music, software)
photographed or downloaded from websites without the
permission of the copyright holders is prohibited by copyright
laws, with the exception that the duplication or quotation of
those is made only for personal use.

Shooting or recording a demonstration, performance or
exhibition may be prohibited in some cases even if it is for
personal use.

Shooting a photo of a person using this product without his or
her permission, or posting a photo of a person you shot on
websites without his or her permission may constitute an
infringement of portrait rights.

@ Mobile Widget, S! Appli, S! Mail, PC Site Browser and Graphic Mail

are registered trademarks or trademarks of SOFTBANK MOBILE Corp.

@ SOFTBANK, SOFTBANK's equivalent in Japanese, and the
SOFTBANK logo are trademarks or registered trademarks of
SOFTBANK CORP. in Japan and in other countries.

@ Yahoo! and the Yahoo! and Y! logos are trademarks and/or
registered trademarks of Yahoo! Inc. in the US.

@ Osaifu-Keitai® is a registered trademark of NTT DOCOMO.

@ Licensed by QUALCOMM Incorporated under one or more of

the following United States Patents and/or their counterparts in
other nations:
4,901,307 5,490,165 5,056,109 5,504,773
5,101,501 5,506,865 5,109,390 5,511,073
5,228,054 5,535,239 5,267,261 5,544,196
5,267,262 5,568,483 5,337,338 5,600,754
5,414,796 5,657,420 5,416,797 5,659,569
5,710,784 5,778,338

@ The microSD™ logo and

Intellectual Property R

@ 79€ is trademarks and/or registered trademarks of

Nuance Communications, Inc. and/or its affiliates in @.ﬂ%&
the United States and/or other countries.

icro micro”
Mg Migro

with MPEG-4 Visual Patent Portfolio License, and you are

permitted to use personally and for the nonprofit purpose in

the following situations:

- To record a movie based on the standard of MPEG-4 Visual
(MPEG-4 Video)

- To play MPEG-4 Video recorded by the consumer engaged in
the nonprofit activities

microSDHC™ logo are trademarks.

@ This product is licensed complying

- To play MPEG-4 Video provided by the provider licensed by
When you use it for other purposes, such as promotion, in-
house information and profit activity, contact the U.S.

@ This product contains Adobe® Flash® Lite™
Player under license from Adobe Systems
Copyright® 1995 - 2009 Adobe Macromedia Software LLC. All
rights reserved.
trademarks of Adobe Systems Incorporated in the United
States and/or other countries.

MPEG-LA
corporation MPEG LA, LLC.
ADOBE'
V3 FLASH
Incorporated. ENABLED
Adobe, Flash and Flash Lite are either registered trademarks or
@ QR code is a registered trademark of Denso Wave Inc.



Intellectual Property Rights

@ Powered by JBlend™ Copyright 2002 - 2009 Aplix
Corporation. All rights reserved.
JBlend and JBlend-related trademarks are trademarks

@

or registered trademarks of Aplix Corporation in JBlend’
Japan and other countries.

@ Java and all Java-related trademarks and logos are (
trademarks or registered trademarks of US Sun t_f)
Microsystems, Inc. in the United States and other E’;

countries.

@ Chaku-Uta and Chaku-Uta Full are trademarks and/or
registered trademarks of Sony Music Entertainment (Japan) Inc.
in Japan and/or other countries.

@ This product contains NetFront Mobile Client Suite
of ACCESS CO., LTD.

ACCESS, ACCESS logo and NetFront are
trademarks or registered trademarks of ACCESS
CO., LTD. in the United States, Japan and other countries.
©2008 ACCESS CO., LTD. All rights reserved.

This software is based in part on the work of the Independent JPEG
Group.

[ ] y(wjls pl_r_l(_)guct is equipped with IrFront by ACCESS IrFront
©2008 ACCESS CO., LTD. All rights reserved.

@ Bluetooth and the Bluetooth logo are ™
€ Bluetooth

registered trademarks of Bluetooth
license for their use from Bluetooth SIG, Inc.

POWERED

ACGESS’
N&&)ﬁ! ae'!nt;ulte

SIG, Inc. NEC Corporation is granted a

@ Multitask, Privacy Angle, Life History Viewer, Quick Info,
Desktop info, Quick Album, Word Prediction, Tomo-Den and
Tomomato-Mail BOX are trademarks or registered trademarks
of NEC Corporation.

@ Powered By Mascot Capsule®/Micro3D Edition™
MASCOT CAPSULE® are registered trademarks of HI
CORPORATION.

@ G-GUIDE, G-GUIDE MOBILE and their logos are registered
trademarks in Japan of U.S. Gemstar-TV Guide International, Inc.
and/or its affiliates.

@ IrSimple™, IrSS™ or IrSimpleShot™ are trademarks of Infrared
Data Association®.

@ Hyper Clear Voice is commercially available based on the
license for SRS VIP+ technology from SRS Labs, Inc. SRS, VIP+,
and the (@) symbol are trademarks of SRS Labs, Inc.

@ TruMedia and Dialog Clarity SRS (®) SRS (®)
[ TruMedia 5.1]

technologies are industrialized
based on the license from SRS Dialog Clarity

Labs, Inc.
Trumedia, Dialog Clarity, SRS and the (@) symbol are
trademarks of SRS Labs, Inc.

@ This product contains software licensed complying with GNU
General Public License (GPL), GNU Lesser General Public
License (LGPL), etc.

For more details, visit “GPL - LGPLEZICDW T at
http:/Awww.n-keitai2.com/guide/download/

@ FrameSolid™ by Morpho, Inc. is used for the frame
interpolation function.

FrameSolid™ is a registered trademark of Morpho, Inc.
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@ This product is equipped with the font FontAvenue product by
NEC Corporation.

@ BookSurfing is a registered trademark of CELSYS, Inc., Voyager
Japan, Inc., and INFOCITY, Inc.

[ ] is a registered trademark of FeliCa Networks, Inc.

@ FeliCa is a contactless IC card technology developed by Sony
Corporation. FeliCa is a registered trademark of Sony
Corporation.

@ Microsoft®, Windows®, Windows Media® and Windows Vista®
are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

@ Microsoft Windows Operating System is indicated in its
abbreviated form as Windows.

@ OS (Japanese) are abbreviated as follows in this guide.

- Windows Vista is an abbreviation of Windows Vista® (Home
Basic, Home Premium, Business, Enterprise, Ultimate).

- Windows XP is an abbreviation of Microsoft® Windows® XP
Professional operating system or Microsoft® Windows® XP
Home Edition operating system.

- Windows 2000 is an abbreviation of Microsoft® Windows®
2000 Professional operating system.

@ This product is antibacterial-coated.

Antibacterial part: Handset body (excluding Display, keys and

terminals)

Inorganic antimicrobial agent, coating: JP0122112A0003N

The SIAA logo indicates the quality control and

information disclosure for this product conformto ~ SIAA:

the guidelines of the Society of Industrial e IN

Technology for Antimicrobial Articles, as a result of evaluations
conducted under ISO 22196.

@ ©ATR-Trek Co., Ltd.

@ OREAZKR/URAD

@ ©0TOMY

@ ©2006 Y15 b=—/KUH

@ ©SUGAR

@ TM&©2008 Felix the Cat Productions, Inc. All Rights Reserved

@ ©DAIKIN.H.T., 2000

@ ©T2i Entertainment

@ The other company names and brand names described in this
guide are trademarks or registered trademarks of the
respective companies.
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ackage Contents

The following items are included in the package with handset.
For additional information on accessories, contact SoftBank Customer Center, General Information (P. 15-52).

M Battery (NEBAL1) Ml Stereo Earphone Conversion
Cable (NELAH1)

M Starter Guide H Warranty (Handset)

- SoftBank 830N supports microSD™ and microSDHC™ memory cards. Purchase a memory card to use related functions.
- Use only specified AC charger (sold separately) to charge handset.



Safety Precautions

@ To ensure proper use of your handset, read these safety Bl Symbols
precautions carefully before use. Keep this guide for future @ Make sure to understand the following symbols and
reference. precautions before reading this guide.

@ Observe these safety precautions to prevent injuries and
damages to property.

@ SoftBank accepts no liability for any loss or damages incurred
by you or a third party as a result of missed calls, etc., due to
malfunction, erroneous operation or failure of this product.

Action is prohibited.

Disassembly is prohibited.

M Labels

@ Risks of injury or damage from improper use are categorized by
levels. Understand these labels before reading this guide.

Wetting the product is prohibited.

® 2o

Handling with wet hands is prohibited.

=)

Great risk of death or serious injury

&DANG ER from improper use

Risk of death or serious injury from

AWARN | NG improper use

Risk of injury or damage to property

& CAUT' O N from improper use

Action is compulsory.

Unplug power cord.

OO &

xi



Safety Precautions

M Handset, Battery, USIM Card, AC Charger Do not charge, use, or leave handset in
(Sold Separately), Memory Card (Not . ® places subject to high temperatures
Included), & Stereo Earphone Conversion (near an open flame or heating
Cable equipment, in direct sunlight or inside a

car on a hot day).

A DAN G E R May cause deformation or malfunction; or may

cause Battery to leak, overheat, ignite, or rupture.

Also, the outer housing may become hot resulting

in burns.

Use SoftBank specified devices (Battery, hicle i fe locati h King |
h tc) onl Stop vehicle in a safe location (where parking is
AC Charger, etc. Y- allowed) before using handset.

Use of non-specified devices may cause Battery to
leak, overheat, rupture or ignite; or may cause
Charger to overheat, ignite, or malfunction.

Do not use excessive force to attach
® Battery or connect AC Charger to

: - handset. Battery or AC Charger may be
® Do not disassemble/modify/solder the wrong way around.

handset. o
Battery may leak, overheat, rupture or ignite.

May cause fire, injury, electric shock or malfunction.
Also, Battery may leak, overheat, rupture or ignite.
Modification of telephone equipment violates
statutory regulations and is subject to penalty.

Keep liquids away from handset.

a J7d

m! If handset and/or battery is not dried after exposure
- to fluids (water, pet urine etc.), overheating, electric
shock, fire, malfunction, etc. may occur.

xii



Safety Precautions

/N\WARNING

O

Do not place handset, Battery, AC
Charger, or Stereo Earphone Conversion
Cable in a microwave oven or pressure
cooker, or on top of an induction heating
(IH) cooktop.

May cause Battery to leak, overheat, rupture or

ignite; or may cause handset/AC Charger to
overheat, emit smoke, ignite, or malfunction.

N

Do not drop or throw handset or expose
it to excessive shock.
May cause battery to leak, overheat, rupture or

ignite; or may cause fire, electric shock, or
malfunction.

Turn off handset when entering gas
stations or other places where flammable
gases (propane gas, gasoline, etc.)
generate. Do not charge battery in such
places.

Gases may ignite.

Before using a mobile phone with Osaifu-Keitai®
inside a gas station, be sure to turn it off. (If IC card

lock is activated, first deactivate it and turn power
off.)

o

If you notice an unusual sound, odor,

smoke, etc. while using, charging or

storing handset, immediately do the

following:

1. Unplug AC Charger from outlet.

2. Turn handset power off.

3. Remove Battery from handset, being careful of
burn or injury.

Continuing use may cause fire or electric shock.

Keep liquids (water, pet urine, etc.) and
conductive materials (e.g. pencil lead,
metal fragments or metal necklaces,
hairpins, etc.) away from External Device
Port and Memory Card Slot.

May cause short circuit, resulting in fire or
malfunction.

xiii



Safety Precautions

Xiv

/AN CAUTION

2,

Do not place handset on a sloping or
unstable surface.
May cause handset to fall resulting in injury or

malfunction. Take particular care when vibrator is
activated.

Keep handset out of reach of infants.

Failing to do so may result in small parts being
accidentally swallowed, or may cause injury.

B Handling Battery

/N\DANGER

@ Properly use and dispose of Battery after checking its
type as displayed on the label on Battery.

Display Battery type

Li-ion00 Lithium-ion

When a child uses handset, it is
recommended that a parent provide
proper instructions to the child and keep
an eye on how the child uses handset.

Failing to do so may cause injury, etc.

Do not store handset in humid or dusty
places or in places subject to high
temperatures.

May cause malfunction.

e 0 O©9

Be careful not to pinch your fingers in
the hinge when opening handset.

Failing to do so may cause injury.

Do not throw Battery into a fire.

May cause Battery to leak, rupture or ignite.

Do not puncture Battery with a nail, hit it
® with a hammer, step on it, or subject it to
strong impact.

May cause Battery to leak, overheat, rupture or
ignite.




Safety Precautions

N

Do not let metal objects (pins, etc.) come
in contact with Battery Terminals. Do not
carry or store conductive materials (e.g.
pencil lead, metal fragments or metal
necklaces, hairpins, etc.) together with
Battery.

May cause Battery to leak, overheat, rupture, or
ignite.

o

If Battery is not fully charged after the
specified charging time has elapsed, stop
charging it.

If you continue charging, Battery may leak,
overheat, rupture or ignite.

If battery fluid gets into your eyes,
immediately rinse your eyes with clean
water without rubbing them, and
consult a doctor.

Failing to do so may result in losing your eyesight.

If you notice an unusual odor,
overheating, discoloration, deformation,
etc. while using, charging or storing
Battery, remove it from handset being
careful of burn or injury, and keep it
away from fire.

Continuing use may cause Battery to leak, overheat,
rupture or ignite.

/NWARNING

If battery fluid gets on your skin or
clothing, immediately stop using and
rinse the fluid off with clean water.

Battery fluid may injure your skin.

If Battery leaks or emits an unusual odor,
immediately stop using it and keep it
away from fire.

Battery fluid is flammable and could ignite causing
fire or could rupture.

If an abnormality in Battery from
external impact (deformed or scratched
from dropping) is visible, immediately
discontinue use.

May cause Battery to leak, overheat, rupture, ignite;
may cause handset malfunction or fire.

Xv



Safety Precautions

BMHandling Handset

xvi

o

Do not allow pets to bite Battery.

May cause Battery to leak, overheat, rupture, ignite;
may cause handset malfunction or fire.

/N\ CAUTION

/N WARNING

N

Do not dispose of batteries as municipal
waste.

Bring used batteries to the nearest SoftBank Shop
or recycling center after insulating the terminals
with tape.

Be sure to observe local regulations on battery
disposal.

N

Do not use while operating a vehicle (car,
motorcycle, bicycle, etc.)

May cause a traffic accident.

Use of a mobile phone while driving is prohibited by
law, and is subject to penalty.

Stop vehicle in a safe location (where parking is
allowed) before using handset.

Keep handset power off near high
precision electronic devices or devices
using weak signals.

Failing to do so may interfere with the device

operation.

* Examples of such devices:
Hearing aids, implanted cardiac pacemakers,
implanted defibrillators and other electronic
medical equipment; fire alarms, automatic doors
and other automatic control devices.




Safety Precautions

Keep handset power off aboard an
aircraft.

Disable auto power-on functions (such as the alarm
function) before turning off handset.

May jeopardize safety of the airplane. Handset
operation aboard an airplane is prohibited by law
and subject to penalty.

If you have a weak heart, be careful with
incoming call vibrator and ring volume
settings.

These may affect your heart.

o

Keep handset away from your ear when
calling in handsfree mode. When playing
games or music with Earphone-
Microphone connected to handset,
adjust the volume properly.

If the volume is too high, it may impair your

hearing. If surrounding sounds cannot be heard
clearly, it may result in an accident.

If thunder is heard outside, retract
Antenna, immediately turn handset
power off and move to a safe place.

Failing to do so may attract lightning and cause
electric shock.

2,

Do not place handset on the dashboard
close to airbags.
In case of airbag inflation, handset may hit

passengers resulting in injury, malfunction or
breakage.

Do not point infrared beam at anyone’s
eyes.
May cause eye injury.

e

If Display or Camera Lens is damaged, be
careful of broken glass pieces or exposed
internal components.

The Display’s reinforced glass prevents shattering;

however touching broken glass edges and exposed
pieces may cause injury.

VL @ e @

If you use electronic medical equipment,
do not place handset in breast pocket or
inner coat pocket.

Using handset near electronic medical equipment
may cause the equipment to malfunction.

Do not allow fluids such as water, metal
pieces or flammable materials to enter
USIM Card Slot or microSD™ Memory
Card Slot.

May cause fire, electric shock or malfunction.

Xvii



Safety Precautions

xviii

/AN CAUTION

If handset affects car electronics, stop
use.

Handset use may affect electronics in some car
models and impair safe driving.

Use caution when using handset for an
extended period as handset may become
hot, especially in high-temperature
conditions.

Skin contact for extended period may cause low-
temperature burns.

If skin abnormality occurs with use of
handset, immediately discontinue use
and consult a doctor.

Handset contains metal material. Depending on

your physical condition, you may experience
itchiness, rash, etc.

Do not bring speaker close to the ear
when making calls in handsfree mode or
when ring tone/melody is playing.

May impair your hearing.

Keep magnetic cards away from handset
and make sure that a magnetic card is
not trapped when closing handset.
Failing to do so may cause magnetic data on a cash

card, credit card, telephone card or floppy disk to
be lost.

Be careful not to pinch your fingers or
Strap when opening and closing
handset.

May cause injury or damage.

Watch TV with adequate lighting and
distance from Display.

May contribute to impaired eyesight.

Do not swing handset by Antenna,
Strap, etc.
Handset may strike you or people around you, or

the strap may break, resulting in injury, malfunction
or breakage.

e & 0 @

Do not turn volume up too high when
using earphones.

Using earphones for extended periods at high
volume may impair hearing or harm your ears.




Safety Precautions

® If Display breaks do not inhale or touch B Handling USIM Card

liquid crystal.
If liquid crystal enters your eyes or f}
mouth, immediately rinse with clean CAUTI o N

water and consult a doctor.

- , . Be careful handling the Notch when
If liquid crystal adheres to your skin or clothing, K .
immediately wipe off with alcohol and wash with o removing USIM Card (IC chip).
soap and water. May injure your hands or fingers.
May result in losing your eyesight or harming your
skin. B Handling AC Charger

Do not use in crowded locations.

Antenna may hit other persons causing injury. Q WARN I N G

Do not use Antenna if broken.
May cause burns or injuries upon skin contact. ® Do not place Charger on a sloping or

unstable surface during charging.

Keep magnetized objects away from May cause handset to fall resulting in malfunction.

handset.

Y\ o1%

Do not cover with clothing or bedding
during charging.
Heat may build up resulting in fire or malfunction.

May cause operation errors.

Xix



Safety Precautions

XX

N

Use the specified power supply and
voltage.

Failing to do so may cause fire or malfunction.
AC Charger: 100 to 240 V AC

(for household AC outlets only)
Also, do not use commercially available transformer
for travel use. May cause fire, electric shock, or
malfunction.

e

When plugging AC Charger into outlet,
keep conductive materials (pencil lead,
metal parts, necklaces, hair pins, etc.)
away from AC Charger plug/terminals
and plug Charger firmly into outlet.

Failing to do so may cause electric shock, shorting,
fire, or other dangers.

Hold and unplug AC Charger from outlet
if handset is not used for an extended
period of time.

Failing to do so may cause electric shock, fire or
malfunction.

Do not touch AC Charger with wet
hands.

May cause electric shock or malfunction.

&

If liquid (water, pet urine, etc.) gets into
AC Charger, immediately unplug AC
Charger from outlet.

Failing to do so may cause electric shock, smoke
emission or fire.

If thunder is heard, do not touch AC
Charger.

May cause electric shock.

Do not use AC Charger if the cord is
damaged.

May cause electric shock, overheating or fire.

If dust or dirt has gotten on the plug,
hold and unplug AC Charger from outlet
and wipe off with a dry cloth.

Failing to do so may cause fire.

2 ® Qe

Do not use AC Charger in humid places
such as in bathrooms.

May cause electric shock.




Safety Precautions

® Do not short-circuit Charger Terminals
when Charger is plugged into an outlet. A C U O
Do not touch Charger Terminals with A TI N
your fingers, etc.
May cause fire, malfunction, electric shock or injury.

® Do not place heavy objects on the cord

When AC Charger is connected to an
outlet, do not pull on cord or otherwise
subject Charger to strong shock.

of AC Charger.
May cause electric shock or fire.

May cause injury or malfunction.

Firmly hold plug and unplug AC Charger
from outlet before cleaning.

Failing to do so may cause electric shock.

Do not unplug AC Charger by pulling the
cord. Firmly hold plug and unplug AC
Charger.

Pulling the cord may damage the cord resulting in
electric shock or fire.

Do not charge a wet battery.
May cause battery to overheat, ignite or rupture.

Unplug Charger from outlet when
charging is finished.
Failing to do so may cause fire or malfunction.

NSV ©6 O
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Safety Precautions
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B Near Electronic Medical Equipment

@ The following information conforms to “The Guidelines on Use
of Mobile Phones and Other Devices to Prevent
Electromagnetic Wave Interference with Electronic Medical
Equipment” (Electromagnetic Compatibility Conference Japan,
April 1997), as well as refers to “The Investigative Research
Report on the Influence of Electromagnetic Waves on Medical
Equipment” (Association of Radio Industries and Businesses,
March 2001).

/N\WARNING

When using electronic medical
equipment other than implanted cardiac
pacemakers/defibrillators outside of
medical institutions, consult device
manufacturer about the influence of
radio waves.

Radio waves may interfere with the operation of
electronic medical equipment.

If you use an implanted cardiac
pacemaker or implanted defibrillator,
carry and use handset at a distance of at
least 22 centimeters away from the
implanted area.

Radio waves may interfere with the operation of

implanted cardiac pacemakers or implanted
defibrillators.

0

Observe the following in medical
institutions. Radio waves from handset
may affect electronic medical equipment.

+ Do not bring mobile phones into an operating
room, ICU (Intensive Care Unit) or CCU (Coronary
Care Unit).

Turn off mobile phones in hospital wards. Disable
auto power-on functions (alarm, etc.) before
turning off mobile phones.

Turn off mobile phones even in lobbies or areas
where use is permitted if there is electronic
medical equipment nearby.

Observe the instructions of individual medical
institutions and do not use or bring mobile phones
into prohibited areas.

.




Safety Precautions

o Keep handset power off in crowded

places such as in packed trains because a
person with an implanted cardiac
pacemaker or implanted defibrillator
may be nearby. Disable auto power-on
functions (alarm, etc.) before turning off
mobile phones.

Radio waves may interfere with the operation of
implanted cardiac pacemakers or implanted
defibrillators.
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General Notes

Usage Basics

@ As handset uses radio waves, it cannot be used where signals are weak or when it is out of service area. If you move to a place with
poor signal reception (e.g. beside/inside a building, in a tunnel, underground or mountain area), calls may be suddenly cut off.
@ Take care not to disturb other people when using handset in public places.
@ If you receive a call while walking, move to a safe place before answering.
@ SoftBank accepts no liability for any damages arising from loss or alteration of data (Phone Book, images, sound, etc.) stored on your
handset or microSD™ memory card as a result of accident or malfunction. Back up important data such as Phone Book entries.
@ Handset is a wireless station under Japanese Radio Law. You may be requested to submit your handset for inspection based on this
law.
@ Using handset near a landline phone, TV or radio may affect the operation of these devices. Use handset as far away as possible
from these devices.
@ Be aware of eavesdropping. Handset employs a digital signal that provides a high level of privacy protection. However, the possibility
of eavesdropping by a third party using special means cannot be ruled out.
<Eavesdropping>
Interception of radio signals by a third party during communication, either intentionally or accidentally
@ Do not trap Strap or other objects when opening and closing handset. Doing so may cause malfunction or damage handset.
@ Display has a protective film to ensure safety (prevent shattering) due to breakage if dropped or subjected to impact. Do not forcefully
remove or damage this film.
May cause injury.
@ Using handset on trains or other public transportation may, in some rare cases, affect their electronic devices.
@ A call may not be connected or you may hear noises:
- In an extremely cold place (e.g. freezer storehouse) where handset may not operate normally
- Near metal furniture which may interfere with signal transmission
- Near electromagnetic sources or magnetized items, including electric products, audio-visual equipment and office appliances (e.g.
computer, microwave oven, speaker, TV set, radio, fax machine, fluorescent lamp, word processor, electric kotatsu, inverter-driven
air conditioner, electromagnetic cooker)

XXiv



General Notes

@ Bluetooth devices operate at the same frequencies assigned to licensed in-house radio stations (in factory production lines), specific
unlicensed low power radio stations, and licensed amateur radio stations (hereafter, “another radio station”) for mobile identification
in addition to scientific, medical, or industrial devices (microwave ovens).

1 Make sure that “another radio station” is not operating nearby.
2 If this equipment interferes with an in-house radio station, immediately change frequency, move to another place or stop
transmission, and contact the following for advice (setting up of partitioning, etc.).
3 If interference between this equipment and a specific low power radio station or amateur radio station occurs, contact the
following.
SoftBank Customer Center From SoftBank handsets 157 (toll-free)
(From any other phones, refer to “Contact” (P. 15-52))

@ If Battery appears deformed or scratched from external impact, contact Customer Assistance.

@ Keep a backup copy of data saved to handset. SoftBank accepts no liability for any loss of data stored on your handset.

@ Do not sit with handset in back pocket of trousers or skirt. Do not place at bottom of bag where handset will be subject to excessive
weight. May cause malfunction.

@ If you use handset for the first time or after an ex ended period of disuse, charge Battery before using handset.

@ Battery operating time varies by the usage environment and the condition of Battery.

@ Do not charge Battery:

- In a humid, dusty, or shaky place
+ Near a landline phone, TV or radio

@ Although AC Charger may become warm while charging, it is not a malfunction.

@ Do not subject handset to excessive shock. Do not deform Charger Terminals. Doing so may cause malfunction.

@ Charge in a location with an ambient temperature within the appropriate range (5 to 35 °C).

@ When Battery life nears its end, it may expand slightly. This is not a malfunction.

@ Handset's FeliCa reader/writer function uses ultra-weak radio waves not requiring radio licensing. Operates at 13.56 MHz range.
Maintain enough distance when using other reader/writers nearby. Be sure to check that other wireless stations operating at the
same frequency range are not nearby.

@ Keep handset away from strong magnetic force. May cause malfunction.

@ Do not scratch Display with metal objects, etc. Doing so may damage Display resulting in malfunction or breakage.
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General Notes

@ Do not insert sharp/hard objects in earpiece/speaker. May cause malfunction or damage.
@ When handset is open, a gap forms between the Display backside and keypad. Keep foreign objects or liquids (water, metal
fragments, flammable materials or any other foreign objects) from entering gap.

Inside Cars

@ Do not use handset while driving. Doing so may compromise safe driving and cause an accident. Handset operation in a car may be
punishable by law.

@ Before using handset, stop the car in a safe place.

@ Handset use may affect electronics in some car models. Confirm with your car dealer whether sufficient magnetic protection
measures are implemented in your car. Failing to do so may compromise safe driving.

Aboard Aircraft

Never use (or even power on) handset on an aircraft. Doing so may compromise flight safety and cause an accident. Handset operation
aboard an aircraft may be punishable by law.

Handling

@ Keep away from liquids and moisture.
Handset, Battery, AC Charger and USIM Card are not waterproof. Do not use them in the rain or in other humid places (e.g.
bathrooms). When carrying handset near your body (pockets, etc.), moisture from sweat may corrode internal parts and cause
malfunction. Damage caused by moisture, as mentioned above, is not be covered by the warranty and repair may not be possible.
@ Use a dry soft cloth (e.g. eyeglass cloth) to wipe handset.
Handset's color LCD may be treated with special coating for enhanced visibility. Rubbing Display with a dry cloth may scratch the
surface. Clean handset carefully using a dry soft cloth for eyeglasses. If moisture or soil is left on Display, the coating may stain or
peel off.
Do not use alcohol, thinner, benzene or detergent, as it may cause discoloration and remove printed logos.
@ Occasionally clean Terminals with a dry cotton swab.
Soiled Terminals may cause poor contact resulting in power failure and insufficient charging.
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General Notes

@ Do not place handset near an air conditioner vent.
Condensation may form due to abrupt temperature changes, leading to internal corrosion and malfunction.

@ Do not apply excessive force to handset and Battery.
Placing handset in a bag packed with many items or sitting down with handset in your pocket may damage Display, Internal Circuit
Board or Battery, and cause malfunction.
Doing so with external device connected to External Device Port may damage connector, leading to malfunction.

@ Although handset becomes warm while being used or charged, it is not a malfunction.

@ Do not leave the Camera Lens exposed to direct sunlight.
Doing so may discolor or burn Optical Element.

@ Do not affix thick stickers or labels to the Display or Keypad side.
Doing so may result in malfunction.

@ Do not leave Battery removed or uncharged for an extended period of time. Doing so may alter or erase the settings and data you
saved. SoftBank accepts no liability for any damages resulting from such loss or alteration.

@ Do not store empty Battery.
Doing so may degrade performance and shorten life of Battery.

@ Keep the covers of External Device Port and microSD™ Memory Card Slot closed.
If they are left open, dust or water may get inside handset causing malfunction.

@ \When removing Stereo Earphone Conversion Cable or AC Charger from External Device Port, do not pull the cord, hold the
connector. Pulling the cord may result in wire breakage or malfunction.

@ If you use an outlet with pullout prevention feature, refer to the instruction manual of the outlet.

@ Avoid extremely cold and high temperatures.
Use handset at an ambient temperature of 5 to 35 °C, and a humidity of 45 to 85 %. If handset is left in an extremely hot place,
handset may power off automatically.

@ Battery is a consumable item. Replace Battery with a new one if the operation time becomes extremely short even after it is fully
charged (depends on conditions of use). Purchase a new battery designated for handset.

@ Charge Battery at an ambient temperature of 5 to 35 °C.
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General Notes

@ Bluetooth function should only be used within Japan. Handset's Bluetooth function complies with and has obtained certification for
Japanese wireless standards.
You may be subject to penalty if used abroad.

@ The FeliCa reader/writer function should be used within Japan. Handset's FeliCa reader/writer function complies with Japanese
wireless standards and you may be subject to penalty if used abroad.

@ The IC card authentication function should be used within Japan. Handset's IC card authentication function complies with wireless
standards and has obtained certification.
You may be subject to penalty if used abroad.

@ Do not attach USIM Card with labels or stickers attached to handset.
May cause malfunction.

@ When connecting an external device, do not insert the connector into External Device Port at an angle. When external device is
connected, do not pull the cord.

@ Do not use handset without Battery Cover.
Battery may dislodge and result in malfunction or breakage.

@ Do not attach labels or stickers to the backside of handset’s Display.
Labels or stickers may catch when handset is opened or closed, resulting in malfunction or breakage.

@ Handset incorporates a security function compliant with Bluetooth standards for security with Bluetooth communication. However,
security may be insufficient depending on such factors as settings. Care is required for communication using Bluetooth.

@ SoftBank accepts no liability for leak of data or information during communication using Bluetooth.

@ Handsfree/remote control features are available only with compatible Bluetooth devices (headsets, audio devices, etc.).

@ Frequency range (1) @ (@)
Frequency range usable with handset's Bluetooth function are as follow. 24 FH 1
124 : Wireless facilities employing 2400 MHz range I S
(2) FH : Modulation method is FH-SS method @
3)1 . Estimated distance from which device causes interference is 10 m or less
(4) —T—T1—2 : Device uses all radio frequencies form 2400 MHz to 2483.5 MHz, and it is not possible to avoid the frequencies

used by mobile object identification systems
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General Notes

@ Precoutions using Bluetooth device
This product operates at radio frequencies assigned to licensed in-house radio stations used in production lines of a factory, specific
unlicensed low power radio stations, and amateur radio stations (hereafter, referred to as “another radio station”) for mobile
identification in addition to scientific, medical, or industrial devices such as microwave ovens.
1. Before using this product, make sure that “another radio station” is not operating nearby.
2. If radio interference between this product and “another radio station” occurs, move immediately to another place or stop radio

transmission to avoid interference.

3. Contact "SoftBank Customer Center, General Information (P. 15-52)" on the back of the guide for details.

@ To use Earphone-Microphone (sold separately), you must connect Stereo Earphone Conversion Cable into External Device Port.

Stereo Earphone Conversion Cable

@ Do not force connector into External Device Port. Connector may be the wrong way around. Check direction of connector before
inserting to avoid damage.

@ When using earphones to make/take calls, earphones must be equipped with a microphone to transmit your voice.

@ You can also hear monaural sound (phone conversation, etc.) in both left and right earphones when you connect a stereo earphone
to Stereo Earphone Conversion Cable.
When a monaural earphone is connected, you can only hear the left channel of stereo audio.

@ Do not expose Stereo Earphone Conversion Cable to excessive shock or throw it at something.

@ Do not place heavy objects on Stereo Earphone Conversion Cable.

@ Beware of use while driving a vehicle. Holding and using a mobile phone is subject to penalty. If it is necessary to receive a call,
indicate that you will call back with handsfree, and call back after stopping the vehicle in a safe location.

Camera

Creating public disturbances from using handset may be subject to penalties based on applicable laws and regulations (e.g. nuisance
prevention ordinance by municipal governments).
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General Notes

Speaker

Since handset's receiver (earpiece) also acts as a speaker, there is the possibility of loud sound directly entering your ear such as when
playing back sound or a call is received. Loud sound impacting your ear may impair hearing. As soon as a call has ended, be sure to
distance handset from your ear.

Touch Sensor
Do not press Touch Sensor with excessive force or use sharp objects (finger nail, ballpoint pen, pin, etc.). May damage sensor.

Copyrights

Copyrighted materials, such as music, images, computer programs and databases, and their respective copyright holders are protected
by copyright laws. Duplication of copyrighted materials is permitted only for individual or home use. Duplications (including data
conversion), modifications, transfers or network distributions of copyrighted materials for purposes other than stated above without
permission of the copyright holders constitute an infringement of copyrights and violation of copyright holders’ rights, potentially
causing claims for reparations or criminal punishment.

Always observe applicable copyright laws when making copies using handset and recording materials using handset camera.

The software installed in this handset is a copyrighted material and involves copyrights and human rights of copyright holders which
are protected by copyright laws. Do not duplicate, modify, alter, detach from the hardware, disassemble, decompile or reverse-engineer
the software in whole or in part by yourself, nor allow any third party to do the same, either.

Functional Limitations
After handset upgrade, subscription cancellation or long periods of handset disuse, TV becomes unavailable.
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General Notes

Caution

Do not use handset if it has been altered. Using an altered device is a violation of the Radio Law.

This handset is certified to conform to the technical standards for specific radio equipment based on the Radio Law, and Technical
Conformity Mark &is printed on the model name seal as certification. If you remove screws and make alterations inside of handset,
the technical standards conformity certification becomes invalid. Do not use handset with the certification invalid, as it is a violation of
the Radio Law.
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General Notes

SAR Certification Information

830N meet the technical standards set by Ministry of Internal Affairs and Communications (MIC) regarding radio wave absorption by a
human body.

These technical standards have been established on a scientific basis to prevent radio waves emitted from wireless devices such as mobile
phones that are used close to a human head from affecting human health. These standards require that the SAR (Specific Absorption
Rate), an indicator of the amount of average radio frequency energy absorbed in the side of a human head, must not exceed the permissive
value of 2 W/kg*. This value includes a substantial safety margin to assure the safety of all persons, regardless of age and physical size.
The value is equal to the international guideline recommended by the International Commission on Non-lonizing Radiation Protection
(ICNIRP) that has a cooperative relationship with the World Health Organization (WHO).

* The technical standards are stipulated in the Radio Law (Article 14-2 of Ordinance Regulating Radio Equipment).

The highest SAR value is 0.362\W/kg for 830N. This value was obtained in accordance with the MIC testing procedure with handset
transmitting at its highest permitted power level. While there may be differences in SAR levels among individual products, they all meet
the MIC’s permissible value. Because mobile phones are designed to operate at their minimum power level required to communicate
with base stations, the actual SAR of handset during a call is usually below the highest value.

For further information about SAR, see the following websites:

+ Ministry of Internal Affairs and Communications (MIC)
http:/Awvww.tele.soumu.go.jp/e/ele/index.htm

- Association of Radio Industries and Businesses (ARIB)
http:/Awvww.arib-emf.org/initiation/sar.html (Japanese)
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General Notes

SoftBank’s Body SAR Policy

*  Body SAR: The SAR value at the maximum transmission power when continuously talking with handset placed on the body and
using earphone-microphone.

**  Specific Absorption Rate (SAR): The value measured when having talked continuously for 6 minutes.

*** Placement on the body: Measurements are taken with the rear of handset facing the body at a distance of 1.5 cm as the ordinary
handset position. In order to comply with radio frequency exposure requirements, use an accessory (e.g. belt clip, holster) that does
not contain metallic parts to maintain a 1.5 cm separation between the body and handset.

For more information, see SOFTBANK MOBILE Corp. Website:
http://www.softbankmobile.co.jp/ja/info/public/lemf/emf02.html

European RF Exposure Information

This handset 830N is a radio transmitter and receiver. This product has been confirmed not to exceed the limits recommended by
international guidelines for radio frequency.

These guidelines were developed by the independent scientific organization International Commission on Non-lonizing Radiation
Protection (ICNIRP) and include a substantial safety margin to assure the safety of all persons, regardless of age and health.

The influence on the human body of radio waves emitted from mobile phones is measured employing a unit known as the Specific
Absorption Rate (SAR). The SAR limit for mobile devices is 2 W/kg. The maximum SAR value for this model handset, when placed on the
ear, is 0.292W/kg for 830N*. As mobile devices offer a range of functions, they can be used in other positions, such as on the body as
described in SoftBank’s Body SAR Policy. In this case, the maximum SAR value is 0.438W/kg for 830N.

Since the SAR is measured at the highest transmitting power level, the actual SAR during a call is usually much smaller. This is because
mobile phones are designed to operate at their minimum power levels necessary to communicate with base stations.

The World Health Organization (WHO) has stated that present scientific information about mobile phone use does not indicate any adverse
effects on the human body. They recommend limiting the talking time or using a handsfree device to keep the mobile phone away from
the head and body to reduce influence of exposure to radio waves.

Additional information can be found at the WHO website:

http://mww.who.int/emf

* Measurements with handset placed on the body are carried out in accordance with the FCC standards. The values are based on
European requirements.
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General Notes

Declaration of Conformity
Ce0168

The products “830N" is declared to conform with the essential requirements of European Union Directive 1999/5/EC Radio and
Telecommunications Terminal Equipment Directive 3.1(a), 3.1(b) and 3.2.

The Declaration of Conformity can be found on the following website:

http://www.n-keitai.com/

Minding Mobile Manners

Use your handset responsibly. Inappropriate handset use can be both dangerous and bothersome. Take care not to disturb others when
using your handset. Adjust handset use according to your surroundings.

@ Turn handset power off in theaters, museums and other places where silence is the norm.

@ Refrain from use in restaurants, lobbies, elevators, etc.

@ Observe signs and instructions regarding handset use aboard trains, etc.

@ Refrain from use that interrupts the flow of pedestrian or vehicle traffic.
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@ SoftBank 830N
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For optimal signal reception, do not cover Internal Antenna with hands or anything

Handset Parts

Frontl
2——o ﬁ co—2 — 3
a
5_
6
7 8
9— 10
11— 12
13
14—
15 — o) o[ 16
N—
" E—

~‘ e— 20
23

[

else. Do not put stickers over Internal Antenna.

Earpiece also functions as speaker. Be careful of ringtone/alarm sounding close by
your ear when receiving or ending a call.
Key illustrations are simplified and differ in appearance from actual handset keys.

I 221
0 Gy — 24
L 25
2 26
[y )
28

SS——

Battery Cover and Battery must be removed when installing memory card.

1 Earpiece/Speaker?

2 Charging Indicator/lllumination

3 Light Sensor

4 Display

5 Touch Sensor B 8208
6 Multi Selector (m) g 093
7 Mail Key =B

8 Yahoo! Keitai Key P

9 Menu Key o

10 Shortcut Key (®P

11 Send Key 7

12 Clear/Back Key (cuear3

13 Power/End Key =

14 Keypad (0])-e7
15 *Key 3

16 # /Manner Key 2

17 Strap Eyelet

18 Microphone

19 External Device Port

20 TV Antenna

21 Side Key I3

22 Internal Antenna

23 Camera

24 Camera Indicator
25 Infrared Port

26 FeliCa Mark

27 Memory Card Slot*
28 Battery Cover



- Handset Parts

IBasic Key Operations
@In Standby (Handset Closed)

No. | Key/Operations Description
5 280 Activate Quick Menu when Touch
Sensor is on.
21 0 Turn Touch Sensor on/off.
Press and hold [J |Set/cancel key operation lock.

@In Standby (Handset Open)

No.

Key/Operations

Description

6

[a) Access widgets.
Press and hold (3 Open S! Quick News List.
=) Open Phone Book Search menu.
)| Open Received Calls window.
Press and hold f0) |Open Received Address List.
=) Open Redial window.
Press and hold (3 |Open Sent Address List.
E] Access Desktop Icons.

No. | Key/Operations Description
7 Open Mail menu.
Press and hold Compose a new message.
8 Access Yahoo! Keitai portal.
Press and hold Open Yahoo! Keitai menu.
9 (= Open Main Menu.
10 Activate function assigned to key.
Press and hold Assign a function to key.
11 Open Tomo-Den Window
12 Play messages on Answering
Machine.
Press and hold Set/cancel Answering Machine.
13 =] Show/hide Desktop Page.
Press and hold (=] | Turn power on/off.
14 | Press and hold Set/cancel IC Card Lock.

Press and hold (5

Set/cancel ECO Mode.

Press and hold

Set font type, thickness and size.

Press and hold

Set Privacy Angle on/off.
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- Handset Parts

papiers buiien E

No. | Key/Operations Description No. | Key/Operations Description
14 | Press and hold (O] |[Enter “+“ (international access 13 =) End call.
code). Press and hold (=] | Turn power off.
16 | Press and hold Sevcancel Manner Mode. 16 | Press and hold Set/cancel Manner Mode.
@®During Voice Calls 21 Press and hold [J |Record other party’s voice.

@During Text Entry

No. | Key/Operations Description

6 =) Insert line feed “ d “ (when cursor is
at the end of text).

E] Add a space (when cursor is at the
end of text).

7 Toggle character entry modes (in
5-touch or T9 input mode). Toggle
double-byte and single-byte
characters (in 2-touch mode).

Press and hold Toggle text input methods (in
5-touch, 2-touch or T9 input
mode).

8 Switch to pictograph/symbol list.

Press and hold

Access My Pictograms (in S! Mail).

No. | Key/Operations Description
6 @) Increase earpiece volume.
Press and hold (8] |Continuously increase earpiece
volume.
=) Decrease earpiece volume.
Press and hold (@) Continuously decrease earpiece
volume.
o) Open Received Calls window.
= Open Redial window.
7 Turn handsfree on/off.
8 Toggle Hyper Clear Voice modes
(High, OFF or Low).
9 =) Open Task Switch window.
10 Display function menu.
12 Hold call.




- Handset Parts

No. | Key/Operations Description

1 Cycle characters in reverse order (in
5-touch mode).

Press and hold Undo last operation (conversion,
pasting, cut, etc.) and return to the
previous state.

12 Delete one character to right of
cursor.

When cursor is at end of text, a
character to left is deleted.

Press and hold Delete all text to right of cursor.
When cursor is at end of text,
delete all text.

15 Enter dakuten (" ) or handakuten
(° ) (in 5-touch or 2-touch mode).
Toggle case (in 5-touch or 2-touch
mode).

Insert line feed “ 4 .”

Press and hold Select area.

16 Toggle Shift, Caps Lock and lower
case modes (when entering
alphanumerics in T9 input mode).

Press and hold Paste copied or cut text.

IOpeningICIosing Handset

Slide Display open.

Slide Display shut.
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ITouch Sensor

Use to operate Camera, TV, Music Player, etc., with handset

closed.

@ Touch Sensor is available in Landscape and Portrait Views.
Position handset as shown below.

<

@ | :

| —

Touch Sensor
N—

Landscape View Portrait View

@ Use J (sidekey) to enable/disable Touch Sensor.
@ Touch Sensor illuminates when enabled. When illumination is
off, Touch Sensor is disabled.
Tip
« Touch Sensor is illustrated as @, &8, B3 in this guide.

Using Touch Sensor

@ Lightly tap Touch Sensor (@, 88 or B)).
@ Use 8 or @ to select pop-up options (e.g. YES/NO).

Note
« Simply tap Touch Sensor with finger. Do not use fingernails,
ballpoint pens, pins or other sharp objects to tap Touch Sensor.

Tip

* Touch Sensor illumination color changes and handset vibrates
upon sensor recognition. Color change and vibration are
longer for a press-and-hold recognition.

» Pressing for 30 seconds turns Touch Sensor off and handset
returns to Standby.



IDispIay Indicators

(l‘ﬁj ::1‘2) T (Tiv T a’it‘s) i‘7> (t‘ai‘s is‘D 1‘0 3‘1) 1‘2 1‘3
BTek=8 E2CHORE
BEYo&Ean
wE® o8 e
() B Battery Level
@ il Signal Strength
OUT out of Range
W Emission OFF Mode
USIM Lock Active
@@ Yahoo! Keitai Mode
& Yahoo! Keitai Communication in
Progress
@u Packet Transmission (No Data Transfer)
® Connecting to Network for Packet
Transmission
=»/“= Packet Transmission
(Sending/Receiving Data)
@ & SSL Secured Site Connected
® & Unread Messages
B Handset Message Memory Full
B usIM SMS Memory Full (g when
there are unread messages)

)

S

@

& Handset & USIM SMS Memory Full
® & Software Updated
@ & Dial Lock Active
S Secret Mode/Secret Data Only Mode
5 Original Lock Active
% Original Lock Active in Secret
Mode/Secret Data Only Mode
7 Infrared Transmission
& Authenticating IC Card
€ S! Addressbook Back-up Synchronizing
® & IC Card Lock Active
® & ECO Mode
't Privacy Angle On (iF when
Backlight is Off)
@ @ Keypad Lock Active (After Closed,
Timer or Lock Key is ON*)
@) @ Bluetooth Communication in Progress
Bluetooth Power Saving
& Bluetooth Call
1@ |8 Memory Card Inserted
Invalid Memory Card Inserted
B Memory Card Reader/Writer in Use
¥ Accessing Memory Card
@ % Voice Call
8 Video Call
& Maximum Call Cost Limit Reached

) /8 USB Cable Connected in
Communication/microSD Mode
microSD Mode
§ /8 Handsfree Device Connected in
Communication/microSD Mode
/8 USB Cable & Handsfree Device Connected
in Communication/microSD Mode
(4 8 Vibration Set for Incoming Calls & Messages
{57 /8., Vibration Set for Incoming Calls/Messages
@ 38 No Ringtone for Incoming Calls & Messages
37/ 3= No Ringtone for Incoming Calls/Messages
Manner Mode
® Auto Manner Mode Start On
% Auto Manner Mode Release On
Alarm Set
& Alarm Set for Today (appears prior
to set time.)
@ g& One Seg Timer Recording in Progress
@ £5 New Messages at Voice Mail Center
@ & - & Voice Messages on Answering Machine
@) ¥ - w5 Video Messages on Answering Machine
* Lock Key is ON by default.
Tip
« To see indicator descriptions:
[ => Settings = (] => Display =>
(m] = icons => (m]

- Display
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IMobiIe Widget (Japanese)

Set Widgets to appear on Desktop.
@ For information about Mobile Widget, see P. 10-2.

— Add Widgets Here

Softkey Functions

Use Pointer to select widget

Desktop Page
Tip
+ When Flash® is set to Standby and widgets appear, Flash®
stops.

IKey IHlumination

Key backlight flashes in seven colors in a variety of patterns.

'9 More Features

Display Settings
Wallpaper

Display Color Scheme
Set Font Type

Interface Language
Guard from Prying Eyes
Display Quality

(> P. 14-4)

Backlight
® Set Backlight & Power Saving
(> P. 14-7)

Standby Indicators
@ Enable Indicator Selector
(» P. 14-10)

Key Illumination

@ Set lllumination for Power On/Off

@ Set Flashing Color for Power On/Off

® Set Flashing Pattern for Call Start

@ Set Flashing Color for Call Start

@ Set lllumination for Emotion-Expressing Mail
@ Set Flashing Pattern for Alarm Notification
® Set Flashing Color for Alarm Notification

@ Set lllumination for Snooze Notification



- Display

@ Set Flashing Color for Snooze Notification

® Set lllumination for Ir/IC Transmission

@ Set Flashing Color for Ir/IC Transmission

@ llluminate When Charging Begins

® Set Flashing Color (When Charging Begins)

® Set Flashing Pattern for Handset Open or Close
® Set Flashing Color for Handset Open or Close

pape)s bunyan P

(> P. 14-39)
Key Backlight
® Set Key Backlight Color
® Set Key Backlight Off

(> P. 14-41)



- USIM Card
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IBefore Using USIM Card

Universal Subscriber Identity Module (USIM) Card is an IC

card that contains customer information (phone number,

etc.). A USIM Card must be inserted to use your handset.

@ Store Phone Book entries and SMS on USIM Card.

@ Insert USIM Card into other USIM-compatible SoftBank
handsets to use information on Card.

@ Do not apply excessive force when inserting/removing USIM
Card.

@ SoftBank is not liable for any damage caused by inserting USIM
Card into other IC card readers/writers.

@ USIM Card may become warm during use. This is not a
malfunction.

@ Keep IC chip clean.

@ For details, refer to the manual supplied with your USIM Card.

@ Do not drop USIM Card or subject to excessive shock. Doing so
may cause malfunction.

@ Do not bend USIM Card or place heavy objects on it. Doing so
may cause malfunction.

@ Avoid extreme temperatures.

@ Do not scratch, carelessly touch or short-circuit the IC chip.
Doing so may result in data loss or malfunction.

@ Clean USIM Card with a dry soft cloth (such as is used for
eyeglasses).

@ Use a SoftBank-designated USIM Card. Using a non-designated
card may result in handset malfunction.

1-10

IOther Notes on USIM Cards

@ USIM Cards are the property of SoftBank.

@ USIM Cards will be reissued for a fee if lost or damaged.

@ Return USIM Cards to SoftBank upon cancellation or
suspension of service.

@ Returned USIM Cards are recycled.

@ USIM Card specifications and performance may change without
prior notice.

@ Keep a separate copy of data saved on your USIM Card.
SoftBank is not liable for lost data.

@ If USIM Card or handset (with USIM Card inserted) is lost or
stolen, suspend service immediately. For details, contact
SoftBank Customer Center, General Information (P. 15-52).

@ Downloaded files (S! Appli, videos, Saved Pages, etc.) saved to
handset or memory card may be inaccessible after USIM Card
replacement, handset upgrade or service subscription
cancellation. If a different USIM Card is inserted, the cookies
and cache are cleared to protect personal information.

D

(= /




Jusim PINs

There are two security codes for USIM Cards: PIN1 and PIN2.

PIN1

PIN1 is a four- to eight-digit code to prevent unauthorized

handset use by a third party.

@ Default PIN1 is 9999.

@ PIN1T can be changed (P. 4-2).

@ When PINT Code Entry Set s set to ON, PIN1T must be entered
each time handset is turned on to be used.

PIN2

PIN2 is required to reset total call cost or to set a maximum
limit to call costs.

@ Default PIN2 is 9999.

@ PIN2 can be changed (P. 4-2).

PIN Lock & Cancellation (PUK)

If PIN1 or PIN2 is incorrectly entered three times

consecutively, PIN Lock is activated, limiting handset use to

specific functions. Enter Personal Unblocking Key

(PUK1/PUK2) to cancel PIN Lock.

@ For information on PUK, contact SoftBank Customer Center,
General Information (P. 15-52).

Note

« If PUK1 is incorrectly entered ten times consecutively, USIM Card
is locked and handset is disabled.

« If PUK2 is incorrectly entered ten times consecutively,
operations requiring PIN2 entry are all disabled.

» Write down your PUK.

 To cancel USIM Card lock, contact SoftBank Customer Center,
General Information (P. 15-52).

- USIM Card
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- USIM Card

@Place USIM Card on tray with gold IC part

—n IUSIM Card Installation facing downward, in the orientation shown
Q @ Remove Battery (P. 1-15) before inserting or removing USIM
E_ Card.
: -
@ Insertion
A 2 Notch
Y] N
a
]
o

oPuII Tray out by catch =
P
— > USIM Card J
A Side with gold IC visible
% facing downward

@Push Tray all the way in

S

1-12



- USIM Card

Removal
0Pu|l Tray out by catch and remove USIM Card
If Tray Detaches

Do not use excessive force to pull Tray; may slide out
completely.

If Tray detaches, face Tray properly and align with gold
guide stripes, then push Tray in all the way.

pape)s bunyan P
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- Battery & Charger

_n INotes on Battery Charging IBattery Installation

@ Charge battery at least once every six months. If battery is left  |nsertion
uncharged for a long period, it may become unusable or its
operation time may decrease. 0Press and slide battery cover off

@ Avoid connecting too many things to one AC outlet. Doing so
may cause the AC outlet to overheat and cause a fire.

@ Battery and AC Charger may become warm during charging,
but this is not a malfunction. If they become too hot, however,
stop charging and contact SoftBank Customer Center,
Customer Assistance (P. 15-52).

@ If Charging Indicator flashes red during charging, battery may
be faulty. Contact SoftBank Customer Center, Customer
Assistance (P. 15-52).

@ Depending on the conditions of usage, the battery may expand
as it nears the end of its life. However, this presents no safety
problems.

@ Check the battery type on its label:

pajie3s buiyen

@Insert battery into place

Mark Type
Li-ion00 Lithium-ion battery Yo
Lithium-ion batteries are a %&
recyclable resource. Do not Li-ion00

dispose of them as municipal

waste. Bring used batteries to your nearest
SoftBank Shop or recycling center after
insulating the terminals with tape. Observe
local regulations on battery disposal.

114



- Battery & Charger

€)Replace cover Removal

@ Turn off handset before removing battery.

@) Remove battery cover
@) Pressing Tab (D), lift out battery (®)

pape}s bunyan P

Align tabs with handset
grooves and slide the cover shut.

Note

+ Do not force Battery Cover shut. Tab may be misaligned, and
cause breakage.

1-15



- Battery & Charger

@ Pull Port Cover in direction of arrow
_n IOpen Port Cover
@Rotate Port Cover (as indicated by arrow)

* When handset is connected to an external device, be cautious
of Port Cover. Excessive force may damage it.

Q

& @Using excessive force may cause damage.

5 @Keep Cover completely open (as illustrated) while Port
«Q is in use.

2

Y Note

&

o

Q.

1-16



ICharging Battery

Using AC Charger

Use only SoftBank-specified AC Charger "ZTDAA1" (sold
separately). In this guide, the ZTDAA1 model AC Charger is
referred to as “AC Charger.”

Port Cover \Ee—
External Device Port

— AL K
9 onnector
R

L4
Release
Tabs

OOpen Port Cover
See P. 1-16.

@Insert Charger connector into External Device
Port

@Extend Charger blades and plug into an AC
Outlet
Charging Indicator lights red while charging. When
charging is complete, Indicator goes out.

() Disconnect connector from handset
Press and hold Release Tabs to remove connector.

@Unplug Charger from AC Outlet
(D Close Port Cover

Note

* Battery can only be charged while inserted in handset.

* When Charging Indicator and Display Indicator [B] go out and
Charge Unusual Stop Charge appears, disconnect handset
from AC Charger and remove battery. Set up handset and
Charger and start charging again. If the same error occurs, AC
Charger may be faulty. Contact SoftBank Customer Center,
Customer Assistance (P. 15-52).

'9 More Features

Backlight
@ Set Backlight during Charging
(> P.14-7)

- Battery & Charger
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- Power On/Off

|

1-18

IPower On

Q @ Make sure USIM Card is correctly
-, . .

- inserted before turning power on.
a

@ @ Press and hold (=)

2 (E] &l

7 b

o 01 SUN  15:30

Q.

Tip

« If handset is turned on immediately
after powering it off or inserting
battery, WELCOME may appear in
Display for a while.

« After USIM Card is replaced, Security
Code is required when powering
handset on for the first time. If Security
Code is incorrectly entered five times,
handset shuts down. Turn handset on
again.

@Powering Handset On for the
First Time (Initial Setup)
Setup prompt appears in Japanese.
Select NO and press (@] to exit.
After changing interface language to
English (P. 14-6), restart handset and
perform setup procedure as follows.

@ [initial Settings] window =>
YES = (u]

@Auto => (W) = Select a time
zone => (@]

HTo Manually Enter Date & Time
=> Manual (Date Time Set) = (u]
=> Select a time zone => (8] =>
Enter date and time => (®)

€)Enter Security Code (9999)
> [m] => Enter new Security
Code = (m] = YES > (m]

() select a font size = (m]

BWhen Separate Setting is
Selected
Set a font size for each function
window (P. 14-6).

6[Keypad Sound Setting] window
=> ON or OFF => (m]

Tip
« Setup prompt no longer appears when

all the initial setup items have been set.
* The default Security Code is 9999.

@ Retrieving Network Information

When (&), (] or [ is pressed after initial
setup, a prompt appears. Select YES to
update network settings.
Tip

* Retrieve network information to use
network-related services, such as mail
and the Internet.

» To manually update network settings:
(o) => Settings =>(m] => Connection
Settings => (m) => Retrieve NW Info
=> (m] => YES => (u)



- Power On/Off

IPower Off
@ Press and hold (=)

Handset shuts down.

"9 More Features

Clock
@ Hide Clock
® Set Auto Time Adjustment
e Manually Adjust Time
® Summer Time
@ Time Zone (Sub Clock)
@ Hide Sub Clock
® Summer Time (Sub Clock)
® Time Zone Major City (Sub Clock)
(> P. 14-2)

Auto Power On/Off
@ Set Auto Power On/Off
(> P. 14-3)
Display Settings
® Set a Wake-up Image
@ Set a Wake-up Message
® Set Font Sizes Collectively
@ Set Font Size for Each Function Window

(> P. 14-4)
Sounds
@ Set Handset Open/Close Sound
(> P. 14-14)

Key/Touch Sensor
@ Set No Sound at Key/Touch Sensor

pape)s bunyan P
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Mobile Manners

papiers buiien E

Use your handset responsibly.

Inappropriate handset use can be both

dangerous and bothersome. Take care

not to disturb others when using your
handset. Adjust handset use according
to your surroundings.

@ Turn handset power off in theaters,
museums and other places where
silence is the norm.

@ Refrain from use in restaurants, lobbies,
elevators, etc.

@ Observe signs and instructions
regarding handset use aboard trains,
etc.

@ Refrain from use that interrupts the
flow of pedestrian or vehicle traffic.

1-20

Activating Manner
Mode

Most handset sounds are muted in
Manner Mode.

OPress and hold

HlTo Cancel Manner Mode
=> Press and hold

Note

* When handset is set to vibrate for
incoming calls, be careful as handset
may slide off, slide into a stove, etc.

Tip

* Shutter click sounds even in Manner
Mode.

* Press and hold to set or cancel
Manner Mode during a call. Short
beeps sound through the earpiece
when Manner Mode is set or canceled
during a call.

'9 More Features

Manner Mode

® Set Manner Mode Type

@ Configure Original Manner Mode

@ Set Time for Auto Manner Mode Start

® Set Time for Auto Manner Mode
Release

® Toggle Auto Manner Mode Start and
Release On/Off

(» P. 14-13)



Security Code, Center Access Code and

Network Password are required to use

handset.

@ Do not reveal these codes to others.
Write down your codes.

@ SoftBank is not liable for any damage
due to handset misuse.

ISecurity Code

Security Code, 9999 by default, is

required to use some handset

functions. The code can be changed.

@ If Security Code is entered incorrectly or
nothing is entered for 15 seconds, a
tone sounds and a message appears.
Enter correct Security Code.

@ Security Code is referred to as #R{EFE
SEEES (operation code) on SOFTBANK
MOBILE Corp. Website (http:/
www.softbank.jp).

Note

* The warning tone does not sound in
Manner Mode or when Keypad Sound
is set to OFF.

Changing Security Code

@Y = settings - (w] =
Security > (8] => Change
Security Code = (8]

@) Enter current Security Code

= (w)

€)Enter new Security Code =
(@) = YES = (u]

ICenter Access Code

Center Access Code, a four-digit code
assigned at initial subscription, is
required to access Optional Services via
landlines or to subscribe to fee-based
information.

INetwork Password

Network Password, a four-digit code
assigned at initial subscription, is
required to use Call Barring.

@ If Network Password is incorrectly
entered three times, Call Barring
settings are locked. Network Password
and Center Access Code must be
changed.

- Codes
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- Other Basic Information

|
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IChecking Battery Level

Use Battery Level meters as a guide only.

Battery Level Indicator
Battery Level indicator appears at top
of Display.

Sufficient

Low

B Almost out. Charge immediately.
(Flashing) Charging

Battery Level Beeper &
Large Indicator

Check battery level by number of
beeps and large indicator.

@Y => settings - (w] =
Other Settings > (®] =
Battery Level = (u]

A large battery level indicator

appears. Beeps sound according to

the battery level.

Three short beeps: Sufficient

Two short beeps: Low

One short beep: Almost out.
Charge immediately.

1-22

Note

* The battery level beeper does not sound
in Manner Mode or when Keypad
Sound is set to OFF.

@®When Battery Is Empty
Recharge Battery appears, the battery
alarm sounds for about 10 seconds, and
handset powers off in about 60
seconds. Charge battery.

IMy Phone Number

Check handset phone number.

Ok =)

Account Details appear.

HMAdd Other Information
=> ) => Enter Security Code => (m]
=> Select an item => [®] => Enter
information = (@] =>

HView All Information
=> (@) => Display All Data => (m] =>
Enter Security Code => (8] => {0y to
switch tabs

HMReset Account Details
=> (@) => Reset = [®] => YES => (m]

Checking Network
Status

Check Network Status to confirm if
voice calls and/or packet transmission
is available.

@ = settings > (m] =
Other Settings —> (m] =>
Network Status > (8]
Network information appears.

(T Packet ..
Dialing TS Description
not not Voice calls/packet
available |available [transmission not

possible.
available |not Voice calls
available |possible, packet
transmission not
possible.
not available |Voice calls not

available possible, packet
transmission

possible.




- Other Basic Information

“Out of Service Area” appears when out
of range.

Dialing Tra:sar:\l?sestion Description Note n_
* ECO Mode is canceled when power is o
available |available |Voice calls/packet turned off and on again. e
transmission -
possible. 3
wn
-,
[}
+
[}
Q.

Stereo Earphone
Conversion Cable
Use Stereo Earphone Conversion Cable

(sold separately) to connect an
earphone.

Jusing ECO Mode

When set to ECO Mode, light, sound,
and Display settings are modified to
decrease battery consumption.

OPress and hold (5]
ECO Mode is set, and “@* appears.

HCanceling
=> Press and hold (5

1-23
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- Menu Operations

Accessing Handset

_ﬂ IFunctions

suonesadQ diseg

@ In this guide, most operations start from
Main Menu.

From Main Menu

Press [ to open Main Menu. Use 3 to
select an item and press (8 to open sub
menus.

MENU

D

Mail | Vahao! Keai | S! Apoli

L
EOoMm

—
Toor WLLRCTIN weere

J8p

Own Data | Phone Book | Settings

Main Menu

Tip
* Handset returns to Standby after 15
seconds of inactivity.

Using Softkeys & Multi
Selector

Press Softkeys or use Multi Selector in
Standby to access assigned functions.

@ Softkeys

- [=): Open Mail menu.

- [¥) (Press and hold): Open Yahoo! Keitai
menu.

- (®): Access the function assigned to the
key.

@ Multi Selector

- (B): Open Active Desktop Page.

=) Open Phone Book Search window.
- I0): Open Received Calls window.

- [®: Open Redial window.

Keyword Search

Enter keywords to search for menu
items.

Q=
@Enter keyword = (]

<Example> Enter “mail”

B Search Word
mai Il

B Compose Message

[BCompose SHS
®Server Mail
BRetrieve New
BTemplate
WMail Setting

BEESel. Area

5 BBl ®2

Corresponding results appear.

@Select an item = (@]

HMToggling Multiple Items
Press [ to toggle items.



From Quick Menu

Use Quick Menu to access TV, Photo
Mode, Photo Slide-show, Movie Mode,
Voice Mode or Music when handset is
closed.

(1]l

Touch Sensor is enabled (On).

@D1ap @ Sor 0

Watch TV

H o T 22

Quick Menu

HReturning to Standby
=> (] or Press and hold (J

Tip
+ Handset returns to Standby after a
period of inactivity.

€) B or B to select a function

=0

®Menu Items

Icon Function

Activate TV (P. 8-7)

Activate Camera in Photo
Mode (P. 7-5)

Activate Photo Slide-
show from Quick Album
(P. 12-5)

JB =

Activate Camera in
Movie Mode (P. 7-7)

Activate Camera in Voice
Mode (P. 7-9)

Activate Music Player
(P.9-6)

)

From Original Menu

Assign often-used functions to
Original Menu for quick access.

0=-E

Original Menu
ccount Details
Retrieve New
Ring Volume
Vibrator
A
C!

hange Security Code

m
@
=
g
5
L
7
8
9
0

Press ] to toggle between Main
Menu and Original Menu.

- Menu Operations
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Menu Operations

Enter Menu Item

Number

Enter these numbers for direct menu

access. Note that Main Menu Theme

must be set to Basic.

@ See P. 15-19 for menu item numbers.

@ See P. 2-30 for details on changing
Main Menu Theme.

<Example> Access Select Ring Tone

(menu no. 13)
Oy
A D=

suonesadQ diseg h

A Incoming Call
Menu13
Select Ring Tone

MENU NUMBER m
@Video Cal |
ELE




IDesktop

Press @ to access Desktop. From
Desktop, press (¥ to toggle Icon
window and Info window.

The following shortcuts are set to Icon
window by default.

- S!I Quick News List - Photo Mode
- TV * Quick Search
Icon Window

Add functions to Icon window and use
them as shortcuts. Notifications
appear to inform you of missed calls,
new messages, etc. Select a
notification to check the information.

8301 SUN 1530

S! Quick News List

®Icons

Function

Icon

Function

S! Quick News List

Show Image

Photo Mode

Play Video

TV

S! Appli

Quick Search

Inbox Folder

Fod e &

Call Phone Number

Movie Mode

g

Compose S! Mail

Voice Mode

4z
[=F

Compose SMS

B2 6023 M¢E

Schedule

L2
=

Access Webpage (Yahoo!
Keitai)

To Do List

Access Webpage (PC Site
Browser)

Text Memo

Eals

Play Melody

Bar Code Reader

- Menu Operations
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Same o

Icon

Function

Icon

Function

Icon

Function/Information

Text Reader

=

Play/Erase Msg.

R

Music Player

<5

Play/Erase VC Msg.

Hi

larm

Missed TV Programs

@Dﬁﬁ

Life History Viewer

@ Notifications

=
i
=

=Ll
=
)

=]

Timer Recording Finished

Calculator

Dictionary

Icon Function/Information
DDI)E] Missed Calls
[Miss|

Maximum Call Cost Limit
Reached

Receive IR Transmission

Answering Machine
Play/delete messages.

Software Update

Bluetooth

Answering Machine (Video
Message)
Play/delete Video Messages.

USB Mode Communication

Original Menu

PC Site Browser

Voice Mail

fo | fi= §2 Be

Network Re-search

Books

New Messages

&
<
S

2ot
T =]

]
=

New S! Info Channel

HS | B | B | ez | B

Failed Alarms

XS
o=

New S! Info Channel Receive
Failure

| A

=
@
2

New Weather Info.




Menu Operations

Icon Function/Information

"Z:Ej Weather Info. Receive Failure
Q

[Miss|

@ Content Keys Acquired

Notifications disappear after accessing the
functions/information. Answering
Machine and Voice Mail notifications
disappear after message is played back.

@ Adding Icons
Add up to 15 icons per Desktop theme.
Select from three Desktop themes.

OFrom a function = (@) =
Add Desktop Icon => (u]

@ Accessing Icons & Notifications
(1100

03.01 SUN 15:30

S! Quick News List

@) 8 to select an icon = (m]
HScrolling Icons
= 0
EChanging Themes
=>(®) => Change Desktop = (#]) =>
Select a theme=> (m] => YES=> (m]

Info Window

Phone numbers, functions, etc. saved
to Icon window appear in Info
window.

@ Accessing Data and Functions

Press () to toggle Info window and
Icon window.

0B-E

Whats New

No new information

03.01 SUN 15:

Info Window

Desktop opens to previously used
window.

@) I3 > Select an item = (|]
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8 Clock

8 Other Settings

Item Details = =
Navigating through
Images & Still images Menus
Movies Open image
Video Scrolling Pages
Play video Use (O3 or i3] to scroll next/previous
Calendar Open Calendar pages.
- Settings Nal [‘Settings | m7]
Clock Access Alarm list —,
e ain lime window 2 Incoming Gall 2 Key/Touch Sensor
(Set Main T d
appears When ClOCk iS 3 Talk 3 External Connection
4 Dialing @ 4 Connection Settings
not set) 5 Video Call | 5o Losaton nio
6 Display 6 Int'l Roaming Set
Settings - Set items on/off 7 Call Time/Charge ‘ 7 Optional Services

+ Change item order

@®ltems
Item Details
What's New | Access/view Notifications
(P. 2-6).
Recent Access new messages
Messages
Schedule Schedule
Access schedule entries
(today/tomorrow)
To Do List
Access To Do List entries
Shortcuts Access Icons saved to
Icon Window
Phonebook Phone Number
Access phone numbers
from Icon window
E-mail address
Select e-mail address
(from Icon window) to
Create S! Mail
Bookmarks Yahoo! Keitai

Access bookmarked sites

PC Site Browser
Access bookmarked sites

9 Security
0 Slide-style Setting

T

T

)

=




Selecting Menu Items
Using Keypad

Use keypad to enter number
corresponding to menu item.

Settings ) RS

Talk

Style Mode Setting LiHyper Clear Voice
ncoming Call 7 Lo
[alic @Auto Voice Memo

ENoise Reduction

MQuality Alarm
SReconnect Signal

[BSet Hold Tone

Dialing

/ideo Call
Display

Zall Time/Charge
Slock

Security &
Blide-style Setting @
=

-

o oe <o osw~l=l

L—Menu Numbers

Return to Previous
Window or Standby
Press to cancel operation and
return to previous window.

Press (—] to return to Standby.
@ May not apply to all functions/windows.

'9 More Features
K Advanced

Main Menu
® Change Main Menu Theme
@ Switch to Simple Menu
® Temporarily Change Design Theme of
Main Menu
(> P. 2-30)

Desktop Icons
@ Edit Title of a Desktop Icon
@ Change Icon Image
® Check Icon Information
@ Change Order of Desktop Icons
@ Delete Desktop Icons
® Reset Desktop Icons
@ Show/Hide Desktop Icons
(> P. 2-30)

Menu Display Settings
@ List View and Details View
® Set Main Menu Theme
® Save Last Selected Menu Item to
Memory
® Add a Menu Item to Original Menu
(> P. 14-8)

Key/Touch Sensor

@ Change Function Assigned to Shortcut
Key

® Set Touch Sensor Backlight

® Set Vibrator and lllumination for Touch
Sensor Operation

® Set Touch Sensor Scroll

® Set Not to Use Touch Sensor

(> P. 14-38)

Desktop Icons
@ Set Desktop Theme
® Show New Message Indicator as 3D
Animation
(> P.14-7)

- Menu Operations

suonesadQ diseg P



Multitask
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Activate up to three functions
simultaneously. Activate one function
per group at one time (except TV &
Music Group).

Function Group Function

Mail Group Mail

Yahoo! Keitai Yahoo! Keitai

Group

S! Appli Group ~ |S! Appli

Settings Group | Settings, Optional
Services

Tools Group Data Folder, Tools,
Phone Book, Own
Data, Camera

TV & Music TV, Music

Group

2-10

@ See P. 15-2 for available combinations
of functions that can be activated at the
same time.

@ Currently active functions are indicated
by task indicators in Task Indicator Area.
To switch to a different function, select
the corresponding task indicator.

n

Mail © Yahoo! Keitai © S! Appli

D8

v Camera | Entertainment

O0m

Toos ML Vv

18p|o

Own Data | Phone Baok || Settings

o

Ii SN2 ] |
Task Indicator Area

@ Transmission fees are incurred while
accessing functions during a voice call.

Activating Another
Function

Activate another function without
exiting current function.

@ while using a function => [y

@)=y => Select another
function = (m]
HEMail Function
After step 1 =
Ml To Access Yahoo! Keitai Portal
After step 1 =>
HTo Activate Function Assigned to

Shortcut Key
After step 1 =



Multitask

IToginng Functions

@) When multiple functions are
active = [

A Incoming Call
Menul3
: Stand-by display
: Quit function
: Select function

: Mobile Widget

Task Switch Window

HSwitching Functions
=> 04 to select a task indicator =>
(w)

HOpening Main Menu
=> o)

HReturning to Standby
=
Press [ in Standby to reopen Task
Switch window.

HEnding Multitask
= (=] => Quit Selected or Quit All
Function => (m]

HOpening Widget List
= (@)

Tip
« Alternatively, press and hold = to end
Multitask and return to Standby.
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- Text Entry

Handset has three text input methods:

5-touch, 2-touch and T9 Input.

@ This guide mainly explains Japanese
text entry in 5-touch mode.

IOverview
Text Entry Window

A text entry window consists of
Character Entry Pane, Guide Pane and
Status Pane. Indicator and key
descriptions are as follows:
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Character
Entry Pane

Guide Pane

(6 @%@ =2 |— Status Pane

Text Entry Window

@ Character Entry Pane

I Cursor

¥ End mark (end of text)

2-12

@ Guide Pane @Status Pane
[Al[¥] CHG |(&) to convert characters 2 ® Text input method
o (2-touch/T9 Input mode) (No
(] (9] All (&) to search Phone Book indicator for 5-touch mode)
@ ¥ Find S O Insert/Overwrite mode
[« ] i to specify a text range
/¥ Area o copy/cut T E @ Character entry mode
CR to insert line feed
Ala to switch case of each Kuten code input mode
character, or to add (P 2-32)
dakuten (" )handakuten 7 Double-byte/Single-byte
) B mode
H AA — aa to cancel Caps Lock o Lower case input mode
mode o
H aa — Aa to set Shift mode i Shift/Caps Lock mode
- (# ] to set Caps Lock —
] A2 = AA m-odeo set Laps foc & Bytes remaining for text
entry
¥ Sel. Press and hold to & Number of entered
Area select area of text to copy characters (appears when
(cut) entering text to USIM
‘¥ Paste |Press and hold to Phone Book/SMS message)
paste copied or cut text
< Back to cycle characters on

a key in reverse order (e.g.
A—=D)




Split Windows

In some instances, a second window
opens with text entry window.

ST i)
Dlately;recently .
Function

window

Ihank you for everythin.

Text entry
window

Referring to Dictionary
from a text entry window

@ Switching Windows

Press (@) and select Change Window
to switch windows.

Changing Text Input
Methods

0[Text Entry] window =
=> CHG Input Method > (u]
=> Select a text input
method = (m]
Alternatively, press and hold (2.

Toggling Character Entry
Modes

@ [Text Entry] window =
Press (9] to toggle entry modes.
Kanji/hiragana => Katakana =>
Alphanumerics => Numbers

Tip
* In 2-touch mode, press 2] to toggle
single-byte and double-byte modes.

Interruptions during

Text Entry

@®When Battery Runs Out
Battery alarm sounds and Recharge
Battery appears. Text is automatically
saved. Access the same function to
continue text entry.
Text may not be saved depending on the
function.

@®When (—J is Pressed
A message appears asking whether to
end text entry. Select YES and press (w)
to end text entry without saving the
text. To continue text entry, select NO
and press ().

@®When a Voice Call Arrives

Answer the call. After call ends, text
entry window returns.

- Text Entry
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Text Entry

Press a key multiple times to cycle

through letters assigned to that key.
@ For key assignment, see P. 15-10.

suonesadQ diseg
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Entering Characters
in 5-touch Mode

Kanji, Hiragana &
Katakana

Enter a reading (in hiragana) and
convert to kanji, katakana, etc.

@®Using Word Prediction

Enter a character and Word Prediction
suggests words starting with that
character. Word Prediction also
suggests word selection for words to
follow. Switch to kanji/hiragana mode
to use Word Prediction.

<Example> Entering “i§H &%
@ [Text Entry] window =

(4 times)

“[F" is entered in Character Entry
Pane.

Suggestion list shows predictions
for words beginning with “[3* in
Guide Pane.

® Edit Memorandums
[od|

grm;nmﬁa

BT L3
ﬁ&ﬂﬁlﬁﬁ‘rﬁm

@) () = Select "t~ - (w)

B Edit Memorandums
Bl

“#& “ appears in Character Entry
Pane.
A suggestion list of words that
follow "5 " appears in Guide
Pane.

HWhen Required Word Does Not
Appear
=
Continue hiragana (reading) entry
in Character Entry Pane to narrow
down selection.



HTo Exit Suggestion List
>
Tip
+ Handset has a learning feature that
adds entered words to the suggestion

list. Press and hold to delete an
added word from the suggestion list.

@ Converting Hiragana

If the required suggestion does not
appear or word prediction is set to Off,
convert to Kanji as shown below:

<Example> Entering “{k<A"

o[Text Entry] window =
(once) = ([0 = (once) =
(twice)

B d emorand

ViSel . 8
STE HEAAR WA EER
#lF II<n HHF 4

HlTo Delete Last Input Character
>

HTo Determine Entered Hiragana
without Converting It
= (m]

(2]cEg0)
HlTo Reconvert to a Different Word
= => Select a word

HTo Change Conversion Range
= O

Dakuten (" ) &
Handakuten (" )

<Example> Entering “H'”

O[Text Entry] window =
(once) = = (m]

Switching to Lower Case

<Example> Change "2 to "> “

O[Text Entry] window = (4]
(three times) = = (m

Pictographs & Symbols
)

B Edit Memorandums

[
8A«08T<ae )HEDS
488LY LAVL@IAAL
ARO? 1 YPOOOOOOO
QOVOOHsA482ARAN

@Select a pictograph/symbol
= (m]

- Text Entry

€) (D = Select “EE" > (]

® Edit Memorandums
HEH SR

suonesadQ diseg P
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- Text Entry

HTo Toggle Pictograph/Symbol
Categories
= & or

HlTo Toggle Full-Screen List and

Continuous Entry
=

=

The pictograph/symbol list
window is closed.

2 |

Emoticons
@ @ = Face Mark => (=)
@) Select an emoticon = (]

suonesadQ diseg

Common Phrases
(Templates)

@ @ => Common Phrases >
(m]

@) select a folder => (m] =
Select a phrase = (®] (twice)

2-16

Alphanumerics,
Numbers & Katakana

Enter alphanumerics, numbers or
katakana in kanji/hiragana input
mode.

O[Text Entry] window =
Enter hiragana = [v] =>
Select a character => (®]

IEditing Text
Deletion & Correction

O[Text Entry] window =
Move cursor to the left of
the character to delete

HlTo Delete All Characters to the
Right of Cursor
=> Press and hold

HlTo Delete Entire Text
=> Move cursor to the end of text
=> Press and hold

@) Position cursor => Enter
correct characters



Copy, Cut & Paste

@ Only one entry can be stored on
clipboard. If you copy or cut new text,
the previously copied or cut text is
overwritten.

@ Copied or cut text can be pasted
repeatedly until you copy or cut new
text, or turn handset power off.

o[Text Entry] window =
=> Copy or Cut = (m]

@Move cursor to beginning of
characters = (]

€) Move cursor to end of
characters = (]

() Position cursor = (@) =
Paste > (u]

IEditing Templates

@ = own Data = (u] =
Common Phrases => (8]

B Common Phrases

WlFolder 1
@Folder 2
@Folder 3

MiFolder 4
BFolder 5
BSecurity Folder

Templates (Common phrases) Window

@Select a folder = (m]

(=] Folder 3
m

LiNot Stored>
B<Not Stored>
@<Not Stored>
M<Not Stored>
S<Not Stored>
B<Not Stored>

M<Not Stored>
@<Not Stored>
@i<Not Stored>
M<Not Stored>

Templates List Window

BWhen Security Folder Selected
=> Enter Security Code => (m]

€)select an entry = (& =
Enter text = (m]

IUsing Dictionaries

Saving Words to Own
Dictionary

Save frequently used words to Own
Dictionary. For each word, save a
reading (in hiragana). When the
reading is entered in a text entry
window, the word appears among the
suggestions.

@ > own Data > (u] =
Own Dictionary => (8]

B Own Dictionary
(2l New) SR

Own Dictionary Window

@) <New> = (m] = Enter word
=> (m] = Enter reading = (8]

HMTo Check Saved Words
=> Select a word = (m]

- Text Entry
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2-17



- Text Entry

Using Downloaded
Dictionaries

Download dictionaries from Yahoo!
Keitai sites. Dictionary must be
enabled in advance.

@ = own Data - (8] => DL
Dictionary > (u]
& Download Dictionary

Lbictionaryl x|
@Dictionary2
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@Dictionary3
M <Not Stored>
S <Not Stored>

Downloaded Dictionary Window

@Select a dictionary = (m]
" " appears next to the enabled
dictionary.
HTo Disable a Dictionary
=> Select a dictionary with " %" =>

Tip

« If an emoticon dictionary is enabled, its
content is reflected in the emoticon list
when entering emoticons.

218

Entering Characters
in 2-touch Mode

Each hiragana character is entered by

combining two key presses.

@ For combinations of character input
keys, see P. 15-11.

@ Procedures for selecting predicted
words and for converting entered
hiragana are the same as those used in
5-touch mode (P. 2-14).

<Example> Entering “F+ > 7 *

@22 (*) = (8)0)
(change to lower case mode)
= (»)=[(8]0]
(change to upper case mode)
= ([0 8](h) = (6] 3]
() =(0J5]()

(2]cIEg0)
Tip
* Pressing also adds dakuten (" )

and handakuten (° ) or toggles upper
case and lower case.

* Press |8 to toggle double-byte and
single-byte modes.

Entering Characters
in T9 Input Mode

Press a key once for each character,

and select the word from the

suggestion list.

@ For key assignment, see P. 15-12.

@ When character entry mode is
“Number,” 5-touch input method is
automatically applied.

<Example> Entering “&"

@ The following example is in Japanese
text entry mode.

0[Text Entry] window = (6]
= (9]

Word predictions for the key
combination appear.

B Edit Memorandums




- Text Entry

I'I;g C@hange Conversion Range 9@ O[I] (5) = (h) = ()
} ; (5) =>(EJ(h) = (BI(E)
HToggle Kanji and Hiragana Re enterlng W°“_’|5 .
Su tion Li Re-enter as shown below if the desired ® FEdit Memorandums n_
ggestion Lists
= word does not appear. ?;
MToggle English and Japanese <Example> Entering “5h5h&" )
Suggestion Lists @ The following example is in Japanese )
= text entry mode. 'Bo
@) [Text Entry] window => (&) @)[Text Entry] window = (8] 2
?ID; iy " (row 5) = (0] (row b) = 5
elect word from among the -
suggestions in Guide Pane. (9 )(row 5) => (0] (row D) . S
MTo Show Converted Words on = (4] (row 1) MIf No Correction is Necessary
Suggestion List “5h5hE " does not appear in => (O to move cursor to the next
= suggestion list. character
For example, if you specify “[&%,” . B To End Re-entering a Word
then “3&%,” “85% " and other @ =
words that have the same reading & Edit Wemorandums Th d dicted/ rted
appear on the suggestion list. E-NnAZ © words precictec/converte
BTo Show Predicted Words on from the re-entered word appear
Suggestion List on the suggestion list.
= (4]0
For example, if you specify “[&%,” — —
then “"&{KH,” "iH " and other o5 @Y @ @h 5
words that begin with the same
reading appear on the suggestion
list. L Cursor is on the first character of
HTo E’_"t Suggestion List and the word. The edit window opens
Continue Character Entry in Guide Pane, where hiragana
= characters of row 5 appear.

2-19



- Text Entry

6 More Features

Y > 0 rovenced]
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Text Entry

® Switch between Lower Case & Upper
Case

@ Switch between Single-byte & Double-
byte

@ Cycle Characters in Reverse Order

@ Undo Last Operation

Move Cursor to Top/End of Text

Overwrite & Insert Modes

Insert Line Feed

Input a Space

Use Dictionary

Quote Text

Use Kuten Codes

(> P. 2-31)

Templates
@ Edit a Folder Name
® Reset a Folder Name
e Edit Templates
® Reset Templates
(> P.2-32)

Dictionaries
e Edit Entries
@ Delete Entries

2-20

e Edit Title
@ View Information
@ Delete Dictionaries

Text Entry

® Set Text Input Method

® Set Word Prediction

® Set to Show T9 Suggestion Words in
Kanji or Hiragana

@ Clear Learning History

e Change Font Size

® Set Auto Cursor Movement in 5-Touch
Mode

(> P. 2-32)

(> P. 14-38)



- Phone Book

IOverview
Save phone numbers, e-mail addresses and other contact information to Phone Book.
Phone Book Phone Book
P

Data & Settings

Contact & Personal Information

Usage Examples

Abbreviated dialing for numbers
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-Gm +[& Name & Reading II?/ilr‘chday 1 E)Fi)ae|ed in Phone Book (P. 3-12).

roup emo
B4 Phone Numbers Estill Image
E13 E-mail Addresses (@ Entry Number Tomo-  Save frequently accessed Phone
EAddress Den Book entries to Tomo-Den

Custom Settings @ ==

Incoming Ringtone Vibration Reject ~ Reject calls from phone numbers
Incoming Image Outgoing Message not saved in Phone Book
lllumination Calls (P. 4-7).
Secret Data When you make calls or write messages, specify

phone numbers or addresses from Phone Book.

@ Back Up Important Information
Keep a separate copy of Phone Book entry information. When battery is exhausted or removed for extended periods, Phone Book
data may be lost or altered. Damage to handset may also affect data recovery. SoftBank is not liable for damages from lost/altered
Phone Book data.
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- Phone Book

Creating Phone Book

_ﬂ IEntries
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<Example>
Enter a name, phone number and
e-mail address, and specify a group

@ =Y => Phone Book = (m] =>
= Add to Phone Book
=> (@] => Phone => (u]

@) @ => (8] => Enter last name
=> (@) => Check reading = (u]
= [0 = [®] = Enter first
name => (8] => Check reading
= (m]

Reading is entered automatically.
Edit as necessary.

@ Add to Phone Book

Phone Book Entry Window

222

€)@ = (m) = Select a group =>
(w]

()E = (m] = Enter phone
number => (8] => Select an
icon = (=]

MTo Save Additional Numbers

Select EJ <Not Stored> and repeat
the same step.

@ => (@] = Enter e-mail
address => (®] = Select an
icon = (=]

HlTo Save Additional Addresses
Select IJ <Not Stored> and repeat
the same step.

(6)E

Setting Incoming Image

o[Phone Book Entry] window
= @ = (|

@) select Image > (®) => Select
a folder = (®] => Select a still
image = (1]

HTo Capture an Image with Camera
=> Photo Mode => (8] => Capture
image => (m]

HTo Cancel Selected Image
=> Release This => (u)

Creating Entries from
Other Functions
Create entries from the following
functions:

+ Received calls - Dialed Calls

- Redial - Text Reader

- Receives/Sent Address List

+ Yahoo! Keitai

+ Phone Number Entry window

<Example> Create an entry from
Received Calls

0@ =>Select a record = (@) =
Add to Phone Book => (]
=> Phone => (8]

@) Add = (8] => Search Phone
Book = Select an entry = (m]
(twice)

Phone Book Entry window with
the phone number automatically
entered opens.



HTo Save As a New Entry
= New = (u]

€)Enter other items = &) =
YES - (m]

Resuming Phone Book
Edit Operation

If battery is empty or if another
function was activated while editing

an entry, resume operation as follows:

@ = = Phone Book = (u] =
=> Add to Phone Book
= (m] = Phone = (@] =
Recall => (m]

HTo Save As a New Entry
= New = (]

@Enter each item = (®) = YES
= [m]
Tip
* Save entry before you exit Phone Book.
Otherwise, all changes will be lost.

IUsing Phone Book

Dialing from Phone Book
@) > Phone Book = u]

Phone Book
EEEI B 3 »

kimaMasami

090392%kk0

Phone Book Entry List Window

Ml To Dial the First Phone Number
=

@) ([ or ) to switch tabs = (J]

to select an entry = (m]

Phone Book Entry Details Window

- Phone Book

@@ to select a phone number
=>

MVideo Call
=

Specifying a Search
Method

(1]

@ Search Phone Book
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[Search Reading
@Search Name

@iSearch Phone No.
MiSearch E-mail

SiSearch Memory No.
[BiSearch Group

MSearch Column
@iSearch All

Phone Book Search Window

@Select a search method = (u]
Search Reading:
Enter a reading and press (.
Search Name:
Enter a name and press (3.
Search Phone No.:
Enter a phone number and press [@).
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- Phone Book
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Search E-mail:

Enter an e-mail address and press ().
Search Memory No.:

Enter three-digit entry number.
Search Group:

Select a group to view saved
entries.

Search Column:

Press a key (1) - (0] or (¥J) to
access the tab corresponding to
that key.

Search All:

Phone Book is organized by tabs
(Japanese syllabary order).

L Phone Book
{BEEREE P »
LAk imaMasami

¥ 0903924kkk0

Phone Book Entry List Window

Tip
+ Phone Book entries saved on USIM
Card are indicated by | .

Accessing Entries from
Other Functions

Access Phone Book entries from
Received Calls, Dialed Calls, Redial and
Received/Sent Address List.

@ Access Phone Book from
Received Calls

o@ = (@) => Look-up Phone
Book => (]

@ Access Phone Book from Dialed
Calls

@ = own Data = (w] =
Dialed Calls > (®) = (@) =
Look-up Phone Book > (u]

@ Access Phone Book from Redial

@ (@ = [@ = Look-up Phone
Book => (]

@ Access Phone Book from
Received Address List

@ Press and hold i0] = (@) =
Look-up Phone Book > (u]

@ Access Phone Book from Sent
Address List

@ Press and hold (& = (@) =
Look-up Phone Book > (u]



- Phone Book

. @To Customize by Phone @To Customize by Group
IPho“e Book settlngs Number/E-mail Address <Example> Set illumination for

<Example> Set a ringtone for incoming messages

incoming voice calls Phone Book Entry List
0[Phone Book Entry Details] o\[/vindow o (@] = érou}o

Customizing Handset
Response

Set different ringtones, images, etc. .
per entry item or Group. Wr:ndOW E>b§ to eCt a Setting = (8]
@®Indicators phone number = [®] = Ring .
@) Select a group = (@) = Rin
The following indicators appear for set Tonellmage > (u] group = (@) 9

Tonellmage > (8]

suonesadQ diseg P

items. .
@ V?lce Call (Recv.) = (m] gMail (Recv.) = (1)
€)Ring Tone > () = Select a .
ringtone type = (8 (= @) lilumination > (u] =
Select a folder = (m] => Select a pattern - (8]
Select a ringtone = (m)) MTo Cancel Custom Settings
MTo Cancel Custom Settings = Select an item =
=> Select an item => Note
e +» Custom settings are unavailable for
g4 Ringtone (Incoming Calls) secret Phone Book entries.
&4 Ringtone (Mail) » Custom Settings are canceled when
g~ lllumination (Incoming Calls) entry is set as secret.

=4 lumination (Mail)

¥ Vibration (Incoming Calls)

[ Vibration (Mail)

g= Incoming Image (Calls)

B8 Outgoing Message (Incoming Calls)
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- Phone Book
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Restricting Calls to/from
Specific Phone Numbers

Restrict calls to/from specific numbers
in Phone Book. This can help manage
personal calls and prevent nuisance
calls.

O[Phone Book Entry Details]
window = 04 to select a
phone number = (@] =>
Restrictions = (u)

@Enter Security Code = [m]
€)select a restriction type =

(w)

Restrict Dialing:

Restrict outgoing calls to all
numbers except a specified
number. To call that number, you
need to dial from Phone Book.
Call Rejection:

Restrict incoming calls from a
specified number.

Call Acceptation:

Receive incoming calls only from a
specified number.

HTo Cancel Restriction
=> Select a restriction type with
kv (a]

2-26

@®When Restrict Dialing is Set
The following operations are disabled:
- Dialing by Keypad
- Dialing from Received Calls
- Calling from Phone Book
(except: calling specified number in
Phone Book)

Tip

* When Restrict Dialing is set, all
records on Redial, Dialed Calls and Sent
Address List are deleted.

* Emergency numbers 110, 119.and 118
are available even when Restrict
Dialing is set.

« If you change or delete the specified
number, the set restriction is canceled.
Cancel Restrict Dialing to edit or
delete.

Setting Entries as Secret

Prevent others from accessing certain

Phone Book entries by setting them as

secret data.

@ Phone Book entries set as secret only
appear in Secret Mode or Secret Data
Only Mode (P. 4-8).

O[Phone Book Entry Details]
window = (@] => Set Secret
= (]

HTo Cancel Secret Setting
=> Release Secret = (m)

Tip

» Phone Book entries saved in Secret
Mode or in Secret Data Only Mode are
automatically set as secret.

« If a Phone Book entry that has been
saved to Tomo-Den is set as secret, the
entry is canceled from Tomo-Den.



- Phone Book

Managing USIM Phone Managing Phone Book
Note ; ;
Book ® Check Custom Ringtone/Image Settings
* Iltems that cannot be saved to USIM by Item
hone Book entries can be copied Phone Book are not copied. . n_
P ) @ Cancel Custom Ringtone/lmage
between handset and USIM Card. * Phone Book entries set as secret cannot ) ©
be copied. Settings by !te‘m ‘ N S
0@ = Tools => (W) = USIM « You must end copying of Phone Book @ Check Restriction Settings by Restriction 2
Operation => @ = Enter entries to make/receive calls or Type o ' o
. @ send/receive messages. @ Cancel Restriction Settings by S
Security Code = Restriction Type g
® Check Number of Phone Book Entries -
@Copy => (@) -> Phone— O More Features @ Edit a Phone Book Entry g
USIM or USIM— Phone > Bl Advanced @ Copy a Phone Book Entry [
(’] => Phone Book -> (] . . @ Delete Entries
Creating Entries @ Delete Items from an Entry
@Search Phone Book ® Savea P(;s;al Code, Address & Memo o Delete an Entry from USIM Card
® Save Birthday (> P. 2-34)
eseled an entry = (a] ® Change Entry Number i
Repeat this step to specify other (> P. 2-33) Customize
entries. Phone Book Search Phone Book
6 => YES => (m] @ Change Index Tab of Phone Book Entry ~ @ Set Preferred Search Method
List Window @ Change Group Name
® Change Font Size (> P. 14-16)
® Change Phone Number/E-mail Address
Order

® Compose an S! Mail from Phone Book
® Compose an SMS Message from Phone
Book
(> P. 2-39)
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- S! Addressbook Back-up

b
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IOverview

Back up handset Phone Book to server.

@ Separate subscription required.
@ See SOFTBANK MOBILE Corp. Website
(http://Awww.softbank.jp) for details.

Using S! Addressbook
Back-up

Synchronizing Phone
Book

Connect to Phone Book backed up on

server and bring it up to date with

handset’s Phone Book.

@ The first time you synchronize will be in
Synchronize regardless of the setting.

@ Synchronization can be any of the
following types.

Sync From
Client

Copy updated
information to server
Phone Book.

Sync From
Server

Copy update
information to
handset Phone Book.

Backup Back up handset Phone
Book to server (note
that Server Phone Book

is deleted).

Restore server Phone
Book to handset (note
that handset Phone

Restore

Book is deleted).

Synchronize Synchronize handset
Phone Book and
server Phone Book.
Both Phone Books are
synced with the

newest information.

228

@ = Tools = (m) = s!
Addressbook Back-up => (8]

B S! Addressbook Backup

[Start Sync
BlAuto Sync Settings
BISync Log

S! Addressbook Back-up Window

@) start Sync = (8] = Enter
Security Code = (u]

OSeIect type of
synchronization = (8] => YES
= (m]
Synchronization starts.
Synchronization results appear
after completion.

(4]E)
Checking Synchronize
Log

0[5! Addressbook Back-up]
window = Sync Log > (u]
= Select an item = (®]



- S! Addressbook Back-up

6 More Features

S! Addressbook Back-up
® Delete Synchronize Log

S! Addressbook Back-up
® Set Auto Synchronize
® Check Auto Synchronize Settings
(> P. 14-16)

(> P. 2-36)
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- Advanced Features
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Main Menu

Start Here
[Main Menu] ..o P. 2-2

Change Main Menu Theme

[Main Menu) = (&) => Select a
pattern => (8] (=> YES or NO => (m))

Desktop Icons

Edit Title of a Desktop Icon

(@) => Select an icon = (@] => Edit
Title => (] => Enter title = (m]

Switch to Simple Menu

[Main Menu] => (&) = Simple

Menu => (8] => YES or NO => (a]

EEJin Simple Menu, font size is larger and
menu options are limited to basic
ones.

Temporarily Change Design Theme
of Main Menu

[Main Menu] = [®] => Select a

theme =

[EINext time you open Main Menu,
default Main Menu returns.

Change Icon Image

(@) = Select an icon = @) => CHG

Icon Image => (®] => Select Icon

Image => (8] => Select a folder =

(m] => Select a file => (m]

EJ7o reset icon image, select Default
Icon Image and press [E].

Delete Desktop Icons

(@) = Select an icon = (@) =
Delete => (]

® To Select Delete This

=> Delete This = (®] = YES => (&]
® To Select Delete selected

=> Delete selected = (®] => Select
icons = (8] = (@) => YES => (m]

® To Select Delete All

=> Delete All = (@) = YES => (u)

Check Icon Information

(@) = Select an icon = (@) = Icon
Info Setting => (m)

Reset Desktop Icons

(m] = [@) => Reset Desktop => (m]
=> YES => (m]

Change Order of Desktop Icons

(@) => Select an icon = (@) => Sort
= (W) = YES => (8] = [0 to select
a position = (&)

Show/Hide Desktop Icons

(w) = (©) => Display Setting => (u]

=> Display always or Display at Use

= (m] (= [m))

[E}When Display at Use is set, Desktop
Icons only appear when you press ()
in Standby.




Text Entry

Start Here
[Text Entry] window ................ P. 2-12

Functions Before Entering Text

Switch between Lower Case &
Upper Case

[Text Entry] window = (@) =>
Lower Case or Upper Case = (m]

Switch between Single-byte &
Double-byte

[Text Entry] window = (@] =>
Single-Byte or Double-Byte => (m]

Functions While Entering Text
Cycle Characters in Reverse Order

[Text Entry] window => Input a

character =

[EIThis procedure is available in 5-touch
mode.

Undo Last Operation

[Text Entry] window => Press and
hold

Move Cursor to Top/End of Text

[Text Entry] window = (@) =>
Jump => (8] => To Beginning or To
End = (u]

Input a Space

[Text Entry] window = (@) =>

Space = (m]

[ZJPress (0 to add a space at the end of
text.

- Advanced Features

P

Overwrite & Insert Modes

[Text Entry] window => (@) =>

Overwrite or Insert => (®]

[EJText entry windows always open in
Insert mode.

Insert Line Feed

[Text Entry] window =>
[EJPress (@) to add a space at the end of
text.

Use Dictionary

[Text Entry] window => (@) => Refer
Dic. => (] => Enter Word => (®]) =>
Enter word => (®] => Select a
dictionary => (8] => Select a word =>
(@) => Read descriptions of the word
® To Enter a Word from Search History
=> Reference History = (8] =>
Select a word = (@] => Select a
dictionary => () => Select a word =>
(@) => Read descriptions of the word

suonesadQ diseg
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- Advanced Features

suonesadQ diseg h

2-32

Quote Text

[Text Entry] window => (@) =>

Quote Data =

® To Quote from a Phone Book Entry
=> Quote Phonebook => (&) =>
Search Phone Book => Select a data
item to quote text from => (m] =>

® To Quote from Account Details
=> Account Details => (@) => Enter
Security Code => (@] => Select a data
item => (@] =>

® To Scan Text by Text Reader
=> Text Reader => (8] => Scan text
with camera =>

® To Scan Bar Code by Bar Code Reader
=> Bar Code Reader => (@] =>Scan a
bar code with camera => (m]

Templates

Start Here

[Templates (Common phrases)]
WINAOW ... P. 2-17
[Templates List] window.......... P.2-17

Edit a Folder Name

[Templates (Common phrases)]
window => Select a folder = (@) =>
Edit Folder Name => (®] = Enter
folder name = (m]

Reset Templates

[Templates List] window => Select
a template =

® To Select Delete This

=> Delete This => (8] = YES => (u]
® To Select Delete All

=> Delete All => (8] => Enter Security
Code = (@] => YES => (u]

EJUser entries are deleted, and
preinstalled templates return to default.

Use Kuten Codes

[Text Entry] window = (@] =>
Kuten Code => (] => Enter kuten
codes (P. 15-13)

Reset a Folder Name

[Templates (Common phrases)]
window => Select a folder = (@] =
Reset Name => (@) => YES => (m]

Edit Templates

[Templates List] window => Select
a template = (@) = Edit = (8] =>
Edit phrase => (m]

Dictionaries

Start Here

[Own Dictionary] window ....... P.2-17
[Downloaded Dictionary] window
.................................................... P. 2-18

Own Dictionary

Edit Entries

[Own Dictionary] window =>
Select an entry => (& = Edit word
=> (@) = Edit reading = (®]




Delete Entries

[Own Dictionary] window =>
Select an entry = (@) => Delete =>
(w)

® To Select Delete This

=> Delete This => (®) => YES => (m]
® To Select Delete selected

=> Delete selected => (B] => Select
entries = (@] = (@) = YES => (&)
® To Select Delete All

=> Delete All => (8] => Enter Security
Code = (@] => YES => (=]

View Information

[Downloaded Dictionary] window
=> Select a dictionary = (@) =>
Dictionary Info => (a1

Downloaded Dictionaries
Edit Title
[Downloaded Dictionary] window

= Select a dictionary => (&) => Edit
Title => (m] => Edit title => (m]

Delete Dictionaries

[Downloaded Dictionary] window
=> Select a dictionary = (@] =
Delete => (m]

® To Select Delete This

=> Delete This = (8] = YES = (u]
® To Select Delete All

=> Delete All => (8] => Enter Security
Code = (8] => YES => (m]

Creating Entries

Save a Postal Code, Address &
Memo

[Phone Book Entry] window =>
or Bl => (@] = Enter content => (&)

- Advanced Features

Save Birthday

[Phone Book Entry]window =>
=> (@] = Enter date of birth = (=]

suonesadQ diseg P

Phone Book

Start Here

[Phone Book Entry] window.... P. 2-22
[Phone Book Entry List] window
..P.2-23

[Phone Book Entry Detalls] wmdow
P. 2-23

[Phone Book Search] wmdow
...P.2-23

Change Entry Number

[Phone Book Entry] window => @
=> (m] => Change entry number =>

(w)

233
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Phone Book Search

Change Index Tab of Phone Book
Entry List Window

[Phone Book Entry List] window
=> (@) => Change Display => (&) =>
Alphabet, Memory No. or Group
= [(w]

suonesadQ diseg h

Change Font Size

[Phone Book Entry List] window or
[Phone Book Entry Details] window
=> (@) = Font Setting = (W) =>
Standard Font, Big Font or Small
Font => (m)

Change Phone Number/E-mail
Address Order

[Phone Book Entry Details] window
=>Select a phone number/e-mail
address = (@) => Move to Top =

(w)

[E3This procedure is available when more
than one phone number/e-mail address
is saved to a Phone Book entry.

Compose an S! Mail from Phone
Book

[Phone Book Entry Details] window
= f04 to select an e-mail address =>
(@) => Compose S! Mail

Managing Phone Book

Check Custom Ringtone/Image
Settings by Item

[Phone Book Entry List] window =>
=> Ring Tone/Image => (m) =
Select an item with “ " => (=] =>
Select an item with “% " = @] =>
Check Settings => [®) => Check
settings of item

234

Compose an SMS Message from
Phone Book

[Phone Book Entry Details] window
=> 04 to select a phone number =>
=> Compose SMS => (] =>
Compose SMS message

Cancel Custom Ringtone/Image
Settings by Item

[Phone Book Entry List] window
=> (@) => Ring Tone/Image = (8] =>
Select an item with "% * = (@] =
Select an item with "% " = (@] =>
Release Settings => (W) => YES =>

(w]




Check Restriction Settings by
Restriction Type

[Phone Book Entry List] window
=> (@) => Restrictions => (®] =>
Enter Security Code => (] => Select
a restriction type with “ % * =
=> Check Settings = (®]

Cancel Restriction Settings by
Restriction Type

[Phone Book Entry List] window
=> (@) => Restrictions => (W) =>
Enter Security Code => (] => Select
a restriction type with “ %" =>
=> Release Settings => (W) => YES

= [(w)

Edit a Phone Book Entry

[Phone Book Entry Details] window
=> (@) => Edit Phone Book => (m] =>
Edit each item => (&) => YES => [u]
® To Save as a New Entry

=> [ => (@] => Enter entry number
The edited entry is saved as a new entry
and the original entry remains the same
as before.

Copy a Phone Book Entry

[Phone Book Entry Details] window
= |®] => Copy to USIM or Copy
from USIM => (m] => YES => (u]

Delete Entries

[Phone Book Entry List] window
=> Select an entry = (@) =
Delete Data => (®]

® To Select Delete This

=> Delete This = (8] = YES => (m]
® To Select Delete selected

=> Delete selected => [B] => Select
entries = (8] = (@] = YES => (=]

® To Select Delete All

=> Delete All => (] => Enter Security
Code => (] => YES => (m] => YES =>

(w)

- Advanced Features
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Check Number of Phone Book
Entries

[Phone Book Entry List] window
=> (@) => No. of Phone Book => (m]

Delete Items from an Entry

[Phone Book Entry Details] window
=> [0 to select an item = (@) =
Delete Data => (8] => Delete Phone
No., Delete Mail Add., Delete
Address, Delete Birthday, Delete
Memorandums, Delete Image or
Delete This => (] => YES => (]
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Delete an Entry from USIM Card

(e = Tools => (@] = USIM
Operation => (8] => Enter Security
Code => (] => Delete => [m]) =>
USIM => (m] => Phone Book => (m)
=> Search Phone Book =>Select an
entry = (®) = @] = YES = (&)

S! Addressbook Back-up
Start Here

suonesadQ diseg h

.................................................... . 2-28

Delete Synchronize Log

[S! Addressbook Back-up] window =>
Sync Log => (m] => Select Log =

® To Select Delete This

=> Delete This => (8] = YES => (m]

® To Select Delete selected

=> Delete selected => (@) => Select

Log = (@) = (&) = YES = (&)

@ To Select Delete All

=> Delete All => (®] => Enter Security
Code => (m) => YES => (m]
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E Overview

Voice call and video call are available on handset.

Voice Cal| mm— Video Call == Emergency Calls

Make Calls to: Make Calls to: Your location is automatically reported to the
—ﬂ corresponding agency (police, etc.) when you
D D place emergency calls (110, 119, or 118) with
) Softbank 3G handsets.
Q ﬁ (Emergency Location Report)
= &= 830N reports Location Information based on
g . positioning signals from radio stations.
SoftBank Non-SoftBank SoftBank Non:SoftBank Landlines @ Regjistration and transmission fees do not apply.
Handsets Mobile Phones Handsets  Mobile Phones @ Positioning accuracy is affected by location and

signal conditions. Always provide your location
and purpose on the phone.

ﬁ C)ther party must use a video Ca”) @ Location Information is not reported when

compatible phone emergency calls are placed without Caller ID
(such as when the number is prefixed with

. 184). However, the corresponding agency may
Landlines obtain your Location Information in a life
threatening situation.

' ' @ Not available during international roaming.

Emergency calls are possible even while

Calllng Abroad % Using Handset Abroad some handset restrictions are active.

+ Restrict Dialing (P. 2-26)

| | from Japan g‘andset g %'loba' Roaming - Keypad Lock (. 4-4)
nt Oha . . ervice eligiole. - Set Max Cost Limit (P. 14-19)
@ Make(recelve voice (Prior app“cation may be - Emission OFF Mode (P. 4-7)
and video calls. - PINT Code Entry Set (P. 4-2)

required.)
* International phone service available + For details of service and eligible countries and regions, see
without separate application. SOFTBANK MOBILE Corp. Website (http:/www.softbank.jp), or
contact SoftBank Customer Center, General Information (P. 15-52).




IMaking Voice Calls 2

@) Enter phone number

@

AkimaiMasami

090392k xkx0

Voice Call Window

€)= toend call
Tip

* Always include the area code even
when dialing from the same area.

* When you hear a busy tone, the other
party is on another line.

» When you hear a message saying that
the other party cannot be reached, the
other party’s mobile phone is off or is
out of signal range.

* When you hear a message asking for
your caller ID, call again with your
number revealed.

« After Display backlight turns off during
a call, if no keys are pressed for about
two minutes, Display goes off and
handset enters power saving mode
regardless of Lighting setting for
Backlight (P. 14-7). Handset can be
operated in power saving mode in the
same way as when Display is lit.

PHONE NUMBER

Phone Number Entry Window

HCorrecting Misentries
=> 04 to scroll cursor => Reenter
number(s)

HDeleting Numbers
=> (04 to select a number =>
Press and hold to delete all
numbers to the left of the selected
number.

HEDeleting Phone Number
Press and hold or(=]

« Call ends when handset is closed.
Connect stereo earphone-microphone
to talk with handset closed.

Available Keys during
Voice Calls

Adjust Earpiece (% or press and hold
Volume (=)}
Hold Call

Ilnternational Calls

International phone service available
without separate application.

@) Enter phone number =
= Int'l call = (u]

@) Select a country code = (u]
=> Select an international
prefix number = (8] =

€)(=toend call

- Voice Call
O)

[cLr =]
[Talking]

Bunres P



- Voice Call

Tip

* When Voice Mail or Call Forward is
activated, set a shorter ring time for
Answering Machine than that for Voice

IAnswering Voice Calls
@ When a call arrives =

QE to end call Mail or Call Forward.
» Answering Machine can be set or
Tip canceled by pressing and holding

in Standby.

» Answering Machine is unavailable
when power is off, in a place with no
signal reception, or in Emission OFF
Mode. Use Voice Mail instead
(see P. 3-15).

» Open handset to answer a call.

IAnswering Machine

Record caller’s messages on handset
when you are unable to answer voice
or video calls.

Setting Answering
Machine

@Y => settings > (w] =
Incoming Call => (&) =>
Answering Machine => (8]

@)ON = (8] => Select an
outgoing message = (8]

€)Enter ring time

@®When a Call Arrives

Answering Machine activates after the
set ring time. Outgoing message plays,
and the caller’s voice/video message is
recorded.

Handset returns to Standby when
recording is complete. Answering
Machine notification and Display
indicator appear. The indicator shows
the number of messages.

[Recording Messagel]

090392k k0

HTo Answer Call during Recording
=



Playing Messages
@) (] = Select notification &
or & = (m

B Play/Erase Msg.

[LlAnswer ing Machinel ki
@Answer ing Machine2
EAnswer ing Machine3
MiAnswer ing Machine4

SAnswer ing Machine5
EVoice Memo

@Auto voice Memol
BAuto voice Memo2

Play/Delete Voice Message Window

Items with a message recorded are

indicated by “%.”
@) Select a message = (1]

HTo Delete a Message While
Playing it

= (@) => Erase => (@] => YES => (m]

Available Keys during
Playback

Tip

* Pressing in Standby also plays
recorded voice messages.

» When there is a voice memo but no

voice message, the voice memo plays.

* To play voice messages from Main
Menu:

() = Tools = (m) => Play/Erase
Msg. => (u]

Available Keys during
Video Message Playback

Play Next Message |U

Play Previous/Next |K¥or (]
Message

Adjust Volume ()
Pause/Play (]
Stop
Return a Voice Call
Return a Video Call

Stop (w] or

Return a Voice Call

Return a Video Call

Tip

* To play video messages from Main
Menu:
() => Tools => (m) => Play/Erase VC
Msg. => (m]

Activate When Call
Arrives

Activate Answering Machine when
unable to answer an incoming call.
Answering Machine setting returns,
after message is recorded.

0When a call arrives = (J

Answering Machine is activated
and starts recording.

Note

» Answering Machine cannot be
activated when memory is full.

- Voice Call
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- Voice Call

0 More Features
K Advanced

Outgoing Call Functions
® Show/Hide Caller ID
® Add Area Code and Country Code
(Prefix Numbers)
(> P. 3-16)

International Calls
® Enter “+" to Call Abroad
(> P. 3-16)

Handling Incoming Calls
® Reject Calls
@ Place Calls on Hold
@ Forward Calls
@ Forward Calls to Voice Mail Center
(> P. 3-16)

Engaged Call Operations

® Handsfree

® Toggle Device (Handset and Bluetooth®
Device)

® Make Other Party Clearer to Hear
(Hyper Clear Voice)

@ Send Touch Tones

(»P.3-17)

Answering Machine
@ Delete Recorded Messages

(> P. 3-18)

Outgoing Calls
@ Save Area Code and Country Code as
Prefix Numbers
® Save Touch Tones
@ Set Numbers after “ %" as Sub Address
(> P. 14-17)
Display Settings
@ Set an Outgoing Call Image
(> P. 14-4)

International Calls
@ Change International Access Code
Automatically Dialed with “+*
® Change a Country Code
@ Save an International Access Code
(> P. 14-17)

Incoming Call Alerts

@ Adjust Ringtone Volume

@ Set a Ringtone

® Set Vibration

® Set lllumination Color

@ Set an Incoming Call Image

® Show Phone Book Entry Images for
Incoming Calls
(» P. 14-10)

Answering Incoming Calls
® Set to Answer Calls by Pressing Any Key
@ Set to Mute Ringtone by Pressing Any
Key
® Set to Answer Calls by Opening
Handset
(> P. 14-12)

Call Settings
® Set Reconnection Tone
® Set Noise Reduction
® Set Weak Signal Alarm
@ Set Clarity of Other Party Voice
@ Automatically Record During Voice Call
@ Set a Hold Message
(> P. 14-18)



- Video Call

IVideo Call Window

Main
window
Call time
. Sub
Video window
call
settings

Video Call Indicators

& Hyper Clear Voice High
Hyper Clear Voice Low

Transmitting Audio
Transmission Failed

Transmitting Video
Transmission Failed

Sending Camera Image
Substitute Image

Handsfree ON
Handsfree OFF

'YCHEEEEE

A Mute

HDeleting Phone Number
=> 04 to select the first or last
number => Press and hold

(2]E)

Photo Mode Portrait
Photo Mode Scenery
Photo Mode Close-up

IMaking Video Calls
@) Enter phone number

PHONE NUMBER

Video Call Window

€)—=toend call

Tip

« Always include the area code even
when dialing from the same area.

* Video calls made to emergency
numbers (110, 119 and 118) are
automatically switched to voice calls.

* An error message with a possible cause
appears when a video call fails to be
connected.

» Handset is unequipped with a front
camera. Image sent to other party is
substitute image or rear camera image.

Phone Number Entry Window

HCorrecting Misentries
=> [ to scroll cursor => Reenter
number(s)

HDeleting Numbers
=> I04 to select a number =>
Press and hold to delete all
numbers to the left of the selected
number.

Bunres P
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- Video Call

Available Keys during
Video Calls

3s

+ Charging may automatically stop or
camera image may switch to substitute
image if charging while making a video
call, depending on temperature and
handset usage (ex. also recording TV).

» Call ends when handset is closed.
Connect stereo earphone-microphone
to talk with handset closed.

Adjust (@ or press and hold (&)

Earpiece

Volume

Hold Call

Toggle Main | Press and hold (®] to

Window toggle image as

Images follows: The other
party’s image — Your
image — The other
party’s image (sub
window off) = Your
image (sub window off)

Zoom In/Out |k or press and hold 5

Outgoing

Camera Image

Mute Audio | (m)

To cancel mute, press
again

Answering Video
Calls

OWhen a video call arrives =

@)(=)to end call

Tip
* Open handset to answer a video call.



0 More Features
K Advanced

Outgoing Call Functions

@ Show/Hide Caller ID

® Add Area Code and Country Code
(Prefix Numbers)

(> P. 3-16)
Handling Incoming Calls
® Reject Calls
@ Place Calls on Hold
@ Forward Calls
(> P. 3-16)

Engaged Call Operations
® Handsfree
@ Toggle Device (Handset and Bluetooth®
Device)
® Set Image Quality
@ Adjust Brightness
® Change White Balance
® Change Color Tone
@ Change Photo Mode
@ Backlight Lighting Time
(»P. 3-17)

Outgoing Calls
@ Save Area Code and Country Code as
Prefix Numbers
® Set Numbers after “ %" as Sub Address
(»P. 14-17)

Display Settings
® Set an Outgoing Call Image
(> P. 14-4)

Incoming Call Alerts
@ Adjust Ringtone Volume
@ Set a Ringtone
® Set Vibration
® Set lllumination Color
@ Set an Incoming Call Image
® Show Phone Book Entry Images for
Incoming Calls
(» P. 14-10)

Answering Incoming Calls
® Set to Answer Calls by Pressing Any Key
® Set to Answer Calls by Opening
Handset
(»P. 14-12)

Call Settings
® Set Reconnection Tone
@ Set Noise Reduction

- Video Call

® Set Weak Signal Alarm
@ Set a Hold Message

(> P. 14-18)
Video Calls
® Set an Image to be Sent during Video
Calls

@ Redial Automatically as Voice Call When
Video Call Connection Fails

® Set an Image to Appear in Main
Window

@ Automatically Switch to Handsfree
Mode in Video Calls

Bunres P
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E Call Logs

Dialing from Call
LOgS
Phone numbers and dates and times of
incoming and outgoing calls are saved

on handset as call logs. Access call logs
to return calls quickly.

Call Log Indicators

The following indicators appear in
Redial, Dialed Calls and Received Calls
windows.

i 3|

Buljed

Voice Calls

k&l Outgoing & Incoming
Missed

A Unchecked Missed

International Video Calls
#d Outgoing & Incoming
B Missed

& Unchecked Missed

Answering Machine
Voice Messages
[&] Video Messages

Packet Transmission

Outgoing & Incoming Calls
Appears when outside the GMT+09
time zone.

Time appears in summer time when
summer time is set.

International Calls

& Outgoing & Incoming
& Missed

& Unchecked Missed

Video Calls
Outgoing & Incoming
w Missed

Redial/Received Calls
DDorg

B Redial 1/2
il 3/ 1 9:45 &
[ AkimaMasani
@ 2/28 20:21
&KitagawaRikio

& 2/27 11:5
‘aNakayamaTaro

E  Received Calls 1/2

A
[ AkimaMasami

@ 2/28 22:06
090392%kkk6

& 2/21 7:12
090392%%kk7

M 2/18 20:47
0903925548
2/15 14:26

M 2/26 21:13
090392%%%X7

& 2/25 10:32
®|0zawak isuke

& Unchecked Missed

3-10

B 2/20 19:56
09039246

Redial Window

awak i suke

&K tagawarikio

Received Calls Window

@) select a record = (7 or

M To Check Details of a Record
=> Select a record = (&)

Dialed Calls

@ = own Data > (u] =
Dialed Calls => (u]

=] Dialed Calls 1/2

L3/ 9:45 5|
[ Akimal

@ 2/28 20:21
&KitagawaRik

& 2/27 11:56
&NakayamaTaro

| 2/26 21:13
090392%%kx7

B 2/2510:32
&0zawaEi suke

B 2/20 19:56
090392x%%*6

Dialed Calls Window

@) select a record = or

Ml To Check Details of a Record
=> Select a record = (m]



Checking Number of
Missed Calls

@ > own Data > (u] =
Received Calls = (u]
The total number of incoming
calls, number of missed calls, and
number of unchecked missed calls
appear.

@) All Calls or Missed Calls
(w)

ICaII Time & Cost

Check the total and last call times and
costs.

Call cost and cost limit may be
unavailable depending on your
subscription.

@ = = settings - (8] = Call
Time/Charge > (®] => Call
Data = (u]

Tip

* Use indicated call times and costs only
as a guide. The actual call time and cost
may be different. Your handset may
not indicate call costs depending on
the service you subscribe. Indicated
costs do not include consumption tax.

* When the last or total call time exceeds
199 hours 59 minutes 59 seconds,
counting restarts from zero seconds.

O More Features
K Advanced

Redial, Dialed Calls & Received Calls
® Change Font Size

@ Show Ring Time (Missed Calls)

@ Delete Records

(> P. 3-18)
Call Time & Cost
® Reset Total Call Time
@ Reset Total Call Cost

(> P. 3-19)

Incoming Call Alerts
® Open Missed Calls Window by Opening
Handset
(» P. 14-10)

Checking Call Logs
@ Change Colors of Names, Phone
Numbers and E-mail Addresses in Call
and Message Log Windows
(> P. 14-14)

Call Costs

@ Set Auto Reset of Total Call Cost

@ Set/Cancel a Maximum Call Cost Limit
(» P. 14-18)

- Call Logs

E
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- Speed Dial

Saving Entries to Tomo-Den
(1wl

=] Tomo-Den
il 2 [ 3[uyls]

IAbbreviated Dialing

Just press a number key from (0] to
(8] and then to call Phone Book

@ If a Phone Book entry has more than
one phone number, handset dials the
first number.

@ to (@)= (orE®

Dialing from Tomo-
Den

Save frequently accessed Phone Book

entries to Tomo-Den to quickly make

calls or send messages.

@ Tomo-Den is unavailable in Secret Data
Only Mode.

@ Although Tomo-Den is available in
Secret Mode, secret Phone Book entries
cannot be saved to Tomo-Den.

312

entries with entry numbers 000 to 009.

no photo

<Not Stored>

Tomo-Den Window

@)S to select a tab = (@) =
Search Phone Book => Select
an entry => (8

€) select a phone number or
e-mail address = (m)
When a checkbox is selected, other
numbers/addresses become grayed
and cannot be selected. To select
another number/address, first
cancel the currently selected
checkbox.

(4]E]

Dialing/Sending
Messages from Tomo-
Den

0

@) S to select an entry =
CALL, MAIL or VIDEO CALL
= (m)
HlTo Send an S! Mail to All Tomo-
Den Entries
=> (@) => Broadcast Mail => (&) =>
Compose S! Mail

'9 More Features
K Advanced

Speed Dial
@ Cancel Entries from Tomo-Den
® Change Tomo-Den Entry Image
(> P. 3-19)



Make calls while overseas.

@ Global Roaming Service may require
prior application. Details and
applications are available online at
http://Avww.softbank.jp
or by contacting SoftBank Customer

Center, General Information (P. 15-52).

@ 330N is compatible with 3G networks.
Transmission is unavailable in
GSM/GPRS areas.

Calling Japan and Other
Countries

OPress and hold (0]

“4+" is entered.

@Enter country code and
phone number with area
code (excluding the first “0")
=

Tip
» Do not omit the first “0"” from area
code when calling Italy.

Calling within the
Same Country

OEnter phone number with
area code =>

- Do not omit “0” from area code.
-+ Country code not required.

- Calling While Abroad (Global Roaming)

'9 More Features

Global Roaming
@ Set Operator
@ Activate Network Re-search for an
Available Operator
® Set Priority for Operators
® Show Operator Name While Roaming
(> P. 14-20)

Bunres P

313



- Optional Services

IOverview

The following services are available
with your handset.

Call Forward calls to a preset

Forward |phone number.

Voice Forward calls to Voice Mail

Mail Center when unable to
answer a call.
Missed Call Notification
Notification (SMS) arrives for
missed calls while handset
was off, out of range or
engaged, etc.

Call Place the current call on hold

Waiting”™ [to answer another incoming
call. Talk with two parties
alternately.

Group Call others during a call and

Calling® |talk with multiple parties
simultaneously.

Call Select whether to restrict

Barring |incoming and outgoing calls
and SMS.

314

Caller ID |Select whether to show or
hide your number when

making calls.

* Separate application is required.

Activating Call Forward

<Example> Forward calls to a specified
number after a set ring
time

@ = Settings = (] =
Optional Services > (u] =
Voice MaillDivert => [u)

Voice Mail/Divert

oice Mail ON
ivert 0

et Status

\
] N
Voice Mail/Divert OFF
G
Erase Icon

Voice Mail/Divert Window

@) Divert ON = (8] => YES =
(m) = VoicelVideo Calls,
Voice Calls or Video Calls
= (m] = Enter phone
number => [m]

MTo Search from Phone Book
=> (§) to select a search method =>
(@) =>Search Phone Book = Select
an entry = (m] => Select a phone
number => (8] (twice)

€)No Answer > (u] => Select a
ring time = (u)
HTo Forward Calls Immediately
=> Always => (1]
Tip

« If No Answer is set, press to
answer incoming call before the call is
forwarded. If Always is set, handset
does not ring/vibrate and all calls are
forwarded to the preset number.

« Call Forward and Voice Mail cannot be
set simultaneously. Call Forward for
video calls is only available with Voice
Mail.

« If you activate Call Forward when Voice
Mail has already been set, Voice Mail is
canceled.



Activating Voice Mail

<Example> Forward calls to Voice Mail
Center after a set ring time

o[Voice Mail/Divert] window
= Voice Mail ON =>(m] =>
YES => (m]

@) No Answer > (8] => Select a
ring time = (u]
M To Forward Calls to Voice Mail

Center Immediately
=> Always => (m]
Tip

« If No Answer is set, press to
answer incoming call before the call is
forwarded to Voice Mail Center. If
Always is set, handset does not
ring or vibrate and all calls are
forwarded to Voice Mail Center.

» Voice Mail and Call Forward cannot be
set simultaneously. Voice Mail is only
available with Call Forward for video
calls.

« If you activate Voice Mail when Call
Forward has already been set, Call
Forward is canceled.

@ Missed Call Notification

SMS notification informs you of missed
calls while handset was off, out of
range, engaged, etc.

(1 nnesanesvs

Follow voice guidance.
@To Play Messages
o[Voice Mail/Divert] window

=> Play Messages > (8] =>
YES => (m]

Canceling Call Forward &
Voice Mail

0[Voice Mail/Divert] window
=> Voice MaillDivert OFF
= (@] = YES => (=]

'9 More Features
Advanced

Call Forward & Voice Mail
@ Delete Icons for Notifying Recorded
Messages

® Check Current Setting Status
(» P. 3-20)

Call Waiting
@ Set Call Waiting
® Answer Incoming Calls during Calls
@ Check Current Setting Status
(> P. 3-20)

Group Calling
@ Hold Current Call to Make Another Call
@ Switch Parties
@ Talk with Multiple Parties
Simultaneously
® Talk with a Specific Party
@ End Call with a Specific Party
(> P. 3-20)

Call Barring

@ Restrict Incoming/Outgoing Calls & SMS

@ Cancel Call Barring

® Change Network Password

® Check Current Setting Status
(»P.3-21)

Caller ID

® Show/Hide Phone Number

® Check Current Setting Status
(> P.3-22)

- Optional Services
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- Advanced Features

Outgoing Call Functions

Show/Hide Caller ID

Enter phone number = (@] =

Notify Caller ID => (] => OFF, ON

or Cancel Prefix => (®) = or

@Alternatively, enter “186" before the
phone number to show your number,
or “184" to hide your number.

[Eshow/hide Caller ID each time you dial
from Phone Book or call logs (Redial,
Dialed Calls or Received Calls).

International Calls

Enter “+" to Call Abroad

Press and hold (0 => Enter
country code = Enter area code =>
Enter phone number => =
Dial = (]

[2)"+" appears when you press and hold
(0], indicating that the international
code set in Auto Int’l Call Set. is
entered.

Forward Calls

When a call arrives = (@) => Call

Forwarding = (m]

[E3This procedure is available when Call
Forward has been activated from Voice
Mail/Divert window.

Add Area Code and Country Code
(Prefix Numbers)

Enter phone number = (@) =>
Prefix Numbers => (8] => Select an
item => (@] => () or

[E)store area codes and country codes
beforehand. Enter prefixes before
making calls.

[E1Add prefix from Phone Book entry,
Redial, Dialed Calls or Received Calls
windows.

[£30046010 is set to FEER/E by default.

Handling Incoming Calls

Reject Calls

When a call arrives => (@) => Call
Rejection => (m]

Voice Calls
Forward Calls to Voice Mail Center

When a call arrives=> (@] => Call

Forwarding => (m)

[E3This procedure is available when Voice
Mail has been activated from Voice
Mail/Divert window.

Place Calls on Hold

When a call arrives = (=] = To

answer call =

[Z)Press (=] again to end the call on
hold.

3-16



- Advanced Features

Engaged Call Operations

Start Here

[Voice Call] window .........cceeuen. P.3-3
[Video Call] window.........cceeue... P. 3-7
Voice & Video Calls

Handsfree

[Voice Call] window/ [Video Call]

window => (&) => YES => (]

[ZlPress (2 again to cancel handsfree
mode.

Toggle Device (Handset and
Bluetooth® Device)

[Voice Call] window/ [Video Call]
window => (@] => Bluetooth/Phone

= (]

Make Other Party Clearer to Hear
(Hyper Clear Voice)

[Voice Call] window/ [Video Call]

window =>

[E3Press (] to toggle setting
High, OFF or Low.

[2] Not available when handsfree is On or
when an external device (ex. stereo
earphone-microphone (sold
separately) is connected.

Video Calls
Set Image Quality

[Video Call] window => (@] =>
V. Call Settings => (] => Visual
Prefer. => (m] => Select an item =

(w)

E

Buijjed

Voice Calls
Send Touch Tones

[Voice Call] window => (& (twice)
=> Settings => (8] => Djaling => ()
=> Pause Dial => (®] (twice)
[ZJEach time you press (/), a touch tone
sequence until “p” (pause) is sent.
[Z)save touch tones in advance
(P. 14-17).
® To send touch tones all at once:
=> Press and hold (3 => Send at one
time = (m]

Adjust Brightness

[Video Call] window => (@) =>

V. Call Settings => () => Brightness

=> (@) = Select a level = (m]

[Z)Available when sending camera
image.

Change White Balance

[Video Call] window = [®] =>

V. Call Settings => (8] => White

Balance => [®] => Select an item =

(w]

[Z)Available when sending camera
image.
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Change Color Tone

[Video Call] window = (@] =>

V. Call Settings => (@) => Color

Mode Set => (8] => Select an item

=> (]

[E)Available when sending camera
image.

Change Photo Mode

[Video Call] window => (@) =>

V. Call Settings => (8] => Photo

Mode => (®] = Select a mode => (m]

[E)Available when sending camera
image.

Answering Machine
Start Here

[Play/Delete Voice Message] window
....... P.3-5

Delete Recorded Messages

[Play/Delete Voice Message]
window => Select a message =
=> Delete This, Delete Rec. Msg. or
Delete All => (@) => YES => (m]
[E)Selecting Delete All also deletes a
voice memo if it has been saved.

Backlight Lighting Time

[Video Call] window => (@] =>
Display Light => (&) => All Time ON
or Same as Backlight => (m]

Call Logs
Start Here
[Redial] window.......ccccecercerunnne P. 3-10
[Dialed Calls] window .............. P. 3-10
[Received Calls] window .......... P. 3-10

Redial, Dialed Calls & Received
Calls

Change Font Size

[Redial] window, [Dialed Calls]
window or [Received Calls]
window = (@] => Font Setting >
(m] = Standard Font, Big Font or
Small Font => (m]

Show Ring Time (Missed Calls)

[Received Calls] window = (@) =>
Ring Time => (u]




Delete Records

[Redial] window, [Dialed Calls]

window or [Received Calls]

window => (@] => Delete => (m]

® Delete Selected Entry

=> Delete This => (®) => YES => (m]

® Select Entries to Delete

=> Delete selected => (B] => Select

records = (®) = (&) = YES => (u]

® Delete All Entries

=> Delete All => (8] => Enter Security

Code = (@] => YES => (=]

[E)selecting Delete All in Redial window
or Dialed Calls window deletes all
records from both Redial and Dialed
Calls.

Call Time & Cost

Reset Total Call Time

(e => Settings => () =>

Call Time/Charge => (] => Reset
Total => (] => Enter Security Code
=> (m]) => Reset Total Duration =>
(m] => YES => (m]

Reset Total Call Cost

b => Settings => (@) =>

Call Time/Charge => (8] => Reset
Total => (] => Enter Security Code
=> (m] => Reset Total Cost => (®] =>
YES => (@] => Enter PIN2 => [m]

Speed Dial
Start Here

[Tomo-Den] window ................ P. 3-12
Cancel Entries from Tomo-Den
[Tomo-Den] window => [0 to
select a tab = (@] => Release This

or Release All => (@] (= Enter
Security Code => (w]) => YES => (m]

Change Tomo-Den Entry Image

[Tomo-Den] window = I to
select a tab = (@) => Image = (u]
=> Select a folder => (] => Select
an image => (1]

- Advanced Features
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Optional Services

Answer Incoming Calls during Group Calling
Start Here Calls
. L . Hold Current Call to Make Another
[Vo!ce MalI/Dl_vert] window .... P. 3-14 [Voice Call] window = Call Call
_ﬂ [Voice Call] window ........ccccu.u.... P.3-3 waiting tone sounds =
n . : [ZPress (m] to toggle between two [Voice Call] window => =
o  Call Forward & Voice Mail barties. Enter phone number =
s ] & i ®) =
a Delete Icons for Notifying . [a;z dl gomkpign[%]BOOk; ﬂrishs
Recorded Messages Check Current Setting Status one boo » search Fhone
Book, select a number and then press
[Voice Mail/Divert] window => e E:> Settings = (8] = O_p_tlonal '. . .
Erase Icon => (m) = YES => (u) Services = (@] => Call Waiting = [E17o dial from Dialed/Received Calls,
(w) = Get Status = (w) press (@) => Redial = (@] or (@) =>
Check Current Setting Status Received Calls = (W] to select a
phone number or name and then press
[Voice Mail/Divert] window = Get s
Status => (u]
Switch Parties
Call Waiting [Voice Call] window => (]
[ZJPress (m] to toggle parties.
Set Call Waiting

b => Settings => () => Optional
Services => (8] => Call Waiting =>
(] => ON or OFF => (] => YES =>

(m]
320




Talk with Multiple Parties
Simultaneously

[Voice Call] window => While
talking with one party = (@] =>
Join Multi Party => (]

Talk with a Specific Party

[Voice Call] window => While

talking with multiple parties =

=> Select Ans. Call => (m] => Select

a party => (]

[EIThe other parties are placed on hold
while talking with the selected party.

End Call with a Specific Party

[Voice Call] window => While
talking with multiple parties =>
=> Select Disc Call =>[®) => Select a
party = (m]

Call Barring

Restrict Incoming/Outgoing Calls
& SMS

fe) = Settings => (] => Optional

Services => (W] => Call Barring =>

(m] => Outgoing Calls or Incoming

Calls => ®] => Select an item => (u]

=> YES => (®] => Enter Network

Password => (]

[EJEmergency numbers 110, 119 and
118 are available even when Call
Barring is set.

[E}When Bar All Outgoing Calls or Bar
All Incoming Calls is set for Call
Barring, Call Forward is unavailable
(When Call Forward is set, Call Barring
is unavailable).

[E31f Network Password is incorrectly
entered three times consecutively, Call
Barring settings are locked. Network
Password and Center Access Code
must be changed. For details, contact
SoftBank Customer Center, General
Information (P. 15-52).

- Advanced Features

Cancel Call Barring

(o) => Settings => (m) => Optional
Services => (@) => Call Barring =
(m] => Cancel All Barring => (] =>
YES => (8] = Enter Network
Password => [m]

Bunres P

Change Network Password

(e => Settings = (W) => Optional
Services => (W] => Call Barring =>
(@) => Set NW Password => (®] =>
YES => (@] => Enter current
Network Password => (@] => Enter
new Network Password => (@] =>
Enter new Network Password
again for confirmation = (u]

Check Current Setting Status

lew => Settings => () => Optional
Services => (W) => Call Barring =>
(m] => Get Status => (] => Select an
item => (m]
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Caller ID

Show/Hide Phone Number

fen) => Settings => (W) => Optional
Services => (W) => Caller ID
Notification => (@] =>
Activate/Deactivate => (8] => ON
or OFF => (m) => YES = (m]

Check Current Setting Status

(e => Settings => (W) => Optional
Services => (@] => Caller ID
Notification => (] => Get Status =>

(w]
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- PIN Settings

b

Aundag

|setting PIN1 Entry

Set to require PIN1 entry each time
handset is turned on.

@ => settings > (w] =
Security => (8] => PIN
Setting > (m]

@) Enter Security Code => (u]

€)PINT Code Entry Set = (u]
<> ON => (8] = Enter PIN1 =

(w)

| changing PIN1/PIN2

@ PINT Code Entry Set must be set to
ON before changing PIN1.

@ = settings > (w] =
Security => (8] = PIN
Setting > (u]

@) Enter Security Code => (u]

€) Change PIN1 Code or
Change PIN2 Code > (u]

@Enter current PIN1/PIN2 =>

©Enter new PIN1/PIN2 => (u]
=> Enter new PIN1/PIN2
again for confirmation = (m]



IActivating Dial Lock Tip

« If Security Code is incorrectly entered five

Prevent others from operating times, handset powers off. Turn handset
handset. power on and enter correct Security
Code.

@ = > settings > (=) =
Security - (8] -> Lock - 8] ISetting Original Lock

@Enter Security Code = (m] Prevent others from accessing handset
. functions/data (e.g. Phone Book, Mail,
nga’ Lock => (m] etc.) that contain personal
Tip information. Original Locks can be
customized.

* The following operations are possible
e wihEm DgiaI’I)_ock 5 activatid: @ For IC Card Lock and Call Remote Lock,

- Power on/off see P. 11-4.

- Calling emergency numbers 110, 119 Activating Original Lock
and 118

- Answering incoming voice/video calls 0@ => Settings = (@] =

- . Security = (8] => Lock =>

Canceling Dial Lock y (8 (=)

@) Enter Security Code => (u]
If incorrect Security Code is
entered, press and enter
correct Security Code.

gEnter Security Code = (]

< Lock
1Dial lock
20riginal lock 1
30riginal lock 2
40riginal lock 3
LJ0FF

Reset lock ‘

Lock Window

@Original Lock (High) -
Original Lock (Low) = (u]
Functions/data specified under the
selected lock type are locked.
HTo Edit Title

=>Select an Original Lock => (@) =>

Edit Title => (m) => Edit title => (m]

@®When Original Lock is Set

Security Code entry is requested when
accessing a locked function or data.
Enter Security Code to unlock and
access function/data. Setting returns
when handset returns to Standby.

@ Dial/Sending Mail and

Incoming/Mail Disp. cannot be
unlocked temporarily.

- Prohibiting Unauthorized Handset Use

Aundag P



- Prohibiting Unauthorized Handset Use

Aundag h

Customizing Original
Lock

Select functions/data to lock.

@®Indicators

s Selected functions/data locked.
B All functions/data locked.

@Select and Lock Functions or
Data

0[Lock] window = Select an
Original Lock =

@Select a category = (m]

€)select a group = (]

() select functions or data to

Lock => (m]
Function is locked. Press () again
to deselect. Repeat to select the
function to lock.

HTo Select All Functions
=> (@) => Select All => (m]

HTo Deselect All Functions
= (@) => Release All => 1)

© [ (three times)

@®Lock Category or Group

o[Lock] window => Select an
Original Lock =

@) Select a category (> (8] =>
Select a group) = (@] =
Select All = (u]

HTo Cancel Lock for Category or
Group
=> (@) => Release All => (u]

O =)
@ Lock All Categories

o[Lock] window => Select an
Original Lock =

@) (@ = select All = (u]

HTo Cancel Lock for All Categories
=> (@) => Release All => (m]

(3]E)

@Lock All Group

O[Lock] window => Select an
Original Lock =

@) Select a category = (m]

@ = Select All = (u]

HTo Cancel Lock for All Group
=> (@) => Release All => (]

O (twice)
IDisainng Keypad

Set Keypad Lock to automatically lock
handset keys when handset is closed or
when handset is not operated for a
certain period of time.

Setting Keypad Lock

@ = = settings = (8] =
Security => (8] = Keypad
Lock = (m]

@) Enter Security Code => (u]



@After Closed or Timer = (u]
=> Select an item => (@] =

Ml To Lock When Handset Closed
=> After Closed => (@] => ON => (]

HTo Lock After Handset Closed a
Certain Time
=> Timer => (®) => Select time until
lock activates => [m]

MTo Lock by Pressing and Holding J
=> Lock Key => (8] => ON => (m]
Pressing and holding [J with
handset closed activates lock.

HTo Require Security Code to Cancel
Keypad Lock
=> Security Code => (8] => YES =>

O
4)E)

@®When Keypad Lock is Set

All key operations are disabled, except
for answering incoming calls and
turning power on/off.

When a call arrives or the alarm is
activated, [ appears at the bottom of
Display to indicate some keys are
operable.

Tip

» Emergency numbers 110, 119.and 118
are available even when Keypad Lock
is set.

Temporarily Unlocking
Keypad Lock

@®When Security Code is YES

@) When Keypad Lock is set =
Enter Security Code => (]

@®When Security Code is NO

@) open handset
Alternatively, press and hold [J.
Tip
« Alternatively, press (), or close and
reopen handset.

Using Secure Remote
Lock

If your handset is lost, lock handset
functions remotely from a PC or other
mobile phones. Once the lock is set, all
key operations are disabled except for
turning the power on. For details, visit
SOFTBANK MOBILE Corp. Website
(http://www.softbank.jp), or access My
SoftBank from your handset by the
following procedure:

=> X=7—1)X ;(Menu List) = (m]
=> My SoftBank => (m]

- Prohibiting Unauthorized Handset Use
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Using IC Card
Authentication

Hold a FeliCa compatible contactless IC

card over handset to authenticate the user

ID without canceling Dial Lock or Keypad

Lock, or without entering a code number.

@ IC Card Authentication is available even
when IC Card Lock is activated.

@ Register up to two contactless IC cards.

Activating IC Card

Authentication

@ = settings -~ (w)=
Security => (8-> IC Card
Authentic. => (8] => Enter
Security Code = (m]

A IC Card Authentic.

Up to 2 of IC Card
can be save

IC Card Authentication Window

@on =[E)- oK ~(u]
HTo Activate Registered IC Card
=> ON =>(m]
HTo Deactivate Authentication
=> OFF => (W]=> YES or NO => (m]
Select YES to delete or NO not to
delete all registered IC Card data.
HTo Register IC Card
=> (@) => New Ext. IC Card => (m]
HTo Delete IC Card Registration
= (@) => Del. Ext. IC Card => (m] =>
Select IC Card to delete => (®] =>
=> YES =>(m]

€)1C card over handset 5)
mark
Once registered, the & on Display
disappears.



B Prohibiting Outgoing/Incoming Calls

Rejecting Calls
without Caller ID

Incoming calls from hidden and/or

unidentified numbers can be rejected.

@y => settings > (m] =
Security = (8| => Call
Setting W/O ID > [u]

@) Enter Security Code => (u]

€) Unknown, Payphone or
User Unset - (u]

() Reject > (m]

HTo Receive Incoming Calls
=> Accept => (B] => Select Ring
Tone or Select Calling Disp. => (m]
=> Select type = (] => Select a
folder => (@] => Select a ringtone
or image => (m]

Rejecting Calls from Numbers
Not Saved in Phone Book
@ => settings > (w] =

Security > (8] => Reject
Unknown > (u)

@Enter Security Code = [m]

€)Reject = (u]
HTo Receive Incoming Calls
=> Accept = (m]

Note
* This procedure is unavailable when Set

Mute Seconds under Ring Time (sec.) is
set to ON (P. 4-7).

Delaying Ringtone for Numbers
Not Saved in Phone Book

Delay ringtone, for calls from numbers
not saved in Phone Book. It can
prevent you from accidentally
returning calls to nuisance calls from
Received Calls; as missed calls with very
short ring times are not saved in
Received Calls, when Missed Calls
Display is set to Not Display.
@ This procedure is unavailable when
Reject Unknown is set to Reject.

@ = settings - (w] =
Incoming Call = (8] =
Ring Time (sec.) => (8]

@Set Mute Seconds = (&) =
ON => (®] = Enter time
before ringtone plays

HlTo Set Zero Seconds
=> OFF => (m]

€) missed Calls Display > (8]
=> Display or Not Display
= (m]

Tip

« Secret Phone Book entries are also
treated as not saved in Phone Book.

* You need not to specify a time when
OFF is selected.

IEmission OFF Mode

The following are prohibited in
Emission OFF Mode:

+ Incoming/Outgoing Calls

+ Incoming/Outgoing Messages

- Yahoo! Keitai Access

@Y = settings > (m) =

Security = 8] = Emission
%—'F Mode => (8] => YES =

Repeat procedure to cancel
Emission OFF Mode.
Tip
+ Emergency numbers (110, 119 and
118) are available even in Emission OFF
Mode.

Aundag P
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Secret Mode & Secret
Data Only Mode

Activate Secret Mode/Secret Data Only
Mode to view secret Phone Book
entries, secret Schedule events and
secret files.

Secret Mode: View all data and secret
data.

Secret Data Only Mode: Only secret
data is available for Phone Book and
Schedule, although all data and secret
data can be viewed for images, mail,
and bookmarks.

Activating Secret Mode
& Secret Data Only Mode

@ => settings > (w] =
Security => (8] = Secret
Mode or Secret Data Only
Mode => (u]

@) Enter Security Code => (u]

Canceling Secret Mode &
Secret Data Only Mode

@ n standby, (=)
IHiding Handset Data

Files stored in Secret Folders are
accessible only when Secret Mode or
Secret Data Only Mode is activated.

@ The following data can be stored in
Secret Folders: Images, videos, received
and sent messages, and bookmarks of
Yahoo! Keitai and PC Browser.

@ Data saved on memory card or USIM

Card cannot be stored in Secret Folders.

@ Each Secret Folder of Data Folder has a
fixed storage capacity as follows:
+ My Picture: Approx. 2 MB
- Videos: Approx. 10 MB

Storing Data in Secret
Folders

@) set handset to Secret Mode
or Secret Data Only Mode

@In a data list window =>
Select a data item = (@) =
Keep in Secret > (u]

Returning Data in Secret
Folders to Ordinary Data

@) set handset to Secret Mode
or Secret Data Only Mode

@)n a data folder list window
=> Secret > (8]

€)select a data item = (@) =
Put Out = (u]

() select a destination folder
= [m]
Tip
« Functions available with Secret Folder
data are limited.
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.:‘ Overview

Handset supports S! Mail and SMS.

Send S! Mail messages to phone e Avaiilable Mail Services
numbers and e-mail addresses. ~ ~
Exchange short text messages with other
7 SMS SoftBank handsets.

" — o )
"‘ s N
“ SoftBank .. Exchange long text messages with S! Mail
Handsets S! Mail compatible SoftBank handsets and other

< il (Separate ©-Mail compatible mobile phones and
“ contract PCs. Images and melodies can also be

»° w required) attached to S! Mail.
o
=
ok 3 e p - Customize Handset E-mail Address.
w
% - Effective for blocking spam.
L4
4 Non-SoftBank ST RTERTE
Mobile Phones [ LT

Use HTML mail to change font size/color, background,
etc.

L J
L4
L/
Server A D " : :
— Emotion-Expressing Mail

@ |f recipient’s handset is turned off or ; :
out of range, sent message is stored Based on sender’s message, handset shows a pictogram

on the server up to 30 days until the matching the sender’s mood.
recipient’s handset becomes available. PCs \_ )

L4
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ISending S! Mail
@rPress and hold

5 New Mai |
[ To |

LOM<No_Address>
Siblect]

5 KNo message

Composition Window

@Select address field = (&) =
Enter Address - (u] =
Enter address = (8]

BAdding Recipients
=> Select address field => (@] =>
Select address field => (m] => Enter
Address => (8] = Enter address =>
(w] =

@Select Subject field = (@] =
Enter subject => [m]

If [4] (double-byte mode) appears,

switch to single-byte mode
(P. 2-31).

Tip
» Add up to 20 recipients total between
To, Cc and Bcc fields.

() select text field => (w] =
Enter text = (m)

, Message
Hello, long time no see!
How about having a meal
gsether again sometime?

|Add Art

BECR
[&Sel. Area  [EliPaste
2y Pictograns
5 BESH R 30644

Text Entry Window

(5]E)

Ml To Cancel Transmission
=>When Start Packet Connection
appears = (®]; or
=> During Transmission =>
BIf Resend mail? Appears
=> YES => (m]

Attaching Files
Attach the following files to S! Mail:

+ Images + Videos

- Melodies - Music (Songs)

- Books - Widget

- Phone Book entries - Account Details
- Schedule - To Do List

- Bookmarks

@ For information about image, video,
melody and music files, see P. 12-2.

0[Composition] window =
= Attach File => (w]

@) select a file type = (1]
(= Enter Security Code =
(@) => Select a file = (=]
HImages with Large File Size
—> Attach Mail, QVGA Scale down
or VGA Scale down => (a]
B Attach Additional Files
=> Repeat steps 1 and 2 above
HOpen an Attached File
=> Select an attached file => (]

.:‘ Sending Messages

|!ewP



.:‘ Sending Messages

ol

Note

» Copy protected files cannot be sent as
attachments or output to external
devices.

Graphic Mail

Create html messages to change font
color/size and background color. Add
scrolling text, paste images, etc.

<Example> Change font size,
background color, insert an
image and set flashing text.

0[Text Entry] window =
= /A = (m] = Select a font
size => () = Enter text = (®]

@) - =@ =Kitoselecta
background color => [m]

HTo Toggle Color Palettes
=>In Background color window =>

Toggle between 25-color and 256-
color palettes.

© = [m]) => Select a folder
=> (] => Select an image =

(w]

Hinserting Images with Large File Size
=> Insert Mail or SubQCIF Scale
down => (m]

O Al @ e e o> (@)
Enter text => (®] (twice) =

A > (W) > e o> (@)
0@ ~®

Adding Addresses to
Blog/Mail Member List

Group addresses into Blog/Mail

Member list to upload blog images

and send messages by group.

@ Set one Blog/Mail Member as a blog
upload destination.

@ = own Data > (u] =
Blog/Mail Member > (s

B Blog/Mail Member 1/2
LUBlog/Mail Member1 |
@Bl og/Mail Member2
BBl og/Mai | Member3

Bl og/Mai | Memberd
51Bl og/Mai | MemberS
6181 0g/Mai | Member6

Blog/Mail Member List

HTo Specify as Blog Upload
Destination
=> Select Blog/Mail Member =>
Blog/Mail Member “ % “ specified
as upload destination appears.

HTo Cancel Blog Upload Destination
=> Select Blog/Mail Member with
B



@Select a Blog/Mail Member
list = (=]

B Blog/Mai| Member1 1/2

LUIXXXX@softbank.ne_jp
@<Not Stored>

B<Not Stored>
Blog/Mail Member Window

@<Not Stored> => 2] => Enter

address = (m]
HTo Save an Address from Phone

Book or Sent/Received Address List
=> <Not Stored> = (@) = Look-
up Address => (8] =>> Phone Book,
Sent Address or Received Address
=> (@) => Select an address =>
() (twice)

ISending SMS Messages

Send short text messages to SoftBank
handsets, specifying phone numbers as
address.

@ =& = compose sMs - (u]

i New SMS
[To_<No Address>

SMS Composition Window

@) =1 = (m) > Enter Address
= (m] = Enter phone
number => (1]

€) = = () = Enter text = (u]

o=

.:‘ Sending Messages

0 More Features
K Advanced

Composing Messages

® Enter Address from Phone Book

@ Enter Address from Sent/Received

Address List

Specify Blog/Mail Member List

Recipients

Set To, Cc or Bcc

Delete an Address

Insert Header/Signature

Enter My Pictograms

Delete Text

Change SMS Message to S! Mail
(» P. 5-16)

|!ewP

Sending Messages

@ Set Priority (S! Mail)

® Server Storage Period (SMS)

® Check Delivery

® Save a Message to Draft without
Transmitting It

® Delete a Message without Transmitting
It

(> P.5-17)
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.:‘ Sending Messages

ol

Attaching Files
@ Shoot an Image/Video to Attach to
S! Mail
® Delete Files Attached to S! Mail
(> P. 5-18)

Blog/Mail Member
e Edit an Address
® Delete Addresses from a Blog/Mail
Member List
e Edit a Blog/Mail Member List Name
® Reset a Blog/Mail Member List Name
(» P. 5-18)

Graphic Mail
@ Apply Effects to Entered Text
e Change Effects
® Cancel Last Applied Effect
® Preview Graphic Mail
@ Cancel All Effects
@ Create Graphic Mail Automatically
@ Save Graphic Mail as a Template
@ Download Templates
@ Create Graphic Mail from a Template
e Edit a Template
e Edit Title of a Template
® Delete Templates
(> P. 5-18)

S! Mail Settings
e Edit Header/Signature
@ Insert Header/Signature Automatically
@ Set to Check Delivery
(> P. 14-21)

SMS Settings
® Set to Check Delivery
® Set Server Storage Period of SMS
Messages
® Set SMS Input Language
(> P. 14-21)



Receiving & Opening Messages

Opening New
Messages

Received Result window opens for new
messages.
By default, complete S! Mail messages
(including attachments) are
automatically retrieved. Transmission
fees apply, depending on your
subscription plan. While traveling
abroad, message retrieval may incur
high transmission fees.
@ Emotion-Expressing Mail
When an S! Mail is received, a
pictogram matching the message
content appears.
If a message contains a specific
keyword, a corresponding indicator
appears (P. 14-22).

&= Received Result

COMPLETED

“Mail

Indicator

Received Result Window

@ Indicators

“[S’ Urgent @) Advice

@ Lo &, Try Hard

g Hate Q\-"ﬁ Invitation

%l]% Happy ? Feedback

ﬁ Angry m Request
Sad & Announcement

[ E

@ Fun @'l OK

!! Surprise .@. Reply

? Question \E,u Information

— appears if message content does not
match any of the above moods or
information.

o[Received Result] window =>
Mail = (u)
@) Select a message = (1]
Tip
+ Alternatively open new messages from
desktop notification.

* Indicator may not always correspond to
message content.

Opening Inbox
Messages

@O = Inbox = (u]

Bl =Inbox

Folder List

@) select a folder = (m)

= Inbox 1/2
L 10:05 Ak imaMasani
=@ 8:23 OzawaEisuke
E=92 2/28 NakayamaTaro|
M= 2/28 [E]AkimaMasam
Si=g 2/28 OzawaEisuke
E&@ 2/27 KitagawaRiki
he pasta we ate yesterd
ay was delicious!
earch for a good restau
rant again!
--—-END----

Message List

|!ewF



.:‘ Receiving & Opening Messages

ol

QSelect a message = (m]

_© 12009/ 3/ 1 10:05
| Fron [EsAK ma Masami
|Soblect| 4 Re -

[The pasta we ate yesterd

ay was delicious!

Search for a good restau

rant again!
-—--END----

Message Window

HTo Check Previous/Next Message
= O
Tip
« Use @ or 4 to scroll.

+ Some attachments may require
content keys to open/play the file.

Replying to
Messages

@ [inbox Message List]
window =>Select a message
= (W) =

HEWhen Original Message Has
Multiple Recipients
=> To Sender or To All => (]

@Edit subject/text =

Replying (Quote
Message)

@ [inbox Message List]
window =>Select a message

= (W) =
@Edit subject/text =
Tip
+ Attachments are automatically deleted
from reply messages.

* Quoting text is only available for
S! Mail replies.

IUsing Mail List

Retrieve Mail List and select messages
to download or forward.

@O = server Mail > (m] =>
Mail List => (®] (= YES =

(m)

Mail List
1 15:28 AkimaMasami

15:25 NakayamaTar of
15:23 KitagawaRiki

Mail List

QSeIect a message = (@] =
Message Receive > (8] =>
Receive This > (]

HTo Receive Multiple Messages
=> (@) => Message Receive => [u)
=> Receive Selected => (1] =>
Select messages = (] =>



HTo Receive All Messages
=> (@) => Message Receive = ()
=> Receive All => (u)

Tip

« If download fails while retrieving all
messages, download is canceled.

» When there is only one message,
message opens upon retrieval.

'9 More Features
K Advanced

Receiving Messages
® Manually Retrieve Messages
(> P. 5-20)

Checking Messages
@ Retrieve Complete S! Mail
@ Delete S! Mail from Server
® Read Out Messages
® Check Message Information
(> P. 5-20)

Server Message Operations
e Update Mail List
® Switch Mail List Views
® Check Server Message Information
® Forward a Server Message
@ Delete Server Messages
® Check Server Memory Status
(> P. 5-20)

Incoming Message Alerts

@ Adjust Ringtone Volume

® Set a Ringtone

@ Set Ringing Duration of Incoming
Message Ringtone

Set Vibration

Set lllumination Color

Open New Mail Window by Opening
Handset.

(> P. 14-10)

Incoming Message Settings

® Customize E-mail Address

® Do Not Show Emotion Indicators

® Set Priority When Receiving Messages
during Operation

@ Set Whether to Read Out Received
Messages

@ Set Voice to Read Out Messages

® Set Manual Retrieval of S! Mail only
after Notification

(> P. 14-22)

Reply Settings
® Change Quotation Marks
(> P. 14-23)

.:‘ Receiving & Opening Messages

|!ewP
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Handling Messages

. €)Select a message = (m]
Message Storage Opening Sent & —
Locations Received Messages o209/ 3/ 11349

=I0iNakayamaTaro
. . siecte | |0
Press (2 to open Mail Main Menu. <Example> Open a Sent Message
Sent, received and draft messages are

Hello, long time no see!
How about having a meal
. : @ = = outbox =
saved in the locations below. . @

together again sometime?
N

Outbox
.
_ﬂ [Tinbox ———1 Received messages
2 Outbox £l
g 3 Draft L_Sent messages E@eFolder3 T —
3 4 Tomomato-Mail BOX | Draft messages Message Window
2 5 Compose Message
— 6 Compose SMS F H
; older List .
7 Server Mail HMTo Check Previous/Next Message
8 Retrieve New I::} @
o Tempits @) select a folder = (m)
0 Mail Setting
leu'“ Outbox 1/2 Tlp
1349 Nakayanalaro « When Outbox/Inbox becomes full,
Message Menu 02 OzawaEisuke

2/28 [EKitagawaRiki Trash Box messages and then the
B oldest messages in Outbox/Inbox are

2/2] OzawaEisuke deleted next time a new message is

el ML cnakt ImenoRces sent/received. Unread and protected
together again sometime? messages and Secret Folder messages
are not deleted.

Message List

5-10



Handling Messages

Mail Windows

Message types, statuses, and attached
file types are shown by indicators.

Inbox Outbox

i Outbox |
@ASecret

(W& Inbox
@Folder1
L)

E@Folder
I @aFolder3 S @Fo|der2
[JiiTrash Box 5i@Fo|der3
Inbox Folder Outbox Folder
List List

Message List Windows

=6

8:23 Ozawaéisake

BE 2/27 (pawaEisuke

Inbox Message Outbox
List Message List
Message Windows
O@—— O—0
" 2009/ 2/28 13:10 " 12009/ 3/ 1 13:49
| Fron [fNakayamaTaro =10iNakayamaTar o
swet| DMeeting spot swectHe | |0

Let’s meet at the ticket|  Hello, long time no see!
gate, OK? How about having a meal
I’11 send a video about together again sometime?)
the restaurant ) ----END----

----END----

N

Received Message
Window

127KBytes|

Sent Message
Window

Folder Type

(21 General Folder
Ml Trash Box Folder
M} Secret Folder

Message Status

B4 Unread Received Message

2 Read Received Message

£ Protected Unread Message

# Forwarded Message

“3 Replied Message

=l Message Sent to a Single
Recipient

=l Message Sent to Multiple
Recipients

Message Type/Attached File Type

&d SMS on Handset

[ SMS on USIM Card

] Image Attached/Image Inserted in
Text

H Video Attached

43 Melody Attached

i1 Song Attached

74 Copyright-protected File Attached

2] Phone Book Entry, Schedule Event
or Bookmark Attached

& Widget Attached

& E-comic Attached

= Forwarded Server Message

{2 Other Type of File Attached

&% Multiple Files Attached

The following marks appear on indicators

to inform you:

[ Folder Contains Unread Messages
5 Locked Folder

* Folder with Auto Sort Set

=4 Protected Message

s Delivery failed to Some Recipients or

Some Attachments Deleted

# Delivery Failed/All Attachments
Deleted

o Attachment Deleted

@ High Priority Message

Tip
+ Copyright-protected files cannot be

opened/played unless they are saved in

Data Folder.

- If Delivery Report was received,
appears in (& field of message.

|!ewF
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.:‘ Handling Messages

ISorting Messages Tip » Using Tomomato-
* Only one Inbox folder can be specified Mail
Automatically sort incoming/outgoing for sorting Reply impossible al
messages into folders. gr?f;?)?w‘zsbutbox el s Store e-mail addresses in Tomomato-
o[FoIder List] => Select a specified for sorting Send impossible Mail and check messages with stored
folder = (@] => Auto-sort = messages. addresses by selecting Tomomato-Mail
« Search addresses from Phone Book, BOX.
_ﬂ @ Received Address List, or Sent Address Checki T t
EWhen Auto Sort is Already Set to List in Look-up address. G:‘C Ing fomomato-
= the Folder Mail
o .
= => Select another criterion => Canceling Auto Sort

@) & => Tomomato-Mail BOX

@) Address Sort > (®) > @ IFolder List] > Select a = (m]
Look-up Address, Look-up folder = (@) => Auto-sort => R
- Wl _Folder 01—
Grzup, L::'I; up Men[wgber (m] %=
(= . . SilaFolder 03
or Enter ress @) select a criterion = (@) = oo o1
HTo Sort by Subject Release - (u] B0 idor 06
=> Subject Sort => (8] => Enter mavolder &7
subject = (1] €)Release This - (8] > YES o cer 09
HTo Sort Messages Failed to be = E]

Replied/Sent

<> Reply Impossible or Send HMTo Cancel Multiple Criteria

Tomomato-Mail Folder List

- => Release Selected => (m] => Window
=
Impossible = (8] Select criteria = (W) => [&] => YES
HMTo Sort Addresses Not Stored in = (m) QSeIect a folder

Phone Book

= Unregistered Add. = &) Ml To Cancel All Criteria

=> Release All => (8] => YES => (m]

5-12



Storing Tomomato-Mail

o[Tomomato-MaiI Folder List]
window — Select a folder =>
=> Enter Address => (8]
Enter Address = (u]

M To Store E-Mail Address From
Phone Book or Sent/Received
Address List
=> Select a folder = (&) =>
Phonebook, Sent Address or
Received Address => 8] =>Select a
address = (=]

Canceling Tomomato-

Mail

0[Tomomato-MaiI Folder List]
window =>Select a folder =
= Unregister > (8] =>
YES = (u]

Prohibiting Access to
Messages

Setting Mail Box Lock
@ = mail setting > (u] =

Mail Box Lock —> (®] =
Enter Security Code = (]

@Select a mail box = (m]

Repeat step 2 to specify other
boxes.

(3]E
Setting Folder Lock

O[Folder List] = Select a
folder = (@) = Folder Lock
=> (@) = Enter Security Code
= (@) = YES = (m]

Locked folders are indicated by "s.

Tip

* Repeat the same procedure to cancel
mail box and folder lock.

« Trash Box folder can also be locked.

« Security Code entry is required to view
messages in locked mail boxes and
folders.

Storing Messages in

Secret Folders

Set handset to Secret Mode or Secret

Data Only Mode beforehand (P. 4-8).

@ Unread Messages cannot be stored in
Secret Folders.

O[Message List] window =>
Select a message = (@) =
Keep in Secret > [u]

@) Keep This = (u]

HlTo Store Multiple Messages
=> Keep Selected = (8] =>Select a
message = (m] =>Repeat the same
step to specify other messages =>
=> YES => (u]

HTo Store All Messages in a Folder
=> Keep All = (8] = YES = (m]

.:‘ Handling Messages

|!ewP
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.:‘ Handling Messages

i s |

@®Returning Messages in Secret
Folders to Ordinary Messages

0[Folder List] => Secret = (u]

@) Select a message > (@) =
Put Out = (u)

€) Put Out This = (m] => Select

a folder = (m]

HTo Return Multiple Messages
=> Put Out Selected => (1] =>
Select a folder => (®] => Select a
message = 8] =>Repeat the same
step to specify other messages =>
= YES = (u]

HTo Return All Messages
=> Put Out All => 8] => Select a
folder => (@] => YES => (m]

Saving S! Mail
Attachments

Saving Image, Video, Melody,
Music and Flash® Files

o[Message] window => Select
a file = (@] => Save Data =
(m] = YES = (m]

5-14

@Select a folder = (m]

HTo Set an Image as Wallpaper, etc.

=> YES => (m] => Select an item =>

(w]

Select NO and press (8] when you

do not want to set the image.
HTo Set a Melody as Ringtone, etc.

=> YES => (@) => Select an item =>

(w]

Select NO and press (8] when you

do not want to set the melody.
Saving an Image
Inserted in Text

@) [Message] window = (@) =
Save Insert Image > (u)

@Select animage = (8] =
YES => (m] = Select a folder

= (w)

€) YES = (] = Select an item
= [m]
HWhen You Do Not Want to Set the
Image
=> NO = (]

Saving a Phone Book
Entry

O[Message] window = Select
contact information (a
phone number, etc.) = (1]
(twice) => Phone or USIM =>
(@) = New => (m]

@)Edit each item =
Saving a Schedule Event

O[Message] window => Select
Schedule data => (8] (twice)

Saving a Bookmark

O[Message] window => Select
a link (URL, etc.) = (m]
(twice) => Select a
destination => (8] (=> Select a
folder = (m))

Note

* Mail-attached bookmarks cannot be
saved to microSD.



0 More Features
K Advanced

Managing Messages

Protect a Message

Move Messages to a Different Folder
Drop Messages into Trash Box
Delete Messages

Delete All Read Messages

Delete All Delivery Reports

Delete Attached Files

Copy SMS Messages between Handset
and USIM Card

Delete SMS Messages on USIM Card
Change Message Color

Add a Folder

Edit a Folder Name

Change Order of Folders

Delete a Folder

Check Number of Saved Messages
Check Sent/Received Addresses
Delete All Messages in Tomomato-Mail
Folder

(> P.5-21)
Using Messages
@ Edit a Sent Message

@ Edit & Send a Draft Message
@ Forward a Message

@ Save Sender, Recipient’s E-mail Address
or Phone Number to Phone Book

@ Call a Phone Number in Text

® Send an S! Mail to an E-mail Address in
Text

@ Access the Internet from a URL in Text

@ Save Number/Address in Text to Phone
Book

@ Search for Information by Keyword

@ Switch Subject Field Views

Change Font Size of Text

® Search for Messages in a Folder

® Sort Messages

@ Filter Messages

°

°

Reset Message List View to Default
Switch All Unread Messages to Read
Messages

® Open S! Mail Delivery Report

(> P. 5-24)

Message View Settings & Others
® Set Message List View
@ Play Attached Melodies Automatically
® Set Number of Text Lines to Scroll
® Set Font Size of Text
® Check Mail Settings
® Reset Mail Settings
(> P. 14-23)

.:‘ Handling Messages

|!ewP
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- Advanced Features

ol

Sending Messages

Start Here

[Composition] window .............. P.5-3
[Text Entry] window .P.53
[Blog/Mail Member List] ........... P.5-4

[Blog/Mail Member] window .... P. 5-5
[SMS Composition] window...... P. 5-5

Composing Messages

Enter Address from Phone Book

[Composition] window/ [SMS
Composition] window => =
(@) => Phonebook => (W) => Select
search method => Select an entry
=> (m] => Select an e-mail address
or phone number => (a]

5-16

Enter Address from Sent/Received
Address List

[Composition] window/ [SMS
Composition] window => =
(m] => Sent Address or Received
Address => [®] => Select an e-mail
address/phone number => (1]
(twice)
[E)Alternatively, select and press IO}
to open Sent/Received Address List.

Specify Blog/Mail Member List
Recipients

[Composition] window => =
(@) => Blog/Mail Member => (1) =>
Select a Blog/Mail Member list =>
(]

[Z)All addresses in the selected Blog/Mail
Member list are entered in the address
field.

[E)You must save addresses to a
Blog/Mail Member list in advance.

Set To, Cc or Bcc

[Composition] window => =
(@) => Select an address = (@] =
Change Rcv. Type => (8] => To, Cc
or Bec = (m)

[E)Cc (Carbon copy): S! Mail copies are
sent to other addresses. Addresses in
the Cc field are revealed to the other
recipients.

[Z)Bcc (Blind carbon copy): S! Mail copies
are sent to other addresses. Addresses
in the Bcc field are hidden to the other
recipients.

[EIWhen there is no address in the To
field, the message cannot be sent.

Delete an Address

[Composition] window => =3
(®] = Select an address = (@) =
Delete Receiver => (®] => YES => (u]




Insert Header/Signature

[Composition] window => (@) =>
Add Header or Add Signature =>

(w)

[E)save header/signature in advance.

Enter My Pictograms

[Text Entry] window => Press and

hold [ = Select a pictograph =

(] =>

[E Toggle categories by pressing (&) or
.

[Z] My Pictograms are only available for
S! Mails.

Sending Messages

Set Priority (S! Mail)

[Composition] window => (@] =>
Priority => (@) => High, Normal or
Low => m]

Delete Text

[Composition] window/ [SMS
Composition] window = (@) =>
Erase Message => (] => YES => (m]

Server Storage Period (SMS)

[SMS Composition] window =>

=> SMS Valid. Per. => (8] => Select a

period = (m]

[Z)Specify a period the SMS message is
stored in the server in case it fails to
reach the recipient because the

recipient’s handset is out of range, etc.

EIWhen None is set, the SMS message is
deleted from the server after it is

resent once in a certain period of time.

Check Delivery

[Composition] window/ [SMS

Composition] window = (@] =>

Delivery Report or SMS Report

Req. => (8] => ON or OFF => (]

[EIWhen ON is set, handset receives a
delivery report.

- Advanced Features

Save a Message to Draft without
Transmitting It

[Composition] window/ [SMS

Composition] window => (@) =>

Save = (m]

[EThe message is saved to Draft.
Messages saved in Draft can be edited
and sent at a later time.

Change SMS Message to S! Mail

[SMS Composition] window =>
=> SI Mail Conversion => (®)

Delete a Message without
Transmitting It

[Composition] window/ [SMS
Composition] window = (@) =>
Delete => (m) => YES = (m]

517



- Advanced Features

Attaching Files

Shoot an Image/Video to Attach
to S! Mail

[Composition] window = (@] =>
Activate Camera => (8] => Photo
Mode or Movie Mode => (] =>
Shoot image/video = (]

ol

Delete Files Attached to S! Mail

[Composition] window => Select
an attached file = (@) = Delete

Att. File or Del All Att.Files => (m]
= YES => (m]

Delete Addresses from a Blog/Mail
Member List

[Blog/Mail Member] => Select an
address =
® To Select Delete this
=> Delete this = (@]=> YES => (@]
® To Select Delete all
=> Delete all => [®) = Enter Security
Code = (@) => YES => (]

Blog/Mail Member

Edit an Address

[Blog/Mail Member] window =>
Select an address = (@] => Edit
Address => (8] => Edit address =

(w)

Edit a Blog/Mail Member List
Name

[Blog/Mail Member List] = Select
a Blog/Mail Member list = (@] =>
Edit Member Name => (8] => Edit
name = (&)

Graphic Mail

Apply Effects to Entered Text

[Text Entry] window => =

Qx| => (W) => Select beginning of

characters = (8] => Select end of

characters = (B] => Select effects

menu = (8] => Apply an effects

[EIselect Q| and press [ to select the
entire text.

Reset a Blog/Mail Member List
Name

[Blog/Mail Member List] => Select
a Blog/Mail Member list => (@) =>
Reset Member Name => (] => YES
= (]

Change Effects

[Text Entry] window => =

Qe => (@] => Select beginning of

characters = (8] => Select end of

characters = (B] => Select effects

menu => (8] => Change effects

[EIselect Q| and press (¥ to select the
entire text.
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Cancel Last Applied Effect

[Text Entry] window => =
Huwe| => (m]




Preview Graphic Mail

[Text Entry] window = =
57 = (m) = [a=d or [¥] to close

preview

Cancel All Effects

[Text Entry] window=> (/) =
e = (W) => YES = (] (=> [m])

Save Graphic Mail as a Template

[Text Entry] window => Enter text

= (W) = (@) => Template => (8] =>

Save Template => (8] = YES => (m]

[B)Attached files except images inserted
in text are not included in a template.
Save up to 45 templates including
downloads. Delete saved templates as
needed.

- Advanced Features

Edit a Template

=> Template => (8] = Select a
template => (] = (@] = Edit = (u)
=> Edit text = (8] (twice)=> YES =>

(w]

Create Graphic Mail Automatically

[Text Entry] window => Enter text
= (7] = A => (@] = [¥to
toggle effects => (m]

[EJEmotion of the message is detected
from the entered text, and a set of
effects that matches the emotion is
automatically applied.

Download Templates

=> Template => (8] =
Download Templates = (@] (twice)
=> Follow onscreen instructions

Edit Title of a Template

=> Template => (8] = Select a
template = (@) = Edit Title => (m]
= Edit title = (0]

|!ewP

Create Graphic Mail from a
Template

=> Template => (] => Select a
template = (@] =

Delete Templates

=> Template => (8] = Select a
template => (@) => Delete => (u]
® To Select Delete This
=> Delete This => (8] => YES => (&]
® To Select Delete Selected
=> Delete Selected = (@] => Select
templates => (@) => &) => YES => (m]
® To Select Delete All
=> Delete All => (8] => Enter Security
Code = (@) => YES => (=]
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Receiving/Opening Messages

Start Here

[Message List] ......cccoueeeerreeemreceneenns P.5-7
[Message] window..................... P.5-8
[Mail List] P.5-8

Receiving Messages

Manually Retrieve Messages

=> Retrieve New = (B] =>
Received Result window opens =>
Mail => @] => Select a message =

(m]

[Z)Press ) or press and hold to
cancel message retrieval.

[ZJRetrieve messages that were stored on
the server while handset was off or out

of range.

Checking Messages

Retrieve Complete S! Mail

=> Inbox => (8] => Select a

folder => (@] => Select an S! Mail

notification => (8] =>

EJAn ! Mail notification is deleted
when you retrieve the message text.

[BJuse this procedure when Message
Download under S! Mail Settings is
set to Manual.

Read Out Messages

[Message] window => (@) => Read
Out Message => (m]

[Z3Press (m] to stop reading.

[E3Press (2] to end reading.

Delete S! Mail from Server

=> Inbox => (] => Select a
folder => (m] = Select an S! Mail
notification => (@] = (@) => Delete
=> (@) => Notification, Server Mail
or Notifi./Server => (®] => YES =>

(w)

Check Message Information
[Message List] = (@) => Mail Info
= (]

[E3This procedure is available only in
Inbox Message List window.

Server Message Operations
Update Mail List

[Mail List] = (®) = Mail List => (m)

Switch Mail List Views

[Mail List] = (@) = List Setting =>
(@) = Subject, Name or Address =>

(w)




Check Server Message Information

[Mail List] => Select a message =>
=> Mail Info => (]

Check Server Memory Status

=> Server Mail => (] => Server
Mail Memory => (u]

Forward a Server Message

[Mail List] => Select a message =
=> Forward => (&) => > (m)
=> Enter address =

Delete Server Messages

[Mail List] => Select a message =>
=> Delete = (m)
® To Select Delete This
=> Delete This => (W) => YES => (]
® To Select Delete Selected
=> Delete Selected = (@) => Select
messages = (8] => &) => YES => (m]
® To Select Delete All
=> Delete All => (m] =>Enter Security
Code => (m) => YES => (m]

Managing/Using Messages

Start Here
[Folder List] ........mreeeeermmrrreeneees P.5-10
[Message List] .....ccooceneremmeeeseennens P. 5-10
[Message] window ... ...P.5-10
[Inbox Folder List] .......ccccouveeerurrneee P.5-11
[Inbox Message List] ........cccoceunnee P. 5-11
[Received Message] window ..P. 5-11
[Sent Message] window.......... P. 5-11
[Tomomato-Mail Folder List] window
P.5-12

Managing Messages
Protect a Message

[Message] window = (@) =>
Protect ON/OFF => (m]

E)if a message is protected, this
procedure cancels protection.

- Advanced Features

Move Messages to a Different
Folder

[Message List] => Select a message
=> (@) => Move => (8] => Move This,
Move Selected or Move All => (u]
=> Select a destination folder = (u)
(= Select messages = (8] = (&) =>
YES = (m]

[ZJA message can also be moved to a
different folder from Message
window.

|!ewF

Drop Messages into Trash Box

[Message List] = (®) => Move to
Trash Box => (8] => Select a
message = (8] = &) = YES => (m]
[E)Protected messages and delivery
reports cannot be moved to Trash Box.
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Delete Messages

[Folder List] = (@) => Delete All =>
(@) = Enter Security Code => (®] =>
YES = (m]

[Message List] => Select a message
= (@) = Delete => (u]
® To Select Delete This
=> Delete This = (@] = YES => (=]
® To Select Delete Selected
=> Delete Selected = (@) = Select
messages = (8] => (€] => YES => (m]
® To Select Delete All
=> Delete All => (W) =>Enter Security
Code = (@) => YES => (=]
[ElProtected messages cannot be
deleted.

Delete All Delivery Reports

[Inbox Message List] = (@) =

Delete => (] => Delete All Reports

=> (@) = Enter Security Code => (8]

=> YES => (m]

[E)Protected delivery reports cannot be
deleted.

Delete Attached Files

[Message] window (= Select
attached files) = (@) => Delete Att.
File or Del All Att. Files => (m]=>
YES = E]

Delete SMS Messages on USIM
Card

(e => Tools => (®] => USIM
Operation => W) = Enter Security
Code => (@] => Delete = [m] =>
USIM => (] => SMS => (8] => Inbox
or Outbox => (®] => Select a folder
=> (@) => Select an SMS message =>
(@ = (=& = YES = (&)

Delete All Read Messages

[Inbox Folder List] = (@] => Delete
Read => (&) => YES => [m]

[Inbox Message List] window =>
=> Delete => (@) => Delete Read
= (@] = YES => (m]

[EJProtected messages cannot be
deleted.

522

Copy SMS Messages between
Handset and USIM Card

() => Tools => (m] = USIM
Operation => (8] => Enter Security
Code => (8] => Copy = (] =
Phone—>USIM or USIM—>Phone =>
(m] => SMS => (1] => Inbox or
Outbox => (m] => Select a folder =
(@) => Select an SMS message = (®]
= [@ = YES = (@]

Change Message Color

[Message List] => Select a message

=> Press and hold

[E3Each time you press and hold (%), the
message color toggles as follows: Red
— Blue — Black




Add a Folder

[Folder List] = (@) => Add Folder
=> (@] => Enter folder name => (m]
=> YES => (@] => Address Sort,
Subject Sort, Reply Impossible,
Send Impossible or Unregistered
Add. => (8] => Make auto Sort
settings => &) => YES or NO = [m]
[Elselect NO and press (8] when you do

not want to make Auto Sort settings to
the folder.

Change Order of Folders

[Folder List] => Select a folder =>

=> Sort Folder => (®) => Select a

position => (m]

EJThe order of preinstalled folders
cannot be changed.

Edit a Folder Name

[Folder List] => Select a folder =>

=> Edjt Folder Name => (m] =>

Edit folder name => (®)

EE]Preinstalled folders cannot be
renamed.

Delete a Folder

[Folder List] => Select a folder =>
=> Delete Folder => (] => Enter
Security Code => (] => YES => (m]

[Z3Folders containing protected
messages and preinstalled folders
cannot be deleted.

[E3This procedure also deletes messages
stored in the folder.

[E)Auto Sort settings are also canceled
when you delete a folder with Auto
Sort settings.

Check Number of Saved Messages

[Folder List] / [Message List] =>
=> No. of Messages =>

[ZJThe total number of messages, and
the number of unread and protected
messages in a folder can be checked
from Folder List.

The number of messages in a folder
can be checked from Message List
window.

- Advanced Features

|!ewP

Check Sent/Received Addresses

Press and hold Q] or press and
hold (& => Select an entry => (u]

Delete All Messages in Tomomato-
Mail Folder

[Tomomato-Mail Folder List]
window = Select folder = (@] =>
Del All in Folder => Enter Security
Code => (@] = YES = (u]
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Using Messages

Edit a Sent Message

=> Outbox => [B] => Select a
folder => (@] => Select a sent
message = (&) => Edit address,
subject and text =>

Edit & Send a Draft Message

=> Draft => (8] => Select a
message => (] => Edit address,
subject and text =

Forward a Message

[Received Message] window =>
=> Reply/Forward => (&) =>
Forward => (®] (twice) = Enter
address =>

[EIThe subject and text can also be edited.

EJFiles attached to/inserted in S! Mails
are also forwarded.

Save Sender, Recipient’s E-mail
Address or Phone Number to
Phone Book

[Message] window = (@) =
Address List => Select an e-mail
address/phone number = (@] =>
Save Address = (&) => YES => (m]
=> Phone or USIM => (®] => Select
saving option = (@) (=> Search
Phone Book =>Select an entry =>
(m)) = Edit each item =

[E)select an address to save to Phone
Book when the message has multiple
recipients.

Send an S! Mail to an E-mail
Address in Text

[Message] window => Select an
e-mail address = [B] => Compose

S! Mail = (=)

Access the Internet from a URL in
Text

[Message] window => Select a URL
=> (@) => Yahoo! Keitai or PC Site

Browser => (m]

Call a Phone Number in Text

[Message] window => Select a
phone number => (8] => Voice
Phone or Video Call => (m] => Dial
= (]




Save Number/Address in Text to
Phone Book

[Message] window => Select an
e-mail address/phone number =>
=> Save Address => (®]) =>
Phonebook => (]
® Save to Handset
=> Phone => (] = Select store
method => (] (=> Search Phone Book
=> Select Phone Book = (®]) => Edit
items => (&) (=> YES or NO = (m))
(= Enter entry number => (m])
® To Save to USIM Card
=> USIM => (m] => Select store
method => (] (=> Search Phone Book
=> Select Phone Book = (®]) => Edit
items = (&) (=> Overwrite or Add =>
(m)) (=> YES or NO => (m))

Search for Information by
Keyword

[Message] window => (@) => Quick
Search => (] => Enter keyword =>
(m] => Enter keyword => (@] =>

or => (m] => Select an
item from search results = (&)
2370 select a keyword from previous
entries, select History, press (], select a
keyword, and then press (m).

- Advanced Features

Search for Messages in a Folder

[Message List] = (@) => Search
Mail => (] => Search Sender,
Search Receiver or Search Subject
=> (@] (=> Select a search criterion
=> (m]) = Select an address, enter
address or subject => (1]

[EINarrow down search results by
repeating the search operation.

|!ewP

Switch Subject Field Views

[Message List] => Press and hold
EIwWhen Mail List Disp. is set to 2 Lines,
view toggles in the order Name —

Address.

[E)When Mail List Disp. is set to 1 Line,
or to 1 Line+Body, the view cycles as
follows: Subject = Name — Address

Sort Messages

[Message List] = (@) => Sort => (m)

=> Select a criterion => (®]

[E3This procedure can be combined with
the Filter operation below.

Change Font Size of Text

[Message] window => Press and
hold

Filter Messages

[Message List] = (@) => Filter =>(m]
=> Select a criterion =>

Elthis procedure can be combined with
the Sort operation above.
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Reset Message List View to
Default

[Message List] = (@] => Display All
=> (]

[EIThis procedure returns the message
list view that has been changed by
search, sort or filter operation to its
original view.

ol

Switch All Unread Messages to
Read Messages

[Inbox Message List] = (@) => Read
All => (m) => YES => (m]

Open S! Mail Delivery Report

[Outbox Message] window =>

=> Disp. Report => (]

[E)Only available in Message window of a
sent message with a requested delivery
report.
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- Overview
-

Access the Mobile Internet via Yahoo! Keitai (SoftBank’s mobile portal site). Browse PC websites using PC Site Browser.

3oUIaU| h

EEEEEEE IIIIIIIIII}PC Websites
n

Internet

(P. 6-5)

[

Use PC Site Browser*. ]

i

=== Mobile Internet Sites

IIIIIIIIIIIIIIII} Yahoo! Keitai

Some web contents automatically
connect to different pages incurring
transmission fees.

Information fees may also apply.

(P. 6-3)
[ Press to access. ]
Transmission & Information Fees About Security

Handset supports SSL/TLS (encryption
protocols for Internet transmissions of
important/sensitive information). Root
certificates necessary to use SSL/TLS are
saved on handset by default.

* When a security notice appears,
subscribers must decide for themselves
whether or not to open the page.
Opening secure pages constitutes
agreement to the terms of SSL/TLS
usage.

SOFTBANK MOBILE Corp., VeriSign
Japan K K., Cybertrust Japan Co., Ltd.,
Entrust Japan Co., Ltd., GlobalSign
K.K., RSA Security Japan Ltd. and
Secom Trust Systems Co., Ltd. cannot
be held liable for any damages
associated with the use of SSL/TLS.

* When Warning Messages is set to ON,

an alert appears each time handset
connects to a website using PC Site
Browser.



. 2 Yahoo! Keitai

. Using Access History Entering URLs
Connecting to ]
Yahoo! Keitai @ Pressand hold (] = History ) Press and hold [7) => Enter
= (m] URL = (m)
Y7
o History bl Enter URL
[Yahoo! JAPAN |
MWwww. XXX.co. jp
| s Ewww:xxx:co:jn
| — Slwww . XXX.co. jp
——n Enter URL Window n_
@)<NEW> = (8] =>Enter URL=> 3
O History List (w) = OK = (m] 5
. 0
Web Page @) select a record = (m] Tip o+
. » A confirmation for SSL/TLS
@Select an item => (m] communication appears each time a
Repeat this step until the page you secure page is opened. & appears in
want to view opens. SSL/TLS compatible pages.
« Some pages require user authentication.
@E] to exit the Internet => Select text entry field and enter your user
YES = @ ID or password.
Tip

« Scroll web pages with & or 88 if Scroll
is On for Touch Sensor Setting.



- Yahoo! Keitai
—

O More Features Customize
_ Internet
Sdvanced @ Clear Cache

Yahoo! Keitai ® Delete Cookies

® Switch to PC Site Browser @ Initialize Memory Status of Internet

@ Open Yahoo! Keitai Main Menu @ Set Whether to Send Manufacture
(> P. 6-13) Number

History ® Set Whether to Send Referer

® Save a URL in History to Bookmark ® Enable/Disable Cookies

@ Check a URL in History ® Set Whether to Activate Scripts

@ Delete Records in History ® Check Internet Settings

(> P.6-13) @ Resetinternet Settings

Entering URLs (> P. 14-25)

® Access a Page from an Entered URL
Record
® Access a Page by Editing an Entered URL
Record
@ Send an Entered URL Record by Mail
® Delete Entered URL Records
(> P. 6-13)

3oUIaU| h

Root Certificates
® Check Certificate Details
@ Switch a Certificate between Valid &
Invalid
(> P. 6-14)



IPC Site Browser

View PC websites using PC Site

Browser. Scroll up, down, left, or right

to view entire page.

@ You may not be able to view as you
want depending on the site.

@ Note that transmission fees may be
expensive for pages with large amounts
of data.

@

[Vahoo! JAPAN [EEIED

CHO Wsetect 00N
SMILTT Eom FUNG

PC Site Browser Window

M| Tabs

One for each title/URL appears when
viewing several pages in Multi
Window.

(®|Page Toggle
Appears when viewing several pages.
Toggle pages with [=].

(®|Layout Display
3 Appears when using PC Site
Browswer.

@|New Window

Open link in a new window.

About Page Layout

When using PC Site Browser, two page
layout types are available for each of
PC Screen and Small Screen:

PC Screen: Scroll pages vertically and
horizontally.

Small Screen: Scroll pages vertically.

Pages are laid out to fit Display width.

Connecting to PC
Websites

@ Press and hold 7] => PC Site
Browser > (]

PC Site Browser Menu

PC Site Browser Menu

@) Home => (8] (> YES or NO >
(m]) = Select an item = (m)

Repeat this step until the page you
want to view opens.

g w YxEQO! © ¢
°
)

Web Page

. 2 PC Site Browser
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. a PC Site Browser
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€) (=) to exit the Internet =
YES => (u]
Tip
+ Scroll web pages with & or 8 if Scroll
is On for Touch Sensor Setting.

Using URL History

O[PC Site Browser Menu] =
History > (m]

= History
LSi tel
@Site2
@Site3
HSited
BSite5

History List

@Select arecord = (®](=> YES
or NO = (m))

Entering URLs

0[PC Site Browser Menu] =
Enter URL => (u]

= Enter URL

Enter URL Window

@) <NEW> ->(m] -> Enter URL =>
(@] > OK = (W] (> YES or NO
= (m))

0 More Features
K Advanced

PC Site Browser
@ Switch Page Layout Types
® Open Yahoo! Keitai Main Menu
(> P.6-13)

History
@ Save a URL in History to Bookmark
® Check a URL in History
@ Delete Records in History
(> P.6-13)

Entering URLs

® Access a Page from an Entered URL
Record

® Access a Page by Editing an Entered URL
Record

@ Send an Entered URL Record by Mail

® Delete Entered URL Records

(> P. 6-13)

Internet

® Clear Cache

® Delete Cookies

@ Initialize Memory Status of Internet



- PC Site Browser
-—

@ Set Whether to Send Manufacture
Number

® Set Whether to Send Referer

® Enable/Disable Cookies

@ Set Whether to Activate Scripts

® Check Internet Settings

® Reset Internet Settings
(> P. 14-25)

PC Site Browser
@ Do Not Show Alert When Activating PC
Site Browser & Switching Browsers
(> P. 14-26)

jPUI9U] F



. 2 Page Operations
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INavigating Pages

Scrolling Pages

If a page extends beyond view, use 3
to scroll page.

Viewing Frames

When a page includes multiple frames,
select frames to view.

@) to select a frame
@) (@ => Frame In = (u]

Navigate through the frame as you
would a page.

M To Exit Frames
=> (@) => Frame Out => (&)

Open Linked Page in
Multi Window

Open up to five pages simultaneously.
Press [2] to toggle pages.

o[Web Page] = Select a link

=
The linked page appears in a new
window.
[Vahoo! JAPANEZES
2w YaHOO! © ¢ i
L
.

»

Multi Window
HTo Toggle Page
=

The page toggles each time you
press ().

HTo Close Opened Page
= => YES => (]

Tip

* Use the following procedure to open
pages in Multi Window other than
linked pages.
=> (@) => Window Operation = (u]
=> Open New Window => (m] =>
Bookmark, Enter URL (,Yahoo! Keitai
or Home) => (m] => Specify page to
open => (m]

Jumping to Next or
Previous Page

Once opened pages are stored in a
temporary storage area (cache). Press
(@), select History Back or History
Forward and press (8] to go back to the
previous page or proceed to the next
page, without connecting to the
network as long as the pages are
stored in the cache.
@ Network connection is made when the
cache is full.



Page Operations

Selecting Links and
Other Items

Operate as follows when buttons and
menus appear in web pages.

-Online Registration-

Terns of Use —— @

Name [ ]-—

Area ®
[Kanto T —®

Gender (+)Male Ofemale —1 @

Pursuit SSpo;ts
Reading |__
[CIMusic @
—_—®

@ |Radio Button

Use K and press (] to select only
one item from a range of options. ®
indicates the item is selected.

® | Checkbox

Use K and press (m] to select
multiple items from a range of
options. indicates the item is
selected.

®|Command Button
Select a command button and press
(m] to activate the assigned function.

@ |Link
Select a link and press (®] to access
the linked page.

@ | Text Box

Select a text box and press (®] to
open a text entry window to enter
text.

® | Pull-down Menu

Select a pull-down menu and press
(m] to open a list of options. Use (@)
to select an item and press (m].

Playing Streaming
Music and Video
Play music and videos appearing on a
page as you download (streaming).
@ Downloaded data is not stored.
@ See P. 9-5 for details on using Music
Player.

0[Web Page] => Select music
or video = (®]

(237830

Once downloading starts, Music
Player activates and play starts.

HTo Adjust Volume
= 0

HTo Pause
= (]

Press (] again to continue.

Note

» Packet transmission fees are incurred
during streaming even if you pause
play.

* Note that expensive packet
transmission fees may be incurred.

EVTBESTI] P



- Page Operations
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6 More Features

Page Operations

® Reload Page

® Save Images/Melodies in a Page

@ Save Background Image of a Page

® Send URL of a Page by Mail

@ Call a Phone Number in a Page

@ Send an S! Mail to an E-mail Address in
a Page

® Access Another Page from a URL in a
Page

@ Save a Phone Number/E-mail Address in
a Page to Phone Book

@ Search for Information by Keyword

® Change Font Size of a Page

® Zoom Page In/Out

@ Jump to Top/End of a Page

® Change Character Code of a Page

@ Play Flash® from the Beginning

@ Check Title, URL or Certificate of a Page

® Show Key Guidance

(> P. 6-14)

6-10

Internet

@ Set Scroll Unit/Speed

® Set Whether to Show Images or Play
Melodies

(» P. 14-25)
Yahoo! Keitai
@ Set Font Size
@ Set Flash® Sound On/Off

(> P. 14-26)
PC Site Browser
@ Set Page Layout

(> P. 14-26)



IUsing Bookmarks

Save URLs to Bookmark for quick
access.

Saving URLs to
Bookmark

@) [Web Page] = (@) =
Bookmark => (®) => Add
Bookmark => (®] = YES =

(m]
@Select a folder = (u]

Accessing Pages from
Bookmark

@ Press and hold [v] =
Bookmark = (u)

@  Bookmark Folder

2@®nicrosD

Bookmark Folder List Window

HMFrom PC Site Browser
Press and hold [x] => PC Site
Browser = (8) => Bookmark => (]

@Select a folder = (m]

=2 Bookmark

Lilleather forecast
@Fortune-tel ling
ELETS

EMusic

STime table

Bookmark List Window
€)select a bookmark = (u]

Tip

* To access a bookmarked page from
another page:
=> Bookmark = (m] =
Bookmark List = (®) => Select a
folder = (8] > Select a bookmark =>

(w]

IUsing Saved Pages

Save an open page to Saved Pages to
view the page at a later time without
connecting to the Internet.

@ Only Yahoo! Keitai pages can be saved.

@ Viewable content is page as it was
saved.

Saving a Page

@ web Page] = (@) = Saved
Pages > (8] => Add Saved
Pages —> (8] => YES = (u]

Opening Saved Pages

OPress and hold [¥] => Saved
Pages - (u)

Saved Pages

Weather forecast
Coupon

Saved Pages List Window

. 2 Bookmarks & Saved Pages
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- Bookmarks & Saved Pages
-—

@) select a page > (1]

3oUIaU| h
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Tip
* To open a saved page from another

page:
=> Saved Pages = (8] = Saved
Pages List => (] => Select a page =>

6 More Features

Bookmarks
e Edit a Title
e Edita URL
@ Send a Bookmark by Mail
® Check Number of Bookmarks
@ Create a Folder
@ Edit a Folder Name
® Change Order of Folders
® Move Bookmarks to a Different Folder
@ Delete a Folder
@ Delete Bookmarks
(»P.6-17)

Saved Pages
e Edit a Title
® Protect Saved Pages
® Check Number of Saved Pages
@ Delete Saved Pages
(> P. 6-18)



Connecting to the Internet

Start Here

[Web Page] .....ccccoverennene P. 6-3, P. 6-5
[History List] «e... P. 6-3, P. 6-6
[Enter URL] window ........ P.6-3, P. 6-6

Yahoo! Keitai
Switch to PC Site Browser

[Web Page] = [®) => Switch to PC
=> (m] => YES => (®] (=> YES or NO

=> (m))

Open Yahoo! Keitai Main Menu

[Web Page] => (@) => Yahoo!
Keitai = (m]

PC Site Browser
Switch Page Layout Types

[Web Page] => (@) => Change Disp.

Mode => (m]

[E3The page layout toggles between PC
screen and Small screen.

Open Yahoo! Keitai Main Menu

[Web Page] = (@) = Home = (u]

History
Save a URL in History to Bookmark
[History List] => Select a record =>

=> Add Bookmark => (®) => YES
=> (8] = Select a folder => (u]

Delete Records in History

[History List] => Select a record =>
=> Delete => (m]
® To Select Delete This
=> Delete This = (&) = YES => (m)
® To Select Delete Selected
=> Delete Selected => (m] => Select
records = (@) => (&) => YES = (m]
® To Select Delete All
=> Delete All => (] => Enter Security
Code => (@] => YES => (m]

- Advanced Features

Check a URL in History

[History List] => Select a record =>
=> URL => (m]

Entering URLs

Access a Page from an Entered
URL Record

[Enter URL] window = Select a
record = (] = OK => (m]

EVTBESTI] F

6-13



- Advanced Features

jJouIdjU| h

Access a Page by Editing an
Entered URL Record

[Enter URL] window = Select a
record => (] => Select URL entry
field => (@] => Edit URL = (@] =>
OK = (m]

Send an Entered URL Record by
Mail

[Enter URL] window => Select a

record = (@] => Compose Message

=> (@] => Enter address, subject

and text =

['qﬂComposition (S! Mail) window opens
with the URL inserted in the text.

Delete Entered URL Records

[Enter URL] window => Select a
record => (@] => Delete = (m]
® To Select Delete This
=> Delete This => (@] => YES = (m)
® To Select Delete Selected
=> Delete Selected = () => Select
records = (@] => (&) => YES => (u]
® To Select Delete All
=> Delete All => (] => Enter Security
Code => (m] => YES => (m]

Switch a Certificate between Valid
& Invalid

fe => Settings = (@] =

Connection Settings => (8] =>

Certificate => (W) => Select a

certificate = (@) => Valid/Invalid =>

(]

[E3This procedure switches a valid
certificate to invalid and an invalid one
to valid.

6-14

Root Certificates
Check Certificate Details

fen) => Settings = (] =>
Connection Settings => (8] =>
Certificate => [®) => Select a
certificate = (m)

Page Operations

Start Here
[Web Page] ......ccoeeneeencns P.6-3, P. 6-5

Reload Page

[Web Page] => (@] => Reload => (m]




Save Images/Melodies in a Page

[Web Page] = (®) => Save File =>
(@] = (Select a file) = (@) = Save
=> (@] = YES => (@] (=> YES or NO
= (m))

[E370 play a melody, select Play and press

[EITo check file properties, select
Property and press (m].

Send URL of a Page by Mail

[Web Page] => (®) => Convenient
Tools => [®] => Compose Message
=> (@] => Attach URL => (8] =>
Enter address, subject and text =
EﬂComposition (S! Mail) window opens
with the URL inserted in the text.

Save Background Image of a Page

[Web Page] = (@) => Save File =

(m] (=> Background Image => (m))

=> Save = (@) = YES => (@] (=

YES or NO => (m))

[ETo check file properties, select
Property and press (m].

Call a Phone Number in a Page

[Web Page] => Select a phone
number => (®] => Voice Phone or
TV Call = (8] = Djal => (m)

Save a Phone Number/E-mail
Address in a Page to Phone Book

[Web Page] => Select a phone
number/e-mail address = (@] =
Add to Phone Book => (®) => YES
=> (] => Phone or USIM => (m] =>
New, Add or Overwrite = (&) =>
Edit each item = (&) = (=>
Overwrite or Add => () (=> YES
or NO => (m)) (=> Enter entry
number => (@)

- Advanced Features

Send an S! Mail to an E-mail
Address in a Page

[Web Page] = Select an e-mail
address = [®) => Compose S! Mail

=

Access Another Page from a URL in
a Page

[Web Page] => Select a URL => (m]

Search for Information by Keyword

[Web Page] = (@] => Quick Search

=> (m] => Enter keyword => (m] =>

Enter keyword => (8] => or

= (@] = Select an item

from search results => (m]

[E370 select a keyword from previous
entries, select History, press (), select
a keyword, and then press (m].

EVTBESTI] F
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Change Font Size of a Page

[Web Page] => (®] => Change Font

Size = (m] = Select a font size = (m]

EElonly available when the page layout
type is Small Screen in PC Site
Browser.

Zoom Page In/Out

[Web Page] = (@) => Zoom = (u]

=> Select a magnification => (u]

Elzoom is only available when PC Site
Browser is set to PC Screen.

Change Character Code of a Page

[Web Page] => (®) => Convenient
Tools => [®) => Change CHR Code
=> (m] => Select a character code =

(w)

[Z1Use this procedure when characters of
a page are illegible.

Show Key Guidance

[Web Page] = (@) => Help => (u]
[EIThis procedure is only available when
using PC Site Browser.

Jump to Top/End of a Page

[Web Page] = (@) => Convenient
Tools => (W) => Head of Sentence or
End of Sentence = (m]

Play Flash® from the Beginning

[Web Page] = (®) => Convenient

Tools => (] => Replay => (u]

[ZJOnly available when using Yahoo!
Keitai.

Check Title, URL or Certificate of a
Page

[Web Page] => (@) => Convenient
Tools => (m] => Sjte Info => (®] =>
Title, URL or Certificate = (m]




Bookmarks & Saved Pages
Start Here

[Bookmark Folder List] window

.................................................... P. 6-11
[Bookmark List] window.......... P. 6-11
[Saved Pages List] window...... P. 6-11

Bookmarks
Edit a Title

[Bookmark List] window => Select
a bookmark = (@) => Edit Title =
(@) = Edit title = (m]

Edit a URL

[Bookmark List] window => Select
a bookmark = (@) = Edit URL =
(m) = Edit URL = (m]

Send a Bookmark by Mail

[Bookmark List] window => Select a
bookmark => (@) => Compose
Message or Attach to Mail => [m)
=> Enter address, subject and text =

[E)Compose Message: Composition (S!
Mail) window opens with the URL
inserted at the top of the text.
Attach to Mail: Composition (S! Mail)
window opens with the bookmark file
attached.

Edit a Folder Name

[Bookmark Folder List] window =>
Select a folder => (@) => Edit Folder
Name => (®] = Edit folder name

=> (m]

- Advanced Features

Check Number of Bookmarks

[Bookmark Folder List] window or
[Bookmark List] window = (@) =>
No. of Bookmarks => (m]

[EIThe total number of bookmarks can
be checked from Bookmark Folder List
window; and the number of
bookmarks in a folder can be checked
from Bookmark List window.

Change Order of Folders

[Bookmark Folder List] window =>
Select a folder = (@) => Sort Folder
=> (m] => Select a position => (®]

[EThe order of Preset folders cannot be
changed.

Create a Folder

[Bookmark Folder List] window =>
=> Add Folder => (8] => Enter

folder name => (]

Move Bookmarks to a Different
Folder

[Bookmark List] window => Select
a bookmark = (@] = Move => (u]
=> Move This, Move Selected or
Move All = (®) => Select a
destination folder = (@] (=> Select
bookmarks => (] => [=)) => YES =>

(w)

EVTBESTI] F
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Delete a Folder

[Bookmark Folder List] window =>

Select a folder = (@) => Delete

Folder => (W) => Enter Security

Code => (8] = YES => (a]

EEIThis procedure also deletes all the
bookmarks saved in the folder.

Saved Pages
Edit a Title
[Saved Pages List] window =>

Select a saved page = (@) => Edit
Title => (8] => Edit title = (m]

Delete Bookmarks

m To Delete All Bookmarks
[Bookmark Folder List] window =>
=> Delete All => (8] = Enter
Security Code => (8] => YES => (m]
m To Delete Bookmarks in a Folder
[Bookmark List] window => Select
a bookmark = (@] = Delete => (u]
® To Select Delete This

=> Delete This = (@] => YES => (]
® To Select Delete Selected

=> Delete Selected => (W] = Select

bookmarks = (&) => &) => YES => (=]
® To Select Delete All

=> Delete All => (m] =>Enter Security

Code => (@) => YES => (m]

Protect Saved Pages

[Saved Pages List] window =>

Select a saved page = (@) =>

Protect ON/OFF => (m]

[EJuse this procedure to toggle saved
pages between protected and
unprotected.

Check Number of Saved Pages

[Saved Pages List] window =>
=> No. of Pages => (m]

Delete Saved Pages

[Saved Pages List] window =>
Select a saved page = (@] =
Delete => (m]
® To Select Delete This
=> Delete This => (@] => YES => (u]
® To Select Delete Selected
=> Delete Selected => (8] => Select
saved pages = (8] => &) => YES =>

® To Select Delete All
=> Delete All => (8] => Enter Security
Code => (m) => YES => (m)
[EJProtected Saved Pages cannot be
deleted.

6-18
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Capture still images and record videos with handset camera.

Shoot Still Images/Videos

Wide Range of Image Sizes

Select image size
accordingly. Use small sizes
for S! Mail attachments and
larger sizes for saving high
resolution images (P. 7-13).

Photo Mode Selection

Select a mode suited to the
subject/scene such as
Portrait, Scenery, and Sports
mode (P. 7-13).

i

Various Camera Features

Among features included are
shooting with Auto Timer,
continuous shooting and
shooting framed images

(. 7-10, P. 7-11).

Chance Capture

Record videos even when
recording time is over

(P. 7-8).

Recorded videos are saved only
for the available recording time
from the end of recording.

o* % oS
Send by S! Mail
¢ ¥

]
i

SoftBank
Handsets

'0

”»”

n

Non-SoftBank
Mobile Phones

~
«a

]

PCs

« Still images are saved in JPEG format
and videos in MPEG4 format.

* Clean the lens with soft cloth.
Fingerprints or grime on the lens may
result in blurred images.

» Handset movement during shooting
may cause image blurring when Shake
Correction is OFF. Setting Shake
Correction to Auto is recommended.

« Although Camera is made with high-
precision technology, some pixels may
appear brighter and some darker.

+ Shooting or saving images when
handset is warm may affect image
quality.

* Exposing the lens to direct sunlight for
an extended period may result in
discoloration of photo images.

* Shutter click and Auto Timer tone
sound at a fixed volume even in
Manner Mode.
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IViewfinder Indicators

@ Handset Closed

Photo Viewfinder

®@ O

@®Handset Open

Photo Viewfinder

®O®oOeLeOe B®®

Video Viewfinder

(©)

Focus Frame (Still Images)

A white frame appears for Auto
Focus. Focus Frame is green when
focus is locked, and red if focusing
failed.

Shake Correction
™) Auto Shake Correction

Storage Location (Still Image)

@ Handset Memory Card
Number of Files That can be Saved
(Still Image)

White number: 11 or more

Yellow number: 10 or less

Red number: No memory space

Storage Location (Video)

@ Handset Memory Card
Storage Capacity (Video)

Blue: 500 KB or more

Yellow: Less than 500 KB

Red: No memory space

Camera Mode

% Movie Mode

&3 Chance Capture

(@] Photo Mode

&1 Auto Continuous Shooting
(&5 Manual Continuous Shooting
&, Voice Mode

Panorama Cap. Mode

eJawie) P
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®

Image Size (Still Image/Video)
- Photo Mode

B 3M (1536 X 2048) to
SubQCIF (128 X 96)

- Continuous Shooting

&4 Screen (240 X 427) to
SebQCIF (128 X 96)

- Panorama Cap. Mode
Panorama (2592 X 480 : Fixed)
- Movie Mode

VGA (640 X 480)to
SubQCIF (128 X 96)

- Chance Capture

B QVCA (320 X 240) to
SubQCIF (128 X 96)

®

White Balance'
Auto

2% Fine

& Cloudy

£ Light bulb
£ Fluorescent lamp

Recording Status (Video)
SIBY Recording ready
O®REC Recording

AF Status Display (Still Image)
AF ON

Close-up

AF OFF

AF Guidance (Still Images)
For AF toggle and focus lock

Auto Timer
5 Auto Timer set

Image Quality (Still Image)
Super Fine Normal
Fine

Zoom (16 steps)
2] Minimum to 277 Maximum

Side Key Guide
Shutter

File Size (Video)
Mail attachment?
Up to 2 MB

Long time

Touch Sensor Guide
End Camera

Photo Mode
Auto
Portrait
Scenery
Backlight
Sports Mode

® @ © e 8 o

Recording Type (Video)
[# Normal (Video & Sound)
[Eh Video only h Sound only

Image Quality (Video)
Long time Fine
Normal Super Fine

Brightness

F2 +2t0 %2 -2

1

In Photo Mode or Continuous
Shooting, only selectable when OFF is
selected for Photo Mode.

Only available when Select Size is
QCIF (176 X 144) or SubQCIF (128 X
96).

Shake Correction

Handset is equipped with this function
for preventing shake during still image
or video shooting. Set this function off
when not needed.




Shoot still images with handset.

Capturing Still
Images

@ = = Camera = (1] =
Photo Mode > (u]

@Frame image in Viewfinder => (m]
The shutter clicks once focus locks
and Focus Frame turns green.

HTo Discard the Shot Image and

Return to Viewfinder
= => YES => (m]

Photo Preview
Window

Photo
Viewfinder

(3]0

Tip

« Attach still images to S! Mail or set as
wallpaper. (P. 7-14)

« Still images are stored in My Picture
under Data Folder. See P. 14-32 for
details on changing the storage
location to Memory Card.

« Shutter clicks even if focusing fails and
Focus Frame turns red.

Available Functions

AF Toggle

AF Lock

Zoom (Telescopic)

Zoom (Wide angle)

@@@@@

Key Guidance

IFrom Quick Menu

@ Use Quick Menu to activate Camera
from closed position.

(1]1

Touch Sensor is enabled (On).

DTap .S or 0

HReturning to Standby
=>(] or Press and hold ]

€)@ or M to select =0

27
pe View)

HReturning to Standby
=0

() Display subject to shoot =]

(5]

HTo Take Shot Again
=>@=>YEs >0

- Capturing Still Images



- Capturing Still Images

Keys in Photo Viewfinder
(Landscape View)

Zoom (Telescopic)
Zoom (Wide angle)
End Photo Mode (]

After shooting, press and hold (J to end
without saving the image.

eidwe) h

@ Set Shutter Sound
@ Set Display for Handset Closed Shooting

"9 More Features

K Advanced (> P.14:31)
. . File Storage
Shoo"cmg still Images @ Set Storage Location for Shot Still
@ Switch Camera Modes
Select Image Size Images
° Select Photo Mod ® Save Shot Still Images Automatically
® Select Photo Mode (> P. 14-32)

@ Adjust Brightness
@ Switch Color Modes
@ Check Storage Capacity
® Toggle Auto Focus
® Set Shake Correction
(> P.7-13)

Using Still Images

® Upload Still Image/Video to Blog

@ Send Still Image with Graphic Mail

@ Attach Still Image to Mail and Send

@ Show Mirror Image of Shot Still Image
® Save Mirror Image of Shot Still Image
@ Show Shot Still Image in Standby

(»P.7-13)

Camera Settings
@ Set Image Quality
@ Set White Balance
® Reduce Flicker



- Recording Videos

Record videos with or without sound,

or record sound only.

@ Videos are stored in Videos under Data
Folder. See P. 14-32 for details on
changing the storage location to
Memory Card.

Tip

« Key operation tones may be recorded if
you adjust zoom, etc. while recording a
video.

IFrom Quick Menu

@ Use Quick Menu to activate Video from

IRecording Videos

@ = camera = (8] = Video Preview Window closed position.
Movie Mode => (] _ 0[]
Recording ends. i Touch Sensor is enabled (On). n_
HTo Play the Recording
= [¥] => YES = (m) @Tap’oru Q
HTo Discard the Recording and BMReturning to Standby 2
Return to Viewfinder =>J or Press and hold [J y

= (o) => YES = (m)

@@ @ or M to selectﬁ =0

GARECORD

Video Viewfinder Available Functions v
@) Frame image in Viewfinder >  |290M (Telescopic) o
Zoom (Wide angle) 3]
Recording starts. Help oJ " Video Viewfinder

(Landscape View)



- Recording Videos
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HReturning to Standby

=0

@Display subject to shoot =]
Video shooting begins.

(51

Video shooting ends.

(6] =

HReturning to Standby
= = YES = 0

Keys in Video Viewfinder
(Landscape View)

Zoom(Telescopic)
Zoom(Wideangle)
End Video Mode (]

After shooting, press and hold Jtoend
without saving the image.

Tip

+ Sound from operating keys (e.g.

adjusting zoom) during shooting may
be recorded.

IChance Capture

Continue recording a video until you
shoot the desired scene even when the
available recording time is over.

0[Photo Viewfinder]/[Video
Viewfinder] = (1) = §§ =
(w)

@) Frame image in Viewfinder =

Recording starts.

When the available recording time
is over, the remaining time
indication flashes.

@ (@] (twice)

Note

» When recorded video exceeds available
memory, handset saves the maximum
recordable time from the end of
recording. Initial portion is deleted.

Recording Only
Sound
Record only audio in Movie Mode.
(Voice Mode)
O[Photo Viewfinder]/[Video
Viewfinder] = (1) = & =
(m]

(210

Recording starts.

€) (=] (twice)
Tip
* To activate Voice Mode from Main

Menu:
le) => Camera = (8] = Voice Mode
= (m]



- Recording Videos

i S
IFrom QUICk Menu Recording ends. Customize

Video Settings

@ Use Quick Menu to activate Voice Mode @u o Set Image Quality
from closed position. ® Set File Size
o[] O M Feat ® Set White Balance
ore reatures i
Touch Sensor is enabled (On). ® Reduce Flicker
E Advanced ® Set Shutter Sound
@Tap , or D Shooting Videos ® Set Display for Handset Closed Shooting
HReturning to Standby ® Switch Camera Modes ) (> P.14-31)
=>J or Press and hold ] ® Select Image Size File Storage
@ Select Photo Mode ® Set Storage Location for Shot Videos
@ or ad to select \ =0 e Adjust Brightness ® Save Shot Videos Automatically n_
TR 5 @ Switch Color Modes (>P. 14-32) o
e ® Check Storage Capacity %
@ Change Video Type z
® Set Shake Correction
(> P.7-13)
i i Using Videos
Sound Redcordmg Window @ Upload Still Image/Video to Blog
(Landscape View) ® Send Recorded Video by Mail
BReturning to Standby ® Show Recorded Video in Standby
=0 e Edit Title of Video
@ Playing Videos
@D (»P.7-13)

Recording starts.



- Various Camera Features

. . 0[Photo Viewfinder]/[Video HTo Stop Continuous Shooting
IContlnuous Shootmg Viewfinder] = (1] = ® or In Automatic Mode:

= (=] => NO => (]
. o
Shoqt up to 20 still images = E] In Manual Mode:
continuously.

. . . =
Automatic continuous shooting mode: K
Automatically shoots a set number of WTo Discard Shot Images and

. . Return to Viewfinder
images at set intervals after you
release the shutter. . = YES = [a]

Manual continuous shooting mode: @Press and hold = Save
Shoots a set number of images, each of or Mirror Save = E]
which is shot by releasing the shutter

manually.

@ See P. 14-31 for details on setting
interval/number of shots for
Continuous Shooting.

Tip
« Image size can only be set to Screen,
QVGA V., QCIF, or SubQCIF.

Continuous Shooting
Viewfinder (Manual)

esawed h

@Frame image in Viewfinder =

Eimage 1/ 5

Thumbnail Preview Window

7-10
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Add Frames to IAuto Timer IPanoramic Shooting
Images @ Auto Timer returns to OFF after Create a single panorama shot
O[Photo Viewfinder] = o shooting. autgmatically bY moving_ handset
. ) ) horizontally while shooting.
Select Frame > (8] = Select () [Photo Viewfinder]/[Video g crting handset move up or down
a folder => (m] => Select a Viewfinder] = (@] => Auto during shooting may produce a shot
frame = [E Timer = E] with a reduced height or blurring.
@ A moving subject may be difficult to
@Compose image in the @ON => (@] = Enter time > (& shoot.
frame = [E . . . i @ Shooting may fail with a subject having
gFrame image in Viewfinder a simple pattern or no pattern. n_
= (a) .
Auto Timer starts countdown, and 0 [Photo Viewfinder] = OJ= 9
Camera Indicator flashes red. = (m] 3
About five seconds before 5

shooting, a countdown tone starts
playing and Camera Indicator
flashes rapidly.

HMTo Stop Auto Timer

= (& or [c=w)
OE
@E] Tip

* To shoot manually during Auto Timer
countdown, press (m].
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@Display one end of subject
= (m]

Panorama shooting starts.

Panorama Shooting

Pan left or right as horizontally as
possible so the subject does not
deviate up or down from the
displayed green line. Keep a good
panning speed so that GOOD
appears. If the speed is too fast,
FAST appears and the scene
cannot be captured properly.

3]0

Panorama shooting ends.
Shooting ends automatically if
shooting reaches the maximum
storable capacity.

HTo Take Shot Again
= = YES = (m]

4]0

0 More Features

After Continuous Shooting
@ View Images
@ Save One Frame
® Save Only Selected Images
@ Save as Animation
@ Open an Image as Mirror Image
e Attach to Mail
(> P.7-14)

After Shooting Framed Images
@ Change Frame before Saving Image

(»P. 7-15)

Camera Settings
@ Set Interval for Continuous Shooting
(> P. 14-31)



Shooting Still Images/Videos

Start Here
[Photo Viewfinder] .................... P.7-5
[Video Viewfinder] .........ccoucu.n. P.7-7

Switch Camera Modes

[Photo Viewfinder] / [Video
Viewfinder] => (1] => Select a
Camera Mode = (u)

Select Image Size

[Photo Viewfinder] / [Video
Viewfinder] = => Select an
image size = (u)

Select Photo Mode

[Photo Viewfinder] / [Video
Viewfinder] => (4] => Select a
Photo Mode => (m]

Adjust Brightness

[Photo Viewfinder] / [Video
Viewfinder] => (5] => Select a
brightness level => (m]

Switch Color Modes

[Photo Viewfinder] / [Video
Viewfinder] = (@) => Camera
Settings => (] => Effect => (] =>
Full Color, Sepia or Monochrome

= (m]

- Advanced Features

Set Shake Correction

[Photo Viewfinder] / [Video
Viewfinder] = (@) => Shake
Correction => (] => Auto or OFF =>

(w]

Check Storage Capacity

[Photo Viewfinder] / [Video

Viewfinder] => (@) => Memory Info
= (]

Toggle Auto Focus

[Photo Viewfinder] => (@] =>
AFchange=> (m] => ON, Close-up or
OFF = ]

Change Video Type

[Video Viewfinder] => (@) =>
Movie Type Set => (8] => Normal,
Video or Voice = (m]

Using Still Images/Videos

Start Here
[Photo Preview] window ........... P.7-5
[Video Preview] window............ P.7-7

Upload Still Image/Video to Blog

[Photo Preview] window/ [Video

Preview] window => (& => Blog

Cont. => (] (=> Attach Mail, QVGA

Scale Down or VGA Scale Down =

(@) => Create and send S! Mail

[E)Specify a blog upload destination
beforehand with Blog/Mail Member
(P. 5-4).

713
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Send Still Image with Graphic Mail

[Photo Preview] window = (&) =>
Insert Image => (8] (=> Insert Mail

or SubQCIF Scale Down => (&) =>

Create and send Graphic Mail

Save Mirror Image of Shot Still Image

[Photo Preview] window = (@) =>
Mirror Save => (]

Attach Still Image to Mail and
Send

[Photo Preview] window => (8] =>
Attach Image => () => (Attach
Mail, QVGA Scale Down or VGA
Scale Down) => (8] => Compose and
send S! Mail

Show Shot Still Image in Standby

[Photo Preview] window = (@] =>
Set as Display => (w] => Stand-by
Display => (8] => Select a layout =
(@) => Check preview = (m]

Play Video

(e => Camera => (@) => Videos =>

(@) => Select folder => (®] = Select

data = (=]

[E)See P. 9-5 for details on the Playback
window for videos.

Send Recorded Video by Mail

[Video Preview] window = (&) =>
Compose and send S! Mail

Show Recorded Video in Standby

[Video Preview] window => (@] =>
Set as Stand-by => (]

Show Mirror Image of Shot Still
Image

[Photo Preview)] window = (@] =>
Mirror Display => (u)

Edit Title of Video

[Video Preview] window = (@) =>
Edit Title => (®] = Edit title = (@]

After Continuous Shooting
Start Here

[Thumbnail Preview] window
.................................................... P.7-10

View Images

[Thumbnail Preview] window =>

Select an image =

[EJPress I to switch to the previous/next
image.

Save One Frame

[Thumbnail Preview] window =>
Select image = (&) => (m)




Save Only Selected Images

[Thumbnail Preview] window =>

Select an image => (8] => Repeat

the same step = [¥] => Save or

Mirror Save => (u)

[E)select a checked image and press (m]
to cancel the selection.

Save as Animation

[Thumbnail Preview] window =>
=> Store All&Anime => (8] =>
Save or Mirror Save => (] =>
Select a destination = (]

Open an Image as Mirror Image

[Thumbnail Preview] window =>
=> Mirror Display or Normal

Display => (u]

Attach to Mail

[Thumbnail Preview] window =>
Select an image = (&) (twice) =
Attach Image => (8] (=> Attach
Mail/QVGA Scale Down => (®]) =>
Compose and send S! Mail

After Shooting Framed Images
Start Here

[Framed Image Preview] Window
v PL7-11

Change Frame before Saving
Image

[Photo Preview] window => (@] =>
Change Frame => (8] => Select a
frame => (m]

- Advanced Features
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- About TV

Handset supports One Seg Digital TV for cellular phones and other information  Precautions

terminals. @ Never watch TV while riding a bicycle,
@ One Seg is available only in Japan. Because other countries use different broadcast motorcycle, or driving a car. You may
systems and frequencies, watching One Seg Digital TV is not possible outside of Japan. not hear the sounds around you clearly,
or TV image/sound may distract you
—— O ne Seg 7 N\ creating the risk of accident. Even while
One Seg is a digital TV broadcasting Data Broadcasts Walklndg, paysttentlorj TIO the tfralfﬂ;
service for mobile devices. It uses Enjoy data broadcasts while ?;:m you. be eSpedCIa écarg ula
Y ) y crossings and pedestrian
one segment of the terrestrial digital watching TV. Access crosswalks
band for TV and data broadcasts program-related information and o7V image/sbund may be affected if a call
that you enjOy at hOme, on your even participate in the program or message is received while Watching TV.
handset. (P. 8-8). @ TV information (TV links or data you
entered in Data Broadcast Mode) saved
/ Record Programs on handset cannot be transferred to
_ﬂ Record a program on memory another handset when you change your
card while viewing it and enjoy it handset to another model or when it is
- again at a later time (P. 8-10). repaired. Keep a memo of necessary
< - information.
View and Record Timer @ TV is available when USIM Card is
Book programs you want to inserted and with a valid SoftBank
contract.

view/record. Program Guide can be

used for booking programs @ Handset has a built-in TV Antenna. Change

the orientation of handset, keep it away

Watch TV in (P.8-12) from/close to your body or move to a
Widescreen Quick Info different place to improve signal reception.
Sender and subject information Keep handset open while watching TV.
appears for new message while TV @ sufficiently extend TV Antenna to improve
is active (P. 14-6). signal reception. An inadequate picture may
\ ) be improved by changing antenna direction,
moving handset away from/closer to you, or

changing locations.



@ TV image/sound may deteriorate or
signal reception may become
impossible in the following areas:

- Areas far from signal towers

+ Mountain areas or places beside tall
buildings

+ Intunnels, underground malls or buildings
with a lot of signal obstructions

@ For more information on One Seg services,
visit the following website:

The Association for Promotion of Digital
Broadcasting

From PC: http://www.dpa.or.jp/

From handset: http:/Awvww.dpa.or.jp/1seg/k/
(Japanese)

When You First Activate TV

A confirmation about operations in
Landscape view (widescreen mode)
appears.

Read information then press (m], select
YES, and press (@] If NO is selected,
information no longer appears when
activating TV.

When a Call Arrives
While Using TV

When a call arrives or when the Alarm
or Schedule Alarm is activated while
using TV, TV is interrupted to receive
the call, etc. TV resumes after the
interrupting function ends.

|Tv Antenna

@ Do not use force when changing
antenna direction.

Extend
0Extend until Antenna stops

@Change direction of
Antenna

Retract

OHoId lower part of Antenna
and push in all the way

- About TV
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- About TV

|Tv Windows

Landscape View

b CDRRITHEDTLET S

BOO—=—1—2X
SEDEISHUVRE (T
BOER

(©)

Quick Info

Information about messages received
while watching TV appears in tickers
(P. 14-6).

Channel (Remote Control No.)

(@)

Guidance Display

When opened: Guide for (9] (press
and hold)

When closed: Program guide and
Touch Sensor B guide

Program Title

Subtitles

@ e|e|e®

Appears while Sound Effect is ON (no
setting required)

)

Signal Strength

Strong

t4g Moderate

B3, Weak

#5 Out of Broadcasting Area

Recording Status

@EELC Recording

@MEC Timer Recording Activated
IFESE (Red) Recording Paused
Time Shift Status

IFTEEEE (Green) Pause

@A Normal Speed

@@ 1.3 1.3x Speed

@WFP 2x Speed

TV Effect

Sound Effects OFF
CS5.1ch

XN Auto

| Live | Concert | Drama | Sporis |
EER NI Suitable for
Each Genre

[EA™3 Manner Mode

Supplementary Information
May appear if data broadcast is
updated while in Landscape view.

Image

TV Power Saving
& TV Power Saving Active

Data Broadcast

Receiving Subtitle Information
Subtitles Available

View Mode
% Image Mode
Data Broadcast Mode

Volume




Configure channel settings for your

area and save stations to a channel list.

@ => TV = (8) = Channel
Settings > (8]

@) select Area > (m] > Select
area = (m] = Select
prefecture/city => (8] => YES
= [m]

Stations for the area are saved to a
channel list.

Tip

« If signals from stations of the selected

area are difficult to receive, search for
stations using the Automatic option.

'9 More Features
K Advanced

Channel Settings

@ Save Stations to a Channel List
Automatically

@ Save Stations of a Different Area to a
Channel List

@ Switch Channel Lists

Channel List

@ Change Title of Channel List

@ Delete a Channel List

® Assign Channels to Remote Control
Numbers

@ Delete a Channel

(> P. 8-14)

(> P. 14-27)

Other Settings
® Reset Channel Settings
(> P. 14-30)

- Initial Setup
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Watching TV

@Ok =>TVv=[8=WatchTv E)(=ItoendTV-=>YES=(@  Available Functions

= E] - Follow the same step to end TV
- ] in Portrait view. Eaui? or 1 (=
2pzed Y - Alternatively, press and hold ontinue
toend TV. Adjust =]}
i Volume
Tip
* TV volume is “0” when Manner Mode Mute
is active and no earphone is connected. T
i ; ; oggle Press and hold (8
TV Window Adjust with [=]} Po?‘t?ait and
* Play TV audio from any Bluetooth L
andscape
@Use Keypad to select a compatible audio device (P. 13-5). ’
channel Toggle 5 Press and hold
Press for channel 10, (0] for Windows® | Windows toggle as
_ﬂ channel 11, and for channel follows: Data Broadcast —
12 Image & Data Broadcast —
E' : Image & Subtitles & Data
HTo Change Next/Previous Channel Broadcast

=g

HTo Automatically Search for
Receivable Stations
=> Press and hold [0
Press (&) or to stop station
search.

1 TV viewing will resume in Time Shift
playback.
2 Available in Portrait view.



Time Shift Playback
While Watching

Resume watching TV even after

pausing with playback.

@ Time Shift playback is available when
you have stopped watching One Seg or
you receive a call.

@ Time Shift playback is unavailable when
Time Shift Setup is set to Auto OFF.

@[1v] window = (u]

TV is paused.

@When it is possible to
resume watching TV => (u]
Time Shift playback starts.

HTo Start From Beginning of Stored
Playback Data
= 0]
HTo Change Playback Speed
= O
HTo End Playback
= (m]

Note

+ Up to two minutes of playback data can
be stored. Data is overwritten starting
from the oldest data. If you resume
viewing after pausing for more than
two minutes, viewing starts from the
beginning of stored data (not from
where you paused).

Tip

» Other channels are unavailable while
TV viewing is paused or during Time
Shift playback.

- Watching TV

IFrom Quick Menu

@ Use Quick Menu to activate TV from
closed position.

(1]1

Touch Sensor is enabled (On).

Drap @ Sor 0
HReturning to Standby
=> (] or Press and hold (J

I:l_

s e .@.‘u“
TV Window (Landscape View)
HReturning to Standby
=> Press and hold J = YES = 3



- Watching TV

Keys in TV Window
(Landscape View)

still image [ ]

recording

Starts/Ends Press and hold B3
Video

recording

Adjust Volume

or & (Lower
volume or raise
volume)

Forward
channel
selection

Press and hold @ or
Press and hold

uh

Returning to
Standby

Press and hold (J

Data Broadcasts
(Japanese)

Data broadcasts are available while
watching TV in Portrait view. Access
various kinds of program-related and
other information in Data Broadcast
Mode.

O[TV] window =>

0k C ORI T ET

HOO=a21—2A
‘$®§l3ﬁ LW
RS

Data Broadcast Modendow

Data Broadcast Mode is activated.
Access the Internet from a link to
view pages relating to the current
program.

HReturning to Image Mode
=

Available Functions

Select a Link [({]
Confirm

Selection of a |(m)
Link

Switch Pages |iOf
Previous Page

Toggle Press and hold
Windows Windows toggle as follows:
Data Broadcast — Image &
Data Broadcast — Image &
Subtitles & Data Broadcast
Note

» Viewing data broadcast information
requires no fees. However, accessing
Internet links will incur transmission

fees.

+ Data broadcasts are unavailable in
Landscape view.




IProgram Guide

@ Use Program Guide to set timer to
record/activate programs.
@ Activate TV from Program Guide.

@ = 7V = (8) = Program
Guide > (m]
See Program Guide help for
further operations.
Before first using Program Guide,
configure initial settings and agree
to the terms of use. Follow the
onscreen instructions.

'9 More Features
K Advanced

Watching TV
® Show Program Information
@ Adjust Brightness
@ Switch Main & Sub Audio
@ Switch Audio Channels
@ Show Current Channel List Information
@ Add Current Station to Channel List
® Select a Program
(> P. 8-14)

Data Broadcasts
@ Reload Page Accessed from Data
Broadcast
® Check Certificate for SSL Page
@ Exit Page and Return to Data Broadcast
(> P. 8-15)

TV Link
® Save TV Links
® Access Pages/Information from TV Links
® Show Details of a TV Link
® Show Number of Saved TV Links
® Delete TV Links
(> P. 8-15)

Image & Sound

@ Set Subtitle Display

@ Show/Hide Icons in Landscape View

@ Save Battery by Dimming Backlight

@ Keep Backlight Lighted While Watching
v

@ Set Time Backlight Stays Lit While
Watching TV

® Set Sound Effects

® Set Visual Image Effects

® Set TV to Pause or Continue for Incoming
Calls (Time Shift Playback)

(> P. 14-28)

Data Broadcasts

@ Set Whether to Show Images in Pages
Accessed from Data Broadcasts

@ Enable/Disable Sound Effects of Data
Broadcasts

® Set Whether or Not to Show
Confirmation Window Again

(> P. 14-29)

- Watching TV
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- Recording/Playing Programs

uh

IRecording Programs

TV programs can be recorded on

memory card while you are watching

them.

@ Data broadcasts are not saved with
recording.

O[TV] window => Press and
hold
Recording starts.

HTo Capture a Still Image
=
Captured still images are saved to
TV folder in Data Folder.

(2]C)
Recording ends.
EWhen Memory Becomes Full
Recording ends and the recorded
portion is saved.

8-10

Note

* The channel remains fixed during
recording.

* Recording certain programs is
restricted. If a restriction is activated
while recording a program, recording
automatically ends, and the part that
has been recorded so far is saved.

» When & appears to indicate handset is
out of the broadcasting area, recording
is paused. When the signal strength
recovers to weak or better, recording
automatically resumes.

* Recordings that you make are for
personal use only. Other uses require

the permission of the copyright holder.

IPIaying Programs

@ > Data Folder => (] =>
TV = (m)

@) Video -> (W) <> microSD =
(w]

microSD
5200903011530001
=
=

1200903011533002
1200903011542003

Recorded Program List Window

HlTo View Captured Still Images
=> Image = (W) => Select a folder

= (m]



G)Select a file = (m]

U & COfRIFEELTL

Recorded Program Playback Window

HlTo Stop Playback
=
Tip
« If a program was stopped partway

through, resume playback from that
point. Select YES and press ().

Available Keys during
Program Playback

Pause/Play (m)
Adjust Volume | ()
Mute
Fast Play o

Frame Forward

(O during pause

Skip by 30
Seconds

Press and hold 04

Toggle Sound
Effects

'9 More Features
K Advanced

Recording Programs
® Edit Title of a Recorded Program
® Reset Title of a Recorded Program
@ Switch Views of Recorded Program List
Window
® Check Information on a Recorded
Program
® Check Volume of Recorded Programs
® Delete Recorded Programs
(> P. 8-16)
Playing Programs
® Specify Point to Start Playback

(> P. 8-16)

Recording Programs
@ Continue/End Recording at Low Battery
(» P. 14-29)

- Recording/Playing Programs
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ISetting View Timer

@ => TV = (m]) = Booking
Program List = (m]

IBooking Program List

LD ar
22009/ 3/ 2(Mon) 14:10

ATV x x
ffevVariety show
32009/ 3/ 5(Thu) 16:15)
TV AA
TiéNews

i s |

P @) (@ = New = (u]

= Edit booked Program
/3/115:30 |
Not Stored>
fie<Not Stored>
D1 Time
&ON/01M. before

Booking Program List Window

HClock Alarm Tone

View Timer Setting Window

8-12

E View/Record Timer

€)@ = (8] = Enter Date - (u]
=> Enter date and time => (®)

HlTo Select a Date from Calendar
=> Choose Date => (®] => Select a
date => (] => Enter time => (m]

@Ej => [m] => Select a channel
= (m]

G = (8] > ON, ONISet Time
or OFF => (&) ( => Select a
time > (m))

(6]E

ISetting Record Timer

@Ok = TV = (8] = Timer
Recording List = (u]

ITimer Recording List

I am
2009/ 3/ 2(Mon) 22:00)
2009/ 3/ 2(Mon) 22:35)
BTV X x
TiéSports

Timer Recording List Window

@) (@ = New = (u]

Edit Program

/ 3/ 1 o
o 3/1
eiNot Stored>
fie<Not Stored>

Record Timer Setting Window



€) O = (8] = Enter Date > (u]
=> Enter date and time to
start recording = (m]

() () = (u] = Enter Date > (u]
=> Enter date and time to
end recording = (m]

HTo Select a Date from Calendar
=> Choose Date => (] => Select a
date => (@] = Enter time => (m)

© & = (] => Select a channel
= [m]

(D@ = () = ON or OFF = (u]

@) =) (=> YES or YES (Confirm
Once) => (m))

When the Set Time
Comes

View Timer:

The alarm sounds for about five
minutes, and the start date and time,
channel, program title and animation
appear in Display. Press any key to stop
the alarm tone.

Record Timer:

One minute before the recording start
time, the alarm sounds for about two
seconds. After the start date and time,
end date and time, channel, program
title and animation appear in Display,
TV activates. Then, recording starts at
the set start time.

Note

« Set a timer start date and time that is
more than one minute from the present
time.

'9 More Features
K Advanced

View/Record Timer

@ Select a Timer Alarm Tone

@ Enter Title of Booked Program

@ Set Regular Activation of View or
Record Timer

® Set Timer Alarm Volume

@ Activate TV Directly from Timer Alarm
Notification Window

@ Set Priority at Recording Start Time
When a TV & Music Group Function is
Active

@ Edit View/Record Timer Settings

@ Change Order of Booked Programs

@ Delete Booked Programs

® Check Volume of Recorded Programs

® Check Result of Timer Recording

(> P.8-17)

- View/Record Timer

P
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- Advanced Features

Channel Settings

Save Stations to a Channel List
Automatically

b => TV => (@] => Channel Settings
=> (@] => Automatic => () => YES
=> (m) => YES => (] => Enter title =>

(w]

Watching TV

Start Here
[TV] Window .....cocvveecerceerennens P. 8-6

Show Program Information

[TV] window => (@] => Program
Info => (m)

uh

Save Stations of a Different Area
to a Channel List

(e => TV => (@) => Channel List =
(m] => Not Stored => @) => Channel
Settings => (W] => Select Area => (u]
= Select area = (®] => Select
prefecture/city = (@) => YES => (m]

Adjust Brightness

[TV] window => (@] => Display
Setting => (] => Brightness => (8]
=> Select a level => (®]

Switch Channel Lists

() = TV => (@] => Channel List =
(m) => Select a channel list = (m]

Switch Main & Sub Audio

[TV] window => (@] => Sound => (]
=> Main/Sub Sound => (8] => Select
an audio output option => (]

8-14

Switch Audio Channels

[TV] window = (®) => Sound =>(m]

=> Sound Switch => (®] => Select an

audio channel = (m]

E)Sound Switch is available when there
is more than one audio channel.

Show Current Channel List
Information

[TV] window = (@) => Channel =
(@) => Channel Info => (m]

Add Current Station to Channel
List

[TV] window = (@) => Channel =

(m] => Add Channel => (8] => YES

= (]

[ZJuse Add Channel when you find a
new station by holding down I3,




Select a Program

[TV] window => (@) => Channel =>

(@) => Tune Service = (] => Select

a service (program) = (u]

ElTune Service is available when more
than one service (program) is
broadcast from the same station.

Data Broadcasts
Start Here

[Data Broadcast Mode] window ......P. 8-8

Reload Page Accessed from Data
Broadcast

[Data Broadcast Mode] window
=> (@) = Data Broadcast => (] =>
Re-read => (m]

Check Certificate for SSL Page

[Data Broadcast Mode] window
=> (@) => Data Broadcast => (] =>
Show Certificate = (u)

Exit Page and Return to Data
Broadcast

[Data Broadcast Mode] window
=> (@] => Data Broadcast => (8] =>
Back to Data BC => (m]

TV Link

Start Here
[Data Broadcast Mode] window...P. 8-8

Save TV Links

[Data Broadcast Mode] window
=> Select an item => (] = YES =>

(w)

[Z3Some TV links may have expiration dates.

Access Pages/Information from TV
Links

b = TV = (m] = TV Link = (m]
[EITypes of TV links are indicated by the
following icons:
Memo information
Data broadcast site
Internet content

Show Details of a TV Link

fo) = TV => (@) => TV Link => (=] =>
Select a TV link => (®) => Display
Detail => (]

Show Number of Saved TV Links

fen) => TV = (@] = TV Link = (®] =
(@) = No. of TV Link => (]

- Advanced Features

P
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- Advanced Features

uh

Delete TV Links

(e = TV = (@] = TV Link => (@) =
Select a TV link =
® To Select Delete This
=> Delete This = (@) = YES => (]
® To Select Delete Selected
=> Delete Selected = [®] => Select a
TV link => [®) => Repeat step of
selecting TV link => (=) => (m)
@ To Select Delete All
=> Delete All => (8] => Enter Security
Code = (@] => YES = (m]

Reset Title of a Recorded Program

[Recorded Program List] window
=> Select a program = (@) =>
Initialize Title => () => YES => (m]

Switch Views of Recorded
Program List Window

[Recorded Program List] window
= (@) => Switch List = (8] => Title
or Title + Image => (w]

Recording Programs

Start Here
[Recorded Program List] window.. P. 8-10

Edit Title of a Recorded Program
[Recorded Program List] window

=> Select a program = (@) => Edit
Title => (m) => Edit title => (m]

Check Information on a Recorded
Program

[Recorded Program List] window
=>Select a program = (@) => Show
Info = (m]

Delete Recorded Programs

[Recorded Program List] window
=> Select a program =>
® To Select Delete This
=> Delete This = (@) => YES => (m]
® To Select Delete Selected
=> Delete Selected => [®] => Select a
file = (@) => (@) => Delete => (@) =>
YES = [E]
® To Select Delete All
=> Delete All =>[®) => Enter Security
Code = (@] => YES => (m]

Check Volume of Recorded
Programs

[Recorded Program List] window
= (@) => Check Memory => (8]

8-16

Playing Programs

Start Here

[Recorded Program Playback]
WINdOW .....ovviirriinnnenssscannas P. 8-11

Specify Point to Start Playback

[Recorded Program Playback]
window => (] => (@) => Location =>

(@) = I3 to specify point = (u)




View/Record Timer

Start Here

[Booking Program List] window P. 8-12
[View Timer Setting] window . P. 8-12
[Timer Recording List] window .. P. 8-12
[Record Timer Setting] window . P. 8-12

Select a Timer Alarm Tone

[View Timer Setting] window =>
=> (@] => Select a folder => ()
(= Select a sub folder = (m]) =>

Select an alarm tone = (m]

Enter Title of Booked Program

[View Timer Setting] window or
[Record Timer Setting] window =>
=> (@] => Enter program title =>

(w]

Set Regular Activation of View or
Record Timer

[View Timer Setting] window or

[Record Timer Setting] window =>

=> (] => 1 Time, Daily or Select

Day => (m]

EIwWhen Select Day is specified, select
days of the week and press (=).

Set Timer Alarm Volume

[View Timer Setting] window or
[Record Timer Setting] window =>
& = (@] = (T to adjust volume =>

(w)

Set Priority at Recording Start
Time When a TV & Music Group
Function is Active

[Record Timer Setting] window =>
& => (m] => Recording or
Operation Preferred => ()

EIwhen Recording is set, the function in
operation is interrupted/ended, and
recording starts. When Operation
Preferred is set, a confirmation asking
whether to start recording appears.

- Advanced Features

Activate TV Directly from Timer
Alarm Notification Window

[View Timer Setting] window =>

(= = (] => ON or OFF = (m]

EIwWhen ON is set, press (@] twice and
select YES from Alarm Notification
window to activate TV and watch the
booked program.

Edit View/Record Timer Settings

[Booking Program List] window or
[Timer Recording List] window =>
Select a booked program = (&) =>
Edit each item =>

P

Change Order of Booked Programs

[Booking Program List] window or
[Timer Recording List] window =>
=> Sort => (W] => Select a
criterion = (m]

8-17



- Advanced Features

Delete Booked Programs

[Booking Program List] window or
[Timer Recording List] window =>
Select a program => (®] => Delete =>

® To Select Delete This

=> Delete This => (8] => YES => (u]
® To Select Delete selected

=> Delete selected => (W) => Select

programs => (] => (&) => YES => (m]
® To Select Delete All

=> Delete All => (@] => Enter

Security Code = (@) => YES => (m]
[E)select Delete past to delete old bookings.

uh

Check Volume of Recorded Programs

[Timer Recording List] window =>
=> Memory Info => (8]

Check Result of Timer Recording

b => TV => (m] => Result Timer Rec
=> (@] => Select an entry => (]
[Z3Press (m] to play the recorded program.

818
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-n About Music Player

Use Music Player to play and organize songs on handset. @ Play not possible with insufficient battery charge.
@ Access the Internet to download music. @ Alarm notification, received calls, etc. while playing will pause
@ Videos can also be played with Music Player. play.

@ Some files are unplayable depending on their format.

Play & Organize Songs/Videos on Handset
Save Music

Inbox
N
% Sa, Save downloaded and transferred music from
Handset [Record Videos Memory Card.
“vaey WMA Memory Card
» Save WMA format  Save music moved/copied
music. from handset or

Transfer to

Memory Card [*= == D transferred from PC.

E 1ddy is %8 Jake|d d1snA

Save Videos
Inbox*

Save shot/downloaded videos, and videos

*
L)
)
L)
L)
L)
L)
|

Download
Download and play music/videos (packet transferred from Memory Card.
transmission fees are charged). Camera* Memory Card
glfaryeastlirgglideos as you download. Downloaded Save recorded Save videos moved/copied from
A\ | /4 data is not stored (packet transmission fees are videos. handset or transferred from PC.
Internet |ncurred even while paused). * Saved videos can be edited as well.
Tip

* Be sure to save music files from PC to Memory Card in the following folder.
¥ PRIVATE ¥ MYFOLDER ¥ My Items ¥ Music



IPIayback Windows
Normal Screen Mode
OB irtist

@ —EAeL]

@ —1

@ ®
®

@—‘ |7
| ®

. EE Pafas |
@Q OO®

Full Screen Mode
(For Video Playback)

@ (ONE)

Artist Name <Creator>"

Title

@

Shuffle Mode

3% ON OFF

Playback Image <Video>'

90|00

Playback Status

PEUER  Play MFIEE Pause
WFF  Fast Forward <4#EF Rewind
®pEAW Slow Play @ Fast Play

To Web
Connect to the URL in the song.

Song/file Selection

G)

Sound Effect is on (appears
continuously)

®e ©

Playback Position

i1 indicates the current playback
position. Use 0¥ to move playback
position during pause.

® | Current Track/Total Tracks in

Folder (Current File Number/Total
Files in Folder)

Elapsed Playback Time/Total
Playback Time

Volume

Guide Display?

Press and hold (J to end
Music Player

0 to pause

0 to resume

@ |Equalizer
& OFF
fp Wn Wire) ErERl CUR
woot el [RapMinneeni@ROER
M5 L For each genre of music
o5 s s User settings
Sound Effect
@& OFF
e TR it CSSln
bl S BRI 15mliH] For different
song styles
uHn s offs User settings
@ |Repeat Mode

OFF
@ Repeat One

@ Repeat Al

Descriptions in < > apply to video
playback.

Only appears when handset closed.

- About Music Player
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- About Music Player

b 1ddy is %8 Jake|d d1snA

Using Music Player the
First Time

When initially using this function after
purchasing your handset, a
confirmation window will ask if you
want to normally play in full screen
mode. Select YES or NO and press (8.

IDownIoading Music

@ Check the fees, expiration date, etc. on
the download site.

@O = Music = m) =
Download Music = (a] =
YES = E]

Ml To Search for Songs to Download
=> Search Music => (8] => YES =>

(w)

@) Follow onscreen instructions

Transferring from PC

@ Convert music CD data to WMA format
and store to microSD card using
Windows Media Player.

@ = settings - (w] =
External Connection = (®]
=> USB Mode Setting > (u]
= MTP Mode -> (]

@Connect handset to your PC
with a USB cable
Music can now be transferred by
operation from your PC. See the
Help for “Windows Media Player”
for details.

gTransfer WMA data from your PC
to microSD card

@Once transferred, remove
USB cable from your PC and
handset

Remove from PC according to
method for the OS.

Note

* Not supported for Windows Media
Player 10. Use Windows Meida Player
11.

Tip

« After transferring WMA data, return
USB Mode Setting to
Communication Mode.



IPIaying Music
@ =Y = Music = (w]
@Select a folder = (u]

3] INBOX

"
42

@ @Musico2
@ @Musicos

Song List Window
€)select a song = (w]

NOW

PLAYING

Music Player Playback Window
(Video Player Playback Window)

Tip

+ Use any Bluetooth® compatible audio

device (P. 13-5).

» To play videos downloaded or recorded

with camera:

(e = Data Folder = (@) = Videos

=> (8] => Specify a video to play

Available Keys during
Playback

@®While Handset is Open

Pause/Play (m]

Adjust Volume @

Play from Beginning |0
Play Previous Song or
Video

Select a Song/File or (8]

Set Equalizer 1

Set Sound Effect 2

Set Repeat Mode (3J)*

Set Shuffle Mode (a4~

Access the Internet (5]

Toggle Normal Screen |(9])

and Full Screen

Toggle Jacket Image or
When there
are several
jacket
images.

End Playback

Play Next Song/Video |[O

Rewind Press and
hold i)

Fast Forward Press and
hold (&

Move Playback Position | ¥ during
pause

* The setting toggles each time you press

the key.

- Music Playback
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- Music Playback
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IFrom Quick Menu

@ Use Quick Menu to activate Music
Player from closed position.

(1]1

Touch Sensor is enabled (On).

@Dtap @D Bor 0

HReturning to Standby
EI>E| or Press and hold U

€)B or & to select (2=0

NOW

PLAYING

Music Player Playback Window

HReturning to Standby
=> Press and hold D

Available Keys in
Playback Window

Play/Pause

Adjust Volume

Bor S

Next Track

Press and hold

Play from Start,
Previous Track

Press and hold

End Music
Player

Press and hold J

IUsing Playlists

Use playlists to play songs by genre or

by artist, or gather your favorite songs

and arrange them in your favorite

order.

@ Songs saved on memory card can also
be added to playlists.

Creating a Playlist

@ =Y = Music = (] = Playlist
= (]

7] Playlist
TEAI | Tracks

9EPlaylist3

Playlist List Window
@) (@) => Create Playlist - (u)

€)select a folder = (m] =
Select a song = (m]

Repeat this step to specify other
songs.



- Music Playback

@When all songs are specified = e Edit a Playlist Name
o Enter playlist name = @) (EJV I IARRINND e Add All Music in Memory Card to
HTo Start Playing the Playlist B Advanced Playlist .
= (m) . . @ Copy a Playlist
Playing Music . .
) ) Ivback ® Check Playlist Information 2
Playing a Playlist ® Resume Playbac o Delete Playlists £
® File Property (»P.9-11) a
0[Playlist List] window => ® Repeat _ %
Select a playlist = (m] ® Set Preferred Sound Quality Customize o
@ Set Preferred Sound Effect ; 'S
HTo Play a Playlist from the Specify Play S UP " Playback Window )
Beginning © Speatly Play Start Position ) @ Change Playback Window Mode P
= Select a playlist = ® Use a Different Function While Playing ¢ Change Design of Playback Window w
_ Music @ Set Image Display Size =
n‘ao‘ . Playlistl @ Open Lyrics (> P. 14-33) _°>
B @ Open Jacket Image T
2 ousic2 @ Check Operation Methods -
(> P. 9-10) n_
Playlist Song List Window Organizing Songs
@ Set a Song as Ringtone
HTo Play All Songs ® Search for Songs
=> All Tracks => (8] (twice) @ Change Order of Songs

® Check Volume of Saved Music
@ Delete All Music in WMA Folder
(»P.9-11)

@Select asong = (m]

Playlists

® Add Songs to Playlist

® Change Order of Playlist Songs
@ Cancel Playlist Songs



- S! Appli
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IAbout S! Appli

S! Appli are applications designed for
SoftBank handsets. Download games
and other applications.

@ About Lifestyle-Appli

Handset includes Osaifu-Keitai®-
compatible S! Appli “Lifestyle-Appli”
(P. 11-3). Change Lifestyle-Appli
settings as any other S! Appli.

@ About Network S! Appli

Since network S! Appli require network
(Internet) connection, transmission fees
are incurred. A confirmation may
appear when an application is
connecting to the network. Follow
onscreen instructions.

Tip
« For information on transmission fees,

contact SoftBank Customer Center,
General Information (P. 15-52).

@ About License Information

To check Java™ and JBlend™ license
information:

@ = s! Appli = () =
Information => (m)

Downloading
S! Appli

@ = s! Appli > (u] =
S! Appli List => (1] =
Download S! App => (8] =>
YES = (u]

@) Select an S! Appli =>
(@] (twice)

HTo Activate S! Appli Right Away
=> YES => (8] => Select an S! Appli
= (]

HMTo Activate S! Appli Later
=> NO = (m]

Note

* Check the battery level before
downloading S! Appli. If the battery
level is low, download may fail.

« If you replace USIM Card due to
damage or loss, downloaded S! Appli
are no longer available.

« If you initialize handset when using an
S! Appli moved to Memory Card, the S!
Appli will no longer be usable.

You will need to download it again.

* When using an S! Appli moved to
Memory Card, using the procedures
below will resave the S! Appli to your
handset and the S! Appli in Memory
Card will no longer be usable.

- Download the same S! Appli with no
Memory Card inserted

- Download the same S! Appli with
different Memory Card inserted

Use an S! Appli resaved to handset as it

is in handset, or again move it to

Memory Card.

Tip

* For how to download Lifestyle-Appli,
see P. 11-3.

* See S! Appli's Help menu or the
download site for operational
information.



IActivating S! Appli
@O = s! Appli => (u] =
S! Appli List => [m]
A S| Appli List 1/4

2 @ Download LifeApp

oowriosd|

3 E 7" 994747
"Den ANEN )

5 SIBATL A =
L )

S! Appli List Window

@) Select an application => (1]

HTo End S! Appli
=> (=] => End => (m)

Tip

« S! Appli is paused when a call arrives.

S! Appli resumes when the call ends.

'9 More Features
K Advanced

S! Appli

® Check S! Appli Information

® Check Volume of Saved S! Appli
® Delete an S! Appli

When Running S! Appli

@ Set Sound Volume

® Set Vibration

® Set Backlight

@ Set Blinking of Backlight

@ Allow/Prohibit S! Appli to Connect to
Network

o Allow/Prohibit S! Appli to Write
Personal Information

® Reset Security Settings of S! Appli

(»P.9-13)

(> P. 14-33)
S! Appli Settings
® Reset S! Appli Settings
® Delete All S! Appli

(> P. 14-34)

- S! Appli
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- Advanced Features

Music Player

Start Here

[Music Player Playback] window
...................................................... P. 9-5
[Song List] window .... .P.9-5
[Playlist List] window........ ..P.9-6

[Playlist Song List] window ....... P.9-7

Playing Music

Resume Playback

fe) => Music => (8] => Resume Play
= (m]

b 1ddy is %8 Jake|d d1snA

File Property

[Music Player Playback] window
= (@) => Detail Info => (W) => File
Property => (m]

EJView file information.

9.10

Repeat

[Music Player Playback] window
=> (@] => Action Setting => (8] =
Repeat Setting => (] => All Repeat
or Single Repeat => (m]

Set Preferred Sound Quality

[Music Player Playback] window=>
=> Action Setting => (8] =>
Sound Effect => () => Equalizer =>
(m] => Select user setting 1 to 3=>
=> Set level for each
wavelength=> (1]
® To return sound quality to initial state
=> Select user setting 1to 3 =
(twice)

Set Preferred Sound Effect

[Music Player Playback] window=>
=> Action Setting => (8] =>
Sound Effect => (] => Effect => (m]
=> Select user setting 1 to 3 =
=> Set level for each effect=> (u]
® To set by existing effects
=> Select user setting 1 to 3 = (&) =>
=> Select effect => (m)
® To return sound effect to initial state
=> Select user setting 1 to 3 =>
(twice)

Specify Play Start Position

[Music Player Playback] window=>
=> Play Menu => (] => Position
to Play => (m]=> Specify play start
position with [O=> (m]

Use a Different Function While
Playing Music

[Music Player Playback] window
=> (=) = Switch to BGM => (&] =>
Activate another function




Open Lyrics

[Music Player Playback] window
= (@) => Detail Info => (@) = Lyric

= [(m)

[EJuse 13 to toggle between lyrics.

Open Jacket Image

[Music Player Playback] window=>
=> Detail Info => (] => Jacket
Image = (m)

[Eluse 13 to toggle jacket images.

Organizing Songs

Set a Song as Ringtone

[Song List] window = Select a
song = (@) => Select Ring Tone =>
(m] (=> Specify play start position
with (0§ => [m)) => Select ringtone
item = (m]

Check Volume of Saved Music

[Song List] window => (@) =>
Memory Info => (&]

Check Operation Methods

[Music Player Playback] window=>
= Help => ()

Search for Songs

[Song List] window, [Playlist List]
window or [Playlist Song List]
window = (@) => Search = (&) =>
Title => (W) = Select a search
criterion => @) => Enter condition
= (]
[E)select a song from search results and
press (m] to play it.

Delete All Music in WMA Folder

(e = Music = (@) = WMA = (a)
=> (@) => Delete All => (8] = Enter
Security Code => (8] => YES => (u]

Change Order of Songs

[Song List] window/ [Playlist Song
List] window = (@] => Sort => (m)
=> Select a criterion = (m]

Playlists

Add Songs to Playlist

[Playlist Song List] window => (@] =>

Edit Playlist => (@] => Add Music =>

(m) = Select a folder => (] => Select

songs => (8] = (@) => YES => (m]

[E3The songs you specified are added at
the end of the playlist.

- Advanced Features
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- Advanced Features

Change Order of Playlist Songs

[Playlist Song List] window =>
Select a song => (@) = Edit Playlist
=> (@] => Sort Playlist => (@] =>
Select a position => (m]

Add All Music in Memory Card to
Playlist

[Playlist List] window = (@) =>
Update All Tracks => (m) => YES =>

(w)

Cancel Playlist Songs

[Playlist Song List] window =>
Select a song => (@) => Edit Playlist
=> (@) = Release Settings => (&)
® To Select Release This
=> Release This => (m] => YES => (m]
® To Select Release Selected
=> Release Selected => (@] => Select
songs = (8] => &) => YES => (m]
® To Select Release All
=> Release All => (@] => Enter
Security Code = (] => YES => (m]

b 1ddy is %8 Jake|d d1snA

Copy a Playlist

[Playlist List] window => Select a
playlist = (@) => Copy to Playlist =>

(w]

Check Playlist Information

[Playlist List] window => Select a
playlist = (@) => Playlist Info => (u]

Delete Playlists

[Playlist List] window => Select a
playlist = (@) => Delete Playlist =
(w)
® To Select Delete This

=> Delete This = (@) => YES => (=]
® To Select Delete Selected

=> Delete Selected = (@) => Select

playlists => (@] => &) => YES => ()
® To Select Delete All

=> Delete All => (®] => YES => (m]

Edit a Playlist Name

[Playlist List] window => Select a
playlist = (@) => Edit Playlist Name
=> (m] => Edit playlist name => (]

9.12



- Advanced Features

S! Appli
Start Here
[S! Appli List] window ............... P.9-9

Check S! Appli Information

[S! Appli List] window => Select an
S! Appli = (@) = Properties => (m)

Check Volume of Saved S! Appli

[S! Appli List] window => (@) =>
Memory Info => (m]

Delete an S! Appli

P 1ddy s 18 19feld d1snAl

[S! Appli List] window =>Select an
S! Appli = (@) => Delete = (@] =>
YES => (u]

9.13
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- Mobile Widget
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IOverview

Download widgets to access the latest

information or use various tools.

Access widgets from Standby by

pressing (3.

@ Add up to five widgets per Desktop
page. Select from four Desktop pages.

@ In addition to preinstalled widgets,
download widgets as needed.

@ Screenshots are for illustrative purposes
and may differ in appearance from
actual widgets.

10-2

@®Network Widgets

Some widgets require network
connection. Transmission fees incur
when using such widgets. Follow

onscreen instructions when connecting.

@ Packet transmission fees apply for
downloading widgets.

Tip

+ Contact SoftBank Customer Center,
General Information for details on
transmission fees.

Checking Overview of
Mobile Widget

0@] = Entertainment => (8]
=> Mobile Widget > (8] =>
Information -> (u]

IUsing Mobile Widget

Open Desktop page and use widgets.

0=

Widgets appear.

01 SUN

15:30

M7 —SEMBLTEE | musicjp

Desktop

Note

* Handset may briefly connect to
network after you press (—J. Packet
transmission fees apply.



Mobile Widget

(2]=) Select Desktop Page Downloadin
i | i .
Use pointer to select widgets o[Active Desktop Page] o Widgets g
=> Select a Desktop page =>

@ Download and add to Desktop page.
@ Store up to 100 widgets.

Switch Desktop 0@] => Entertainment —> (u]

TDesktop Wi dget => Mobile Widget = @ =
‘ Widget Contents = (m] =

: 22 ; m
Active Desktop Page Download W’dget = @ %
M Alternatively, in Standby, press () @Select WI(.:Igets to download ;"
to open Active Desktop page. = (m] (twice) 5
A "% " appears next to the selected 3
€) use 3 to select widget = Desktop page. €) Paste on Desktop > (8] = o
O Select a Desktop page => () &
=> Move into position = (8] m_
HTo Activate Immediately
=> Start =>(m]
HTo Check Information
=> Property =>(m]

HlTo Open List
=> Widget Contents —>(m)

HlTo Return to Previous Window
=> Back =>(m)

103



- Mobile Widget

Widget List Icons &
Indicators

% Widget Contents 1/4
ownload Widget

Widget List

@ | Contents Icon

|9 Access Download Widget.

Appears when no icon set to
widgets.

B Uninstalled widgets. Select to
start installation.

b jJusWIUIeIS)UTY

@ |Data Information

B Preinstalled widgets

B Downloaded widgets

B Added to Desktop Page
Sendable by mail

Infrared transmittable
Transferable to Memory Card

G|

Bs2

104

IAdding Widgets

0[@] => Data Folder = (®] =
Widget - (m]

@) select widgets to add =
= Paste on Desktop - (8]
=> Select a Desktop page =
(m) => Move into position =
(w)

Tip

+ Add up to five widgets in each Desktop

page.

0 More Features
K Advanced

Mobile Widget

@ Change Position of widgets

@ Delete from Desktop Page

@ Place widgets in Foreground or
Background

@ Update Display

Mobile Widget Settings

@ Set Whether to Use Mobile Widget

® Check Auto Synchronize Settings

@ Set Whether to Automatically Transmit
When Abroad

@ Delete All widgets from Desktop Page

o Set Whether to Use Cookies

@ Delete Cookies

(> P. 10-9)

(> P. 14-35)



- S! Quick News

. . Checking Updated
IUSIng S! Quick News |, formation ™) More Features
Registered news can be updated 0[5! Quick News List] window EJ Advanced
automatically and checked from . SI Quick News
standb => Select an item = (@] ! .
Y- @ Manually Update List
; WTo Check Next Updated Information @ View Descriptions of Registered News

<Example> Register news on iy @ Delete Registered News/Items

S! Quick News List (> P. 10-9)
0Press and hold ()

;

IR a— S! Quick News

SR 1-AL (87 @ Hide S! Quick News in Standby

@ Set Ticker Speed

@ Set Information to appear in S! Quick
News

@ Hide S! Quick News Images

® Reset S! Quick News Registered
Contents

S! Quick News List Window (> P. 14-36)

@) Add News = (8] => YES =
(m]

@Select an item = (®]

Follow onscreen instructions.

F juswuIeIdjug
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- S! Info Channel
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Using S! Info
Channel
This information service automatically
receives the latest news, weather, and

other information.
@ Transmission fees are incurred.

Subscribing for Service
Subscribe by registering to receive
service.

@ (=Y => Entertainment -> ()
=> S! Info Ch./Weather -

! S! Info Ch./Weather
ew |

S! Info Channel Menu

106

@Register/Cancel > (W) =
YES =>(m]

€)select a contents =>(m)
Continue by following onscreen
directions to subscribe.

Checking Latest
Information

A Desktop Icon notifies you when new
information is received.

@) (m)->Desktop Icons & = (m)
Continue by following onscreen
directions. Web page operation is
the same as for Yahoo! Keitai.

Tip

* To check from a menu:
[S! Info Channel Menu] => What's
New =>(u]

* To check previous information:
[S! Info Channel Menu] => History =>
(@] => Select a date => (@] => Unread
or read backnumbers are indicated
with & or 4.

Weather Indicators

After subscribing, weather indicators
showing current weather appear in
Standby.

@ Weather Indicators

... |Clear
-@: (Daytime) > |Later
<) |Clear (Night) | / |Partial
> |Cloudy Pollen (Low)
4 | Rain Pollen (High)
UV Rays
4 | Thunder =] (Low)
UV Rays
Snow /g] (High)

<Example> Cloudy, partial rain
ey
@ Besides the above, indicators for chance

of rain, typhoon information, seasonal
information, etc. appear.



Checking Weather Report

0[5! Info Channel Menu] =>
Weather Indicator > (m) =
Weather = (u)

"9 More Features
K Advanced

S! Info Channel

@ Receive Previous Unreceivable
Information

@ Store Images/Melodies from Web Pages

® Store Background Images from Web
Pages

® Add Phone Numbers/Mail Addresses
from Web Pages

(» P. 10-10)

Weather Indicators
® Manually Update Weather Information

(» P. 10-10)

S! Info Channel
@ Set Whether to Display Desktop Icon For
New Received Information
@ Set Font Size for Web Pages
@ Set Font Size
(> P. 14-37)

- S! Info Channel

Weather Indicators

@ Set Whether to Automatically Update
Weather Information

@ Set Whether to Display Weather
Indicators in Standby

@ Set Whether to Display Desktop Icon For
New Received Information

(»P. 14-37)

F juswuIeIdjug
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Download e-comics, e-photo albums,
and other CCF file books.

IObtaining Books

Download books from the Internet.

@ Downloaded books are stored in Books in
Data Folder.

@ Some books require you to obtain a
contents key (right to use contents).

@ -> Data Folder > [®] ->
Books > (8] => Download
Books => [m) => YES = (m]
Continue by following onscreen
directions to download.

Tip
+ Downloads from BookSurfing® are also
available.

10-8

IUsing BookSurfing®

View e-comics, e-photo albums, etc.
(CCF file).

@ (=Y => Entertainment -> (u)
=> BookSurfing —>(u)
BookSurfing® is activated.

See the Help for BookSurfing® for
operation.

Tip

+ Alternatively, activate BookSurfing® by

selecting BookSurfing from the
S! Appli list.



Mobile Widget
Start Here
[Active Desktop Page] ............. P. 10-3

Change Position of widgets

[Active Desktop Page] => Point to
target widgets = [®] => Change
Layout => (8] => Move into
position => (m]

Update Display

[Active Desktop Page] => Point to
target widgets = [®] => Renew

Display => (m]

Delete from Desktop Page

[Active Desktop Page] = Point to
target widgets = (@) => Delete
Content => (m] => YES => (u]

Place widgets in Foreground or
Background

[Active Desktop Page] => Point to
target widgets = (®] => To front or
To back = (m]

S! Quick News
Start Here
[S! Quick News List] window... P. 10-5

Manually Update List

[S! Quick News List] window =>
Select an item = (@) => Refresh
This or Refresh All => (] => YES =>

(w)

View Descriptions of Registered
News

[S! Quick News List] window =>
Select an item = (@) => Outline =>

(w]

- Advanced Features

Delete Registered News/Items

[S! Quick News List] window =>
Select an item =
® To Select Delete This
=> Delete This => (] => YES => (&]
® To Select Delete All
=> Delete All => (®] => YES =>
(m] (twice) = Enter Security Code =>
(m) (twice)

F juswuIeIdjug

Automatically Update List

{ew => Entertainment => (®] => SI
Quick News => (8] => Settings =>
(@) => Auto Refresh => (B] => Select
an item => (W) => Select an interval,
ON or OFF => [m] (twice)

10-9
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S! Info Channel
Start Here

[S! Info Channel Menu] window
.P.10-6

Receive Previous Unreceivable
Information

[S! Info Channel Menu] window
=> Get Latest Contents = (] =>
YES = E]

Store Background Images from
Web Pages

[Web Page] => (@] => Save File =>

(m]=> Background Image => (@] =>

Save => (] => YES => (u]

[Z)Select Property and press (m] to check
file information.

Store Images/Melodies from Web
Pages

[Web Page] = (@) => Save File =

(m) => Object => (] => Select a file

=> (W) = Save => (8] => YES => (u]

[E)select Play and press (m] to play
melody file.

[E)select Property and press () to check
file information.

Add Phone Numbers/Mail
Addresses from Web Pages

[Web Page] = (@] => Add to
Phone Book => (®] => YES => (m] =>
Phone or USIM => (&) => New or
Add (overwrite) = (8] = Edit
items =

10-10

Weather Indicators
Start Here

[S! Info Channel Menu] window
.................................................... P. 10-6

Manually Update Weather
Information

[S! Info Channel Menu] window
=> Weather Indicator => (&) =>

Manual Update => (8] => YES => (u]
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Osaifu-Keitai®

IAbout Osaifu-Keitai®

“Qsaifu-Keitai®” is a range of IC Card-
based services used by Osaifu-Keitai®
compatible handsets.

Make purchases using e-money or
e-ticketing. Hold handset up to a

reader/writer to pay for your purchase.

@ Osaifu-Keitai® Terms

Osaifu- |Cellular phone equipped

Keitai® |with “FeliCa” contactless IC
card technology for reading
and writing data by holding
phone up to a reader/writer.

ICCard |AnIC chip embedded in

Osaifu-Keitai®-compatible
handsets.

Lifestyle- |S! Applications to use
Appli Osaifu-Keitai®. Some
applications are preinstalled.

112

Tip

» Data saved in IC Card varies by service
content and usage history.

Procedures to delete IC Card data vary
by Lifestyle-Appli.

Contact Osaifu-Keitai® service
providers for details.

» Softbank is not liable for damage from
accidental loss or alteration of IC Card
data or settings.

+ IC Card data can be misused if your
Osaifu-Keitai® compatible handset is
lost or stolen. Softbank is not liable for
any resulting damages.

Getting Started

= Downloading Lifestyle-Appli =
Download Lifestyle-Appli via
Internet website.
- Lifestyle-Appli is saved to
Data Folder.

v

= Registrations/Settings =

Activate Lifestyle-Appli to complete

registration or customize settings.

- Make deposit into account, check
payment records or balance, etc.

Note

* Keep a copy of service passwords,
customer service contact, etc. in a
separate place.



Osaifu-Keitai®

Downloading Lifestyle-

Appli

@ = Tools => (8] => Osaifu-
Keitai > (] = Lifestyle-
Appli => (8] => Download
LifeApp => (®] => YES = (u]

@) Select a Lifestyle-Appli => (1]

(twice)

HTo Activate Lifestyle-Appli Right
Away
=> YES => (m) => Select a Lifestyle-
Appli = (=]

HTo Activate Lifestyle-Appli Later
=> NO => (m]

Note

* Check the battery level before
downloading Lifestyle-Appli. If the
battery level is low, download may fail.

» If you replace USIM Card due to
damage or loss, downloaded Lifestyle-
Appli are no longer available.

Activating Lifestyle-

Appli

@ = = Tools = (m] = Osaifu-
Keitai = (m] = Lifestyle-
Appli => [m]

~ Lifestyle-Appli 1/2

Lifestyle-Appli List Window

@) Select a Lifestyle-Appli = (1]

HTo End Lifestyle-Appli
= (=) => End => (=]

Note

* Keep a copy of service passwords,
customer service contact, etc. in a
separate place.

Tip

« Lifestyle-Appli is paused when a call
arrives. Lifestyle-Appli resumes when
the call ends.

IUsing Osaifu-Keitai®

Reader/Writer Transactions
@ There is no need to activate a Lifestyle-
Appli during transaction.

@ Make sure battery is adequately charged.

@ Transactions are possible even when
handset power is off or during calls or
Internet transmissions.

@Hold 2) logoupto a
reader/writer => Check scan
result on reader/writer

display

Place this part
over reader/writer

- Hold handset parallel to the
reader/writer. Try moving handset
around if recognition is slow.

P sjool
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Osaifu-Keitai®

Note . . HTo Set Operation of IC Card Lock
» Softbank is not liable for damages from Actlvatlng IC Card after Power Off
accidental loss or alteration of IC Card LOCk => IC Lock(Power-off) => (&) =>
data or settings. Maintain or IC Card Lock ON = (m]
Tip Use this function to restrict access to BWTo Cancel IC Card Lock
« Data may be unreadable if a metal and prevent unauthorized use of => Press and hold in Standby
object, etc. is between 5) logo and Osaifu-Keitai®. => Enter Security Code = (m]
reader/writer. 0@] = Tools = @ o
oois Remote Lock
Osaifu-Keitai => (] = IC

Call from a specified phone to activate
Card Lock Set. @ Call Remote Lock.

@Enter Security Code = (m] @Saving Numbers to Activate

Call Remote Lock
A IC Card Lock Set.

IC Card Lok — @ = Tools = (] =
21C Lock(Power-off) Osaifu-Keitai = E] = Call

Remote Lock => (u]

9 o @Enter Security Code = [m]
IC Card Lock => (8] => ON =>
@ OON = E]
- 8 appears in Standby.
- Alternatively, set IC Card Lock by:
Press and hold (8] in Standby.

IC Card Lock Setting Window

E sjoo1
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Osaifu-Keitai®

M To Cancel Call Remote Lock
=> OFF => (m]

A Call Remote Lock

Not ed>
Not Recorded>

Call Remote Lock Setting Window

@<Not Recorded> => (®] =
Enter Phone Numbers => (®]
HMTo save numbers from Phone
Book, Redial or Received calls
=> (@) => Look-up Address => ()
=>Phone Book, Redial or Received
Calls => [m] => Select a number =>

(w]

HTo save a Payphone number
=> (@) => Payphone => (]

(5]
@ Activating Call Remote Lock

@) using one of the specified
phones, call handset
- Send Caller ID.

@) Hang up after handset
receives the call

€) within three minutes,
repeat @)-@) twice
« After the third Missed Call, IC Card
Lock is set; a message announces IC
Card Lock activation.

Note

« If series is interrupted by another call,
Missed Call count is reset. Start over
from the beginning.

'9 More Features
K Advanced

Osaifu-Keitai®

® Check Lifestyle-Appli Properties

® Check Memory Status

@ Delete a Lifestyle-Appli

@ Edit Call Remote Lock Numbers

@ Delete Call Remote Lock Numbers

(»P. 11-23)

Osaifu-Keitai®
® Set illumination for IC Card
® Delete all Lifestyle-Appli
® Set Whether to Enable Opening from
Browser
(> P. 14-41)

P sjool
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Life History Viewer

View activities in chronological order.

Life History Viewer

Window
RODRIERIERD
O}
O—
Life History Viewer Window
S 4 9
S
0
_A .
®) — sameey Oz=Es f . N | ®
@ ——— 2002/63/60 68

DE/EEI0Y  GEED
2009/63/01 ©2:30

o— EEET—O

116

Time Axis

®|e

Scale of Time Axis

@|lcon

Still image, image: Image thumbnail
Movie: Movie icon

Schedule: Schedule icon

Mail message(send/receive)history:
Mail message (send/receive)icon

®

Date and time

Still image, image, movie:
Shooting, Updating or Saving date
and time

Schedule: Start date and time

Mail message (send/receive) history:
Received/Sent date and time

@ | Data properties

Still image, image, Movie: No image
Schedule: Schedule name

Mail message (send/receive) history:

the receiver for the sent mail

Title

Still image, image, movie: Title
Schedule: Schedule name

Mail message (send/receive) history:
The sender for the received mail, and
the receiver for the sent mail

The sender for the received mail, and

® |Data Type
{2+ Still image, Image data

Video
Schedule
1 Received
&= Sent
Received & sent messages




Life History Viewer

Viewing Data in
Chronological Order

@ = = Tools = (m] = Life
History Viewer => (8]

HTo Reduce/Enlarge Scale of Time
Axis

= (& or (v

@) select a data item = (=]

0] | i
2009/03/01 08:05
o0m |
i REES
Life History Viewer Closeup Window

©
The function corresponding to the
data type is activated and the data
is opened.

0 More Features

Life History Viewer
@ Hide Some Items in Life History Viewer
@ Update Life History Viewer

(»P. 11-23)
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Save future events to Schedule. Set the
alarm to be activated at a specified
time with message and animation
appearing to remind you of the event.
Saved events can be checked from
Schedule window.

IScheduIe Window

® 2009/ 3/ 1(Sun)

Schedule Window

118

Calendar

Blue date: Saturdays

Red date: Sundays, public and other
holidays

__: Today

[J: Events for the morning

W Events for the afternoon

®

Information Panel
Date, day of the week, content type
icon, time, and saved content
+ Content Type Icon

( (or a user icon) Event

# Holiday
+ Event Repetition Icon

[ Daily event

0 Weekly event

M Monthly event

Annual event

Event for over a day

Saving Events to
Schedule

@ = Tools = (=] =>
Schedule = (u]

@) (=) => Schedule -> (u]

B  Edit Schedule

EiNot Recorded> |
@2009/ 3/ 115:30

&
®<Not Recorded>
E<Not Recorded>

Event Edit Window

€)El = (8] => Enter subject =
(m] = Select an icon = (u]

Q)m => (@) = Enter start/end
date and time = (1]



-. Schedule

© & = () => 1 Time, Daily
(), Wweekly (I0), Monthly
(D) or Annually () => (=]
HTo Specify Days of the Week
=> Weekly ([[]) => (m] => Put
checkmarks to days of the week =>
(DO = (m] = Select an alarm
notification option = (m]
HlTo Activate Alarm Prior to Event
=> ON/Set Time => (8] => Enter
time
@) 5 = (@] => Select an alarm
tone type = (8] (=> Select a
folder => (m] => Select an
alarm tone = (m))
Folders are unavailable when
Clock Alarm Tone or OFF is
selected.

@& = () = Enter place = (u]

©) 3 = (] = Enter details =
(@) =

Entered content appears when
alarm sounds or vibrates.

@Alarm Notification Operations
When the set time arrives, alarm sounds
and animation appears (on Display) for
approximately five minutes.

When handset is closed, press Jto stop
the alarm and read out the schedule
sujbect.
When handset is opened, press any key
to stop the alarm.
Press any key again to end notification
message.

Tip

« If the set alarm time arrives during a
call, alarm tone sounds through
earpiece.

« If a call arrives while the alarm is
sounding, the alarm stops.

Adding Holidays

@ [schedule] window = [&) =
Holiday => (m]

@)@ => (8] => Enter year,
month and date = (u]

€)& = (@) => 1 Time or
Annually (i) => (=

()& = (@] => Enter content =>

(5]E]
IChecking Saved Events

@ = Tools > (m] =>
Schedule = (u]

B 2009/ 3/ 1(Sun)
TWTF

> 3 4

B U s 2%
3

[EIWjogging

[Elcleaning

Blgoing out
@ 21:00 dinner

Schedule Window

-
HTo Toggle between Weekly View 8
and Monthly View y
=
@) to select a date with 11\
events =

B 2009/ 3/ 1(Sun)
[ H:glr-glwlu

Event List Window

119



- Schedule

€)select an event = (u] €)select an event = (m)
Y Schedule Repeat this step to specify other 0 More Features
Dg’tﬂe%g%-mg events or vibrates. n Advanced

EALTES! O - YES = (w) Schedule

@ Sort Events by Icon
®To D_el_ete All Events Prior to a ® Check Number of Saved Events
Specified Date ® Edit an Event
. Copy an Event
In [Schedule] window, sel ¢ oy
od [Schedule] 3 do_ dse ect ® Make/Cancel Secret Setting of an Event
Event Details Window ate, [Event.Llst] va OWOr ¢ Delete All Events
[Event Details] window => ® Reset Holidays
Deleting Events @ Search Information by Keyword
(»P.11-24)
@To Delete One Event @Delete = (] = Delete Past
. ustomize
- O[Event List] window = - %C:} Se[IEect an item => (8] Alarm
= =
8 Select an event => S ® Set Priority at Alarm Notification Time
iy . ® Change Alarm Tone
il @Delete => (m] => Delete This g (> P. 14-3)

_m = (m] = YES = (m]

@To Delete Multiple Events
o[Event List] window =

@) Delete > (u] => Delete
selected -> (]

11-10



i\ To Do List

Save tasks to To Do List. Set Alarm to

remind you of deadlines.

ISaving Tasks

@ => Tools => (m] => To Do

List => (m] =
MTo Edit a Saved Task
=> Select a task =

B Edit To Do List

HlTo Cancel a Due Date
=> No Date = (u]

()= = (] = Select a priority
level = (m]

G = (m] = Select a category
= [m]

(DO = (m) = select an alarm
notification option = (m]

@Alarm Notification Operations

When the set time arrives, alarm sounds
and animation appears (on Display) for
approximately five minutes.

When handset is closed, press [J to stop
the alarm and read out the schedule
sujbect.

When handset is opened, press any key
to stop the alarm.

Press any key again to end notification
message.

cdinner |
012009/ 3/ 1(Sun)21:00

HTo Activate Alarm Prior to Due Tip
Time « If the set alarm time arrives during a
=> ON/Set Time => W) => Enter call, alarm tone sounds through
time earpiece.

« If a call arrives while the alarm is

Task Edit Window sounding, the alarm stops.

@) E = (8] => Enter task = (@)

Task appears when alarm time

@)D = () = Select an alarm
tone type = (8] (=> Select a
folder = (m] => Select an

P sjool

arrives.
alarm tone = (®)) =
@El = @ = Enter Date E:> @ Folders are unavailable when
= Enter due date and time Clock Alarm Tone or OFF is
S0 selected.

HMTo Enter Due Date from Calendar
=> Choose Date => (8] => Select a
date on Calendar = (@) = Enter
date/time = (m]

1111
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To Do List

Checking Saved
Tasks

@ => Tools = (8] => To Do
List = [m]

B To Do List:All

=8 jogging
(iaddinne

Task List Window
@) select a task => (u]

Completion Date:
No Date

Task Details Window

Tip
+ Overdue tasks are indicated by red
status icons (e.g. Pial).

1112

IDeIeting Tasks
@To Delete One Task

O[Task List] window => Select
a task =

@Delete => (m) => Delete This
= (@] = YES => (m)

@To Delete Multiple Tasks
O[Task List] window =

@) Delete > (8] -> Delete
selected => (m)

€)select a task => (u]

Repeat this step to specify other
tasks.

O = YES = (u]

0 More Features

To Do List

® Sort Tasks by Category
® Change Order of Tasks
® Set Task Status

® Delete All Tasks

Alarm
@ Set Priority at Alarm Notification Time
® Change Alarm Tone

(» P. 11-25)

(> P. 14-3)



-. Text Memo

Save short notes or messages as text

memos.

@ Saved text memos can be inserted in
Schedule or in messages.

ISaving Text Memos

@ = = Tools = () = Text
Memo = (u]

Text Memo

1ank _you for e

.How are
3 <Not Recorded>
H<Not Recorded>
5<Not Recorded>
6 <Not Recorded>
7<Not Recorded>
B <Not Recorded>
9<Not Recorded>
O'<Not Recorded>

Text Memo List Window

@<Not Recorded> = (9] =
Enter content = (8]

HTo Edit a Saved Text Memo
=> Select a text memo = (&) =>
Edit content = (&)

IDeIeting Text Memos
@To Delete One Text Memo

0[Text Memo List] window =>
Select a text memo =

@) Delete > (8] = Delete This
= (@] = YES => (=]

@To Delete Multiple Text Memos

o[Text Memo List] window =

@) Delete > (m] -> Delete
selected - (m]

€)select a text memo = (|)
Repeat this step to specify other
text memos.

O = YES = (u]

0 More Features
K Advanced

Text Memo
® Save a Text Memo to Schedule
® Sort Text Memos by Category
® Check Text Memo Information
@ Delete All Text Memos
(» P. 11-25)

P sjool
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A Voice Memo

The following two types of voice . . .
memos can be recorded with Voice Recordmg the Other IRecordmg Your Voice
Memo: ’ i
“Voice memo during a call” to record Party ERCLEE 0@] = Tools = E] = Voice
the other party’s voice during a call; OPress and hold (J during a Memo => (u]
and “Voice memo in Standby” to call
record your voice in Standby. A short beep sounds through the 9 YE.S = (8 = Record your
@ Only one entry, either a voice memo earpiece, and recording starts. voice
during a call or a voice memo in When remaining recording time Speak into microphone after short
Standby, can be. saved on handset. reaches five seconds, a short beep beep sounds through earpiece.
When a new voice memo is recorded, sounds. When recording is When remaining recording time
the prey|ously saved entry is finished, two short beeps sound. reaches five seconds, .a sh'ort beep
overwrlt.ten. o WTo Stop Recording Sf)Lfnds. When recording is
@ The available recording time is 20 <> () or Press and hold (] finished, two short beeps sound.
seconds for both types of voice memos. MTo Stop Recording
@ See P. 3-5 and P. 3-18 for playing and > (m)
deleting a recorded voice memo.
Tip

* Recording stops automatically when a
call arrives, alarm goes off or another
function is activated.

E sjoo1
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Calculator

@ = Tools = (m] =>

Calculator => (u]

@Enter numbers with Keypad
= Enter +, —, X or = with
Multi Selector

HTo Calculate Negative Numbers
=> f0] => Enter numbers with
keypad = Enter +, —, X or +
with Multi Selector

(3]0

Result appears.

Available Functions

Enter Number (o) -(=]
+ (Add) E
— (Subtract) o)
X (Multiply) [a]
+ (Divide) ©
= (Equal) (w)
Decimal Point
Cancel Calculation (A€)
Clear Number aea) ([2€7)

Tip

« If the calculation result exceeds 10

digits, .E appears.

P sjool
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ISetting Alarm

@ => Tools = (] => Alarm

= (m)

Alarm List

HMTo View Alarm Entries

E sjoo1

11-16

=> Select an entry => (m]

Snooze Stimes/5min
Auto Power OFF

Alarm Details Window

@Select an alarm =

®Snooze Stimes/5min
®Auto Power OFF

Alarm Setting Window

€) & = (] = Enter title => (W]

Title appear in Alarm message.
()@ = (m) = Enter time = (W)

© @ =>(®) => 1 Time, Daily (@)
or Select Day ([l) => (&)
HTo Specify Days of the Week
=> Select Day ([]) = (w) =>

Put checkmarks to days of the
week =

(D B = (m] = Select an alarm
tone type = (8] (=> Select a
folder => (m] => Select an

alarm tone = (m))

Folders are unavailable when
Clock Alarm Tone or OFF is
selected.

@ = ®) = [T to adjust

volume = (u]

@5 = (m] = ON = (] = Enter
number of activation times
=> Enter time interval

Ml To Cancel Snooze
=> OFF => (] => Enter ringing
duration

€)@ = (=) => ON or OFF = (u]
= (=)



Alarm

@Alarm Activation Operations

When the set time arrives, alarm is
activated and animation appears (on
Display). When the auto power-on
function is set to ON in Alarm Setting
window, handset is automatically
turned on, if it has been off, to activate
the alarm.

Press any key to stop the alarm tone.
When Snooze is set to OFF, press any
key again to cancel the alarm with two
short beeps, and return to the window
before the alarm activation.

When Snooze is set to ON, the alarm
sounds repeatedly in the set time
interval. Press (—] to cancel Snooze
with two short beeps.

Note

+ The alarm and snooze cancellation
beeps do not sound when Keypad
Sound is set to OFF.

» Set the auto power-on function to OFF
in Alarm Setting window and turn off
handset, when you are near high-
precision electronic devices or devices
using weak signals, on an aircraft or in
a hospital where handset use is
prohibited.

« If a call arrives while the alarm is
sounding, the alarm stops.

« If the alarm activation time comes
during a call, Snooze does not work
even if it is set to ON.

ICanceIing Alarm

0[Alarm List] = Select an
alarm =

Each time you press (¥, the alarm
toggles between ON and OFF.
Tip
+ Alarm settings are retained even if the
alarm is canceled.

'9 More Features
K Advanced

Alarm
® Cancel All Alarms
@ Edit Alarm Settings

Alarm
@ Set Priority at Alarm Notification Time
@ Change Alarm Tone

(> P. 11-26)

(> P. 14-3)
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-. Bar Code Reader

JAN codes and QR codes can be HlTo Use Auto Focus
scanned by Bar Code Reader using =
handset camera. M To Scan a QR Code Made of

About JAN & QR Codes Several Data Areas (QR Codes)

IScanning Bar Codes

@ Position handset camera at a distance of
10 cm from the bar code.

E sjoo1

@®JAN Code

A bar code made of vertical lines (bars)
with different widths and spaces in
between, representing numbers.
Handset can scan 8-digit (JAN8) and
13-digit JAN13) bar codes.

O®QR Code

A two-dimensional code representing
alphanumerics, kanji, kana, or
pictographs. Some QR codes are made
up of several data areas that are
scanned as individual QR codes and
then automatically combined as one QR
code.

11-18

@ = Tools => (] => Bar
Code Reader -> (u]

@) Frame the bar code in the
recognition field

Scanning

Bar Code Scanning Window

Scanning starts automatically.

r.,1 , Land- indicate the corners

of the recognition field.
HTo Cancel Scanning
=> (m] => oK => (m]
HlTo Adjust Zoom
=[] (Zoom out) or (¥ (Zoom in)

=> OK => (m] (twice) => Scan a QR
code

Repeat this step to scan other QR
codes.

All component QR codes must be
scanned in order to access or save
scanned data on handset.

€) Check scanned data

HTo Discard Scanned Data
= => YES => (m]

()@ -> store > (m) = YES >
(m] = OK = (m)

Tip

* A JAN code/QR code must be
accurately focused and be enlarged to
fill the recognition field.

* Scanning may take a while.

» Some bar codes may not be scanned
depending on the size, version or print
quality, or due to scratches, stains,
damage or the reflection of light.



Bar Code Reader

IChecking Scanned Data
@) [Bar Code Scanning]

window = => Reading Using Scanned Data

Data List = (] ® Make a Call
® Compose a Message
F; ® Access the Internet
@20090301_1225_0000 ® Save to Phone Book
320090301_0915_0000 o Save a Bookmark
e Copy Text

Scanned Bar Code Data List Window ® Edit Title of Scanned Data

@Select an entry > (u)

B Bar Code Reader

@ Delete Scanned Data
(»P. 11-27)

Scanned Bar Code Data Details Window

P sjool

Tip

+ Characters that are not supported by
Bar Code Reader are replaced with
spaces (blanks).

11-19



-. Text Reader

Use Text Reader to scan printed text.

Scan Modes

Free memo

Scan Japanese or English
text, and save the text to
Text Memo.

(©)

Recognition Frame

Card read

Scan name, phone
number, e-mail address,
postal code, address and
memo printed on
business cards, and save
all scanned data
collectively as a Phone
Book entry.

Text Scanning Window

B Card Read

When not fitting in a Frame
Tn_[«»:Ifem Change ®

- . .
L Akima+Masami
f—

Compose
message

Scan address, subject or
message text, and open
Composition (S! Mail)
window with the
address, subject or
message text entered.

URL

E sjoo1

Scan URL, and access the
page or save the URL to
Bookmark.

Mail address

Scan e-mail address, and
compose an S! Mail to
the address.

Phone
number

Scan phone number,
and make a call to the
number.

11-20
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Text Scanning Window

®

Scan Item Icons
[&] Name

[&] Phone number
[ E-mail address
[ Postal code
[&] Address

B Memo

[To] Address

fut] Subject

[Bl Message text

Recognized Text Field

Recognition Mode

Key Guidance

@ 0| e|e

Negative Mode
Nega appears when NEGA/POSI
Mode is set to Negative Fix.

Remaining Number of Characters
That Can be Scanned




IScanning Text

@ Position handset camera at a distance of

10 cm from the text.

@ => Tools = (®] => Text
Reader -> (]

@) New = (m) => Select a scan
mode = (8]

Text Scanning Window

€) 3 to select a scan item icon

=> Frame text in the
recognition frame
HTo Adjust Zoom

=> (8] (Zoom in) or (@) (Zoom out)

(4]0

The text is scanned.
The recognized text appears.
HTo Rescan the Same Text
= => YES => (m]
HWhen Scanned Text Overflows
Recognized Text Field
=> ¥ to scroll the field
HlTo Save Scanned Text without
Correcting It
>
HTo Scan Following Text
=> (@) => Frame text in the
recognition frame (include several
scanned characters of the
preceding text) = (m]
HlTo Scan Another Item
=> (@) => [0 to select a scan item
icon => Frame text in the
recognition frame => (m]

© (@ -> store - (m)

Tip
« Text must be accurately focused and be
enlarged to fill the recognition frame.
* When Processing -+ appears, do not
move handset.
+ Handwritten text is not recognized.
» Text may not be recognized correctly
when:
— Faxed or copied text is scanned.
— Decorated characters are scanned.
— Spaces between characters are
uneven.
- Text is indistinguishable from the
background.
- Ambient lighting is inappropriate.

P sjool
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-. Text Reader

IChecking Scanned Text (¢ JVENTEES
@ = Tools = W] = Text

Reader > (m] => Reading Scanning Text
Data List = (u] @ Correct Scanned Text
@ Edit Scanned Text

B Text Reader i
T —— @ Set Printing Status of Text

® Set Guidance ON/OFF
@ Set Vertical/Lateral Scan
(> P. 11-26)

Using Scanned Data
o Make a Call
Scanned Text List Window @ Compose a Message
Access the Internet
Save to Phone Book
Save a Bookmark
Search Phone Book
Save a Text Memo
Copy Text

Delete Scanned Data

@) select an entry = (u]

B Text Reader
LIV ES o f tbank|

E sjoo1

(»P.11-27)

Scanned Text Details Window
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Osaifu-Keitai®

Start Here
[Lifestyle-Appli List] window

.P.11-3
[Call Remote Lock Setting] window
.P.11-5

Check Lifestyle-Appli Properties

[Lifestyle-Appli List] window =>
Select a Lifestyle-Appli = (@) =>
Properties => (m]

Check Memory Status

[Lifestyle-Appli List] window =>
=> Memory Info => (u]

Delete a Lifestyle-Appli

[Lifestyle-Appli List] window =>
Select a Lifestyle-Appli = (®] =>
Delete => (m] => YES => (m]

Edit Call Remote Lock Numbers

[Call Remote Lock Setting]
window => Select phone number
=> (m) => Change phone number =>
() => YES => (m]) =>

Delete Call Remote Lock Numbers

[Call Remote Lock Setting]
window =>Select phone number
=> (@) => Delete this or Delete All
= [m) = YES = (m)

Life History Viewer
Start Here

[Life History Viewer] window

.................................................... P. 11-7
[Life History Viewer Closeup] window
.................................................... P. 11-7

Hide Some Items in Life History
Viewer

[Life History Viewer] window or

[Life History Viewer Closeup]

window => (@) => Display setting

=> (@) => Select a data item => (m]

= Select an item => (8] =>

[Z)Only checked items appear in Life
History Viewer window.

Update Life History Viewer

[Life History Viewer] window or
[Life History Viewer Closeup])
window = (@) => Reload => (m]

- Advanced Features
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Schedule

Start Here

[Schedule] window .................. P. 11-8
[Event Edit] window .. ... P.11-8
[Event List] window ...... ... P.11-9
[Event Details] window ......... P. 11-10

Sort Events by Icon

[Schedule] window, [Event List]
window or [Event Details]
window => (@] => Icon Display =>
(@) => Select an icon = (m]

Check Number of Saved Events

[Schedule] window => (@) = No.
of Schedules => (]

Edit an Event

[Event List] window/ [Event
Details] window (=> Select an
event) = (@) = Edit => (@] = Edit
each item =>

11-24

Copy an Event

[Event List] window/ [Event

Details] window => (@] => Copy =>

(m] => Edit each item =

[EJRepetition setting of an event is
canceled when it is copied.

Make/Cancel Secret Setting of an
Event

® To Make Secret Setting

[Event Edit] window => Enter each

item =

® To Cancel Secret Setting

[Event List] window/ [Event

Details] window => (@] => Release

Secret => (W) => YES => (m]

[5)Before making/canceling secret
setting, set handset to Secret Mode or
Secret Data Only Mode (P. 4-8).

Delete All Events

[Schedule] window, [Event List]
window or [Event Details]
window = (@) = Delete => (®] =>
Delete All => (] => Enter Security
Code => (] = Select an item => (®]
=> YES = (m]

Reset Holidays

[Schedule] window => (@) => Reset
Holiday => (@] => YES => (m]




Search Information by Keyword

[Event Details] window = (@] =>

Quick Search => (&) => Enter

Keyword => (8] => Enter keyword

= (@] = or = (@) =

Select an item from search results

= (m]

EE170 select a keyword from previous
entries, select History, press (m), select
a keyword, and then press (w].

[E]7o enter a keyword with Quote
keyword, select Quote Keyword,
press (@], and select range start/end.

Change Order of Tasks

[Task List] window = (@) =>
Sort/Filter => (8] => Select a
criterion = (m]

To Do List

Start Here

[Task List] window ................. P. 11-12
[Task Details] window ........... P. 11-12
Sort Tasks by Category

[Task List] window = (@] =>
Category Display => (8] => Select a
category = (u]

Set Task Status

[Task List] window/ [Task Details]
window (= Select a task) = (@) =
Change Status => (8] => Select a
status = (®]

[E3The set status is indicated by the status
icon in Task List window and in Task
Details window.

EIwhen Completion is set as status,
enter the completion date.

Text Memo

Start Here
[Text Memo List] window...... P. 11-13

Save a Text Memo to Schedule

[Text Memo List] window => Select

a text memo = (@) => Edit

Schedule => (®] = Enter each item

=

[ZJEvent Edit window opens with the text
memo details set as event content.

Delete All Tasks

[Task List] window => (@) => Delete
=> (@) => Delete All => (8] => Enter
Security Code => (®] => YES => (u]

Sort Text Memos by Category

[Text Memo List] window => Select
a text memo = (@] => Category =
(m] => Select a category = (u]

Check Text Memo Information

[Text Memo List] window => Select
a text memo = (@) => Text Memo
Info => (m]

- Advanced Features
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Delete All Text Memos

[Text Memo List] window = (@] =>
Delete => (] => Delete All => (m] =>
Enter Security Code => (8] => YES

= (m]

Alarm

Start Here

[Alarm List] ..P.11-16
[Alarm Details] window......... P. 11-16

Cancel All Alarms

[Alarm List] / [Alarm Details]
window => (@) => Release All => (m]
=> YES = (m]

Edit Alarm Settings

[Alarm List] => Select an alarm =>
=> Edit each item =

11-26

Bar Code Reader & Text Reader
Start Here

[Scanned Bar Code Data List] window
.................................................. P. 11-19

[Scanned Bar Code Data Details]
WINAOW ....eeeereereceeerceeeeeen s P. 11-19

[Text Scanning] window ........ P. 11-21

[Scanned Text List] window
.................................................. P. 11-22

[Scanned Text Details] window
.................................................. P. 11-22

Scanning Text

Correct Scanned Text

[Text Scanning] window = Scan
text = 0§ to move cursor to the
character you want to correct =
Press the number key
corresponding to the correct
character on the suggestion list
[EPress to toggle between upper
case and lower case.

Edit Scanned Text

[Text Scanning] window => Scan

text => (@) = Edit => (m] => Edit

text using keypad

[E370 cancel editing and return to
scanned text, press (@), select Select
Recog. Data and then press ().

Set Printing Status of Text

[Text Scanning] window => (@) =>
NEGA/POSI Mode => (m] => Auto
setting, Positive Fix or Negative
Fix => (m)

[E)set to Positive Fix when dark-colored
text is printed on a light-colored
background.

[E)set to Negative Fix when light-
colored text is printed on a dark-
colored background.

Set Guidance ON/OFF

[Text Scanning] window => (@] =>
Guidance OFF or Guidance ON =>

(w)




Set Vertical/Lateral Scan

[Text Scanning] window => (@] =>
Vertical Writing or Lateral Writing

= [(w)

Using Scanned Data
Make a Call

[Scanned Bar Code Data Details]
window/ [Scanned Text Details]
window =>Select a phone number
=> (@) => Dialing => (®) => Voice
Phone or Video Call => (®) => Djal
=> (] = Talk => (=) to end call

Access the Internet

[Scanned Bar Code Data Details]
window/ [Scanned Text Details]
window = Select a URL = (@] =>
Internet => (@] => YES => (]

Compose a Message

[Scanned Bar Code Data Details]
window/ [Scanned Text Details]
window => Select an e-mail
address = (@) = Create S! Mail =
(@) => Compose and send S! Mail

Save to Phone Book

[Scanned Bar Code Data Details]

window/ [Scanned Text Details]

window => Select an item = (@) =>

Add to Phone Book => (]

® To Select Phone
=> Phone = (8] => New or Add =>
(@] (=> Search Phone Book => Select
an entry = [®] (twice)) = Edit each
item = (&) (= YES => (m))

® To Select USIM
=> USIM =>(®) => New or Overwrite
=> (m](=> Search Phone Book =>
Select an entry => (m] (twice))=> Edit
each item = (&) (=> Overwrite* or
Add => [m))

= To select Overwrite, press (], select
YES, then press (m).

Save a Bookmark

[Scanned Bar Code Data Details]
window/ [Scanned Text Details]
window = Select a URL = (@] =>
Add Bookmark => (®] (twice) =
Select a folder = (w)

Search Phone Book

[Scanned Text Details] window =>
Select an item = (@) = Search
Phone Book => () => Search Phone
Book

Save a Text Memo

[Scanned Text Details] window =>
Select an item = (@) => Add to
Memo => (u]

- Advanced Features
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Copy Text

[Scanned Bar Code Data Details]
window/ [Scanned Text Details]
window => (@] => Copy => (] =>
Select beginning of characters =
(@] => Select end of characters =>

(w)

Edit Title of Scanned Data

[Scanned Bar Code Data List]
window =>Select an entry =>
=> Edit Title => [®] = Edit title =

(w]

Delete Scanned Data

[Scanned Bar Code Data List]
window/ [Scanned Text List]
window => Select an entry =
® To Select Delete This

=> Delete This = (8] => YES => (=]
® To Select Delete All

=> Delete All => (8] => Enter Security

Code = (m] => YES => (m]

E sjoo1
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.: ‘ About Data Folder

Use Data Folder to manage data on handset. New data created by handset functions or obtained via the Internet or mail

are saved to different folders according to the file format.
@ Some folders contain links. Use the links to access download sites in Yahoo! Keitai.

Folders & Files in Data Folder

My Picture Melody S! Appli Ring Songs * Music
Image files such as those Melodies and audio Downloaded S! Appli Chaku-Uta®,
taken by camera and files recorded by Voice and Lifestyle-Appli Chaku-Uta Full®,
downloaded My Pictograms Announce downloaded music files

and music files transferred
using MTP mode

Videos Books Widget TV
Video files such as Downloaded book files Downloaded widgets Recorded programs' and
those recorded by files still images captured
camera from programs?

1 Can be saved on memory card only.
2 Can be saved on handset only.

b jusawabeuep eyeq

When Data Folder memory is full or number of files savable is reached, a message asks whether to delete unnecessary data (note,
however, this message may not appear depending on the data type). Follow the steps below to delete data:

YES => (m] => Select a folder => (®] => Select a data item => (@] => (&) => YES = (m]

@ You may need to select a data type before selecting a folder if the data you want to delete has multiple storage areas.

@ You may need to select more than one data item to delete depending on the degree of insufficient memory.
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.: ‘ Accessing Files

Functions in My Picture

IOpening Files
@ = > Data Folder -> (u]

@) Select a folder and a sub
folder => (u]

2 @Track02
3 @Track03

9 @Tracko4

File List Window

HTo Open a File on Memory Card
=> microSD => (m)

@Select a file = (m]

NOW

PLAYING

Opened File Wlndow

Window

Selecting a file in My Picture folder
opens a window such as below.

EIlil 7

m

15:30]

[ Full
My Plcture Window

The following operations are possible

in My Picture window.

Switch Files

=]

Toggle Normal Screen
and Full Screen

Zoom In/Zoom Out*

() =[] or (@)

Show at Actual Size*

() =@

Scroll Large-sized or
Zoomed-in Image*

(o]

* Press (W] to return to the original size.

Functions in Melody

Window

Selecting a file in Melody folder opens

a window such as below.

NOW PLAYING

Melody Window

The following operations are possible

in Melody window.

Switch Files o
Adjust Volume @
Stop (]
End

F juswabeuely eyreq
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.: ‘ Accessing Files

Quick Album Tip Return to =
(SI idesh ) « Alternatively, activate this function original plzs
iaesnow from =) = Camera = (8) = Quick (zoomed in/out)
View JPEG images saved in My Picture. ’S_Ibll’m ﬁd@ in the followi Image switch
Set images to switch automatically or o:ijray Cllelr TantEfe=ss () Ul vellietying) effect (Slide— + Effect changes
manually. ®Inb;)x Fade — Cube— w‘ith ea;h press.
@ Quick Album is also available for JPEG ®Camera RGB) Sllc:]e: Sllldis to
images saved to Memory Cards. ®User created folder Irzlagd;:oFrac?etin/out
0[@c¢> Data Folder => (u]=> icosRleicilis Cube: Rotates as
. . . . cube
My Picture > (8] Keys Available in Quick Album RGB: Splits into
9 . red, green, and
o , ,
" ®During Manual Play blue then rotates
5 Previous/next E Detect face and
2 image zoom in (Face) |- Press[¥]to toggle
@ Zoom in/out (=] when several
[ faces are
‘ED Image scroll (1J-09] detected.
i Scroll in bel
2 (B el ) dicrr:dilgns.e ow Start Photo
_ﬂ @ Slldte-sr:ow
Quick Aloum Window (auto play)
e > @During Auto Play
End Photo Slide-
2 ¥\ show (auto
e play)
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@®When Activated from Quick

Menu

Toggle auto
play/manual

play

Previous image
(manual play)

Next image
(manual play)

End Quick
Album

Press and hold (J

ICreating Animations

Create animations each of which is

made of up to 20 frames using still

images in My Picture folder.

@ -> Data Folder > (m] =>
My Picture > (] =
Original Animation > (m]

Original Animation List Window

@) <New> => u]

@Select aframe = (8] = Select
afolder = (m] = Select a still
image = (1]

Repeat this step to assign a series
of images to their respective
frames.

HTo Cancel an Assigned Image
=>Select a frame => (8] => Release
This => (&)

(4]E)

Note

* Only images in JPEG format can be used
for creating animations.

* Some images may be unavailable
depending on the image size or file size.

* Images saved on external memory devices
(i.e. memory card) cannot be used.

Tip

+ Select an animation you created in
Original Animation List window and
press (m] to play the animation.

.: ‘ Accessing Files
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.: ‘ Accessing Files

Using Playlist
(Melodies)

Save melodies to Playlist to play back
in the saved order.

@[ -> Data Folder > (m] =>
Melody => (8] => Playlist >
= Edit Playlist => (u]
HTo Clear Playlist
=> (@) => Release Playlist => (m] =>
YES => (W)

@Select a number = (8] =
Select a folder = (@] =
Select a melody = (8]

Repeat this step to assign other
melodies to different numbers.

HTo Cancel an Assigned Melody
=> Select a number = (@) =>
Release This => (m]

(3]E)

b jusawabeuep eyeq
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Tip

» Select Playlist folder in Melody and
press (m] to play Playlist.

+ Changing file names of melodies on
Playlist, or deleting melody files clears
Playlist.

Using Playlists
(Videos)

Save videos to a playlist to play them in

the playlist order.

@[ -> Data Folder > (m] =>
Videos => (8] => Playlist =>

(w]

> Playlist

Wl _Playlistl |
2@Playlist2
3@Playlist3
q@Playlist4
S@Playlist5

Playlist List Window

@) select a playlist = (@) = Edit
Playlist > (u]



.: ‘ Accessing Files

Select a number = (8] = .
Oscectamumber 28+ IS

. Display Settings
Select a video = (] K Advanced ° SZt I)r/nage Lisgt View
Repeat this step to assign other Opening Files (> P. 14-4)

videos to different numbers.

HlTo Cancel an Assigned Video
=> Select a number = (@) =>
Release This => (] => YES => (m]

(4]
Tip

« Select a playlist in Playlist List window
and press (8] to play the playlist.

® Check File Information
® Change Order of Files
@ Set an Image to Appear in Standby
® Set a Video to Appear in Standby
@ Set a Melody/Video as Ringtone
(» P. 12-15)

Viewing Images
@ Play Animation from the Beginning
® Compose Four Images to Make One
@ Set Display Size of an Image
e Edit Title of an Original Animation
® Cancel an Original Animation
(> P. 12-15)

Playing Melodies
@ Play All Melodies in the Same Folder
Repeatedly
(> P. 12-16)

Playing Videos
@ Switch Display Format of File List
Window
o Clear a Playlist
(> P. 12-16)

F juswabeuely eyreq
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.: ‘ Editing Files

b jusawabeuep eyeq

IEditing Still Images

Basic Flow of Operations

@ => Data Folder > (] =>

My Picture > (®] => Select a

folder = (®) = Select an
image = (m]

My Picture Window

@) (@ => Edit Image > (8] =
Select an editing option =>
(@) = Edit image

€)(®] to end editing

128

¢)(®] = YES or NO = (m]

Selecting YES overwrites the
original image. Selecting NO saves
the edited image as a new file in
the same folder.

Note

= Only images with % can be edited.

* Repeated editing may cause deterioration
of image quality or increased file size.

Adding a Frame

o[My Picture] window =>
= Edit Image = (®] =
Frame => (]

@) select a frame => (m]

HTo Change Frame
=0

HTo Rotate Frame 180 Degrees
=

HTo Cancel Frame
= (®) => Cancel => (m)

(3100
(¢)(®) = YES or NO => [u]

Adding Stamps

@ My Picture] window =>
= Edit Image = (®] =>
Marker Stamp > (8]

@) Select a marker stamp = (u])

HMTo Rotate Marker Stamp
= (@) =>90° to right, 90° to left or
180° = (m)

HTo Enlarge/Reduce Marker Stamp
=>®] => Scale up or Scale down =>

(w]
HTo Cancel Marker Stamp
=

€) 3 to select a position = (®]

HTo Paste Another Marker Stamp
=> (@) => Select a marker stamp =>

(m]
(4]0)
© @) = YES or NO = (u]



Pasting a Text Stamp

@ My Picture] window =
= Edit Image => (8] =
Character Stamp => (u)

@)Enter text => (1]

HTo Edit Text
=> (@) => Character input => (®] =>
Enter text = (m]

HlTo Change Text Color
=> (@) => Character Color => (®] =>
Select a color = (m)
Press (9] to toggle color palettes.

HTo Change Font Type
=> (@) => Font Type => (m) =>
Gothic or Ming-Cho => (m]

HTo Change Font Size
=> (@) => Font Size => (W) => Select
a font size => (m

€) 3 to select a position = (m)

(4]0
© (@] = YES or NO = (m]

Cropping an Image

@ My Picture] window =>
= Edit Image => (8] = Trim
away = (m]

@Select asize = (m] = i to

position cropping area = (8]

(3]0
¢)(m] => YES or NO = (m)

IEditing Videos

Clip the desired scenes from saved
videos.

@ > Data Folder > (m] =>
Videos => () => Select a
folder => () = Select a video
= (@) = Edit Video => (m)

9 = Trim Videos => (8] =
Any Size or 295KB > [u)

3]E)
The video playback and clipping
start at the same time.

.: ‘ E g Files

HTo Start from a Halfway Point
=> (] => At a desired point => (1]
=

() (®] to stop =
Selected portion plays.
When 295KB is selected, clipping
stops automatically when the size of
clipped video reaches 295 KB.

@[E] (twice) = YES = (u]

Note

» Only QCIF (176 X 144) or smaller videos
with % can be clipped.

» Editing may cause deterioration of
image quality.

0 More Features
K Advanced

Editing Files
® Retouch an Image
® Adjust Image Brightness
® Rotate an Image
® Change Image Size
@ Correct Backlight
® Refresh Skin Tone
(» P. 12-16)
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.: ‘ File & Folder Management
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ICreating a Folder

@ -> Data Folder > (m] =>
Select a folder type = (m]

<Example>When My Picture is
Selected

L] My Picture

T ®Download Pictures
2®0Download My Pict

S @Mail Art

6 @My Pictograms

7 @Auto Graphic Mail
B @Preset Screen
Si@0riginal Animation
0 (@microSD

Folder List Window

@ => Add Folder -> (] =>
Enter folder name = (m)
Tip
* Folders can only be created in handset
Data Folder.

12-10

Moving Files to a
Different Folder

O[File List] window => Select a
file = (@] = Move = (u)

@) Move this > (m] = Select a
destination folder => (@] =
YES = E]

HlTo Move Multiple Files
=> Move selected => (®) =>Select a
destination folder = (@] => Select
a file => (m] => Repeat the same
step to specify other files = (&) =>
YES = [E]

HMTo Move All Files in a Folder
=> Move all => (8] => Select a
destination folder => (@] => YES =>

(w)

0 More Features
K Advanced

Managing Folders
@ Edit a Folder Name
@ Delete a Folder
@ Delete All Files in My Picture, Melody or
Videos Folder
(»P. 12-17)

Managing Files
@ Edit a Title in My Picture File List
Window
® Check Volume of Saved Files
@ Edit a File Name
® Delete Files
(»P. 12-17)



Save files to memory cards. Still images
and videos shot with handset camera
can be saved directly to memory card.
Data can be copied and moved
between handset and memory card.
Data on memory card can also be
accessed from Data Folder.

@ Handset supports memory cards of up to
8 GB.

@ Do not insert or remove memory cards
when handset power is on.

@ Insert memory cards properly. Otherwise,
they cannot be used on handset.

@ Do not affix stickers or labels to memory
cards. As memory cards are very thin
and precise mechanisms, even a thin
sticker or label on a memory card may
cause contact failure or destruction of
data.

@ Keep memory cards out of reach of
infants who may accidentally swallow
them or be injured.

@ Do not remove a memory card or power
off handset while writing and reading
data with that memory card. It may
cause data loss or malfunction.

@ Access to memory cards may be
unavailable when the battery level is
low.

Inserting & Removing
a Memory Card

Before inserting/removing a memory
card, remove battery cover and battery
referring to Battery Installation

(P. 1-14).

Insertion

olnsert memory card into
Memory Card Slot until it
locks
Insert gently with the printed logo
facing up.

Logo should
face up

.: ‘ About Memory Card

Tip

* If i appears in Display, there may be a
contact failure. Remove and reinsert
memory card.

Removal

@ Press and release
Gently pull out memory card.

Note
» Memory card may break if inserted or
removed with force.

1211

F juswabeuely eyreq



Managing Memory Cards

@Select a file = (m

Formatting a Accessing Memory
B 09030102
Memory Card Card Data T —
s ng
@ Format memory cards on handset only. 0@] => Tools => (8] => microSD
Memory cards formatted on another Manager - [E

device or PC may not work.

@ Formatting a memory card deletes all SR oS Hanads /2 Data List Window
, Qi Pioture ———
the data on it. @Me lody .
=Sl @Select a data item => (=]
@ (=) = Tools > (W] => microSD Syidos e S—
<

Contents
jogging

Manager => (u]

. Cat
@) (@) = microSD format - (u] “None
. Completion Date
= Enter Security Code => (u] A
=> YES = (u] microSD Manager Window 2009/ 3/ 1 8:00

Note @) Select a category = (|]
* Do not remove memory card while
formatting. Handset/memory card
malfunction may occur. %333%313?
 Make sure that there is no important 1009030102
data left on the memory card before
formatting it.

To Do List Data Details Window

jusawabeuep eyeq

h

File List Window
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Copying Data between
Handset & Memory Card

Following items can be copied to/from
handset and memory card:

Phone Book entries,
Schedule, To Do List,
text memos, Inbox,
Outbox, Draft,
bookmarks, content
keys

PIM Data

Still images, My
Pictograms, Flash®,
melodies, videos, songs

Files in Data
Folder

Copying Handset Data to

Memory Card

Copy Phone Book entries, Schedule,

messages, images, videos, etc.

<Example> Copy data in Data Folder

to memory card

O[Data List] window = (@] =

Copy to microSD > (u]

@) Copy this > (m] = Select
copy destination folder =>

HTo Copy Multiple Data
=> Copy selected => (8] => Select
copy destination folder => (m]) =>
Select a data item => (8] =>Repeat
the same step to specify other data
=> (@) => Select copy destination
folder => YES = (m]

HTo Copy All Data
=> Copy All => (m] => Enter Security
Code = (m] => YES = (=]
Tip
* When one Phone Book entry or
Schedule event that is set as secret is
copied to memory card, its secret
setting is canceled.
* Files attached to messages may be
deleted.
* You need to select a destination folder
when copying data in Data Folder.
* You must select the copy destination
folder to copy data from Data Folder.
+ Data saved in Pre-installed folders of
Data Folder cannot be copied.
+ Content keys are copied collectively at
one time.

Copying Memory Card
Data to Handset

@To Copy Images or Other Data
to Handset

@ -> Data Folder => (m] =
Select a folder type => (®]) =>
microSD => (8] = Select a
folder and sub-folder => (m]
= Select a data item = (@) =
Copy to Phone - (u]

QCopy this = (u)

HMTo Copy Multiple Data
=> Copy selected => (] => Select a
data item => (®) => Repeat the
same step to specify other data =
= YES = (u]

HTo Copy All Data
=> Copy all => () => Enter Security
Code => (] => YES => (m]

.: ‘ Managing Memory Cards
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.: ‘ Managing Memory Cards

jusawabeuep eyeq

@To Copy PIM Data to Handset

<Example> Copy Data in Overwrite
Mode

@ = = Tools = (=) =
microSD Manager => (8] =>
Select a PIM data type > (]
=>Select a data item = (@) =>
Copy/OW to Phone > (u]

@) Copy This = (u]
HlTo Copy Multiple Files
=> Copy selected => (8] => Select a
file => (@) => Repeat the same step
to specify other files =>

HTo Copy All Files
=> Copy All => (m]

@Enter Security Code = (m] =>
YES => (m] = YES = (u]

Note

» When copying memory card data to
handset in overwrite mode, the
corresponding data on handset is
overwritten by the copied data.

* If the maximum storable number of
items is reached when copying all
items, copying stops at that point.

12-14

Configuring Print
Settings of Images

Specify which images on memory card
to be printed and the number of
prints, etc. in DPOF (Digital Print Order
Format) settings so that the images can
be printed by DPOF compatible
printers or print service shops.

@ = = Data Folder > (®) =
My Picture => (] =
microSD => (8] => DCIM =>

(w]

@) select a folder = (m] =
Select a still image = (@) =
DPOF setting = (m]

€) DPOF set One - ()
HTo Specify Multiple Images
=> DPOF set Choice => (®) => Select
a still image => (m] => Repeat the
same step to specify other images
=

() Print => (8] => Print Sheets
=> () => Enter number of
prints => (]

©a Date > (8] => ON or OFF
= (@]

(6]E

0 More Features

Memory Card
® Check Available Memory Space of
Memory Card
® Check & Repair Memory Card
® Delete Data on Memory Card
@ Cancel Print Settings of Images
(> P. 12-18)



Accessing Files

Start Here

[File List] window .........cc..c........ P. 12-3
[Opened File] window ............. P.12-3
[My Picture] window................ P. 12-3
[Melody] window..................... P. 12-3
[Original Animation List] window
........ .P.12-5
[Playlist List] window............... P.12-6

Opening Files
Check File Information

[File List] window/ [Opened File]
window (= Select a file) => (@) =>
Image Info, Video Info or Melody
Info => (m]

Change Order of Files

[File List] window => (@) = Sort =>
(m) => Select a criterion = (m]

Set an Image to Appear in
Standby

[File List] window/ [Opened File]

window (=> Select a file) = (@) =>

Set as Display => (8] => Stand-by

Display => (@] (=> Select a layout =>

(@) = Confirm preview => [=])

[Z)Set images to appear when making
calls or sending messages.

Viewing Images
Play Animation from the Beginning

[My Picture] window = (@] =>
Retry => (m]

Set a Video to Appear in Standby

[File List] window => Select a file
=> (@) => Stand-by Display = (®] =>
YES = E]

Set a Melody/Video as Ringtone

[File List] window/ [Opened File]
window (=> Select a file) = (@) =>
Ring Tone => (W] => Select an item

=> (m]

Compose Four Images to Make One

[File List] window => (@] =>
Composite Image => [B] => Select a
position => (] => Select a folder =>
(m] = Select an image => (] =>
Repeat the same step to assign
three other images to their
respective positions = (2] => (m]
[EJOnly images in JPEG format can be
used for creating composite images.
[E)Copyright-protected images are
unavailable.
[E)images saved on memory card cannot be
used.

- Advanced Features
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Set Display Size of an Image

[My Picture] window => (@) => Set
Image Disp. => (8] => Normal or Fit
in Display => (m]

Edit Title of an Original Animation

[Original Animation List] window
=> Select an animation = (@) =>
Edit Title => (m] => Edit title => [m]

Playing Videos

Switch Display Format of File List
Window

[File List] window => (®] => List
Setting => (] = Title or
Title+Image => (®]

Cancel an Original Animation

[Original Animation List] window
=> Select an animation = (@) =>
Release Animation => (8] = YES =>

(w]

Clear a Playlist

[Playlist List] window => Select a
playlist = (@) => Release Playlist =
(m] => YES = (m]

Editing Files

Start Here

[My Picture] window................. P. 12-8
Editing Still Images

Retouch an Image

[My Picture] window => (@) => Edit
Image => (8] => Retouch => (] =>
Select an effect = (®] (three times)
=> YES or NO => (m]

Playing Melodies

Play All Melodies in the Same
Folder Repeatedly

[Melody] window => (@] => Set
Repeat Play => (8] => ON => (m]

12-16

Adjust Image Brightness

[My Picture] window = (®) => Edit
Image => (®] => Brightness => (]
=> [0 to adjust brightness => (m]
(twice) => YES or NO = (u]

Rotate an Image

[My Picture] window => (@) => Edit
Image => (8] => Rotate => (8] =>
90° to right, 90° to left or 180° =
(m] (three times) => YES or NO => (m]




Change Image Size

[My Picture] window => (@) => Edit
Image => (8] => Change Size => (u]
=> Select a size => (8] (three times)
=> YES or NO => (m]

Correct Backlight

[My Picture] window => (@) => Edit
Image => (8] => Correct Backlight
=> (m] (three times) => YES or NO
= (]

Managing Folders

Start Here
[Folder List] window .............. P. 12-10

Edit a Folder Name

[Folder List] window => Select a

folder => (@) => Edit Folder Name

=> (@) = Edit folder name = (u)

[ZJOnly names of user-created folders
can be edited.

Delete All Files in My Picture,
Melody or Videos Folder

[Folder List] window = (@] =>

Delete all Image or Delete All =>

(@] => Enter Security Code => (®] =>

YES => (m]

[EIwhen files that are set as wallpaper,
ringtone, alarm tone, etc. are deleted,
their settings are reset to default.

Refresh Skin Tone

[My Picture] window => (@) => Edit
Image => (8] => Refresh Skin Tone
=> (@] (three times) = YES or NO
= (a]

Delete a Folder

[Folder List] window => Select a

folder => (@) => Delete Folder => (u)

=> Enter Security Code => (8] =>

YES => (m]

[EJOnly user-created folders can be
deleted.

[EJFiles in the selected folder are also
deleted.

[EIwhen files that are set as wallpaper,
ringtone, alarm tone, etc. are deleted,

their settings are reset to default.

Managing Files

Start Here
[File List] window .........ccceeunenee P. 12-3

Edit a Title in My Picture File List
Window

[File List] window => Select an

image file = (@) = Edit Title => (u]

=> Edit title = (1)

ETitles of files saved in Pre-installed
folders cannot be edited.

- Advanced Features
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Check Volume of Saved Files

[File List] window = (@) =>
Memory Info => (u]

Edit a File Name

[File List] window => Select a file

=> (@) => Edit File Name => (&) =>

Edit file name = (m)

EINames of files saved in Pre-installed
folders cannot be edited.

Delete Files

[File List] window => Select a file
= (@) = Delete => (m]
® To Select Delete this
=> Delete this = (@) => YES => (m]
® To Select Delete selected
=> Delete selected = E] => Select
files = (@) = (@) = YES = (u]
® To Select Delete all
=> Delete all = @ => Enter Security
Code = (@) => YES => (m]

Memory Card

Start Here

[microSD Manager] window.. P. 12-12
[File List] window ................... P. 12-12
[Data List] window .........cc..... P. 12-12
[Data Details] window ........... P. 12-12

Check Available Memory Space of
Memory Card

[microSD Manager] window, [File
List] window, [Data List] window
or [Data Details] window = (@) =>
microSD Info => (m]

Delete Data on Memory Card

[File List] window => Select a data
item = (@) = Delete = (u)
® To Select Delete this
=> Delete this = (@] = YES => (@]
® To Select Delete selected
=> Delete selected => [B] => Select
files = (W) = (@) => YES => (m]
® To Select Delete all
=> Delete all => (] => Enter Security
Code = (@) = YES => (u]

Check & Repair Memory Card

[microSD Manager] window =>

=> Check microSD => (8] => YES =>

(m]

[E370 cancel checking and repairing a
memory card, press (&) or (—).

[Z3Some memory cards may not be
repairable.

12-18

Cancel Print Settings of Images

fe) => Data Folder => (8] => My
Picture => (®) => microSD => (m] =
DCIM => [®] => Select a folder =>
(m] => Select a still image = (@) =
DPOF setting => (8] => DPOF set
One or DPOF set Choice = [m] (=>
Select an image => [®) => Repeat
the same step to specify other
images = (&) = Print OFF or All
Print OFF => (m)
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Infrared

IGetting Started

Wirelessly exchange files with infrared

compatible devices.

The following data can be transferred

via infrared:

- Still images

- Melodies

- Videos

+ My Pictograms

+ Songs

- Books

-+ Widget

- Phone Book entries, Account Details

- Schedule events

- To Do List tasks

- Received messages, sent messages

- Draft messages

+ Text memos

- Common Phrases (Templates)

- Own Dictionary data

- Bookmarks (Yahoo! Keitai and PC Site
Browser)

Note

*» Handset cannot send all still images,
melodies, videos, My Pictograms or
songs at one time.

KA11A1dBUU0)
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Precautions

@ Data may not be sent depending on the
status of the receiving device. Folder
settings of received messages or
bookmarks, etc., or contents of Graphic
Mails may be lost or incorrectly
transferred depending on the receiving
handset model.

@ Handset is out of range during infrared
transmission, so such functions as voice
and video calls, the Internet access and
sending/receiving S! Mails are
unavailable. This may continue even
after infrared transmission is finished.

@ Transferring data may take a while
depending on the amount of data.
Some data may not be received by
handset.

@ During transmission, progress bar
shows approximate number of files
transferred. Note that actual progress
may be faster.

@ Some pictographs and symbols in
messages and Phone Book entries may
not be received by handset correctly.

@ All the still images on handset are
overwritten, even those set as Phone
Book entry images, if handset receives
all still images at once.

@ Align Infrared Ports of both sending and
receiving devices, as shown below.

Infrared
Port

jvithin 20 cm

Within £15°

Infrared
Port

@ Do not move either device until a
message appears indicating completion
of data transmission. Do not place any
objects between the devices. Do not
obstruct Infrared Ports.

@ Infrared transmission may be disrupted
by direct sunlight, directly under
fluorescent lighting or near other
infrared devices.



. ‘ Infrared —

Authentication
Password

To transfer multiple files at once, the
same authentication password must
be entered on both sending and
receiving devices.

Transferring Data via
Infrared

Sending One File

Send one file at a time from a data list
window/data details window.

@ n a data list window, select
a file or open a data details
window = (@] => Send Ir
Data = (u

HlTo Send a JPEG Image
In a data list window =>
This enables faster transmission.

@) Set the receiving device to
receive data

€) Align Infrared Ports => YES
= (m]
Transfer starts.
When the file is sent, a message
appears indicating completion of
transfer.

HTo Cancel Transfer
=
Tip
* In the case of high-speed transmission
of JPEG images, the receiving device
may fail to receive images, even when

the image transmission is successfully
completed by the sending device.

Receiving One File

@ = => Tools = (m] = Receive
Ir Data => (8] => Receive >

(w]
@Align Infrared Ports

Transfer starts.
MTo Cancel Transfer

=g

€) When file is received => YES
= (a]

File is saved to handset.

File is discarded if no operation is
done in about 30 seconds of
transfer.

Sending All Files

Send all files at one time from a data
list window/data details window.

@ n a data list window/data
details window = (@] =
Send All Ir Data => (m)

@) Enter Security Code = (W] =>
Enter authentication
password

€) set the receiving device to
receive data

(@) Align Infrared Ports => YES
= (a]

Transfer starts.
When all files are sent, a message
appears indicating completion of
transfer.

MTo Cancel Transfer
=

P TV AR ETTTT s
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. ‘ Infrared

Receiving All Files
9 Note ) More Features

0@] = Tools = E] => Receive * When handset receives all files, the

Ir Data = @ = Receive All corresponding files on handset are
o E] overwritten. For example, when Phone Book
rr:?er::;zte;e;gIﬁzsn?jlsler??sz?ug deisr;'gall iz ® Do Not Send Phone Book Entry Images
@Enter Security Code => (8] = protected ones are overwritten; and via Infrared
Enter authentication when it receives all Phone Book data or (> P. 14-16)

Schedule data, all the Phone Book
entries or events, including those set as
€) Align Infrared Ports => YES Sl BLIS G o
* Receiving of data ends automatically if
= (m] data reaches the maximum storable
capacity.

password

() When an overwrite
confirmation appears =>
YES = (u]

Transfer starts.
When files are saved to handset, a
saving completed message
appears.

HTo Cancel Transfer

=g

b KA11A1dBUU0)
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Bluetooth®

IOverview

Transmit data by wireless connection
between Bluetooth® compatible
devices (wireless headset, handsfree
device, audio device, etc.).

Handset Bluetooth® specifications are
as follows.

Bluetooth® standard Ver. 2.0 +
EDR compliant

Version

HSP: Headset Profile

HFP: Handsfree Profile
A2DP: Advanced Audio
Distribution Profile (stereo,
high quality)

AVRCP Audio/Video
Remote Control Profile

Profiles

Precautions

@ Handset is not guaranteed for
connection/operation with all
Bluetooth® devices.

@ Connected Bluetooth® devices must be
certified as Bluetooth® standard as
designated by Bluetooth® SIG.

@ Depending on other party device
characteristics/specifications, there may
be inability to connect, incompatible
operation/display methods, or inability
to transmit data even if other party is
Bluetooth® standard.

@ The frequency band (2.4 GHz) used by
Bluetooth® devices is shared with other
kinds of devices. Interference from
other devices may result in decreased
transmission speed/distance or
disconnection.

@ Static noise may occur depending on
the connection device and environment
during wireless/handsfree talk.

@ TV audio is unavailable with Bluetooth®
devices non-compliant with the
copyright protection standard SCMS-T.

@Handset Functions

Function Description
Headset Wireless talk is available
Profile when connected to a
wireless headset.

Handsfree Handsfree talk is available

Profile when connected to a car
navi and using a
microphone-speaker.

Audio Profile |Enjoy music/TV audio
when connected to a
wireless headset and
audio device.

Note

» When connected to a wireless headset
or handsfree compatible device, a ring
tone sounds when Forward Ring Tone
is set to OFF and Headset Usage
Setting is set to Headset+speaker.

P TV AR ETTTT s
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. ‘ Bluetooth®

IUsing Bluetooth®

Adding a Bluetooth®
Device
Search and add a device.

0[@] => Tools = (®] =

Bluetooth = (]

Bluetooth
Jevice List
@Register New Devices

SBluetooth Settings

Bluetooth Menu

@ Register New Devices =

(w)

Handset searches for devices.
Added device appears in Device
List.

b KA11A1dBUU0)
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€)select device to add = (W) =>
YES > (8] = Enter
Bluetooth passkey = [u]
Enter the same Bluetooth® passkey
(4 to 16 characters) for both
sending/receiving devices.
Receiving device must have
passkey entered within 30 seconds
after the sending device.
Enter the designated passkey for a
handsfree device (other party).

Tip

* When a Bluetooth® device is not
added, search and add from Device
List in Bluetooth® menu.

* You do not need to enter a passkey
again for a device that has been added.

Connecting
Connect to an added device.

O[Bluetooth Menu] => Device
List => (u]

Device List

HTo Search for New Bluetooth®
Device

=
@) select target device => ()

Connectiong to the device starts.



@Select service = (1]
flashes once connected.
For a device capable of connecting
to multiple services, a
confirmation window will ask if
you want to connect to another
service.

Ml To Discontinue a Connected
Service
=> (m) = YES => (m]

Device List

The type of added device and service
are shown by indicators.

Device List

(O]

Device Type1
/= pC

® Phone

» AV device
Other

. ‘ Bluetooth®

2 Service status appears as below.

Device Name
Bluetooth® address appears for non-
added devices.

Status
O Added
80 Not added (newly detected)

Icon | Letters | Backgr. |Border| Status
& | gray — — | Connection
history: No
@ |white| — gray |Connection
history: Yes
[ | white| — | white |Connection
standby
B8 | black green | white | Connected

Services?

[ Headset

[ Handsfree

@ Audio

B Remote Control

1

An icon with a key mark appears for
protected devices.

Calling with Wireless
Device

Connect wireless headsets or
handsfree devices.

@ connect to target device

@ Make/receive call with
device
ESwitching Between Handset and
Device
=> Press and hold

Talk switches each time you press
and hold

P TV AR ETTTT s
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. ‘ Bluetooth®

b KA11A1dBUU0)

Playing music and audio
with Wireless Device

Connect to a device with audio device
to play Music Player music and TV
audio.

0Connect to target device
@Play music, TV or etc.

Tip

* To adjust volume, use volume control
on Bluetooth device.

+ Connecting once to an audio device
with audio service is stored as a
connection history. When handset's
Bluetooth® function is active
(Bluetooth ON), audio devices with a
connection history are automatically
connected through audio service when
playing music or TV.

138

Suspending Bluetooth®
Connections
Suspend all Bluetooth® functions

(connected or on standby) and disable
Bluetooth.

0[Bluetooth Menu] =
Bluetooth OFF => (8] => YES
= (]

MTo Activate Bluetooth®

=> [Bluetooth Menu] => Bluetooth
ON => (m]

Setting Bluetooth® to

Connection Standby

Set standby status for all added devices.

0[Bluetooth Menu] => Accept

Registered -> () => Accept
All = (a)

HTo Release all Connection Standby
=> Release All => (a]

HTo Set Individually
=> Separate Setting => (] =>
Select service =>
Services with checked boxes enter
Connection Standby.

'9 More Features
K Advanced

Bluetooth®

@ Protect Added Device

® Change Name of Added Device

® Delete Added Device

® Open Information for Added Device

(»P. 13-11)

Bluetooth®

@ Set Detection Time for Device

@ Set Whether to Send Ring Tone for Voice
Call, Video Call to Headset or Handsfree
Device

@ Set Whether to Enable Calling from
External Device

@ Check Handset Bluetooth® Information

(> P. 14-42)



.5 ‘ PC Connection

Connect handset to a PC with a USB

cable to use the following functions.

@ USB cable is sold separately as an
optional accessory.

Function Description

Data transfer* | Transfer Phone Book,
Schedule and To Do
List data between
handset and a PC

(P 13-9).

USB memory Use memory card
inserted in handset as
an external drive of a
PC to read and write
data with memory card

(P. 13-10).

* USB driver must be installed in advance.

IUSB Driver

This software is required for your
handset to connect with a PC. First
install on your PC referring to the web
site below for installation details.
http://www.n-keitai2.com/guide/
download

IData Transfer

Use SoftBank Utility Software to

connect with a PC via USB cable and

use various kinds of data on a PC. See

the following web site for software

details.

http://www.n-keitai2.com/guide/

download/

@ USB Driver must be installed before
using SoftBank Utility Software.

@ Synchronization unavailable for Phone
Book, Schedule, and To Do List.

ISetting USB Mode

Set USB mode before connecting
handset to your PC via USB cable.

To use a data transfer tool, or use
handset as a modem for packet
transmission, set USB mode to
Communication Mode.

To access memory card data from a PC,
set it to microSD Mode.

@ = settings > (m) =
External Connection => (]
=> USB Mode Setting - (m]

) Communication Mode or
microSD Mode -> (u]

P TV AR ETTTT s
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Accessing Memory
Card Data from a PC

Connect handset to your PC using a

USB cable, and access memory card

data from the PC.

@ Set USB Mode Setting to microSD Mode
in advance.

@ Connect handset to your PC
using a USB cable
This enables memory card data to
be accessed from your PC.

@) When you are finished,
disconnect handset from the
PC
Follow the procedure for safely
removing external devices (which
differs slightly according to the
operating system), when
disconnecting handset from the
PC.

13-10

Note

* Make sure handset and the PC are properly
connected. Otherwise, data cannot be
transferred, and may even be lost.

« If handset's battery is almost or
completely empty, data cannot be
transferred, and may even be lost.
Check handset’s battery level and the
power of your PC.

» Do not remove the USB cable while
copying data from your PC to handset.
If the USB cable is removed during data
transfer, data cannot be transferred,
and may even be lost.

IUsing Handset as Modem

Use handset as an external modem for

packet transmission.

@ Refer to the instructions of your Internet
service provider or the manual of your
PC for the network connection settings
on your PC.

@ To use “Access Internet” for data
communication, you do not have to
sign up with a service provider. For
information about the service overview,
access points and setting procedures,
contact SoftBank Customer Center,
General Information (P. 15-52).



- Advanced Features

Bl h®

uetoot Open Information for Added
Start Here Device

[Device List] ....cccooverrennee P.13-6. P.13-7 | [pevice List] = Select target
Protect Added Device device = (@] = Description = (8]

[Device List] = Select target

device = (@] => Protection Setting

= (a]

[E)if already protected, select Protection
Setting to cancel protection.

Change Name of Added Device

[Device List] => Select target
device = (®) => Change Device
Name = @ => Enter device name

= (]

Delete Added Device

[Device List] = Select target
device = (@) = Delete => (@] =>
YES => (m]

P TV AR ETTTT s
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141



- Clock, Display & Sounds

Clock
e b => Settings = (8] => Clock => (m]
Hide Clock => Clock Display => (8] => Display => (8] => OFF => (m]
Clock Size => Clock Display => (] => Size => (] => Select a size => (m]
Clock Color => Clock Display => (] => Color => (8] = Black or White => (u]
Set Auto Time Adjustment => Set Main Time => (8] => Auto Time Adjust => (8] => Auto => (8] =>
Select a time zone = (®)
+ Press &) to change city/area name in Time Zone Selection field.
Manually Adjust Time => Set Main Time => (8] => Auto Time Adjust => () => Manual(Date Time
Set) = (] => Select a time zone => (@] = Enter date and time = (@]
Summer Time => Set Main Time => (8] => Summer Time => (&) => ON => (&}
n Time Zone (Sub Clock) => Set Sub Clock => (8] => Display Method => (8] => Always => (&) =>
£ Select a time zone = (®]
-,
g Hide Sub Clock => Set Sub Clock => (] => Display Method => (8] => OFF => (m]
E' Summer Time (Sub Clock) => Set Sub Clock => () => Summer Time => (8] => ON => (®]
=
o  Time Zone Major City (Sub Clock) => Set Sub Clock => (8] => Area Name => (] => Display => (u]
=]
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- Clock, Display & Sounds

Alarm

fe) => Settings => (8] => Clock => (m]

Set Priority at Alarm Notification Time

=> Alarm Setting => () => Operation Preferred or Alarm Preferred => (m]

Change Alarm Tone

=> Clock Alarm Tone Set => (] => Select an item => (] => Set an alarm
tone

Auto Power On/Off

Set Auto Power On/Off

(e => Settings => (8] => Clock => (8] => Auto Power ON or Auto Power
OFF => (m] => ON => (] => Enter time => () => 1 Time or Daily = (u]

Style Mode Settings

[ = Settings - (8] > Style Mode Setting > (u)

Set Display Design Collectively

= Select a style = (8] => YES => (m] (=> YES => [m))

Check Default Style Mode Settings

=> Select a style =
« Details of some items can be checked by selecting an item and pressing (&).

Edit Title of a Style

=> Select a style = (@) => Edit Title => () => Edit title => (m]

Save Current Style Mode Settings as
Favorite

= BICA D (Favorites) = (2] = (@) => Take Setting Info => (8] => YES =>

(w)

+ The current style mode settings can later be recalled collectively from S&ICAD
when they are changed.

F uoineziwoljsn)
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- Clock, Display & Sounds

Change Each Item for Favorites = BFICA D (Favorites) = (B = Select an item => 8] => Set an image
Clear All Favorite Settings => B5/CA D (Favorites) = (@) => Reset Setting Info => (8] => YES => [m]

Display Settings
[y <> Settings > (8) <> Display —> (W)

Wallpaper => Display Setting => (] => Stand-by Display => (8] => My Picture or
Videos => W) => Set an image/video (=> Select a layout => (8] (twice))
Show Calendar in Standby => Display Setting => (8] => Stand-by Display => (8] => Calendar => (®] =>

Background => (8] => Set an image = Select a layout => [®] (twice)

+ Select No Background if you do not want any image in the background of the
calendar.

+ Press (m], use (@) to select the calendar and press (®] to operate it. Use (@) to switch
to the previous/next month. Press (@] to activate Schedule.

o) Set Random Display of Images in => Display Setting => (8] => Stand-by Display => (8] => Random Display =>

w  Standby (@) = Select a folder => (] => Select a layout = (8]

g - Images switch at random each time handset is opened or returns to Standby.

E' Set a Wake-up Image => Display Setting => (] => Wake-up Display => (8] => My Picture => (m]

g. => Set an image

3 Seta Wake-up Message => Display Setting => (B8] => Wake-up Display => (8] => Message => (8] =
_m Enter message = (8]
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- Clock, Display & Sounds

Set an Outgoing Call/Message Image

=> Display Setting => (8] => Djaling, Video Call Dialing or Mail Sending =>
(@) = Set an image

Set an Incoming Call, Message Image
or Video

=> Display Setting => (] => Calling, Video Call Calling or Mail Receiving
=> (W) => Select Calling Disp. or Select Receiving Disp. => (8] (=> My
Picture or Videos => (®)) => Set an image/video

Set an Image for New Messages or
Received Result Window

=> Display Setting => (B) => Retrieve New or Mail Rec’d Result => (8] =>
Set an image

Display Color Scheme

=> Display Design => [8) => Color Theme => (] => Select a color => (m]

Set a Battery Level Indicator/Signal
Strength Indicator Pattern

=> Display Design => (8] => Icon Pattern => (8] => Battery Icon or Antenna
Icon => (@] => Select a pattern = (m]

Change Softkey Color

=> Display Design => 8] => Soft Key => (8] => Select a color => [m]

Set Font Type

=> Font => (8] => Font Type = (8] => Gothic or Ming-cho => (8]
- Alternatively, press and hold in Standby to make font settings.

Set Font Thickness

=> Font => (] => Thickness => (8] => Thin or Bold => (]
+ Alternatively, press and hold in Standby to make font settings.

Set Font Sizes Collectively

=> Font => (] => Character Size => 8] => Standard or X-large => (]

+ Items settable with Separate Setting for Character Size can be set collectively.
+ Alternatively, press and hold in Standby to make font settings.
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Set Font Size for Each Function => Font => (W) => Character Size => (8] => Separate Setting => (8] => Select
Window a window => (8] => Select a size => (W] =>

+ Alternatively, press and hold in Standby to make font settings.

+ In PC Site Browser, this procedure is only available in Small Screen view.

Interface Language => SZER ~ (W) => F&EZ or English = (m]

- To change interface language from Japanese to English:
> o) > ZFE > (W) > Fr X TL 1 <> (8] => Language => (8] => English => (m]

Set Image List View => Viewer Settings => (8) => Picture or Title => (u]

Guard from Prying Eyes => Privacy Angle => (8] => ON => (m]

- Alternatively, press and hold in Standby to toggle Privacy Angle on and off.
+ When Privacy Angle is set, Display is whitish and the viewing angle is narrower.
+ Turning power off/on cancels Privacy Angle.

Show Information of Messages => Quick Info Setting => (W) => Display Sender or Display Sender/Subject
Received When Watching TV = (m]

Set 3D Effect When Returning to => Screen Effect => (W) => Select an item => (®]

Standby

Display Quality => Image Display Mode => (8] => Normal, Vivid or Dynamic => (u]

- The Visual Image Effect setting in TV Effect has preference for TV display quality.
+ A preview image for each mode appears during selection in Image Display Mode
to check the effect.

_m Charging Display (Handset Closed) => Display On Charge => (8] => Wide Stand-by Clock, Photo Slide-show
or OFF => (m] => Select a folder = [m]
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Backlight

fe) => Settings —=> (8] => Display => (8] => Backlight => (u]

Set Backlight & Power Saving

=> Lighting => (8] => ON or OFF => [®] (=> Select time Backlight is lit = [m])
=> ON or OFF => [®] (=> Enter a time before the Power Saver Mode is
activated)

+ Press and hold (5 to toggle TV Power Saving on/off.
+ When the Power Saver Mode is activated, nothing appears in Standby and Keypad
backlight flashes. Pressing any key cancels the Power Saver Mode.

Set Backlight during Charging

=> Charging => (8] = Standard or All Time ON => (]

Set Brightness of Backlight

=> Brightness => (8] => ON or OFF => (8] => Select a Level => (1]

+ Set Brightness to Level 6 to use Display with the maximum brightness. Backlight is
Level 4 by default. A higher setting reduces battery life.

Desktop Icons

fe) = Settings => (8] => Display => (u]

Set Desktop Theme

=> Desktop Icon => (] => Select a theme => (8] => YES => (m]
+ Press (2] to see details of the selected theme.

Change Icon Design of a Theme

=> Desktop Icon => (8] => Select a theme => (&) => Select an icon = (@) =
CHG Icon Image => 8] => Select Icon Image or Default Icon Image => (8]

=>Set an icon
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Change Order of Icons of a Theme => Desktop Icon => (B] => Select a theme => (8] => Select an icon => (@) =
Sort => (@] => Select a position = (m]

Copy Icons to Another Theme => Desktop Icon => (] => Select a theme => (&) => Select an icon = (@) =
Copy => (m] => Copy This, Copy Selected or Copy All => (8] => Select a
destination theme = (@) (=> Select icons = (8] = @)

+ When Copy Selected or Copy All is selected, select YES and press (8] at the end of
the procedure.

Move Icons to Another Theme => Desktop Icon => [B] => Select a theme = (8] => Select an icon = (@] =>
Move => (@] => Move This, Move Selected or Move All => (8] => Select a
destination theme => (8] (=> Select icons => (@] => (&) => YES => (=)

Delete Icons of a Theme => Desktop Icon => (m] => Select a theme => (8] => Select an icon => (@) =
Delete => (W) => Delete This, Delete selected or Delete All => (®] (=> Select
icons = (@] = [&)) = YES => (@]

Show New Message Indicator as 3D | => 3D Display Setting => (8] => ON => (u]
Animation

Menu Display Settings

f) = Settings => (8] => Display => (8] => Menu Display Set =>(m]

List View and Details View => Menu Display => (8] => List or Detail => (]
- Select View for menus from f=> Settings = (m].
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Set Main Menu Theme => Theme => (®] => Select a theme => (®]
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Change Icon Design (Original Theme)

=> Theme => (8] => Original Theme => (8] => Select a menu item = (] =>
Set an image
+ Change Main Menu icons to any preferred image.

Change Background (Original Theme)

=> Theme => (] => Original Theme => W) => Background Image => (] =>
Set an image
- Change Main Menu background to any preferred image.

Reset Original Theme Settings

=> Theme => (8] => Original Theme => (8] => Select a menu item = (@) =
Reset or All reset => (8] => YES => (m]

+ This procedure is only available when any Original theme settings have been
changed.

Save Last Selected Menu Item to
Memory

=> Memory Focus => (8] => ON => (m]

D= - &

Add a Menu Item to Original Menu

=> <Not Recorded> => (&) => [} to select a function => (m]

Change Order of Original Menu Items

=> Select an item => (@) => Sort => 8] => Select a position => (m]

Cancel Original Menu Items

=> Select an item => (@) => Release or Release All => (®] => YES => (m]

Reset Original Menu

=> (@) => Reset Org. Menu => (8] => YES => (m]
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Standby Indicators

Enable Indicator Selector (o) => Settings => (W) => Display => @) => Icons Setting => (] => ON => (m]

- The indicators at the top of Display are enabled by pressing (8] in Standby. Use &4 to
select an indicators and press (] to access the corresponding function.

Incoming Call/Message Alerts
fo) => Settings => (8) => Incoming Call => (u]

Adjust Ringtone Volume => Ring Volume => (8] => Phone, Video Call or Mail => (8] => (7] => [m]
+ When Step is set, the ringtone volume increases every three seconds. When Silent
is set, no ringtone sounds.
Set a Ringtone => Select Ring Tone => (8] => Phone, Video Call or Mail => (8] => Select
Ring Tone => (W) = Select an item => (8] => Select a folder => (] =>Set a
ringtone
Q Set Random Playback of Melodies as | = Select Ring Tone => (] => Phone, Video Call or Mail => (®] => Select
g" Ringtones Ring Tone => (8] => Random Melody => (] => Select a folder => (m]
3 - Melodies in the selected folder are played at random as ringtones.
§. Set Ringing Duration of Incoming = Mail Ring Time = (8] = Mail = (8] => ON => (8] = Enter ringing
o  Message Ringtone duration
3 + When OFF is set, no ringtone sounds and handset does not vibrate when receiving
_m messages.
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Set Vibration*

=> Vibrator => () => Phone, Video Call or Mail => (8] => Select a pattern => (8]
+ When Melody Linkage is set, handset vibrates to the melody set as ringtone.

Set lllumination Color

=> lllumination => (] => Set Color => (8] => Phone, Video Call or Mail =>
(@) => Select a color => (]

Set lllumination Pattern

=> lllumination => (W) => Set Pattern => (8] => Standard or Melody

Linkage => (m]

- Even when Melody Linkage is set, lllumination may not flash to the melody
depending on the set ringtone.

Set lllumination to Flash for Missed
Calls/New Messages

=> lllumination => (8] => Missed Info => (] => ON => (a]

Set an Incoming Call/Message Image

=> Select Ring Tone => (8] => Phone, Video Call or Mail => (] => Select
Calling Disp. or Select Receiving Disp. => (8] (=> My Picture or Videos =>
(m]) => Set an image/video

Show Phone Book Entry Images for
Incoming Calls/Messages

=> Disp. Phone Book Image => (8] => ON => [u]

* When Vibrator is not set to OFF, be careful not to let handset fall off a desk or slide too close to a stove, etc. when it vibrates.

b => Settings = (W) => Slide-style Setting => (u]

Open New Mail Window by Opening
Handset

=> Setting When Open => (8] => Display New Mail => (&) =>
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Open Missed Calls Window by
Opening Handset

=> Setting When Open => [8) => Display Missed Call => (] =>
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Answering Incoming Calls
b => Settings => (8) => Incoming Call => (8]

Set to Answer Calls by Pressing Any | => Answer Setting => (8] => Any Key Answer => (1]
Key - Answer incoming voice calls by pressing a key from (7], (W), (0 - (97, (%), (ceaq),
(®), () and IG8. The any key answer function is disabled for incoming video calls.

Set to Mute Ringtone by Pressing Any | => Answer Setting => (8] => Quick Silent => (]
Key + Mute the ringtone by pressing a key from (0] - (9, (33, [a=a, (€] (for voice calls
only), and K3 or by opening handset.

b = Settings => (8] => Slide-style Setting > (®]

Set to Answer Calls by Opening => Setting When Open => (8] => Answer Incoming => (8] =
Handset + When set to ON, opening handset starts call even if Answer Setting is set to Quick
Silent.
+ When set to OFF, operation follows Answer Setting.
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Manner Mode

b => Settings => (8] => Incoming Call => (8] => Manner Mode Setting => (8]

Set Manner Mode Type

=> Manner Mode Set => 8] => Select a Manner Mode => (8]
+ When Super Silent is set, all tones emitted through the earpiece are also muted.

Configure Original Manner Mode

=> Manner Mode Set => (8] => Original => (8] => Set each item =>

Set Time for Auto Manner Mode Start

=> Manner Start Time => (8] = Start Time Set1 or Start Time Set2 =
= [ => (8] = Enter time = (8] = & => (8] => 1 Time, Daily ([) or Select
Day () => (@] => (Select day => (&) =

Set Time for Auto Manner Mode
Release

=> Manner Release Time => (] => Release Time Set1 or Release Time Set2
= (&) = 03 => (8] => Enter time => (W) = & => (&) => 1 Time, Daily () or
Select Day ({ll) => (w) => (Select day = [®)) =>

Toggle Auto Manner Mode Start and
Release On/Off

=> Manner Start Time or Manner Release Time => (8] => Select an item =

- On/off toggles each time you press (). Settings (e.g., time) are not updated.
+ Use the following procedure to cancel all settings at once.
=> (@)=> Release All => (8] => YES => (m]
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Checking Call Logs
b => Settings => (8) => Incoming Call => (8]

Change Colors of Names, Phone => Disp. Call/Receive No. => [B] => Select a color => (m]
Numbers and E-mail Addresses in Call |. pressing (=) toggles the color palette between 16 colors and 256 colors.
and Message Log Windows - To reset the color settings to default, press ().

Sounds

f) = Settings => (m) => Other Settings => (m]

Set to Play Charging Start/End Tones |=> Charge Sound => (8] => ON => (u]

Sound Emitted at Level 1 for First => Volume Restriction => (8] => ON => [&]

three Seconds - Applies to ring tone and alarm.
- After three seconds pass, ring tone and alarm sounds at set volume.

[ <> Settings > (W) = Slide-style Setting > (u]

Set Handset Open/Close Sound => Slide Sound => [8) => Open Sound or Close Sound => Select a sound =
(] => Ring Time => (®) => Select time sound emitted => (&)
+ Slide and close sounds not emitted when set OFF.
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e =) () = Tools => (8] => Voice Announce => (8]

Record Sound to Set as Ringtone or
Outgoing Message

=> Select an item = (@] => YES => (8] => Record sound (for about 15
seconds)
- Press (W) to stop recording.

Play Recorded Sound

=> Select an item with “%* => (&]

Delete Recorded Sound

=> Select an item with " = (@] => Erase => (8] => YES => (u]

Earphone-Microphone

b = Settings = ()

Audio Output

=> External Connection => (8] => Headset Usage Setting => (8] =>
Headset+speaker or Headset Only => (m]

Microphone Setting

=> External Connection => 8] => Headset Mic. Setting => (8] => Built-in
Microphone or Headset Microphone => (1]

Answer Calls Automatically

=> External Connection => (8] => Auto Answer Setting => () => Phone or
Video Call => (m] => ON => (] => Enter ring time

Save a Phone Number to Dial with an
Earphone-Microphone

=> Dialing => (8] => Headset SW to Dial => (8] => Voice Call => (] =>
Select a Phone Book search method => (8] => Search Phone Book = Select
an entry => (8] => Select a phone number => (1]
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Phone Book

Set Preferred Search Method [Phone Book Search] window (P. 2-23) =>Select a search method = (8] =>

OK => (m]

+ To cancel the preferred search method, press in Phone Book Search window,
select the search method with “¥,” and then press (=.

Change Group Name [Phone Book Entry List] window (P. 2-23) => (@] => Group Setting => (] =>

Select a group => (8] => Edit group name => (]

+ The name remains the same only for No Group.

Do Not Send Phone Book Entry (e => Tools => (] => Forwarding Image => (8) => OFF => (u]
Images via Infrared

S! Addressbook Back-up

b = Tools = (m] => S! Addressbook Back-up => (u]

Set Auto Synchronize => Auto Sync Settings => (8] => ON/OFF => (8] => ON => (8] => Enter
Security Code => (] => Set synchronize timing => (8] (=> Set synchronize
cycle and day = [®)) => Select synchronize type => (] => YES => (®] (twice)

Check Auto Synchronize Settings Auto Sync Settings => (W) => Confirm Settings = (u]
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Outgoing Calls

fe) = Settings => (8] => Dialing => (u]

Save Area Code and Country Code as
Prefix Numbers

=> Prefix Setting => [®) => Select an item = (&) => Enter name => (8] =>
Enter prefix numbers => (]

Save Touch Tones

=> Pause Dial => (] => &) => Enter touch tone numbers => (m]
+ Press and hold to enter “P” (Pause).

Set Numbers after “%" as Sub Address

=> Sub-address Setting => (8] => ON => (]

International Calls

f) => Settings => (8] => Dialing => (W) => Int'l Dial Assistance => (u]

Change International Access Code
Automatically Dialed with “+”

=> Auto Int’l Call Set. => (] => ON => 8] => Select a country code => (®] =>

ERRE > )
+ When OFF is set, the international access code is not entered when you press and
hold (0.

- Select an international access code you set in IDD Prefix Setting.

Change a Country Code

=> Country Code Setting => (8] = Select an item => (8] => Enter country
name => (8] => Enter country code => (1]
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Save an International Access Code

=> IDD Prefix Setting => (] => Select an item => &) => Enter international

access name = (®] => Enter international access code => (]

P
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Call Settings

b => Settings = (8) = Talk => (u]

Set Reconnection Tone

=> Reconnect Signal => (8] => High Tone or Low Tone => (m]

Set Noise Reduction

=> Noise Reduction => (8] => ON => (m]

Set Weak Signal Alarm

=> Quality Alarm => (] => High Tone or Low Tone => (1]

+ Calls may be disconnected without sounding the alarm when signal suddenly
becomes too weak.

Set Clarity of Other Party Voice

=> Hyper Clear Voice => (] => High, Low and OFF => (m]

Automatically Record During Voice
Call

=> Auto Voice Memo => (8] => ON => (u]
+ Record latest 60 seconds of call (two recordings).

Set a Hold Message

=> Set Hold Tone => (8] => On Hold Tone => (8] => Select a hold tone => (m]

Call Costs

fe) => Settings => (8] => Call Time/Charge => (8]

Set Auto Reset of Total Call Cost
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=> Auto Reset Total Cost => (8] = Enter Security Code => (8] => Auto
Reset => (8] => ON or OFF => (8] => Enter PIN2 => (]

+ When ON is set, the total call cost indication is automatically reset to zero at twelve
midnight on the first day of each month.
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Set/Cancel a Maximum Call Cost
Limit*

=> Set Max Cost Limit => (8] => Enter Security Code = (8] => @ => (@] =>
Enter cost limit = (] => [ => (@] => ON => (m] => Set alarm tone => Set
alarm volume => (&) = Enter PIN2 => (m]

+ A call ends automatically and % appears in Display when the total call cost exceeds
the set maximum limit.

+ When the set total call cost limit has been reached, all outgoing calls are disabled. To
enable outgoing calls, set the maximum call cost limit to 0O:
=> Set Max Cost Limit => (8] => Enter Security Code = (m] => E3 => (] (twice)=>
=> Enter PIN2 => (m]

* Cost display may not be available depending on your subscription. If unavailable, you will also be unable to set a cost limit.

Video Calls

fe) = Settings = (8] => Video Call =>(m]

Set an Image to be Sent during Video
Calls

=> Select Image => 8] => Select an item => (8] => Pre-installed or Original
= (w]

+ To set an image other than the preinstalled image:
=> Original = (8] => Change Setting = (m] = Set an image

Redial Automatically as Voice Call
When Video Call Connection Fails

=> Auto Redial as Voice => (B] => ON => (u]

Set an Image to Appear in Main
Window

=> Display Setting => (8] => Main Display => (8] => Other Side or My Side
= (=]

Automatically Switch to Handsfree
Mode in Video Calls

=> Hands-free Switch => (&) => ON => (m]
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Global Roaming
fe) => Settings => (8] = Int’] Roaming Set => (8]

=> NW Search Mode => 8] => Manual => (8] => Select an operator => (1]

+ When Auto is set, an available operator is set automatically.
+ Use this procedure when handset is out of the service area of the currently used

operator.

Activate Network Re-search for an => NW Search Mode => (8] => Network Re-search => (8] => Select an
Available Operator operator = E]

+ An operator is available when NW Search Mode is set to Manual.

=> PLMN Setting => 8] => Select an operator => (@) => Change Priority =>
(@) = Select a position on the priority list = (8] = (@] => YES => (&)

- When Auto or Network Re-search is set under NW Search Mode, you are
automatically connected to the highest priority operator among available operators.

Set Operator

Set Priority for Operators

Show Operator Name While Roaming | => Display Operator Name => (8] => Display ON => (u]
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S! Mail Settings
= Mail Setting > (8]

Edit Header/Signature

=> Header/Signature => (8] => Edit Header or Edit Signature => (8] (twice)
=> Edit header/signature =>

Insert Header/Signature
Automatically

=> Header/Signature => (] => Insert Setting => (8] => Header or Signature

= (m] = ([

Set to Check Delivery

=> SI Mail Settings => (8] => Delivery Report => (8] => ON => (m]

- After a recipient receives your S! Mail, a message titled S! Mail Report is sent to your
handset.

SMS Settings

=> Mail Setting -> (8] => SMS Settings -> (1]

Set to Check Delivery

=> SMS Report Request => (8] => ON => (u]
- After a recipient receives your SMS message, a message titled SMS Report is sent to
your handset.

Set Server Storage Period of SMS
Messages

=> SMS Validity Period => () => Select a period = (8]
+ When None is set, SMS messages you send are not stored on the server.

Set SMS Input Language

=> SMS Input Character => (8] => Japanese (70char.) or English (160char.)
= (]
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Incoming Message Settings

= Mail Setting > (8]

Customize E-mail Address

=> Custom Mail Address => (8] => Follow onscreen instructions

Do Not Show Emotion Indicators

=> Emotion/Keyword => 8] => Take the checkmark off from Disp. Emotion
=

Show Keyword Indicators

=> Emotion/Keyword => (8] => Put a checkmark to Disp. Keyword =>

Select a keyword entry field => (8] => Enter keyword => (8] =>

+ When handset receives an S! Mail containing the specified keyword, a keyword
indicator 4V - /@ appears.

+ In case a message contains both the content that matches an emotion indicator
(P. 5-7) and a specified keyword, the keyword indicator takes priority.

Delete Keywords

=> Emotion/Keyword => (8] => Select a keyword = ®) => Delete Keyword
or Delete All Keyword => (8] => YES => (@] =>

Set Priority When Receiving Messages
during Operation

=> Receiving Setting => (8] => Alarm Preferred or Operation Preferred =>

(w)

Set Whether to Read Out Received
Messages

=> Read Out Setting => (W) => Read Out Received Mail =>(®] => ON or OFF
= (a]

Set Voice to Read Out Messages
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=> Read Out Setting => (8] => Select Voice => (8] => Select a voice type =

(w)

Set Manual Receive

=> §I Mail Settings => (8] => Message Download => (8] => Manual => (u]
+ The entire text is receivable by user operation.
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Reply Settings

Change Quotation Marks

=> Mail Setting => (8] => Header/Signature => () => Edit Quotation
Marks => (@) => Edit quotation mark => (®]

Message View Settings
= Mail Setting => (u)

& Others

Set Message List View

=> Mail List Disp. => (W) => 2 Lines, 1 Line or 1 Line+Body => (] => Subject,
Name or Address => (]

Play Attached Melodies Automatically

=> Start Attachment (auto) => (8] => ON = (=]
-+ Automatic play only for received mail.

Set Number of Text Lines to Scroll

=> Scroll => (8] = 1 Line, 3 Lines or 5 Lines => (®]

Set Font Size of Text

=> Font Size => (8] => Select a size = (m)

Check Mail Settings

=> Check Settings => (m]

Reset Mail Settings

=> Reset => (W] => Enter Security Code => (8] => YES => (m]
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SMS Server Settings

f) = Settings = [®) => Connection Settings => (8] => SMS Center Selection =>(u]

Change SMS Center Address

=> 819066519300 => 8] => Enter SMS Center address => (m] =>

International or Unknown => (]

+ Adress is 819066519300 by default. SMS may become unavailable if Center address
is changed.

Reset to SoftBank SMS Center
Address

=> Reset => @] => Enter Security Code => (@) = YES => (m]
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Internet

Internet

SRR AN CRETD Press and hold (] => Browser Settings => (8]
Sl RIS GV Press and hold () => PC Site Browser => (8] => PC Site Brw. Settings —> (8]

Set Scroll Unit/Speed

=> Scroll => (8] => Whole Page, Half Page or Single Line => (m]

Set Whether to Show Images or Play
Melodies

=> Downloads => 8] => Display Images or Play Sounds => (8] => ON or
OFF => (m]

Clear Cache

=> Memory Manager => () => Delete Cache => (8] => Enter Security Code

= (@] = YES = (]

Delete Cookies

=> Memory Manager => 8] => Delete Cookies => () => YES => (m]

Initialize Memory Status of Internet

=> Initialized Browser => (8] => Enter Security Code => (8] => YES => (u]

Set Whether to Send Manufacture
Number

=> Security => (8] => Manufacture Number => (8] => ON or OFF => [u]

Set Whether to Send Referer

=> Security => (8] => Send Referer => (8] => ON or OFF => (m]

Enable/Disable Cookies

=> Security => (] => Cookie Settings => (8] = Select an option => (8]

Set Whether to Activate Scripts

=> Security => (8] => Script Settings => () => Select an option => (&)

Check Internet Settings

=> Check Settings or Check PC Site Brw. Set => (m]

(o]
[
(U]
-
o
3
N
[
[=
o
3

Reset Internet Settings

=> Reset or Reset PC Site Brw. Set => (8] => Enter Security Code => (8] => m_

YES => (m]
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Yahoo! Keitai

St Press and hold () => Browser Settings => (8]

Set Font Size => Font Size => (®) => Select a size => (m)
Set Flash® Sound On/Off => Flash Sound Effect => (8] => ON or OFF => (u]

PC Site Browser

Press and hold () => PC Site Browser => (8] => PC Site Brw. Settings = (8]

Do Not Show Alert When Activating |=> Warning Messages => (8] => OFF => (m]
PC Site Browser & Switching Browsers

=> Display Mode Settings => () => PC Screen or Small Screen => (8] =>

Set Page Layout
Select a size = (m)

Network Connection Settings

Set Whether to Send Location (e => Settings => (W) => Send Location Info => (8] => Enter Security Code
Information => (m] => Confirm, Send or Not Send => (u]
+ Set to Confirm or Send to obtain information.
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TV

Channel List
[y => TV => (@) => Channel List > (a]

Change Title of Channel List

=> Select a channel list = (@) => Edit Title = (®] => Edit title => (®]

Delete a Channel List

=> Select a channel list => (@] => Delete This => (8] => YES => (m]
+ The currently used channel list cannot be deleted.

Assign Channels to Remote Control
Numbers

=> Select a channel list => (2] => (@) => Remote Control No. => (] => Select
a remote control number => (8] => Select a channel => (8] => Repeat the
same step = (&) => YES = (u]

Delete a Channel

=> Select a channel list = |®] => Select a channel => |®] => Delete This =
(m] = YES => (m]
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Image & Sound
fe) = TV => (m] => User Settings => (8]

Set Subtitle Display => Subtitles => [8) => ON (Wide: Bottom), ON (Wide: Top) or OFF => (m]

Show/Hide Icons in Landscape View |=> Icon Always Show => (8] => ON or OFF => [u]
- Icons other than for program title no longer displayed if set to OFF.

Save Battery by Dimming Backlight |=> TV Power Saving => (] => YES => (&]

Keep Backlight Lighted While => Display Light => (8] => Constant Light => (&)

Watching TV

Set Time Backlight Stays Lit While => Display Light => (8] => Lighting Duration => (8] => Enter lighting time
Watching TV > (m]

Set Sound Effect => TV Effect = (8) => Sound Effect => (] => Select an effect = (m]

Set Visual Image Effect => TV Effect => (8) => Visual Image Effect => (8] = Select an effect => (1]
Set TV to Pause or Continue for => Time Shift Setup => (8) => Auto ON or Auto OFF => (]

Incoming Calls (Time Shift Playback)

b uoneziwolsn)
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Data Broadcasts

b = TV => (m] => User Settings => (8] => Data BC Settings —> (8]

Set Whether to Show Images in Pages
Accessed from Data Broadcasts

=> Set Image Disp. => (8] => ON or OFF => (m]

Enable/Disable Sound Effects of Data
Broadcasts

=> Sound Effect => (] => ON or OFF => (m]

Set Whether or Not to Show
Confirmation Window Again

=> Reset Disp. Set. => (] => YES or NO => (u]

+ Once you select YES (By default) in a confirmation window for accessing a web
page from Data Broadcast, the window no longer appears. Use this procedure to set
the window to reappear.

Recording Programs

Continue/End Recording at Low
Battery

bew) => TV => (m] => User Settings => (8] => Rec. While Low Battery => (8] =>
ON or OFF => (u]

F uoineziwoljsn)
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Other Settings

fe) = TV => (m] => User Settings => (8]

Check TV Settings

=> Check TV Settings => (m]

Reset Channel Settings

=> Reset Channel Setting => (8] => Enter Security Code => (] => YES => (m]

Clear Data Broadcast Memory

=> Reset Storage Area => (8] => Select an affiliated station = (@) =>
Delete This or Delete All => (] (=> Enter Security Code => (®]) => YES =>

(w)

Rest TV Settings

=> Reset TV Settings => () => Enter Security Code => (8] => YES => (a]

b uoneziwolsn)
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- Camera

Cameral/Video Settings

Set Image Quality

[Photo Viewfinder] (P. 7-5)/[Video Viewfinder] (P. 7-7) = |®] => Quality
Setting => (8] = Select a quality = (u]

Set File Size

[Video Viewfinder] (P. 7-7) => => Select a file size => (®]

Set White Balance

[Photo Viewfinder] (P. 7-5)/[Video Viewfinder] (P. 7-7) => (6 => Select an

item => (m]

- In Photo Viewfinder, you need to set Photo Mode (P. 7-13) to OFF before setting
white balance.

Reduce Flicker

[Photo Viewfinder] (P. 7-5)/[Video Viewfinder] (P. 7-7) = |®] = Camera
Settings => (W] => Flicker => (8] => Auto, Mode 1 (50Hz) or Mode 2 (60Hz)

=> (m]

Set Shutter Sound

[Photo Viewfinder] (P. 7-5)/[Video Viewfinder] (P. 7-7) = |®) => Shutter
Sound => (®] => Select a shutter sound = (m]

Set Display for Handset Closed
Shooting

[Photo Viewfinder] (P. 7-5)/[Video Viewfinder] (P. 7-7) = (&) = Icon
Always Show => (8] => ON or OFF => (u]

+ Below icons do not appear if set to OFF.
@ Photo Viewfinder
Focus Frame, Auto Timer, Number of Files That Can Be Saved
@ Video Viewfinder
Auto Timer, Storage Capacity, Recording Status, Recording Time (remaining)

Set Interval for Continuous Shooting

[Continuous Shooting Viewfinder] (P. 7-10) => (®) => Interval/Number =>
(@) = Shot Interval => (®] => 0.5 Seconds, 1.0 Seconds or 2.0 Seconds =>

(w]

F uoineziwoljsn)
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- Camera

Set Number of Shots for Continuous |[Continuous Shooting Viewfinder] (P. 7-10) => (®) = Interval/Number =>
Shooting (@) => Shot Number => (8] => Enter Shot Number => (u]

File Storage & Continuous Shooting

Set Storage Location for Shot Still [Photo Viewfinder] (P. 7-5)/[Video Viewfinder] (P. 7-7) = @] => Select to
Images/Videos Save = (®] = Phone or microSD => (] => Select a folder => [m]

- To save videos on memory card, select a folder of Inbox.
Save Shot Still Images/Videos [Photo Viewfinder] (P. 7-5)/[Video Viewfinder] (P. 7-7) = |®) => Auto save
Automatically Set => (m) => ON => (m]

- Still images and videos shot with handset camera are saved to the folders specified
in Select to Save.

b uoneziwolsn)
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- Player & S! Appli

Playback Window

Change Playback Window Mode

[Video Player Playback] window (P. 9-5) => (@] => Action Setting = (] =>

Screen Setting => (8] => Normal Screen Mode or Full Screen Mode => (u)

Change Design of Playback Window

[Music Player Playback] window (P. 9-5) => (@) => Action Setting => (®) =>

Change Skin => (] => Select a design => (]

Set Image Display Size

[Video Player Playback] window (P. 9-5) => (@] => Action Setting => (] =>

Set Image Disp. => [8) => Normal or Fit in Display => (]

When Running S! Appli

[ = S1 Appli => (B) => Settings > (8]

Set Sound Volume

=> Sound)/Vib Settings => (8] => Volume => (8] => ({] to adjust volume =>

(w]

Set Vibration

=> Sound/Vib Settings => (] => Vibration => (8] => ON or OFF => (u]

Set Backlight

=> Backlight Settings => (8] => Switch ON/OFF => (m] => Always ON,
Always OFF or Link To Phone Set. => (]

Set Blinking of Backlight

=> Backlight Settings => (8] => Blink => (8] => ON or OFF => (m]

SERNEE () => ST Appli => (B) => S! Appli List => (8]

F uoineziwoljsn)

Allow/Prohibit S! Appli to Connect to
Network

=> Select an S! Appli = [®) => Security Settings => (] => Net Access = (8]

=> All Permit, Prompt at 1st only, Prompt each time or Disable => (m]
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- Player & S! Appli

Allow/Prohibit S! Appli to Write => Select an S! Appli = (@) => Security Settings => (8] => Write User Data

Personal Information => (m] => All Permit, Prompt at 1st only, Prompt each time or Disable =>
(m]

Reset Security Settings of S! Appli => Select an S! Appli = (@) => Security Settings => (W) => Reset Security
Set. => (m] => YES => (m]

S! Appli Settings
b => S1 Appli => (8] => Settings => (m]

Reset S! Appli Settings => Reset => (W] => Set to Default => (8] => Enter Security Code => (8] =>
YES = (m]

Delete All S! Appli => Reset => (8] => Delete All S! App => (8] = Enter Security Code => (@] =
YES = (m]

b uoneziwolsn)
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- Entertainment

Mobile Widget Settings

fe) = Entertainment => (8] => Mobile Widget => (m] => Settings —>(u]

Set Whether to Use Mobile Widget

=> Standby Disp. Set. => (8] => ON or OFF => (m]

Check Auto Synchronize Settings

=> Auto Refresh => (8] => ON or OFF => (m]

Set Whether to Automatically

=> Auto Roaming => (] => ON or OFF => (u]

Transmit When Abroad
Delete All Widgets from Desktop => Delete Content => (] => Select a Desktop page = (8] => YES => (m]
Page - All Widgets in selected Desktop page are deleted.

Set Whether to Use Cookies

=> Cookies => (@) => ON or OFF => (m]

Delete Cookies

=> Delete Cookies => (@] => YES => (m]

F uoineziwoljsn)
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- Entertainment

S! Quick News
f) = Entertainment => (8] => SI Quick News => (8] => Settings => (m]

Hide S! Quick News in Standby => Standby Settings => (8] => Standby Disp. Set. => (8] => OFF =>
(m] (twice)
Set Ticker Speed => Standby Settings => () => Speed Settings => (8] => Fast, Normal or

Slow => (] (twice)
Set Information to appear in S! Quick |=> Standby Settings => (8] => Unread & Read Set. => [8) => Unread Only

News or Unread & Read => (8] (twice)

Hide S! Quick News Images => Set Image Disp. => (8] => OFF =>(®] (twice)

Reset S! Quick News Registered => Del. Quick News => [8) => YES => (8] (twice) = Enter Security Code =>
Contents (®) (twice)

b uoneziwolsn)
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- Entertainment

S! Info Channel

f) => Entertainment => (8] => S! Info Ch./Weather => (8] => Settings > (8]

Set Whether to Display Desktop Icon
For New Received Information

=> S!I Information Notif. => (] => ON or OFF => (m]

Set Font Size for Web Pages

=> Font Size => (8] => Select font size => (m]

f) = Settings => (] => Display => (8] => Font => (u]

Set Font Size

=> Character Size => (8] => Separate Setting => (] => S! Info Ch. => (m] =>
Select font size => (]

Weather Indicators

{» = Entertainment => (] => S! Info Ch./Weather => (8] => Weather Indicator = (8] =

Settings = (1]

Set Whether to Automatically Update
Weather Information

=> Weather Update => (8] => ON or OFF => (m] (=> YES => (m))

Set Whether to Display Weather
Indicators in Standby

=> Standby Setting => (8] => ON or OFF => (]

Set Whether to Display Desktop Icon
For New Received Information

=> Weather Notif. => (8] => ON or OFF => (m]

F uoineziwoljsn)
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- Other Settings

b uoneziwolsn)

Text Entry

fe) => Settings => (8] => Other Settings => (] => Character Input Set => (8]

Set Text Input Method

=> Input Mode => (8] => Select an input method => (m]

Set Word Prediction

=> Prediction => (8] => ON or OFF = (u)

Set to Show T9 Suggestion Words in
Kanji or Hiragana

=> T9 Change Mode => (8] => T9 Kanji Change Mode or T9 Kana Change
Mode => (m]

Clear Learning History

=> Clear Learned => (8] => Enter Security Code => (] => T9/Expect Words/
Pic. or Kana/Kanji Change/Face => (8]

Change Font Size

=> CHG Input Size => (] => Select a size => (W]

Set Auto Cursor Movement in 5-Touch
Mode

=> Auto Cursor => (8] = Fast, Normal, Slow or OFF => (a]

Key/Touch Sensor

fe) = Settings => (] => Key/Touch Sensor => (8]

Set Key/Touch Sensor Sound Off

=> Keypad Sound => (8] => OFF => (m]

Change Function Assigned to Shortcut
Key

=> Shortcut-key Setting => (8] => Select a function => (8] => YES => (m]

+ Alternatively, press and hold (®] in Standby to set Shortcut-key Setting.
- To return to original settings, press (@), select Reset Shortcut-Key, and press ().
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- Other Settings

Set Touch Sensor Backlight

=> Touch Sensor Setting => (8] => ON => (8] => Backlight => (8] => Select a

color => (m)

Set Vibrator and Illlumination for
Touch Sensor Operation

=> Touch Sensor Setting => (8] => ON => (] => Touch Sensor Linkage =>
(] => Vibrator or lllumination => (] => ON or OFF => (m]

Set Touch Sensor Scroll

=> Touch Sensor Setting => (8] => ON => (8] => Scroll => (8] => ON or OFF

=> (]

+ Touch Sensor scrolling will be available for web pages and Message Details window

when set to ON.

Set Not to Use Touch Sensor

=> Touch Sensor Setting => (8] => OFF => (m]

Key lllumination

SERLEE) (o) => Settings = (8] = Hllumination => (8] => Key Hlllumination => (8] => ON => (m]

Set lllumination for Power On/Off

=> Power ON or OFF => (®] => Set Pattern => (8] => ON or OFF => (®]

Set Flashing Color for Power On/Off

=> Power ON or OFF => (®] => Set Color => (8] => Select a color => (]

Set Flashing Pattern for Call Start

=> Talking Start => (8] => Set Pattern => (8] => Select a pattern => (m]

Set Flashing Color for Call Start

=> Talking Start => (8] => Set Color => (®] => Select a color => (m]

Set lllumination for Emotion-
Expressing Mail

=> Emotion => (8] => Always, Unread Mail Only or OFF => (m] => Scroll =>

(=] => ON or OFF => (m]

F uoineziwoljsn)

Set Flashing Pattern for Alarm
Notification

=> Alarm => (] => Set Pattern => (8] => Select a pattern = (]
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- Other Settings

Set Flashing Color for Alarm => Alarm => (8] => Set Color => (] => Select a color => (m]

Notification

Set lllumination for Snooze => Snooze = (W) => Set Pattern => 8] => ON or OFF => (m]

Notification

Set Flashing Color for Snooze => Snooze => (8] => Set Color => (m] => Select a color = (u]

Notification

Set Illlumination for Ir/IC Transmission |=> Ir Exchanging or IC Exchanging => (8) => Set Pattern => (8] => ON or
OFF => m]

Set Flashing Color for Ir/IC => Ir Exchanging or IC Exchanging => (8] => Set Color => (] => Select a

Transmission color = (m)

llluminate When Charging Begins => Charge Starting => (8] => Set Pattern => 8] => ON or OFF => (u]

Set Flashing Color (When Charging | => Charge Starting => (8] => Set Color => (] => Select a color => (u]

Begins)

Set Flashing Pattern for Handset => Open or Close => (W) => Set Pattern => 8] => ON or OFF => (a]

Open or Close

Set Flashing Color for Handset Open |=> Open or Close => (8] => Set Color => (] (=> YES => (m]) => Select a color
or Close > (m)

b uoneziwolsn)
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- Other Settings

Key Backlight

SERdEEE) b = Settings => (8] = Hlumination => (u]

Set Key Backlight Color

=> Key Backlight => () => Select a color => (m]

Set Key Backlight Off

=> Key Backlight => (] => OFF => (u]

Osaifu-Keitai®

Set illumination for IC Card

(e => Tools => (@) => Osaifu-Keitai => () => IC Card Illlumination => (®] =>
ON or OFF => (u]

Delete all Lifestyle-Appli

(e => SI Appli => (8] => Settings => (8] => Reset => (8] => Delete All
LifeApp => (8] = Enter Security Code => (8] => YES => (m]

Set Whether to Enable Opening from
Browser

fe) => Tools => (W) => Osaifu-Keitai => (W) => Interface Settings = (8] =>
Enter Security Code => 8] => Browser => (8] => ON or OFF => (m]

F uoineziwoljsn)
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- Other Settings

Bluetooth®

fe)=> Tools => (8] => Bluetooth => (8] => Bluetooth Settings —> (u]

Set Detection Time for Device => Time-out to Search => (8] => Enter search time => [u]

Set Whether to Send Ring Tone for  |=> Forward Ring Tone => (8] => ON or OFF => (u]

Voice Call, Video Call to Headset or  |. ging tone will also sound from handset if Headset Usage Setting is set to
Handsfree Device Headset+speaker and Forward Ring Tone is set to OFF.

Set Whether to Enable Calling from => Dial From Other Device => (8] => Valid or Invalid => (m)
External Device
Check Handset Bluetooth® => Bluetooth Info => (m]

Information « Press (&) to change name of added device.

Resetting Handset
f) = Settings => (m) => Other Settings = (m]

Reset All Settings to Default => Reset Settings => (B] => Enter Security Code => (8] => YES => (m]

Initialize Handset to Default Status | => Initialize => (8] => Enter Security Code => (8] => YES => (8] => YES => (u]

+ When the initialization is completed, handset automatically shuts down and restarts.

+ When handset is initialized, all data downloaded and saved on handset are deleted
and cannot be restored.

+ Your Security Code will also be reset to default.

b uoneziwolsn)
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b xipuaddy

Multitask Combinations

Function Yahoo! A igi
q el S! A Data Optional | Phone | Own A Original
Ic\“:_"e"tF'y t' skl rlffeI:\at: Appli SRR Folder Tk Services | Book Data BRES)n (e Menu
ctive Function
Mail Group 0? |O O (oX O 08 O o" O O O O O
Function
Yahoo! Keitai O |x O 0 @) o8 |O o" O @) O @) @)
Group Function
S! Appli Group O O X 08 O o8 O o" O O O O O
Function
Settings Group o |0 O X 0O 08 X o O O O O O
Function
Tools Group O |0 @) 0% X X O X X 0% |0 |x @)
Function’
TV & Music Group |03 |04 o> |o® o4 ol O o3 O X X O'6 O
Function
During a Voice Call (O |O X x7 X 0° oniz |03 O X x15 | x e)
During a Video Call | x X X X X x10 x X X X X X X
During Packet O @) @) 0 O 08 0 o 0 % <15 |0 0O

Transmission with a

PC Connected

O: Can be activated.

X : Cannot be activated.

1 Except Receive Ir Data and USIM Operation which cannot be activated with another function.
2 Compose Message and Compose SMS cannot be activated at the same time.
3 Audio functions such as those for reading out messages and playing mail-attached melodies cannot be activated at the same time

as Music Player.
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Multitask Combinations

Audio functions such as those for playing melodies and videos cannot be activated at the same time as Music Player. TV is
temporarily paused.

S! Appli cannot be activated when Music Player is playing. TV is temporarily paused.

Cannot be activated depending on the function.

Only Pause Dial, IC Card Lock Set., Keypad Sound and Network Status are available.

Receive Ir Data, microSD Manager, Voice Announce and USIM Operation are unavailable.

Only the following functions are available: Schedule, Calculator, Dictionary, Text Memo, To Do List, IC Card Lock Set.,
S! Addressbook Back-up, Account Details, Bluetooth and voice memo during a call.

Voice memo during a call is available only when you press and hold [J.

Playing messages at Voice Mail Center is impossible.

Caller ID Notification is unavailable.

Restrictions is unavailable.

Common Phrases, Own Dictionary and DL Dictionary are unavailable.

Only Booking Program List, Timer Recording List and Program Guide (only during packet transmission) are available.
Camera cannot be activated when Music Player is playing.

-
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- Software Update

b xipuaddy

Check if software on handset needs to
be updated, and update it through the
network if necessary.

@ Before updating software, turn off
handset and restart it to make sure that
all handset functions have ended.

@ Disconnect the USB cable from handset.
The software update, if it is done with
the USB cable connected, may not be
properly completed.

@ No transmission fees apply to check or
update software.

@ Updating software may take 30 minutes
or so. Wait for the software update to
finish before using handset.

@ Make sure battery is sufficiently charged
before updating software.

@ Update software in a location of good
signal reception. Do not change
locations while updating software.

@ Never remove battery or USIM Card or
turn off handset while updating
software.

@ Other handset functions are available

once the software update is completed.
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@ Data saved on handset is retained when
you update software. However, data
may be lost depending on the handset
condition (e.g. a malfunction). We
recommend that you make backups of
important data (though it may be
impossible to back up some
downloaded data) before updating
software. SoftBank is not liable for any
data loss.

@ If software update fails, handset may
become inoperable. If this happens,
contact SoftBank Customer Center,
Customer Assistance (P. 15-52).

IUpdating Software

@Y = settings > (w] =
Other Settings > (8] =
Software Update - (8]

@) software Update - (1]

A Software Update

We recommend that you
stay in a place with
a good reception while
executing Software

Undate. Sending/
receiving call/mail is
not available during
update. Continue?

€)Follow onscreen instructions

@ After Software is Updated

After an update completion message
appears, handset restarts automatically,
and update results appear.

A Software Update
Reboot completed.Now
checking updated
information.

Software Updated Window

Checking Update Results

@y => settings > (m] =
Other Settings —> (8] =
Software Update -> (8]

@) Update Result - (u)



- Software Update

Using Regular Updates

A confirmation for software update
appears at the scheduled time. Press (m]
or leave handset for a while to start
automatic software update.

@ If other functions are being used at the
scheduled time, software update
cannot start. End all functions to open
the software update confirmation
window (if you keep using other
functions for more than ten minutes
after a scheduled time, software update
is canceled).

-
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o F xipuaddy



- Troubleshooting

b xipuaddy

Problem Possible Cause & Remedy Refer to Problem Possible Cause & Remedy Refer to
Cannot turn on |ls battery properly installed? P 1-14 Cannot make |Is Keypad Lock active? P 4-4
handset. calls using - - - —

Is battery exhausted? P.1-22 Keypad Is Dial/Sending Mail specified to P 4-3
’ be locked in Original (Dial) Lock
It takes a long |It takes time if there are large - mode? ginal (Dial
time to turn on |amounts of data (e.g., Phone
handset. Book entries) saved on handset. Is Restrict Dialing set? P.2-26
Cannot charge |lIs battery properly installed? P 1-14 A message is  |Did you include the area code -
battery. heard saying when dialing a phone number?
Charging Is the cha}rger (sold separately) , P 1-17 that the
Indicator does |Plugged into an outlet properly? number you
notlight up.  [is the connector of AC Charger have reached is
correctly inserted into handset? not in service.
Battery drains  |Has the battery reached the end P 1-14 Only a busy Does Network is busy at this -
100 fast. of its service life? tone is heard moment Please try again later
The battery life may shorten after dialing a  |appear in Display?
depending on the usage phone number.
environment. Cannot receive |Is handset in Manner Mode? P.1-20
The battery operation time calls. : oo
fluctuates );cc%rding to how you The incoming IAS/Ihadndfet in Emission OFF P 4-7
use handset. ringtone does oae:
- - not sound. Is Ring Volume set to Silent? P.14-10
Cannot make |Is handset out of service area or in -
calls. a location with a weak signal?
Is @ maximum call cost limit set? P. 14-19
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- Troubleshooting

Problem Possible Cause & Remedy Refer to Problem Possible Cause & Remedy Refer to
The other Is the earpiece properly placed - Nothing Is Power Saver Mode activated? P 14-7
party’s voice is |against your ear? appears in - -
difficult to hear : : Display. !f handset is Ief‘l[ in a very hot place, -
during calls. Is anything obstructing the - it may automatically shut down.

speaker if it is in handsfree mode? If this happens, move handset to a

- location at an appropriate

Is the earpiece volume properly P 3-3, temperature (5 to 35°C) and wait

adjusted? P38 for a while until the keys become
The other Is the earpiece volume properly P.3-3, operable again.
party’s voice is | adjusted? P.3-8 Display is hard |Is Brightness under Backlight set | P. 14-7
Eca)ﬁslow during to see. to Dark?

- - Is ECO Mode set to ON? P 1-23

Handset is slow |This may occur when there are -
to react when |large amounts of data saved on Is Privacy Angle set to ON? P 14-6
keys are handset, or when large amounts - — -
pressed. of data are being transferred Dlsplgy Is Lighting under Backlight set P 14-7

between handset and memory backlight does  |to OFF?

card. not light.
Cannot hear Is Keypad Sound set to OFF? P 14-38 A message The image, vid_eo or song is unavailable -
key operation : appears instead |with the fun;t|on being used when any
tones. Is handset in Manner Mode? P. 1-20 of an image, of the following messages appear.

video or song. |Not available, Expiredfile and No

Side Key is Is Keypad Lock active? P 4-4 preview data
uﬁgsrﬁgfdset appears The image file may be corrupted. -
is closed. instead of an

image or preview.

-
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- Troubleshooting

b xipuaddy

Problem Possible Cause & Remedy Refer to Problem Possible Cause & Remedy Refer to
The Flash® clock |Is Keypad Lock active? P 4-4 Insert microSD |Memory card is not properly P 12-11
appearing in appears. inserted or may be damaged.

Standby is - -
stopped. Replace with a |Perform a scan disk on memory P 12-18
new one or card.
Images shot When shooting images indoors, P 14-31 check the disk
with handset  |flicker may occur due to appears.
camera flicker. |fluorescent lighting, etc. - -
Changing the Flicker setting may Network s This may be dug to errors or heavy -
help reduce flicker. busy at this traffic c.)n.the voice call lines or packet
moment transmission network. Try again after
Still images or Were the still images or videos P 14-31 Please try a while.
videos shot with  [shot with Flicker not set to again later Emergency calls to 110, 119 and 118
handset camera |Auto? appears. are still possible.
are too bright. Set Flicker to Auto. - -
Function End one of the currently active -
Still images or Select a Photo Mode suited to the | P. 7-13 cannot functions to continue operation.
videos shot with  [subject or scene. operate any
handset camera more appears.
are blurred.
Other These messages appear when you -
Cannot watch Is handset out of the digital - function try to use an unavailable function
TV. terrestrial broadcast service area active Cannot |when another function is active.
or in a location with a weak start appears.
signal?
Other
Are the channel settings done? P 8-5 function
- - active Cannot
Insert USIM USIM Card is not properly inserted | P. 1-12 operate
appears. or may be damaged. appears.
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Problem Possible Cause & Remedy Refer to
Memory This message appears when -
shortage operation is interrupted due to
appears. insufficient memory. Reboot

handset.
Connection Network connection is interrupted -
failed appears. |due to weak signal.

The page you are trying to access -

is very busy. Try again after a

while.
(microSD The indicator appears when a P.12-18
card indicator | defective memory card is inserted.
marked with ?)
appears.
Osaifu-Keitai® [Has the battery run out? P 1-22
cannot be used.

Has IC Card Lock or Call Remote P 11-4

Lock been set?

- Troubleshooting
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- Text Entry Key Assignments

Iln 5-touch Mode

b xipuaddy

15-10

Key |Kanji/hiragana Entry Mode | Katakana Entry Mode Alphanumeric Entry Mode Number Entry Mode
J BLIZBBNSAH FAOIF7AoTA 1 J@-:~" 1 1
hELIFT AFo4 32 abcABC2 2
TUTHEZ HYREY3 defDEF3 3
4] feB5DTED FFVF R 4 ghiGHI4 4
HICshiaD FIXXR5 JKIKLS 5
eJ FOBNE AN ZaV; N3 mnoMNO6 6
FHOHD N=LXET parsPQRS7 7
PIOL L & +v13v2138 tuvTUV8 8
(=N 5b%N3 SU)Lo9 wxyzZWXYZ9 9
(o) DEH— 0I5 2—-0 0 0+3
° 456 < 456 —___ a5 *
«o ? 1 - Space’ «o ? | - Space’ -& () ¥ Space #

1 Appears as dunng double-byte entry.

2 The lower case of 7" can be entered in double-byte mode.

3 Press and hold (%] to enter "+.”

4 Can be toggled between upper case and lower case.

5 (*Jtoinsert line feed “ J .*

6 Before conflrmlng characters press [O to display “_,” and press again in this state to enter “* “ or ** *

7 o, "? "1 “and “ - " cannot be entered ‘when entering readings in Own chtlonary or in USIM Phone Book.




- Text Entry Key Assignments

Iln 2-touch Mode

@In Double-byte Mode

@In Single-byte Mode

Key [ Press Next Key [ Press Next
1/2|3|4|5|6(7|8|9|0 1/2|3|4(5|6(7|8| 9 |0
DT |(H|WLWDS|A|B8|A|B|C|D|E |1 (7|4 |9|T|4#|A|B|C| D ]|E
ﬁ BlWw|5|A|s|a|lblc|d]|e ﬁ PlA v || #]a|blc| d e
T (p|=|<|F[|F|G[H|I]|Y Ta(n|x|o|sfa]F|a|H] 1 [V
a flaglh|ilij a fleg|n]| i |
B|c|L|TF|E|[Z|K|LIM|N|O (Y [y |A|E|V[K|[LIM|[N|O
kK|il|m|n]o kK{lfm| n|o
4 (1| B|D|T|&E|IP|Q|IR|IS|T 49 (F|Y| 7| M| P]Q|R] S |T
) pla|lri|s|t Y plafr [ t
SliE|lC|HB|R[D|UIVIW|X]|Y S|F|Z X[/ |U]V|W| X |Y
ulviwlx]|y Ufviwl] x |y
BIF|O|B|N[F|Z[?|!]|—|/ 6| N || T [AN|R|[Z]?2]! - /
z 7
7| F|H|T|D|B|¥[& ! 7V || L|x|E[V]E =
8|®| (|[B]) |& # o2 8l r|([a])[3]x]¢ @ |’
» ) £ i 1 3
9(5(b|d|N|[A[1|2|3|4|5 Q|7 (Ubfjb|jOfT]2]|3| 415
@e|/|-|_ neip| cojp [acp [EEpe
O(b|zE[A|S|2|6]7]8]9]0 0|77 617189 |0
s} o 3 . | com [ il | httpy/ - [nttsy/

1

Katakana are entered in
double-byte mode when
entering readings in USIM
Phone Book.
Can be entered as double-
byte characters when
entering pictographs is
possible, such as in Text
Memo and Common Phrases.
Press (0] to toggle
between upper-case and
lower-case modes. Pressing
after entering an upper
case character switches to the
lower case character.
After characters that cannot
have “* “or “* ," a separate
“t or " " is entered.
Before confirming characters,
press (O to display “_,“ and
press again in this state to

enter “* " or

ue u

TA sbace is entered for these
key combinations.

F xipuaddy
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Text Entry Key Assignments

Iln T9 Input Mode

15-12

Key K::itil{;'i;:ggga Eﬁ::;ﬁ::e Alphanumeric Entry Mode
) Rowds, 1 Row 7, 1 J@721(),-_:" ~°& ¥ 1Single-byte
space

23| Rown, 2 Row#, 2 abcABC2
Row, 3 Row't, 3 defDEF3
C4)|  Rowrz, 4 Row?%, 4 ghiGHI4
5) Row’, 5 Row7, 5 JKIKLS
=0 Rowl&, 6 Row/\, 6 mnoMNO6
Rowz, 7 Row ¥, 7 pqrsPQRS7
Row+, 8 Row*7, 8 tuvTUV8
=D Row 5, 9 Row 3, 9 wxyzZWXYZ9
(o] nE N DIy 0

> n—.0 54— 0

§ 12 12 26

g_ 3 3

X

M

- For key assignments in number entry mode,

see the table in “In 5-touch Mode."”

- Numbers do not appear when entering

readings in USIM Phone Book and Own
Dictionary.

+ Press to toggle the case as follows:

Caps-lock cancel mode — Shift mode —
Caps Lock mode

- Caps Lock mode: All characters are entered

in upper case.

Shift mode: The first characters of words are
capitalized and the rest of characters are
entered in lower case.

Caps-lock cancel mode: All characters are
entered in lower case.

- Once characters entered in Shift mode have

Ul

been determined, the mode is switched to
Caps-lock cancel mode.
When editing a reading, pressing

adds/cancels “* “or “* "
to insert line feed “ 4 .~
N ’u " ’u uo ’u N ’u w o, and "(Space)”

appear right after a reading or character is
determined.

The lower case of “J“ can only be entered
in double-byte mode.

“~ " is entered in double-byte mode.
Pressing before confirming characters
enters a space before confirming.



Kuten Code List

@Actual Display font may differ in appearance from the following.

> WEEREE KN KRE REZ  KKBERME
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m7 K R A LG 4 4 0 JligHI=] T R o e
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Sr|dEKAYE XHERMESE REE ER RIENKESEKE BER  HHZREECR

WGHMWE% HENESH Rk HIBE BilE  FERGIMSED EHE Eitokh

m5%ﬂiﬁﬁ EEKERENY  RERH EIN | SRR R IR

£ v [EHLEHRREKHMHAEN - SCEHRE — EHKERKEEKERE S SREFEK

o ENEEHERRIIEEE  RMEINE  RRERENRITEDR  EEEX

€ o BRI RIINKHTHESREIE S IXIRGRIENK RRGKERDH SR B iinenn MISXHHESX

- NEMERELXSIRBEEE FHEEY SHSHIHKEESREY Sy

o HIRNDIRRINIEK FREKKEIENE DRI BKRe HCHIRRERN KEN JEEEN

o B OIRE IUREKERE CHME@EEHE FHENEEE 2 R EERSR

g=| W BE O omXEEE GHSRKmIE WD e MR

hr g ¥ @GEND  RETREX  MINEREEIRNHE [RIEIEmESR o SRR

] ms HIHE [ERISEE EINEENMETN CRERLRE SR ReEm

P Zelg R, SKEEEN XREZLHERSR SEREMERE | e ChimE

k<] e RERR B RRE S i S TR M I i | T AT (T R KUK B DX

O 5o HERE EEZETSORBEDEENHHITFRNKEREETR (RIS

v T HHEER — SEREHE RS0 RO TS IR IREREE

< 2 KEHEN EERKERORRESHBREEIIRZEREIHEDNRE  (eRESER

m ° 2 BN XREDERGCE WERESEROEE R R RRS

=] B8 woo—a amcwo~roco-—AamTLO~NOOO—AmTLON ~NO®O—Mm

> 2% FFR2=% S2322=%3523535995233055888 SS5aanA
[

Appendix

1514



Kuten Code List

Appendix
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go| WKESR EHE IRRERKKE  HEN B O ¥ RBKE &
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Kuten Code List

Fourth digit of Kuten codes

BRI RURIEEER
o 5 R A 1K 555
YO B 5 o e
U PR R g

=R EREE
[IE£3 Bt D U ot R AR R
SKEREEERNR
Eofaskist Poboputin g

H RN S RISIEE
SR R R R
BEIE R G LR
S 38R S K B

MK RESUE R R
BRI HEER
RIS K DB K
HEDRE@ R

Eﬁ%ﬁﬁ%%=2 ﬂr%%gﬂ§§¥ Eﬁﬁﬂ%ﬁﬁﬁﬁ EE uﬁﬂﬁﬁ%
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L S 00 0 O 0 R 72, G410 50 4 Ut A R o S EC T OGS T DR i KE I 2 a0

15 1%

digit50123458789

1st-3rd

BRI R EER RO MK B XS IRIRRE MK

™
©
)

558
559
560
562
564
565
566
567
568

=)
©
)

570
596

Fourth digit of Kuten codes

18 597

B | 591
£ 5% | 592
& I | 593
15| 594
BE| 595
w

16| 598

IR U R K N
DEWEIEEIREL
IRL R K K

e SRERERHIN KK
BB T EEIOH 3K S A AR K
S IR S S
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] ] =1 55 5 0o L 5% 0 {00 B 7 4 R 158 6 A - BRSBTS 4
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1st - 3rd
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0

Fourth digit of Kuten codes
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Fourth digit of Kuten codes
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Fourth digit of Kuten codes
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Fourth digit of Kuten codes

digit50123456789
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- Menu List

- Enter menu item numbers for direct menu access. Note that Main Menu theme must be set to Basic.

- See “Check Default Style Mode Settings” (P. 14-3) for menu items whose default settings differ according to the model color.

@ Mail
2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
Inbox — — — P. 5-7,
P 5-21
Outbox — — — P. 5-10,
P. 5-24
Draft — — — P. 5-24
Tomomato-Mail — — - P.5-12
BOX
Compose Message - - - P. 5-3
Compose SMS - - — P. 5-5
Server Mail Mail List - - P 5-8,
P. 5-20
Server Mail Memory — - P. 5-21
Retrieve New — — - P. 5-20
Template — — — P.5-19
Mail Setting Custom Mail Address — — P 14-22
Scroll 1 Line P. 14-23 >
Font Size Standard %
Mail List Disp. 1 Line+Body %
Start Attachment (auto) OFF ~3
Header/Signature - P 14-21
? P. 14-ZBI B_
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- Menu List

b xipuaddy

2nd-level Menu 3rd-level Menu | Menu Item No. Default Setting Refer to
Mail Setting Mail Box Lock — - P.5-13
Receiving Setting Operation Preferred P 14-22
Read Out Setting Select Voice: Female 1, Read Out Received Mail: ON
Emotion/Keyword Disp. Emotion: ON, Disp. Keyword: OFF
S! Mail Settings Message Download: Auto(All), Delivery Report: OFF P. 14-21
SMS Settings SMS Report Request: OFF, SMS Validity Period: 3 Days, SMS
Input Character: Japanese(70char.)
Check Settings — P 14-23
Reset —
@®Yahoo! Keitai
2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
Yahoo! Keitai - - - P 6-3
Bookmark — — — P 6-11
Saved Pages - - -
History - - - P 6-3
Enter URL - - —
PC Site Browser - - See " @PC Site Browser under Yahoo! Keitai” (P. 15-31). P 6-5
Browser Settings Font Size — Standard P. 14-26
Scroll Single Line P 14-25
Downloads Display Images: ON, Play Sounds: ON
Flash Sound Effect ON P 14-26
Memory Manager - P. 14-25
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- Menu List

2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
Browser Settings Security Manufacture Number: ON, Send Referer: ON, Cookie Settings: |P. 14-25
Enabled, Script Settings: Ask NW Access
Check Settings —
Initialized Browser — -
Reset —
@®S! Appli
2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
S! Appli List — — — P. 9-8,
P 9-9,
P.9-13
Settings Sound/Vib Settings — Volume: Level 4, Vibration: ON P 14-33
Backlight Settings Switch ON/OFF: Link To Phone Set., Blink: ON
Reset - P. 14-34
Information - - — P 9-8
oTV
2nd-level Menu 3rd-level Menu | Menu Item No. Default Setting Refer to
Watch TV - - - P 8-6,
P. 8-14 >
Program Guide — — — P.8-9 %
Booking Program List — — - P.8-12 g
Timer Recording List — — - %
Result Timer Rec — — — P. 8-18
TV Link - — — P. 8-15 B_
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2nd-level Menu 3rd-level Menu | Menu Item No. Default Setting Refer to
Channel List — — - P.8-14
Channel Settings — — — P. 8-5
User Settings Subtitles — ON (Wide: Bottom) P 14-28
Rec. While Low Battery ON P. 14-29
TV Effect Sound Effect: Auto, Visual Image Effect: Dynamic P 14-28
TV Power Saving OFF (not set)
Display Light Constant Light
Data BC Settings Set Image Disp.: ON, Sound Effect: ON P 14-29
Icon Always Show ON P. 14-28
Time Shift Setup Auto ON
Check TV Settings — P. 14-30
Reset Channel Setting —
Reset Storage Area -
Reset TV Settings -
@Camera
2nd-level Menu 3rd-level Menu | Menu Item No. Default Setting Refer to
Photo Mode — — — P.7-5
Movie Mode - - — P 7-7
Voice Mode - - — P 7-8
Quick Album — — - P 12-4
Videos — — - P.7-14
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@Entertainment
2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
Mobile Widget Widget Contents — — P.10-3
Settings Auto Refresh: ON, Auto Roaming: OFF, Cookies: ON P 14-35
Information — P 10-2
S! Quick News S! Quick News List — — P. 10-5
Settings See " @ Settings for S! Quick News under Entertainment”(P. 15-32) -
S!'Info Ch./Weather | What's New — — P.10-6
History —
Register/Cancel -
Get Latest Contents - P.10-10
Settings S! Information Notif.: ON, Font Size: Standard P. 14-37
Weather Indicator Weather Update: ON, Standby Setting: ON, Weather Notif.. |P. 10-6
ON P. 14-37
BookSurfing - - — P 10-8
@Tools
2nd-level Menu 3rd-level Menu | Menu Item No. Default Setting Refer to
Alarm - 44 - P.11-16
Schedule - 45 - P11-8 2z
Calculator - 85 - P.11-15 B
Dictionary Enter Word - — P.2-31 g_
Text Reader — — — X
Reference History - — P 2-31 m_
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2nd-level Menu 3rd-level Menu | Menu Item No. Default Setting Refer to
Text Memo - 42 - P.11-13
To Do List - 95 — P 11-11
Life History Viewer - - — P 11-6
Osaifu-Keitai - - — P 11-2
S! Addressbook Start Sync — — P.2-28
Back-up Auto Sync Settings — — P 14-16
Sync Log - - P.2-28
Account Details — 0 — P 1-22
Bar Code Reader — — — P 11-18
Text Reader - - — P 11-20
Receive Ir Data — 79 - P.13-3
Bluetooth - - - P 13-5
Play/Erase Msg. - - - P 3-5,
P.3-18
Play/Erase VC Msg. — — — P.3-5
Voice Memo — 43 - P.11-14
Voice Announce — 91 - P 14-15
Forwarding Image — — ON P 14-16
microSD Manager - - - P.12-12
USIM Operation — — — P.2-27,
P 5-22
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@®Data Folder

2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
My Picture — 46 — P.12-2
Melody — 16 —
S! Appli — — —
Ring Songs - Music - - -
Videos - - —
Books - - -
Widget — — -
v = = -
@ Music

2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to

- - - - P 95

@®O0wn Data

2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
Received Calls — 24 — P 3-11
Dialed Calls — — — P 3-10
Blog/Mail Member — 97 - P.5-4 >
Tomo-Den - - - P.3-12 %
Common Phrases - 38 — P 2-17 g
Own Dictionary - 82 = P2-17 %
DL Dictionary — — - E
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@®Phone Book

2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
— — — — P 2-21
@Settings
2nd-level Menu 3rd-level Menu | Menu Item No. Default Setting Refer to
Style Mode Setting - - Differs according to the model color. P 14-3
Incoming Call Ring Volume 50 Phone, Video Call, Mail: Level 4 P. 14-10
Select Ring Tone 13 Phone (Select Ring Tone: Pattern 1, Select Calling Disp.: Flying Type),
Video Call (Select Ring Tone: Pattern 3, Select Calling Disp.: Flying Type),
Mail (Select Ring Tone: You've got mail 1, Select Receiving Disp.: Flying
Type)
Vibrator 54 Phone, Video Call, Mail: OFF P. 14-11
[llumination 89 Set Color (Phone: Color 10, Video Call: Color 5, Mail: Color
1), Set Pattern: Standard, Missed Info: ON
Manner Mode Setting 20 Manner Mode P 14-13
Disp. Phone Book Image — ON P 14-11
Answer Setting 58 Any Key Answer
Mail Ring Time 68 Mail: ON (Ring Time: 05 Seconds) P. 14-10
Ring Time(sec.) 90 Set Mute Seconds: OFF, Missed Calls Display: Display P 4-7
Answering Machine 55 OFF P.3-4
Disp. Call/Receive No. — Solid Black, Berry Pink and Glitter Orange: White, Light Grey |P. 14-14
and Frost Green: Black
Talk Hyper Clear Voice — Low P 14-18
Auto Voice Memo - OFF
Noise Reduction 76 ON
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2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
Talk Quality Alarm 75 No Tone P.14-18
Reconnect Signal 77 No Tone
Set Hold Tone — On Hold Tone: Tone 1
Dialing Pause Dial 84 — P 14-17
Sub-address Setting — OFF
Prefix Setting - ERFEE (Prefix: 0046010)
Dialing Headset SW to Dial — OFF P. 14-15
Int’l Dial Assistance - Auto Int'l Call Set.: ON, Country Code Setting: B4 (Country Code: |P. 14-17
81), IDD Prefix Setting: EBF(E (IDD Prefix Code: 0046010)
Video Call Visual Preference - Normal P.3-17
Select Image On Hold, Holding, Substitute Image, Answering Machine, P 14-19
Preparing, Voice Memo: Pre-installed
Auto Redial as Voice OFF
Display Setting Main Display: Other Side
Hands-free Switch ON
Display Display Setting 56 Differs according to the model color. P 14-4
Backlight 70 Lighting: ON+Saver (Light Time: 01 Minutes), Charging: P.14-7
Standard, Brightness: ON+Level 4
Display Design 86 Differs according to the model color. P. 14-5 _°>
Font 66 Font Type: Gothic, Thickness: Bold, Character Size: Standard 'g
Desktop Icon 63 Theme 1 P 14-7 g_
3D Display Setting — ON P. 14-8 ~3
SEEEIR (Language) 15 [EE P.14-6 B_
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2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
Display Original Menu 52 Account Details, Retrieve New, Ring Volume, Vibrator, Alarm, |P. 14-9
Change Security Code
Menu Display Set 57 Menu Display: List, Theme: Differs according to the model color, [P. 14-8
Memory Focus: ON
Viewer Settings - Picture P. 14-6
Icons 36 - P.1-7
Icons Setting — ON P.14-10
Privacy Angle — OFF P. 14-6
Image Display Mode — Vivid
Quick Info Setting — Display Sender
Display On Charge - Wide Stand-by Clock
Screen Effect — Turn
Call Time/Charge  |Call Data 61 - P.3-11
Set Max Cost Limit - Notify Setting: OFF P.14-19
Reset Total 60 — P 3-19
Auto Reset Total Cost — OFF P 14-18
Clock Set Main Time 31 Auto Time Adjust: Auto, Summer Time: OFF P 14-2
Set Sub Clock — Display Method: OFF, Summer Time: OFF, Area Name: Display
Clock Display 39 Display: ON, Size: Small, Color: Differ according to the model color.
Alarm Setting - Alarm Preferred P. 14-3
Clock Alarm Tone Set — Alarm Tone
Auto Power ON - OFF
Auto Power OFF — OFF
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2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
Security Lock - OFF P 4-3
IC Card Lock Set. - OFF P 11-4
Call Remote Lock - OFF
Keypad Lock - After Closed: OFF, Timer: OFF, Lock Key: ON, Security Code: [P 4-4
NO
Emission OFF Mode - NO (not set) P 4-7
Secret Mode 40 OFF (not set) P 4-8
Secret Data Only Mode 41 OFF (not set)
Reject Unknown — Accept P 4-7
Call Setting W/O ID 10 Unknown, Payphone, User Unset: Accept (Select Ring Tone:
Same as Ring Tone, Select Calling Disp.: Same as Display)
Change Security Code 29 9999 P 1-21
IC Card Authentic. — OFF P 4-6
PIN Setting — - P. 4-2
Slide-style Setting | Setting When Open — Answer Incoming, Display New Mail, Display Missed Call: OFF |P. 14-11
Slide Sound - Open Sound: Open-1 (Ring Time: 2.0 Seconds), Close Sound: |P. 14-14
Close-1 (Ring Time: 2.0 Seconds)
lllumination Key lllumination - See " @Key lllumination for lllumination under Settings” (P. 15-32) -
Key Backlight — Differ according to the model color. P 14-41 _°>
Key/Touch Sensor  |Keypad Sound — ON P. 14-38 'g
Touch Sensor Setting - ON P 14-39 g_
Shortcut-key Setting — Music Player P 14-38 ~3
External Connection  |USB Mode Setting - Communication Mode P 13-9 B_
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2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
External Connection | Headset Usage Setting — Headset+speaker P 14-15
Headset Mic. Setting — Headset Microphone
Auto Answer Setting — Phone, Video Call: OFF
Connection SMS Center Selection — 819066519300 P.14-24
Settings Certificate - All Certificates: Valid P 6-14
Retrieve NW Info — P 1-18
Send Location Info — — Confirm P. 14-26
Int’l Roaming Set | NW Search Mode — Auto P.14-20
PLMN Setting —
Display Operator Display OFF
Name
Optional Services | Caller ID Notification 17 ON P.3-22
Voice Mail/Divert - - P 3-14,
P. 3-15,
P 3-20
Call Waiting — — P. 3-20
Call Barring - - P.3-21
Other Settings Charge Sound — ON P 14-14
_g Battery Level 71 — P 1-22
'g Network Status - -
g_ Character Input Set 35 Inpu”t Mode: 5-touch, Prediction: QN, T9 Change Mode: T9 P 14-38
=3 Kanji Change Mode, CHG Input Size: Standard, Auto Cursor:
Normal
_ﬂ Volume Restriction — ON P.14-14
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2nd-level Menu 3rd-level Menu | Menu ltem No. Default Setting Refer to
Other Settings Reset Settings 23 - P. 14-42
Initialize — -
Software Update - — P 15-4
@PC Site Browser under Yahoo! Keitai
4th-level Menu 5th-level Menu | Menu ltem No. Default Setting Refer to
Home — — — P. 6-5
Bookmark — — - P.6-11
History - - — P. 6-6
Enter URL - - -
Yahoo! Keitai — — — P. 6-3
PC Site Brw. Settings | Warning Messages - ON P. 14-26
Scroll - Single Line P 14-25
Display Mode Settings — PC Screen: 100%, Small Screen: Standard P. 14-26
Downloads — Display Images: ON, Play Sounds: ON P. 14-25
Memory Manager - -
Security — Manufacture Number: ON, Send Referer: ON, Cookie Settings: Enabled, Script Settings: ON
Check PC Site Brw. Set. - —
Initialized Browser - -
Reset PC Site Brw. Set. — —

F xipuaddy
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@Settings for S! Quick News under Entertainment

4th-level Menu 5th-level Menu | Menu ltem No. Default Setting Refer to
Auto Refresh S! Quick News — OFF P 10-9
General — OFF
Special — ON
Standby Settings Standby Disp. Set. — ON P. 14-36
Speed Settings — Normal
Unread & Read Set. - Unread & Read
Set Image Disp. — — ON
Del. Quick News — — —
@Key lllumination for lllumination under Settings
4th-level Menu 5th-level Menu | Menu ltem No. Default Setting Refer to
Power ON Set Pattern - ON P. 14-39
Set Color - Color 7
Power OFF Set Pattern - ON
Set Color — Color 7
Talking Start Set Pattern — lbuki
> Set Color — Color 7
g Emotion — — ON (Always)
g Alarm Set Pattern - Kodou
2 Set Color - Color 1
- Snooze Set Pattern — ON
_ﬂ Set Color - Color 2
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Refer to

4th-level Menu 5th-level Menu | Menu ltem No. Default Setting
Ir Exchanging Set Pattern - ON
Set Color - Color 5
IC Exchanging Set Pattern — ON
Set Color - Color 3
Charge Starting Set Pattern — ON
Set Color — Color 5
Open Set Pattern - Differs with handset color.
Set Color - Differs with handset color.
Close Set Pattern - Differs with handset color.
Set Color - Differs with handset color.

P 14-39
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- Specifications

= o o Camera still images for 5 t0 20 files?
IMaln SpeCIflcatlons continuous shooting
Still image file [JPEG
Modal 330N format ;
_ - Video recording |Handset: Up to approx. 272 sec.
Dimensions (H x W x D) 107 x49x13.9 mm time microSD™ memory card (64 MB):
Weight Approx. 113 g Up to approx. 120 min.3
Continuous Standby Time Approx. 570 hrs — \C/Ide? file format| MP4
- - t i
Continuous Talk Time Voice Call: Approx. 220 min. w%r':cu‘iﬁglﬁme Approx. 170 min.
Video Call: Approx. 110 min. _ .
_ - : Maximum Approx. 600 min.*
Charging Time Max. 120 min. recording time
Display Type Display: TFT 262,144 colors Storage Chaku-Uta® ang Approx. 180.0 MB®
Size Display: Approx. 3.0 inches Capacity Chaku-Uta Full
: ; - ; 1 In case the image size is Sub QCIF (128 x 96) and the image
Pixels Display: 409,920 pixels quality is set to Fine (the file size is 10 KB).
(480 x 854 dots) . : . .
2 Varies depending on the image size.
Camera Imaging device |[CMOS 3 Time for recording when recorded in the following conditions:
Lens size 1/4 inch Handset |microSDT"' memory card
Effective pixels |Approx. 3.2 million pixels Image size Sub QCIF (128 X 96)
Recording pixels [ Approx. 3.14 million pixels Image quality Normal
Zoom (digital) |Up to approx. 15 x File size 2MB | Long Time
Still images Up to approx. 1,000 files Recording type Normal
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Approximate time when recorded on a 2-GB microSD™ memory card.
Shared with images, videos and saved pages.




IHandset Materials

Where Used Material/Finish
Outer Display surface  [PC resin + stainless plating,
casing acrylic UV-cured coating
Keypad surface
Display bac SUS plating, electrodeposited

coating

Keysheet center confirmation
button

PC resin, vapor deposition +
acrylic UV-cured coating

Battery Screws

Iron, nickel plating

compart- [Cover
ment

PC resin, acrylic UV-cured
coating

Terminals

Copper alloy, gold plating

Battery (terminals)

Epoxy resin (glass epoxy), gold
plating
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Maximum Number of Storable

Maximum P
Item Number That Can be
Protected

Template (Graphic Mail) 456 -
Answering Machine Voice calls: 5 —

(20 sec. each)

Video calls: 2

(20 sec. each)
Voice Memo 1 (20 sec.) —
Dialed Calls 30 -
Received Calls 30 -
Speed Dial 10 (Entry Number -

000-009)

Items
Item Maximum Tll\in:tx(ig: Il?e
Number Protected
Phone Book entries 1,000" —
Schedule [Events 2,500 -
To Do List |Tasks 100 -
Mail Received 1,000234 1,0002
messages
Sent 400234 200
messages
Draft 202 -
messages
Bookmarks |Yahoo! Keitai | 100° —
PC Site 100° -
Browser
Saved Pages 1002 50
S! Appli 1002 -
Still images 1,000%24 -
Videos 100%° -
Widget 1002 -
Melodies 2002 —
Songs 1002 -

15236

1 Up to 50 entries can be saved on USIM Card.

2 The actual number that can be saved or protected may be less
depending on the data size.

3 An additional 10 received and sent SMS messages can be
saved on USIM Card.

4 Up to 100 additional messages/files can be saved in Secret
Folders.

5 Up to 10 additional files can be saved in Secret Folder.

6 Includes data stored by default.



IMemory Card Folders & Files

Folder File
DCIM XXXNECDT Still images captured with handset camera
PRIVATE |MYFOLDER |Mail Inbox Backup data of Inbox
Sent Messages Backup data of Outbox
Drafts Backup data of Draft
Utility Calendar Backup data of Schedule
Contacts Backup data of Phone Book
Memo Backup data of Text Memo
Rights Backup file of content keys
Tasks Backup file of To Do List
My Items Book Book files
Widget Widget files
Bookmarks Backup file of Bookmarks
Flash(R) Flash® files
Games and More S! Appli files
Music Songs
Pictograms My Pictograms
Pictures Still images
Sounds & Ringtones | Melodies
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Folder File
PRIVATE |MYFOLDER |My ltems Videos Videos
WMAudio WMA files
NE_Folder Other files
SD_VIDEO | MGR_INFO TV Program recording management file
PRGXXX TV Program recording files
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2-touch Mode .....cccevvvvvcieeniennen.
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From Data Broadcasts .................... 8-8
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From Scanned Data
From TV Links .......
From URL in Text ... .
From Web Page ..........cccooeviein.
Multi WIndow .........cocoevvieieee.
PC Site Browser ........cccccccceeeveeenn.
Use Access History
Use URL History .....ccccooovvvviieiiiens
Yahoo! Keitai ......cc..ccooevveiiiiien.
Account Details .......cccouvevieeeiennns
Add Folder
Bookmark ... 6-17
Data Folder ......c...ccooeevviiiein 12-10
MESSAges ..ovvveeieiiieiie 5-23
After Sales Service .......ccccveeunennn. 15-51

Alarm e

cancel oo

Edit oo

Release All .

Set
Alarm Activation Operations ..... 11-17
Alarm Notification Operations

Schedule .....ocooiiiiiii 11-9

To DO LiSt cvvvviiiiiiiiiieeeieeee 11-11
Answer Incoming (Slide-Style) ...14-12
Answer Setting .........ccccviiiinnen. 14-12
Answer Video Calls .. ... 3-8
Answer Voice Calls .....c.ccoeevveernennne 3-4
Answer Voice Calls
(Bluetooth®) ......cooceeeeeeeeeeeeeeene 13-7
Answering Machine ........cccecenene 3-4

Activate When Call Arrives ............. 3-5

Play/Delete Messages ............ 3-5, 3-18

SettiNgS «oovveeieeee e 3-4
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Auto Answer Setting ......ccccceeeene 14-15

Auto Power On/Off .......cccceevveneenne 14-3
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Auto Timer ................ 7-11
Auto Voice Memo .14-18
AUTO-SOIt ...oviieeiiiieeeeeeee e 5-12
B
Backlight ..o 14-7
Bar Code Reader ........cccoeeeuveennen 11-18
Check Scanned Data .................. 11-19
Delete Scanned Data .................. 11-28
SCAN i 11-18
Basic Key Operations .........ccccceveue 1-3

Battery ..o 1-14
Charge ...ccoovvvee. 1-14, 117
Check Battery Level .......cccccceveneee 1-22
Installation ..........ccoooieiiiiiie 1-14

Blog/Mail Member .........ccccceecvrene 5-4
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Blog Upload Destination ................. 5-4
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Edit Address ..........
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Bluetooth® ............. ..
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ConNeCting .vcoovvveeeiieiieeie e
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Delete Added Device .................. 13-11
Device List ......oovvvieiiiiiiiiiiiiie, 13-7
Discontinue .......cccccovviiieiiiiiiee, 13-8
Playing Music .. .13-8

Search ........ .13-6
Settings ... . 14-42
Talk v 13-7
Booked Programs ..........ccccceceruene. 8-12
Change Order .......cccooceiviiiiennne. 8-17
Delete ..oooovveeieieeeeeeee 8-18
Edit .......... 8-17
Bookmarks ... .. 6-11
Access Page .. 6-11
Add Folder ..........cccoooiiiiii, 6-17
Delete ...oo.oooviieieiie e 6-18
Delete Folder ........ccccoeveveiieennn. 6-18
Edit URL ..o 6-17
MOVE ..o 6-17
Number of Bookmarks ................. 6-17
SAVE i, .. 6-11
Save Scanned URL .... 11-27
Send by Mail ......... ..6-17
Sort Folder ........cocoovvvviiiiiiii 6-17
BOOKS ...veeeeeeee e 10-8
BookSurfing® ......cccoeveeeeeeeieennas 10-8
C
Calculator .....ccoeeeeveeeeceeciees 11-15
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Call Barring ......cocceeeereneneenenennens 3-21
Call Forward .......coceeveeiieeienrieneenne 3-14
Call Rejection ......ccevceeneeieerieennnnne 3-16
Call Time/Charge .3-1
Call Waiting ....... ..3-20
Caller ID ... ...3-16, 3-22
CaAMEera ..occovvceeieeeee s 7-2
Add Frames ........ccccooeviviiiiiins 7-11
AFchange ... 7-13
AUtO TIMEr ..o 7-11
Blog Upload ........ccocveviiiiiicne 7-13
Brightness .......c.ccccoviiiiiiiiiis 7-13
Camera Modes ... 713
Capture Still Images .........ccccoeeeneen. 7-5
Chance Capture ........cccoeveierennn 7-8
Continuous Shooting ..........c........ 7-10
Effect oo 7-13
Image Size ... 7-13
Memory INfo ..o 7-13
Photo Mode ........ccccoeviiiiiiiin 7-13
Photo Viewfinder
(Landscape View) .......ccccocveveenrnne. 7-5
Record Videos .........ccccevveviiincnnn. 7-7
Send Images/Videos by Mail ......... 7-14
Settings ..ovveiieie 14-31
Shake Correction ..........cccevein. 7-13
Video Viewfinder
(Landscape View) ........cccoceveeennennn. 7-7

Viewfinders ........ccoovvevveviiiiie 7-3
Voice Mode ......ccooveviveiiiiiiiee 7-8
Capture Still Images .......ccccceceveenee 7-5
Center Access Code ... 1-21
Certificate ......c....... ...6-14
Chance Capture ......cccoeveeeeeiveceenens 7-8
Change
Entry Number .........cccoooviviiiiiis 2-33
Font Size (Message Text) .............. 5-25
Graphic Mail Effects ... 5-18
Ilconimage ......ooooveviiiiiiiiii 2-30
Network Password ...................... 3-21
PIN1/PIN2 .
Security Code ......cooviriniiiii 1-21
Set To, CcorBCC oo, 5-16
Change SKin .....ccccvveeierieneeiens 14-33
Channel List .....c..ccooeeveveeeiieeiiene 14-27
Delete a Channel .............ccc........ 14-27
Remote Control Numbers ........... 14-27

SWItCH o
Channel Settings . .
AUtoMatiC .oooveiieiiii

Character Stamp
Charge Battery .....cccocveveniennenne

AC Charger .....
Charge Sound
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Check Battery Level ..o 1-22
Check Settings (Mail) .................. 14-23
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(Yahoo! Keitai/PC Site Browser) 14-25
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Compose SMS
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From Tomo-Den ...
From Web Page .........ccccoovriinn.
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IWarranty

A warranty card is included with 830N.

@ Check that the store name and purchase date sections have
been filled correctly.

@ Read the card carefully and store it in a safe place.

@ See the card for the warranty period.

Note

+ SoftBank assumes no responsibility for any damages incurred
by you or third parties as a result of losing opportunities to
make calls, etc. due to a failure or malfunction of this product.

IAfter Sales Service

Refer to “Troubleshooting” (P. 15-6) before submitting your

handset for repair.

If problems still persist, contact SoftBank Customer Center,

Customer Assistance of your area (P. 15-52), or consult with

your nearest SoftBank shop.

Provide us with detailed information of your problems.

@ Repair within the warranty period is carried out in accordance
with the conditions of the warranty.

@ Repair after the warranty period is carried out if possible, and
the owner of handset is responsible for any repair costs.

Note

+ SoftBank assumes no responsibility for any damages incurred
by you or third parties as a result of losing opportunities to
make calls, etc. due to a failure, error or malfunction of this
product.

» Data and settings you saved may be lost or altered as a result
of failure or repair of handset. It is recommended that you
keep a backup copy of important data (e.g. Phone Book
entries, image and sound files). SoftBank assumes no
responsibility for any damages due to the loss or alteration of
handset data.

* Disassembling or modifying handset may constitute a violation
of Radio Law. Your handset will not be accepted for repairs if
it has been modified.

Tip

« For information on after sales service, contact your nearest
SoftBank shop or SoftBank Customer Center, General
Information (P. 15-52).

- Warranty & After Sales Service
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- Customer Service

If you have any questions about SoftBank handsets or services, call General Information. For repairs, call Customer

Assistance.
SoftBank Customer Centers SoftBank Global Call Center
From a SoftBank handset, dial toll free at 157 for General From outside Japan, dial +81-3-5351-3491 (Make sure to
Information or 113 for Customer Assistance. dial the correct number. International charges will apply.)

H Call These Numbers Toll Free from Landlines

Subscription Area Contact
Hokkaido, Aomori, Akita, Iwate, Yamagata, Miyagi, Fukushima, Niigata, Tokyo, | General Information @ 0088-240-157
Kanagawa, Chiba, Saitama, Ibaraki, Tochigi, Gunma, Yamanashi, Nagano,
Toyama, Ishikawa, Fukui Customer Assistance @ 0088-240-113
Aichi, Gifu, Mie, Shizuoka General Information @ 0088-241-157

Customer Assistance @ 0088-241-113

Osaka, Hyogo, Kyoto, Nara, Shiga, Wakayama General Information @@ 0088-242-157

Customer Assistance @ 0088-242-113

Hiroshima, Okayama, Yamaguchi, Tottori, Shimane, Tokushima, Kagawa, Ehime, | General Information @ 0088-250-157
Kochi, Fukuoka, Saga, Nagasaki, Oita, Kumamoto, Miyazaki, Kagoshima,
Okinawa Customer Assistance @ 0088-250-113
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